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Client Software License

Subject to the terms and conditions herein, Captaris grants you a
non-exclusive, non-transferable, personal license to install, run and use the
client software provided as part of the Product on an unlimited number of client
computers or devices that are owned or controlled by you for use in the
capacity for which you have paid license fees and solely with the server
software properly licensed by you under this EULA.

Documentation

You may make and use a reasonable number of copies of any documentation
provided with the Product; provided, that such copies will only be used for
internal business purposes in connection with the components of the Product
for which you have paid the applicable license fees and are not to be
republished or redistributed (either in hard copy or electronic form) beyond
your premises.

Backup
You may make one copy of the Product for back-up and archival purposes.

Updates

Any software provided to you by Captaris which updates or supplements the
original Product is governed by this EULA unless separate license terms are
provided with such updates or supplements, in which case, such separate
terms will govern.

License Limitations

Except with respect to an Evaluation Edition, the preceding licenses apply only
to the extent you have ordered and paid for the applicable licenses. The
preceding sections state the entirety of your rights with respect to the Product.
Captaris reserves all rights not expressly granted to you in this EULA. Without
limiting the foregoing, you will not, and you will not authorize or permit any third
party to:

(a) use the Product for any purpose other than your internal business
purposes;

(b) use an Evaluation Edition for any purpose other than your evaluation and
testing of the Product during the thirty (30) day evaluation period;
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(c) license, distribute, lease, rent, lend, transfer, assign or otherwise dispose of
the Product or use the Product in any commercial hosted or service bureau
environment;

(d) reverse engineer, decompile, disassemble or attempt to discover the source
code for or any trade secrets related to the Product, except and only to the
extent that such activity is expressly permitted by applicable law
notwithstanding this limitation;

(e) modify, alter or create any derivative works of the Product;

(f) exceed the capacity or concurrent user limitations for the license purchased
by you; or

(g) remove, alter or obscure any copyright notice or other proprietary rights
notice on the Product;

(h) disclose the results of any benchmark testing using the Product to any third
party; or

(i) circumvent or attempt to circumvent any methods employed by Captaris to
control access to the components, features or functions of the Product.

Audit

Captaris shall have the right to audit your compliance with the terms of this
EULA. You agree to grant access to Captaris to facilities, equipment, books,
records and documents and to otherwise reasonably cooperate with Captaris
in order to facilitate any such audit.

Ownership

The Product is valuable property of Captaris and its suppliers and is protected
by copyright and other intellectual property laws and treaties. Captaris or its
suppliers own all right, title and interest in and to the Product and all copyright
and other intellectual property rights in the Product.

Limited Warranty

Captaris warrants to you that the components of the Product for which you
have paid the applicable license fees will perform substantially in accordance
with the accompanying Product manual for a period of thirty (30) days from the
date of receipt.

Exclusive Remedy
If a component of the Product fails to conform to the foregoing warranty, then
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Captaris will use commercially reasonable efforts to repair or replace the
nonconforming component. If Captaris is unable to repair or replace the
nonconforming component or determines, in its sole discretion, that repair or
replacement is not practicable, then Captaris may instead terminate this EULA
as it pertains to the nonconforming component and return the license fee paid
by you for the nonconforming component. To the maximum extent permitted by
applicable law, the foregoing sets forth Captaris's and its suppliers’ entire
liability and your sole and exclusive remedy for breach of the limited warranty
set forth above. THE LIMITED WARRANTY SET FORTH ABOVE IS VOID IF
THE FAILURE IS DUE TO ACCIDENT, ABUSE OR MISAPPLICATION AND
DOES NOT APPLY TO AN EVALUATION EDITION. Any replacement
component will be warranted for the remainder of the original warranty period,
if any.

Indemnification

Captaris will defend you against any judicial proceeding based upon a third
party claim that the components of the Product for which you have paid the
applicable license fee infringes any U.S. patent, U.S. trademark, copyright or
trade secret and will indemnify you against any damages, judgments and costs
finally awarded against you in such proceeding; provided that, you: (a) give
Captaris prompt written notice of the claim; (b) permit Captaris to control the
defense and settlement of the claim; and (c) cooperate with Captaris in the
defense and settlement of the claim. Captaris's defense and indemnification
obligations will not apply to any actual or alleged infringement based upon: (i)
modification of the Product by anyone other than Captaris, (i) abuse,
misapplication or casualty loss, (i) use of the Product in combination with any
other program or device, if such infringement would have been avoided but for
such modification or combination, or (iv) failure to install or use any error
corrections, fixes or other updates furnished by Captaris, if such infringement
could have been avoided by such installation or use. In the event any
component of the Product licensed by you or your use of such component is
held to infringe or in Captaris’s reasonable judgment is likely to infringe any

third party intellectual property right, Captaris may, at its option, (x) obtain a
license for you to continue to use such component, (y) modify the component
so that it is noninfringing, or (z) terminate this EULA as it pertains to such
component and refund a portion of the license fee paid by you for such
component prorated over three (3) years from the date of purchase. The
foregoing indemnification obligations do not apply to an Evaluation Edition or
the Third Party Programs. Any indemnification that may be provided for any
Third Party Program is set forth in any separate license agreement
accompanying the Third Party Program.

Disclaimer of Warranties

EXCEPT AS EXPRESSLY SET FORTH ABOVE, CAPTARIS AND ITS
SUPPLIERS PROVIDE THE PRODUCT “AS IS” AND WITH ALL FAULTS.
CAPTARIS AND ITS SUPPLIERS HEREBY DISCLAIM ALL OTHER
WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, ARISING BY LAW
OR OTHERWISE, INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OR USE, TITLE AND NONINFRINGEMENT, WITH REGARD TO
THE PRODUCT. WITHOUT LIMITING THE FOREGOING, CAPTARIS
DOES NOT WARRANT THAT THE PRODUCT WILL BE FREE OF BUGS,
ERRORS, VIRUSES OR OTHER DEFECTS.

Disclaimer of Certain Damages

IN NO EVENT WILL CAPTARIS OR ITS SUPPLIERS BE LIABLE FOR THE
COST OF COVER OR FOR ANY INCIDENTAL, INDIRECT, SPECIAL,
PUNITIVE, CONSEQUENTIAL OR SIMILAR DAMAGES OR LIABILITIES
WHATSOEVER (INCLUDING, BUT NOT LIMITED TO LOSS OF DATA,
INFORMATION, REVENUE, PROFIT OR BUSINESS) ARISING OUT OF
OR RELATING TO THE USE OR INABILITY TO USE THE PRODUCT OR
OTHERWISE UNDER OR IN CONNECTION WITH THIS EULA OR THE
PRODUCT, WHETHER BASED ON CONTRACT, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY OR OTHER THEORY EVEN IF
CAPTARIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Limitation of Liability
CAPTARIS'S AND ITS SUPPLIERS' LIABILITY ARISING OUT OF OR
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RELATING TO THE USE OR INABILITY TO USE THE PRODUCT OR
OTHERWISE UNDER OR IN CONNECTION WITH THIS EULA OR THE
PRODUCT IS LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
THE PRODUCT REGARDLESS OF THE AMOUNT OF DAMAGES YOU
MAY INCUR AND WHETHER BASED ON CONTRACT, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY OR OTHER THEORY. The foregoing
disclaimer of warranties, disclaimer of certain damages and limitation of liability
will apply to the maximum extent permitted by applicable law. The laws of some
states/jurisdictions do not allow the exclusion of implied warranties or the
exclusion or limitation of certain damages. To the extent that those laws apply
to this EULA, the exclusions and limitations set forth above may not apply to
you.

Export Restrictions

You acknowledge that the Product is subject to U.S. export restrictions. You
agree to comply with all applicable laws and regulations that apply to the
Product, including without limitation the U.S. Export Administration
Regulations.

U.S. Government License Rights

All Product provided to the U.S. Government is provided with the commercial
license rights and restrictions described in this EULA. By installing, copying or
using the Product, the U.S. Government agrees that the Product is
"commercial computer software" or "commercial computer software
documentation" within the meaning of FAR Part 12.

Trademarks

This EULA does not grant you any rights in connection with any trademarks or
service marks of Captaris or its suppliers.

Termination

Without prejudice to any other rights, Captaris may terminate this EULA if you
do not abide by the terms and conditions contained herein. Upon termination
of this EULA, you must cease use of the Product and destroy all copies of the
Product and all of its component parts.
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Assignment

You may not assign (whether voluntarily, involuntarily, by operation of law or
otherwise) this Agreement, the licenses granted to you hereunder, or any other
rights under this Agreement without the prior written consent of Captaris.
Subject to the foregoing restriction on assignments by you, this Agreement will
be fully binding upon, inure to the benefit of, and be enforceable by Captaris
and its respective successors and assigns.

Governing Law; Jurisdiction

Unless expressly prohibited by local law, this EULA is governed by the laws of
the State of Washington, U.S.A. without regard to any conflict of law principles
to the contrary. The 1980 U.N. Convention on Contracts for the International
Sale of Goods or any successor thereto does not apply. You hereby
irrevocably submit to jurisdiction of the state and federal courts located in King
County, Washington with respect to any proceeding under this EULA or
relating to the Product. You will not prosecute any action, suit, proceeding or
claim arising under or by reason of this EULA except in such courts.

Attorneys' Fees

In any action or proceeding to enforce rights under this Agreement, the
prevailing party will be entitled to recover costs and reasonable attorneys' fees.

Severability

If any provision of this EULA is held by a court of competent jurisdiction to be
invalid, illegal, or unenforceable, the remainder of this EULA will remain in full
force and effect.

English Language

It is the express wish of the parties that this Agreement and all related
documents be drawn up in English. C'est la volonté expresse exigé par les
parties que cette convention et tous les documents y afférents, soient rédigés
en anglais seulement.

Entire Agreement

This EULA sets forth the entire agreement of Captaris and you with respect to
the Product and the subject matter hereof and supersedes all prior and
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contemporaneous understandings and agreements whether written or oral. No
amendment, modification or waiver of any of the provisions of this EULA will be
valid unless set forth in a written instrument signed by the party to be bound
thereby.
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Chapter 1
Introduction

RightFax includes email gateways for Novell GroupWise and

About the RightFax System

The RightFax system is a comprehensive network fax solution for
creating, sending, receiving, and managing faxes directly from a
user's desktop computer. RightFax features and intuitive design
make faxing as easy as printing to a network printer.

A user can enhance the fax by adding a cover page, overlaying a
form, attaching documents, and inserting graphics.

FaxUtil is the RightFax mailbox where users create, view, print, and
manage faxes. With FaxUltil, users can forward, route, and delete
faxes. They can view other users’ fax mailboxes and delegate views
into their personal fax mailboxes.

The RightFax fax server manages network print queues assigned to
faxing, converts outgoing faxes, schedules outgoing faxes, and
routes incoming faxes. Routing can be optimized with Intelligent
Least-cost Routing™ rules. The server consists of several services
that run on one server computer or several networked computers
to distribute heavy workloads.

Similarly, RightFax fax board services can be installed on remote
servers to distribute the workload across several computers and to
provide expanded channel capacity and system redundancy.

A RightFax email gateway acts as a communication link between
the RightFax server and an email server. With an email gateway, the
user's customary email client software can serve as the fax client.

SMTP/POP3. Advanced gateways for Microsoft Exchange and
Lotus Notes are available as separate modules.

Using This Guide

The RightFax Administrator's Guide is designed for RightFax
administrators who will be installing and configuring the RightFax
software on both client and server computers. This guide assumes
you have knowledge of the Windows operating systems operating
systems, as well as knowledge of networking systems and your
own organization’s network.

Other Resources for RightFax Users

Because your RightFax servers can support dozens, hundreds, or
even thousands of fax users, RightFax has designed its end-user
documentation to be thorough, easy-to-use, and easily accessible.

In addition to the user's guides, quick reference cards give you
quick and easy access to the most common fax management
features of the FaxUtil, Microsoft Exchange, Lotus Notes, and Web
Client fax client applications. These useful cards are compact and

can be easily distributed throughout even the largest organizations.

13



RightFax 9.4 Administrator's Guide

Getting Help Online Editing Contact Information in FaxUtil

Most of the RightFax windows and dialog boxes include
context-sensitive help. Typically, this help describes each field and
option in a dialog box. This context-sensitive help can be launched
from the question mark icon in the title bar of a dialog box.

[ 7]

tioh |

Click the
question mark icon

e Click this icon, and then click any option on the dialog box to view
its definition.

e Or, press F1 to view a definition.
Online help for tasks or conceptual topics also is available. View

this help by selecting the Help menu. You can browse the help for
a topic or use the index to look up key words and terms.

% RightFAY FaxUtil

File Fax List Tools | Help

Contents
nten o Select the

Errars
Embedded Codes Hel P menu

ti,

Contact Information
About, .,

The RightFax Web site offers the latest product information.
Updated documentation, a searchable customer support
knowledgebase, software downloads, and the latest product
offerings are all online at www.captaris.com/rightfax.

In the FaxUtil Help menu, users can select Contact Information,
and a dialog box opens that lists RightFax technical support
contact information.

Figure 1.1 The Contact Information Dialog Box

x
Tareach RightFax technical suppart, call (520] 320-7070 -

tanday through Friday 5:00 A M. to 5:00 P.M
or Saturday 7:00 A M. to 3:00 P.M. Pacific time.

Flease provide the fallawing information:

- Compaty name, phone number, and support plan
number [or invoice number and date).

- RightFax product, version, and registration number.

- Tupe of fax board (brand. model number. and serial
number]

- Type of computer, operating system/enviranment,
network and amount of memany.

- A concise description of the nature of the problem. If
possible, provide a scenario that can be used to
reproduce the problem.

=l

This contact information appears in English with RightFax contact
information, but you can edit the text to provide customized
information. To do so, edit the text file Contact.txt located in the
\RightFax\Bin folder on the RightFax server. You can enter 24 lines
of text and up to 59 characters per line.

Captaris Training Services

RightFax training gives you the skills to optimize your RightFax
solution. Our comprehensive technical, administrative, and user
training programs produce full utilization and understanding of
RightFax products. Regular classes are held at the state-of-the-art
RightFax Training Center in Tucson, Arizona, throughout the year, or
you can choose the convenience of training at one of our regional
locations. Training materials and computer-based training tools are
also available. For more information on RightFax training, please



visit our Web site at www.captaris.com/training, or call us at RightFax Customer Support:
(520) 320-7098 and let us help you develop a customized training

plan for your organization. Captaris Voice: (520) 320-7070
Suite 210 Fax: (520) 321-7461
6303 E. Tanque Verde Web: www.captaris.com/rightfax
Tucson, Arizona 85715 USA Email: tech@captaris.com

Captaris Implementation Services

Captaris Implementation Services offers a team of highly skilled e .
engrg)ineers wpho are experts in the deployment, impIerr?en)t/ation, and 5:00 A.M. to 5:00 PM. Pacific time, Monday through Friday
integration of RightFax solutions. Implementation services include 7:00 A.M. to 3:00 P.M. Pacific time, Saturday

installation and configuration, upgrades, configuration review, and
advanced integration services. Whether it's through remote dial-in,
an on-site implementation, or a combination of both, the
Implementation Services team can quickly integrate RightFax
solutions with your existing applications. - = =

Support Sales and Administration: (520) 320-7000

Customer Support

Your Customer Support Guide includes detailed information about
the support options available to RightFax customers. Please fill out
the RightFax Software Warranty & Registration Card and return it
immediately. If you have questions of a technical nature, contact
your organization’s RightFax administrator or network administrator
before calling the RightFax customer support department. On the
RightFax Web site, a database of customer support knowledge
contains a wealth of information on installing, configuring, and
maintaining RightFax software.

Chapter 1 Introduction 15
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Chapter 2
Understanding the RightFax Servers

Thank you for choosing RightFax fax server software. With this Rig htFax Enterprise Server

comprehensive network fax solution, you can create, send, receive,
and manage faxes directly from your desktop computer, saving
time, money, and manpower. The RightFax system features and
intuitive design make faxing as easy as printing to a network printer.
Administrators will find that because it is a native Windows service,
RightFax is easy to install, configure, and manage. RightFax offers
the following versions of its fax server software:

¢ RightFax Business Server
¢ RightFax Enterprise Server

¢ RightFax Enterprise or Business Server with the Integration
Module

¢ RightFax Satellite Server

RightFax Business Server

This RightFax server supports unlimited user accounts. It includes
one fax channel, but is expandable to up to 30 fax channels.

This RightFax server supports unlimited user accounts. It includes
three WorkServers and one fax channel, expandable to support
unlimited fax channels. This server includes the RightFax Web
Client™ and the OCR Router™, OCR Converter”, Docs-on-Demand™,
and TeleConnect™ modules.

The Enterprise server is also available as a product suite that
includes the RightFax Enterprise server, plus the Gateway for
Microsoft® Exchange, the Gateway for Lotus Notes®, the Document
Management Connector”, and the SNMP Alerting”, and PDF
modules.

RightFax Server with the Integration Module

The RightFax server and the RightFax Integration Module enable
applications for information exchange. The Integration Module
integrates RightFax with applications on mainframe, mid-range, and
local area network host systems.

e The RightFax Small Business Integration Module can be installed
on the RightFax Business and Enterprise servers.

e The RightFax Enterprise Integration Module can be installed on
the Enterprise server.

17



RightFax Satellite Server

This RightFax server supports up to 15 user accounts. It includes
two WorkServers and two fax channels.

How RightFax Works

RightFax is comprised of these basic components:

o Fax image files

¢ Fax database (SQL)
o Fax server services

e Fax client programs

Before configuring RightFax for your particular network installation,
you should understand the function of each component.

Fax image files

All sent and received faxes are stored as compressed graphic
image files (CCITT Group Il format) in the RightFax\Image folder.
Fax image files are assigned file names by the RightFax server and
these file names are directly referenced by the RightFax SQL
database.

Each individual page of a fax is saved as a separate file. All files
associated with a single fax will have the same file name, but
different file extensions will indicate the page number. File
extensions for RightFax image files are numeric, starting with
number 301, indicating the first page of the fax. The file extension
increments by 1 for each subsequent page of the fax.

Warning |If you re-name RightFax image files, they will not be
A) recognized by the RightFax server.
A typical fax consumes 35 Kb, though some can be as large as
150 Kb or as small as 5 Kb per page. Because fax images can
consume a large amount of disk space, you should dedicate at

N
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least 500 Mb of storage to your RightFax server. More space may
be required depending on the number of faxes sent and received,
and how frequently old faxes are deleted.

Note RightFax monitors the amount of free disk space on the server and
will shut down certain processing elements when available disk space
falls below 50 Mb. When sufficient disk space is restored, fax processing
continues automatically.

Fax database

RightFax uses a SQL database to manage RightFax system
objects (such as users, groups, and printers) and to organize, track,
and route faxes. RightFax provides some database management
and diagnostic utilities. Third-party and custom SQL utilities can
also be applied to the RightFax database. For more information on
the RightFax database and applicable SQL database management
tools, see Chapter 30, “Backing Up and Maintaining the RightFax
Software and Database”.

Fax server services

The RightFax fax server consists of several services: the RightFax
Server module, RightFax WorkServer modules, RightFax RPC
Server module, RightFax Database module, RightFax Queue
Handler, RightFax DocTransport module and, optionally, the email
gateway and integration modules. In most cases, all the services
run on the same machine so that the Server module can
automatically start and stop the programs as necessary. However,
the RightFax WorkServer and BoardServer modules can run on
different computers to redistribute heavy workloads.

The RightFax Server Module

Manages the network print queues assigned to faxing, controls the
conversion of outgoing faxes, and works with the BoardServer
module to schedule outgoing faxes and route incoming faxes.



The RightFax WorkServer Module

Performs one or more functions on behalf of the RightFax Server
module. It periodically asks the RightFax database if its services
have been requested, executes requested tasks, and notifies the
database when tasks are complete. You can configure multiple
WorkServer modules to handle processor-intensive tasks such as
print-to-fax file conversions. For example, one WorkServer can
convert PCL-5 print files into fax images, while another WorkServer
separately handles automatic printing of incoming faxes.

The RightFax DocTransport Module

Lets you configure the methods by which RightFax will be able to

transmit documents. This module lets you configure fax boards for
conventional fax transmission, as well as set up RightFax for SMS
messaging, Fax-over-IP, DOCplus, and Eicon fax boards.

The RightFax BoardServer Module

Acts as an interpreter between the fax boards and the Server
module. It handles requests to schedule outgoing faxes for
transmission and informs the Server module when a new fax has
been received and needs to be processed. Multiple BoardServer
modules can be installed on remote servers to distribute the
workload across several machines and provide expanded channel
capacity and system redundancy.

The RightFax Database Module

This is the fax database manager. It accesses the SQL fax
database to provide client programs with the information used in
fax transactions including deleting, forwarding, creating, viewing,
and printing faxes.

The RightFax RPC Module

Acts as an interpreter between the RightFax client programs and
the fax database on the server.

The RightFax Queue Handler

Monitors the HPFAX print queue for inbound jobs and directs them
to RightFax for processing.

RightFax client programs

FaxUtil

FaxUtil is RightFax's Windows-based client application. With
FaxUtil, users can view, print, and manage their faxes. Version 9.3
servers support versions 8.7 or higher of the FaxUtil client.

RightFax Web Access

RightFax Web Access is RightFax's browser-based client
application. It includes all the functionality of FaxUtil, but can be
accessed by users from any compatible Web browser.

Enterprise Fax Manager

Enterprise Fax Manager is the primary RightFax administrator
application. With Enterprise Fax Manager, the RightFax
administrator can manage users, groups, printers, least-cost
routing, and the general functions of the fax system.

Enterprise Fax Manager Web Edition

Enterprise Fax Manager Web Edition is a browser-based RightFax
management tool. It includes all the functionality of Enterprise Fax
manager, but can be accessed from any compatible Web browser.

Installing the RightFax Server

For information and instructions on installing the RightFax server
software, refer to the RightFax Installation Guide.

Chapter 2 Understanding the RightFax Servers
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Chapter 3
Configuring the RightFax Server Module

The RightFax Server module manages the network print queues Configuring the General Tab
assigned to faxing, controls the conversion of outgoing faxes, and
works with the RightFax BoardServer module to schedule outgoing Figure 3.1 The Server Configuration Dialog Box General Tab

faxes and route inbound faxes. You can configure the RightFax
Server module to customize global fax settings, inbound fax routing,

I Server Configuration - LOCAL, Base Level, Yersion 9.30 |

Admin Meszages | Data Sharing I eTranzpart I

and notifications about document processing and server status. Gererd | Advanced | Featue Activation Custom Messages | UserMessages

. . . " Enable CSID Routing Matification
Although the default configuration of the RightFax Server module ot ik Hons ¥ Allow Notiication T rin ONCE Driy

. nable Luc eaders - ) ) L. ) .
allows you to send and receive fax documents, you should R * Notifcation time i in minutes. (Min 6, Ma.333.)
configure it to meet the needs of your enterprise immediately after ™ fas cuse ¥ User Notty Time: 6 =f  Adrin Noiy Time: [50
installing the RightFax server software. D T —
it Lalewad IﬁTEfSB = Cauint: |5_ Interval: |5_

To configure the RightFax Server module Delay alFases Lt [ere 5ot 2] sMsCount [§ sMisImewat [5

Recard DNIS information: IFax 01D rumber 'l

1. On the RightFax server, select Start > Programs > Enterprise [ Auto Delste Faied Gateway Fares
Fax Manager. This runs Enterprise Fax Manager, the RightFax
server administration tool. For more information on Enterprise
Fax Manager, see Chapter 8, “Managing Fax Servers with
Enterprise Fax Manager”.

2. Click the name of the RightFax server to configure in the tree in Cancel_|
the left pane of the Enterprise Fax Manager window. A list of ] o .
services appears at the |ower-right pane of the window. Enable CSID Routlng Enables automatic inbound routlng

using CSID (caller subscriber identification). CSID data is
information about the calling party sent to the fax board by the
phone company. The CSID is different for each caller, and can be
The rest of this chapter explains each of the options in this dialog anything from a phone number to a company name.

box.

3. In the Service Name list, double-click RightFax Server
Module. The Server Configuration dialog box opens.
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For CSID routing to work, you must create a CSID routing table
that lists RightFax routing codes and the CSIDs to be routed to
them. For more information on CSID routing and creating a CSID
routing table see “Configuring CSID Routing” on page 242.

Enable Quick Headers Allows a second line to be added
below the TTl line (the line listing the date, time, page number, total
pages, and fax ID at the very top of each fax page). After the quick
header is enabled, you can customize the text in the BoardServer
module (see “Quick Header Format” on page 71. If this check box
is selected, quick headers will be applied to all outgoing faxes.

Note Intel® Dialogic® fax boards do not support the Quick Header
feature.

Create New User when Printing to the Fax Queue
Assigns a new RightFax user ID to network users who print to the
fax queue but don't have a RightFax user ID. RightFax uses the
“Default” user ID as a template when creating new users.

Disable Routing of Faxes with Errors \When enabled, this
option will prevent routing of incomplete faxes through an email
gateway or network directory. Faxes are still available through
FaxUtil and will have a status of ‘Incompletely Received'.

Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax Server
Module” You can select the following options:

¢ None. No information is saved.

« Terse. Records critical errors only.

o Normal. Records errors and major events only.

¢ Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution If you leave this value set to “Verbose” for long periods of time,
the Event Log can become full which may prevent new events from being
logged.

RightFax 9.4 Administrator's Guide

Delay All Faxes Until Specify the time of day after which all
faxes sent by users without RightFax administrative access will be
sent. To not delay faxes, select “None set”

Forced delays can also be set for groups of RightFax users. For
more information on groups, see Chapter 10, “Creating Groups of
Users”.

Number of Fax Queues to Create Specify the number of fax
print queues to create to allow multiple users to send simultaneous
print-to-fax jobs with Windows Terminal Server. This is the
maximum number of sessions that can simultaneously access the
RightFax print queue. The number of queues you specify depends
on the number of fax users supported by Terminal Server. Specify
as many print queues as necessary to prevent sessions from
hanging in the print queue.

If you are not supporting multiple sessions on a Windows Terminal
Server, this option should be set to “1”

Record DNIS Information Specify where to store DNIS
(dialed number identification service) information for each incoming
fax. DNIS is specially encoded data that may be included with your
incoming calls as a service provided by your phone company.
RightFax fax records do not include a field dedicated to storing
DNIS information, so you must use one of three existing fields:

e Select “Fax DID number” to save DNIS information where the
originating phone number is saved.

e Select “Billing code 1" to save DNIS information in the fax Billing
Code 1 field.

e Select “Billing code 2" to save DNIS information in the fax Billing
Code 2 field.

e Select “Don't record” to discard DNIS information.

Note Because it overwrites any data in the location you specify,
DNIS information should be saved to a field that is not used by
your RightFax system.
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Notification settings

A

Notification settings can be changed without stopping and
re-starting the RightFax services.

Allow Notification Enables fax notifications to be sent to
RightFax users. When this check box is selected, users receive
notification messages based on the notification options specified in
FaxUtil.

Admin Once Only Notifies the group administrator and

alternate administrator of their users’ unviewed faxes one time only.

User Notify Time Specify the length of time in minutes that the
server will attempt to notify a user of an unviewed fax before it
notifies the user's group administrator.

Admin Notify Time Specify the length of time in minutes that

the server will notify a user’s group administrator of unviewed faxes.

Note By default, the RightFax server sends periodic notifications to
users every five minutes. To re-define this interval, add a REG_DWORD
value called Notify_Freq to HKEY_LOCAL_MACHINE\Software
\RightFax\FaxServer and set the value data to the number of minutes you
want there to be between notifications.

Retry settings

Count Specify the number of times (including the first attempt) an
outgoing fax transmission will be attempted after it encounters a
non-fatal error (for example, a busy signal).

Interval Specify the minimum delay in minutes before a failed fax
transmission is rescheduled to send.

If a fax has not been successfully sent after the specified number of
retries, it will be saved in the sender's FaxUtil mailbox with the
status message: “ED:Fax Number Busy”” (“ED” stands for “Error,
Transmission Dropped”). The sender can force RightFax to
manually retry sending the fax by clicking the fax and press
CTRL+K.

Configuring the Advanced Tab

Figure 3.2 The Server Configuration Dialog Box Advanced Tab

EﬂServer Configuration - LOCAL, Base Level, Yersion 9.30 21x|
Admin Meszages Data Sharing eTranzsport I

General Advanced | Feature Activation I Custom Messages User Messages
—Database - = Billing Codes

Event LogLevel: [[TTmS ,l ™ walidate from E-mail gateways

M Thiead l__l I Use External Validation

awimurn Threads: |1« n
Separate Validation: IBUlh Fields -

Mazimum File /0 Threads: |1 'I

Maintenance backup

m— - .,  Extemal Document Connector |
I~ Enabled

Sends: IDisabIed ¥

Scheduled time: |12:DU Ak 'l Feceives: IDisabIed x

~ 506L Connection
| DSH=RightFax; ID—sa;PW0—47CZ3ESAZSE06EE30HH 3430, u

Character Set Mode
’7 V' ANSI Mode

Select Service Account... |

Cancel |

Database settings

AN

Event LogLevel Specify the level of information logged in the
Application Event Log under the name “RightFax Database
Module” You can select the following options:

e None. No information is saved.

e Terse. Records critical errors only.

e Normal. Records errors and major events only.

e Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution |If you leave this value set to “Verbose” for long periods of time,

the Event Log can become full which may prevent new events from being
logged.

Chapter 3 Configuring the RightFax Server Module
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Maximum Threads Sets the number of database 1/0 threads
reserved to service client requests.

The RightFax Database module can respond to database requests
from multiple clients and multiple protocols at the same time. The
efficiency of this process depends on the number of database 1/0
threads available. Because each thread uses resources (file
handles, CPU time, and memory), you should never increase the
number of threads to more than 10. If a database request occurs
when all the threads are busy, the request will wait in line to be
serviced.

Maximum File 1/0 Threads Sets the number of file I/O
threads reserved to service client requests.

The RightFax Database module can respond to file 1/0 requests
from multiple clients and multiple protocols at the same time. The
efficiency of this process depends on the number of file 1/0
threads available. Because each thread uses resources (file
handles, CPU time, and memory), setting this value too high will
deplete the server's resources for other tasks. If a file I/0 request
occurs when all the threads are busy, the request will wait in line to
be serviced.

Billing code settings

Billing code settings can be changed without stopping and
restarting the RightFax services.

Validate from Email Gateways Validates all billing codes
added to fax-bound email messages. If a billing code cannot be
validated, the fax will not send and the user will receive notification
that the fax did not send due to an invalid billing code. If this check
box is not selected, billing codes may be added to fax-bound email
messages but will not be validated prior to sending (in other words,
any billing code will be accepted).

Use External Validation Tells RightFax to use an external
program to verify billing codes on outbound faxes. This gives the
user the ability to validate faxes based on several different criteria,
not just billing codes. To work, a program must be written with the
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RightFax API to perform the verification of billing codes. For
information on downloading and using the RightFax AP, visit the
Captaris Web site at www.captaris.com.

Separate Validation Customizes the way in which required
billing codes are validated against the RightFax database.
Selecting “Both Fields" requires both Billing Code 1 and Billing
Code 2 fields contain valid codes. “Field 1 or Field 2" requires
either of the billing code fields to contain a valid code, but not
necessarily both. “Field 1 Only” requires only the Billing Code 1
field contain a valid code. “Field 2 Only” requires only the Billing
Code 2 field contain a valid code.

External document connector

The external document connector settings are used for integrations
between RightFax and third-party systems. These settings should
only be set by following the instructions for integrating with a
third-party system.

Click to clear the Enabled check box to disable and prevent the
external document connector from writing large amounts of unused
data to the server hard drive.

SQL Connection

This field displays the connection string that defines the RightFax
server's connection to the SQL database. You can make changes
to the SQL connection by clicking the [...] button on the right. For
more information on changing and editing the connection to the
RightFax database on the SQL server, see “Changing the
Connection to the SQL Server” on page 305.

Select Service Account Click this button to select a service
account for the RightFax Server and RightFax Database services.
Specifying an account for these services is only required if you
want to connect to the SQL database using Windows
authentication. Enabling Windows authentication to the SQL
server requires additional configuration. For instructions on
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configuring network authentication to the SQL server, see

“Configuring Windows Authentication to the SQL Server” on

page 319.

Configuring the Feature Activation Tab

The Feature Activation tab allows you to launch the Captaris

Product Licensing Utility (or PLU). The PLU is required when

changing or adding to your feature set.

For more information on upgrading your server license, add

additional fax channels, and add new RightFax components, refer
to the RightFax Installation Guide.

Configuring the Custom Messages Tab

These options let you customize the text of messages that are sent
for fax status notifications for users (described on page 131).

Figure 3.3 The Server Configuration Dialog Box Custom Messages Tab

E,’\Server Configuration - LOCAL, Base Level, Yersion 9.30

Admin Messages
General Advanced

Sending fax:

Imaging error:

Bad form type:

Feady for preview:
Bad fax phone number:
Too many retries:
Sending erar:
Incomplete fax:

Invalid biling code:
Mew faw:

Viewed or printed fax:
Successiul send:

Fax needs approval:
Fax number blocked:
Hurnan Anzwered Fax:
Fax blocked by Do Mot Dial:

I Diata Sharing |
Custom Messages

eTransport

I Feature Activation User Messages

Sending faxto =1 at 2.

Imaging eror encountered, fax abandoned (From: =1 To: ~2 & ~3 Emor ~

B ad form type specified on outgoing Fax

An outgoing Fax is ready for previewing.

Bad fax phone number specified on outgoing fax.

Fax to ~1 abandoned after ~4 attempts.

Fawto ™1, en~3

One of your outgoing faxes needs attention,

''our outgoing fax containg an invalid biling code.

~1 page fax for ~2 from ~3 has amived [TeleConnect [D:™4)

Fax for ™1 not viewed or printed.

"T'our fax has been successiully zent to ~1 at ~2.

One of your autgaing faxes needs approval

Fax to ~1 abandoned, fax number blocked.

Fawto ™1 canceled by Human Answer Fax system, fax abandoned

Fax to 1 was blocked by Do Mot Dial restrictions

2=

Cancel

Notification messages can contain a combination of text and
variable data. Each message has its own available data variable

options, described in the following table.

Table 3a Notification Message Options

Notification

message Variable options When used

Bad fax phone ~1=UserID The fax number contains
number ~2 = Fax phone number invalid characters.

Bad form type ~1 =User ID A bad form was specified.

Fax blocked by

~1 = Recipient’s name

A fax was not sent

Do Not Dial ~2 = Recipient’s fax number | because the destination
~3 = Fax error code fax number was blocked
~4 = Sender's user ID by the Do Not Dial feature.
~5 =Billing code 1 (described on page 215.)
~6 = Billing code 2
~7 = Recipient’s company
~8 = An HTML link to the fax

on the WebUtil client (if
applicable)

Fax needs ~1=User ID One of the sender's

approval ~2 = Recipient's name outgoing faxes needs
~3 = Recipient’s fax number | approval.

Fax number ~1 = Recipient’'s name The recipient’s fax number

blocked ~2 = Recipient’s fax number | is blocked by the RightFax

~3 = Fax error code

~4 = Number of retries

~5 = Billing code 1

~6 = Billing code 2

~7 = URL link to the fax on
the RightFax server
(this option can only be
used with a RightFax
email gateway

BoardServer. Fax
numbers can be blocked
using the following
options:

Dialing rules.

The call blocking
Windows Registry entry
on the BoardServer.

Chapter 3 Configuring the RightFax Server Module
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Table 3a Notification Message Options (Continued)

Notification
message Variable options When used
Human ~1 = Recipient's name The fax was canceled (not

Answered Fax

~2 = Recipient’s fax number
~3 = Fax error code

~4 = Number of retries

~5 =User ID

accepted) by the recipient
when the recipient
responded to the RightFax
voice prompt.

Imaging error

~1=UserID

~2 = Recipient's name

~3 = Recipient’s fax number
~4 = Error encountered

The server cannot
generate a fax image.

Incomplete fax

~1=User ID
~2 = Unique ID of the fax

The sender did not
complete all of the

required fax information
fields.

Table 3a Notification Message Options (Continued)
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Notification
message

Variable options

When used

Sending error

~1 = Recipient's name

~2 = Recipient’s fax number
~3 = Fax error code

~4 = Number of retries

~5 = User ID

~6 = Billing code 1

~7 =Billing code 2

~8 = Recipient's company

The fax could not be sent.

Sending fax

~1 = Recipient’'s name

~2 = Recipient’s fax number
~3=User ID

~4 = Recipient's company

The fax starts to send or is
still sending after a few
minutes.

Successful send

~1 = Recipient’'s name

~2 = Recipient’s fax number

~3 = Recipient’'s company

~4 = URL link to the fax on
the RightFax server
(this option can only be
used with a RightFax
email gateway)

The fax transmission was
successful.

Invalid billing ~1=UserID The sender did not
code ~2 =Billing code 1 provide a valid billing
~3 =Billing code 2 code.
New fax ~1 = Number of pages A new fax was received.
received
~2=UserID
~3 = Received remote ID
~4 = TeleConnect ID
~5 = Unique ID of fax
~6 = URL link to the fax on
the RightFax server
this option can only be
used with a RightFax
email gateway)
Ready for ~1=UserID The fax was held for
preview ~2 = Recipient’s name preview and is now ready.

~3 = Recipient’s fax number
~4 = Billing code 1
~5 = Billing code 2
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Table 3a Notification Message Options (Continued)

Notification
message

Variable options

When used

Too many retries

~1 = Recipient’s name

~2 = Recipient’s fax number

~3 = Fax error code

~4 = Number of retries

~5=User ID

~6 = Billing code 1

~7 =Billing code 2

~8 = Recipient's company

~9 = URL link to the fax on
the RightFax server
(this option can only be
used with a RightFax
email gateway)

The fax was abandoned
after the maximum number
of send attempts.

Viewed or printed
fax

~1 =User ID

A received fax has not
been viewed or printed.

To return a notification message to the default setting, select the

text, delete it, and then click OK. The next time you open the dialog

box, the default message will be listed.

Configuring the User Messages Tab

These options let you customize the text of SMS or pager
messages that are sent for fax status notifications for users
(described on page 127). For more information on configuring
SMS and pager notifications, see Chapter 17, “Adding SMS and
Pager Services”.

Figure 3.4 The Server Configuration Dialog Box User Messages Tab

IF,|Server Configuration - LOCAL, Base Level, Yersion 9.30 x|
Admin Meszages | Data Sharing | eTransport |
General Advanced I Feature Activation Custom Mezzages User Messages

MNew fax received: IF\eceived ~1 page fax fram ~2. TeleConnect ID="3

QOutbound fax abandoned: |Fax to ™1 at ~2 abandoned after ~4 attempts.

Recipient has been sent a fax; |Y0u have been sent a document from ™1 to ~2.

Cancel |

Chapter 3 Configuring the RightFax Server Module
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For each message type, enter the custom message text you want.
Some messages also let you add variables that are specific to the
event you are being notified of. Each pager alert has its own set of
available variables, described in the following table.

Table 3b User Message variables

Alert Variables When used

New fax ~1 = Page count Sent to a RightFax user

received ~2 = CSID or ANI of sender | when a new fax is received.
~3 = TeleConnect ID
~4=CSID
~5 = ANI

Outgoing fax | ~1 = Recipient's name
abandoned

Sent to a RightFax user

~2 = Recipient’s fax number | whose outbound fax has

~3 = Short error description | failed to send for any reason.
(last attempt)

~4 = Send attempts

~5 = Owner ID

~6 = Billing code 1

~7 = Billing code 2

~8 = Recipient’s company

~6 = URL link to the fax on
the RightFax server
(requires the Gateway
for Microsoft
Exchange)

Recipienthas | ~1 = From name Sent to the fax recipient to
beensenta | ~2=To name notify that a fax has been
fax sent from the RightFax
server. The fax recipient
notification address is
entered by the RightFax
client user when creating a
new outbound fax.
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To return a notification message to the default setting, select the
text, delete it, and then click OK. The next time you open the dialog
box, the default message will be listed.

Configuring the Admin Messages Tab

These options let you customize the text of SMS or pager
administrative alerts (described on page 128). For more
information on configuring SMS and pager notifications in
RightFax, see Chapter 17, “Adding SMS and Pager Services”.

RightFax Enterprise versions 8.7 and higher include a more
comprehensive Alerting and Monitoring service that lets you select
from hundreds of server statistics to monitor and define the event
thresholds, alert types, and alert messages to send. For more
information on the RightFax Alerting and Monitoring service, see
Chapter 18, “Using the Alerting and Monitoring Service”.

Figure 3.5 The Server Configuration Dialog Box Admin Messages Tab

IF}|Server Configuration - LOCAL, Base Level, Yersion 9.30 2lx|
General | Advanced | Feature Activation | Custom Meszages | Uszer Messages |
Adrnin Messages [rata Shaiing I eTransport

Dizk space ciritically low | on disk space [<50ME). Many fax server functions have been suzpended.

Dizk space getting law IDne or more diives on the fax server are approaching critically law disk zpa

Intemal queue reached 90%; IThe fax server internal queus is more than 90% utilized.

Send queue koo deep IThe send gueue depth on server 3 iz cuently. ~1/~2 [fakes/pgs).

Probable bad line: |Pr0bable bad phone line detected.

Heartbeat: IFax server 1 up for ~2 [dkmes); load: ~3; faxes sent:™4, revd ™5

Server shutdown inconectly: IThe fax server process was nat propery shutdown,

EBoardserver failed. one running IThe DocTransport on ™1 is no longer mnning. Fax sending and receiving

Boardserver failed. none running |.~’-\II DocTransports are down. Fax zending and receiving is not cumrently op

Cancel |
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For each message type, enter the custom message text you want.
Some messages also let you add variables that are specific to the
event you are being notified of. Each pager alert has its own set of

available variables, described in the following table.

Table 3c Admin Message Settings

Alert Default message Variables
BoardServer | All BoardServers are None
failed, none | down. Fax sending and
running receiving is not currently
operating.
BoardServer | The BoardServeron ~1is | ~1 = BoardServer
failed, one no longer running. Fax machine
running sending and receiving
operations are functioning
on other BoardServers.
Disk space | One or more drives on the | None
critically low | fax server are critically low
on disk space (<50MB).
Many fax server functions
have been suspended.
Disk space | One or more drives on the | None
getting low | fax server are
approaching critically low
disk space (<150MB).
Heartbeat Fax server ~1 up for ~2 ~1 = Fax server name
(periodic (d:h:m:s); load:~3; faxes | ~2 = Up time
status) sent:~4, rcvd:~5. (dd:hh:mm:ss)
~3 = Fax server internal
queue usage
~4 = Total faxes sent
since install date
~5 =Total faxes received
since install date

Table 3c Admin Message Settings (Continued)

Alert Default message Variables
Internal The fax server internal None
queue queue is more than 90%
reached utilized.
90%
Probable Probable bad phone line | None
bad line detected.
Send queue | The send queue depth on | ~1 = Queue depth
too deep server ~3 is currently: (faxes)
~1/~2 (faxes/pgs). ~2 = Queue depth
(pages)
~3 = BoardServer
machine
Server The fax server process ~1 = Fax server name
shutdown was not properly shut
incorrectly down.

To return a notification message to the default setting, select the text,
delete it, and then click OK. The next time you open the dialog box, the
default message will be listed.

Configuring the Data Sharing Tab

The capacity of RightFax servers can be multiplied by combining
two or more servers that share a common SQL database. This is
accomplished by installing and configuring multiple RightFax
servers to share a RightFax database and corresponding resource
folders. See the RightFax Installation Guide for installation

instructions.

The fields within the Data Sharing tab represent folders that must
be shared among all the RightFax servers within a Data Sharing
environment. Share permissions must be given to the account used
to run both the Server module and DocTransport module. This
account must have full control of these folders. Choosing this

Chapter 3 Configuring the RightFax Server Module
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account can be done by click the Select Service Account button.
The Remote Service Paths button allows you to specify paths to
the \RightFax\Image directory on Remote DocTransport servers.

For Example:
\\<Shared Storage>\RightFax\Image
\\<Shared Storage>\D$\RightFax\Image
\\<ip address>\RightFax\Image
\\<Shared Storage>|RightFax\Image

A complete list and description of the shared data folders is
provided below.

« Image (contains sent and received faxes stored as compressed
graphic image files).

« SIG (contains graphic images of user signatures for placement
on faxes).

« Papers (contains the names of overlay form files).
e FCS (contains fax cover sheets).
« Outgoing (contains outbound files from all submission methods

that are held while being processed into fax images, such as
temporary fax queue spool files).

o BFT (contains text files created by the OCR process).

e CmdData (contains transaction files for each fax sent via email or
via SecureDocs).

Each of these folders can be located in common disk storage, such
as a storage area network (SAN), network share on file server, or
network access to a local drive on one of the RightFax servers. The
folders must be accessible to all the servers in the shared
configuration.
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Configuring the eTransport Tab

The eTransport options configure the server to send outbound fax
documents to email addresses in addition to fax numbers.

Figure 3.6 The Server Configuration Dialog Box eTransport Tab

IF,|Server Configuration - LOCAL, Base Level, Yersion 9.30 x|

General | Advanced | Feature Activation | Custom Meszages | Uszer Messages |
Adrnin Messages | Data Sharing eTransport

SMTP Hosthame: I

Account; I

Password: |

[ SMTP service extersions

wieb Server. |RF92 TrainCaptaris com

Cancel |

SMTP Hostname Enter the name of the SMTP mail server to
which outbound documents sent to email addresses via the
RightFax client applications will be sent. If no SMTP mail server is
specified here, RightFax users using the FaxUtil client will not have
the option to address fax documents to an email address.

Important Using the eTransport service requires SMTP server with
relay enabled.

Account If the SMTP mail server requires an account name in
order to gain access, enter the account name in this box.

Password Enter the password for the account name that you
entered in the Account Name box.
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SMTP service extensions If the SMTP mail server uses SMTP
service extensions, select this check box. SMTP service extensions
start an SMTP session by issuing the EHLO command instead of
the HELO command.

Web Server Enter the Internet host name of the machine running
the 11S server that the RightFax SecureDocs module is installed on.
This field is required if you have installed the RightFax SecureDocs
Module. For more information on this option and configuring
RightFax for certified document delivery, refer to the RightFax
SecureDocs Module Guide.

Web Site Enter the name of the folder on the IIS server that
contains the certified document delivery Web site. This field is
required if you have installed the SecureDocs Module. For more
information on this option and configuring the RightFax server for
certified document delivery, refer to the RightFax SecureDocs
Module Guide.

Starting and Stopping the RightFax Server

The RightFax server is comprised of several services, called
“modules.” These are:

e Server module

o BoardServer module

o Database module

¢ DocTransport module

o Queue Handler

e RPC Server module

o WorkServer module

« Integration module (optional)

o Email Gateway module (optional)

These services are configured and started during installation. You

should only need to stop and start RightFax services during server
or network maintenance.

Starting or stopping the RightFax server requires starting or
stopping the separate processes. There are two ways to start or
stop the processes.

Starting the Server Using the Services Program

In Windows Control Panel, start the Services program. In the list of
services, you will see several RightFax modules. To start the
RightFax server, click the RightFax BoardServer module and click
Start. Next, click the RightFax Server module and click Start. This
will start the RightFax Database module, RightFax Server module,
and the RightFax WorkServer modules.

Starting the Server at a Command Prompt

N

In a command prompt window at any prompt, enter the following
command:

net start serviceshortname
(for example, net start rfserver)
Note You should never start the RightFax Database module,

WorkServer modules, or Email Gateway modules directly. They must be
started by the RightFax Server module.

Stopping the RightFax Server

To stop the RightFax server from Windows Control Panel, click
Stop on the RightFax Server module and the RightFax BoardServer
module services.

To stop the RightFax server from a command prompt, type the
following:

net stop serviceshortname

(for example, net stop rfboard)

Chapter 3 Configuring the RightFax Server Module
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Understanding the Services

The following table describes each RightFax service and tells
whether the service is started automatically or manually by

Windows on startup. Note that if the startup is automatic, it can be

stopped and started as needed.

Table 3d RightFax Services

Table 3d RightFax Services (Continued)
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Short

Service name name Startup | Description

Captaris RFIsoConv | Auto Configurable server that

Conversion controls conversion of Office,

Engine HTML, and OCR documents.

Captaris Sync CapaSync | Auto Configurable server that

Module controls one-way
synchronization from Active
Directory or LDAP data sources

RightFax RFBOARD | Auto The communication link between

BoardServer RightFax and the fax hardware.

module

RightFax RFDB Manual | A multi-threaded module that

Database module handles communication
between the database files
(located in the
RightFax\Database folder) and
the fax clients.

RightFax RFDOCTRANS | Auto Allows configuration of the

DocTransport methods by which RightFax

module will transmit documents.

RightFax Email RFEMAIL Manual | The communication bridge to an

Gateway module optional email gateway.

Short

Service name | name Startup | Description

RightFax Paging | RFPAGE Auto Monitors RightFax for pager

module notification events and handles
communication between
RightFax and the SMS or pager
services.

RightFax RFPROD Auto Allows applications on a

Integration mainframe to send custom faxes

module through the fax server.

RightFax Queue | RFQUEUE | Auto Monitors the RightFax print

Handler queue for jobs to be forwarded
to the server for fax conversion.

RightFax RPC RFRPC Auto The communication bridge to fax

Server module clients that use IPX, SPX or
TCP/IP via remote procedure
calls.

RightFax RFRemote | Auto Provides inter-communication of

Remoting RightFax services and
applications by remote servers.

RightFax Server | RESERVER | Auto The bridge between all other

module RightFax services. Also
responsible for stopping and
starting the WorkServer,
Database, and email gateway
modules.

RightFax RFWORK# | Manual | One or more modules

WorkServer responsible for RightFax's most

modules processor-intensive functions

such as cover sheet generation,
PCL5-to-fax conversion, and
optical character recognition.
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Understanding the Fax Server Internal Event
Queue

The Fax Server module is responsible for queueing and monitoring
each of the fax server internal processes, which are collectively
called the “Event Queue!” The status of the Event Queue is
measured as a percentage of server resources that are occupied
with Fax Server module functions (such as sending and routing
faxes).

The Event Queue is represented as the ratio of fax traffic volume to
server resources. The higher the traffic volume, the higher this
number will be. The Event Queue status is displayed in Enterprise
Fax Manager when you open and select a RightFax server.

When the Event Queue of a RightFax server reaches 90 percent,
the server will suspend certain functions. At 90 percent, all new
outbound and inbound faxes will be held (temporarily set aside)
while the server processes the existing workload. After the Event
Queue falls to 75 percent, these held faxes will be scheduled for
processing along with all new fax traffic.

This internal workload regulation is handled by the Fax Server
module and cannot be overridden. If the fax server is consistently
reaching the 90 percent capacity level, you should consider
upgrading the fax server’'s system resources and/or fax channels.
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Chapter 4
Configuring the WorkServer Modules

Each RightFax WorkServer module performs one or more
processor-intensive functions on behalf of the RightFax Server
module. They regularly query the Database module for jobs to be
serviced, execute those tasks, and notify the database when
finished.

Product integrations with Kofax and Peoplesoft can be enabled
through the RightFax WorkServers. Additional product integrations,
including advanced Xerox, HP, and Sharp integrations are now
available or will soon be available for download from the Captaris
Web site.

Although the default configuration of the RightFax WorkServer
modules allows you to send and receive fax documents, you should
configure the WorkServer modules to meet the needs of your

enterprise immediately after installing the RightFax server software.

To configure the RightFax WorkServer modules

1. On the RightFax server, select Start > Programs > Enterprise
Fax Manager. This runs Enterprise Fax Manager, the RightFax
server administration tool. For more information on Enterprise
Fax Manager, see Chapter 8, “Managing Fax Servers with
Enterprise Fax Manager”.

2. Click the name of the RightFax server to configure in the tree in
the left pane of the Enterprise Fax Manager window. A list of
services appears at the lower-right pane of the window.

3. In the Service Name list, double-click RightFax WorkServer1
Module. The WorkServer Configuration dialog box opens.

The rest of this chapter explains each of the options in this dialog
box.

Figure 4.1 The WorkServer Configuration Dialog Box
21

X — Telephany Server Fouting
Bemate WorkS 5
Printer Configuration ) et v Stz [~ Enable I™ Delete after route

K.ofax NetScan Configuration [V Use PCL converter for text fles Server ICaIIXDH
PeopleSoft Configuration .

) 5 [ I vl
OCR Configuration SEREES Frowear | 77

- Workserver 2
- Workserver 3

InterConnect Retry Settings

LCount: |5— Interval: |5—

Optimize Faxing |

™ Optimize Covers [ Short Bodies

Network Messaging

Delete Image Fies ——— fchive Setlings |
acr :
InterConnect Farmat: ITlFF-GS 'l I~ | Histary
PostScript Pt I
Ewvent LogLevel |Terse Vl Inde file: I
™ Separate file per page output
Erequency: {15 j‘ I~ | Equilrac archive

I~ | &lwaus delete after archive
Biling Code import interval: |0 I™ | frchive coversheet

Add WorkServer | Delete WorkServer | Select Service Account |

Cancel

Each WorkServer is configured separately. To configure a
WorkServer, click the WorkServer number or one of its
configuration options in the left pane.
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Remote WorkServer Service Tells RightFax that this
WorkServer will execute on a separate Windows machine on the
network. If this check box is selected, the WorkServer service will
not be started automatically by the RightFax Server service. For
more information on running WorkServers remotely, see “Installing
WorkServers on Remote Computers” on page 45.

Use PCL Converters for Text Files Uses the RightFax Printer
Control Language (PCL) conversion engine when converting PCL
files and ASCII text files to fax format. This conversion usually
produces more accurate fax images of PCL and ASCI| text files
than the RightFax native document conversion engine. If you notice
that PCL or ASCII text files are not converting to fax format as
accurately as you expect, click to clear this check box to return to
using the RightFax native document conversion engine.

Services Specify the tasks that the selected WorkServer will
perform. Only selected services will be performed by the selected
WorkServer. The following table lists each WorkServer service and
its function.

Table 4a WorkServer Services
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Table 4a WorkServer Services (Continued)

Service Function
Network Network broadcast notifications.
Messaging Important If you are using Windows 2003 and

wish to use Network Broadcast notifications, you
must open the Control Panel and enable the
Messenger service, which is disabled by default.

In addition, Network Broadcast notifications are
not possible with Windows Vista clients, as the
Messenger service is not included with Windows

Vista.

OCR Optical Character Recognition (requires the
RightFax OCR Converter or OCR Router
module).

Overlay Overlay faxes with forms.

PCL5 PCL5-to-fax conversion.

PostScript PostScript-to-fax conversion (requires the

RightFax PDF or SecureDocs module).

Print Handle requests for both on-demand and
automatic fax printing.

Service Function

Archive Archive sent faxes.

Cover sheets Create cover sheets.

CVL Handle faxes with multiple LIBDOC or LIBDOC2
and ADDDOC embedded codes.

Delete Image Delete fax image files.

Files

FileRoute Route received faxes to network folders.

InterConnect Route received faxes to another RightFax server.

You can assign a single task to multiple WorkServers or dedicate a
WorkServer to one task only. How you configure your WorkServers
depends on your organization's needs and fax server workload. In
most cases, the default task does not need to be changed.
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Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax
WorkServer Module! You can select the following options:

¢ None. No information is saved.
o Terse. Records critical errors only.
o Normal. Records errors and major events only.

¢ Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution If you leave this value set to “Verbose” for long periods of
time, the Event Log can become full which may prevent new events
from being logged.

Frequency Specify how often, in seconds, the WorkServer will
query the Database module for new requests. If you only have one
WorkServer module, 5 to 10 seconds is an appropriate setting.
However, if you run multiple WorkServers, a lower frequency (for
example, 15) will prevent requests from overloading the Database
module. This prevents the WorkServers from keeping the Database
module so busy that clients cannot be serviced in a timely manner.

Billing Code Import Interval The interval in minutes that the
WorkServer will check for a new billing code delta file (used to
query billing codes from external billing code source). At each
interval, the WorkServer checks for a file called Codechg.csv in its
own (the WorkServer) folder. If the file exists, the WorkServer
imports the additions, changes, and deletions specified in the file.
For more information on using billing codes from an external
source, “Importing Billing Codes”on page 158.

Telephony server routing

AN

Enable Allows the RightFax system to integrate with your
enterprise telephony server system. For information on custom
integrations with your fax server, refer to your telephony server
documentation.

Caution Any WorkServer that has telephony server routing enabled will
be dedicated to telephony routing only thus all other WorkServer
activities will be ignored. For this reason, you must have only one
Workserver configured for telephony routing and at least one additional
WorkServer that is not assigned to perform telephony routing.

Server Specify the name of the telephony server on your network
to integrate with the RightFax server.

Protocol Select the network protocol to use for communicating
between the RightFax and telephony servers.

InterConnect retry settings

RightFax InterConnect allows faxes received on one RightFax
Enterprise server to be automatically routed to a fax mailbox of the
same name on a different RightFax Enterprise server on the same
network. With InterConnect, interoffice faxes can be sent via the
network that links the RightFax Enterprise servers in each office,
rather than via the phone lines, saving time and potential long
distance phone charges. For more information on configuring
InterConnect routing see “RightFax InterConnect”on page 217.

These settings will only be available if you have selected
“InterConnect” under Services (described in “Services”on
page 36.)

Count Specify the number of times the originating fax server will
attempt to forward the fax to the destination fax server when it
encounters a non-fatal error (e.g., server temporarily down).

Interval Specify the time delay, in minutes, between retries.

Chapter 4 Configuring the WorkServer Modules
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Optimize faxing

Short Covers Makes fax cover sheets only as long as the cover
sheet text requires (ignoring any blank space at the end of the
cover sheet), potentially reducing transmission times. This may
produce a partial page on some destination fax machines.

If this check box is not selected, cover sheets will be padded to fill
an entire page.

Short Bodies Makes each page in the body of the fax only as
long as the text requires (ignoring any blank space at the end of
pages), potentially reducing transmission times. This may produce
partial pages on some destination fax machines.

If this check box is not selected, each fax page will be padded to fill
an entire page.

Archive settings

RightFax can save a copy of each user's outbound faxes. This fax
“archive” feature is useful for tracking and storing all of your
organization's outbound faxes or for integrating RightFax with
image tracking software systems.

Archived faxes are saved in a network folder that you specify and
can include an optional fax history file and archive log entry.
Archived faxes are saved using unique file names generated by
RightFax with a file extension corresponding to the file format used
for the archive.

Each fax is archived individually upon completion, whether or not
the fax was successfully sent. A fax will be archived one time for
each recipient, so one fax sent to a group of ten recipients will be
archived as ten separate faxes.

Each RightFax user is individually configured for fax archiving. To
enable fax archiving for a user, select the Archive Sent Faxes
check box in the User Permissions tab of the User Edit dialog box
in Enterprise Fax Manager (see “Archive Sent Faxes"on page 123.)
Also, in order to archive sent faxes, at least one of the WorkServers
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must have “Archive” selected under Services (see “Services”on
page 36.) For each WorkServer that will manage archiving, you
must also complete the archive settings here.

Format Specify the file format used when archiving faxes. The file
format you should choose depends on how you plan to use the
archived faxes. By default, files are archived in a multi-page
TIFF-G3 format with Group Il data compression.

History Includes each fax's transmission history with the archived
fax image. The fax history is a separate ASCI| file saved in the
archive folder using the same file name as the fax but with the
extension.trx.

Path Specify the folder, in UNC format, where archived faxes will
be stored. The WorkServer will create the specified path if it
doesn't already exist.

The path can be customized using special variables that are
replaced in the path name each time a fax is archived. Using
variables in the path name lets you archive faxes to separate folders
based on the sender, the date, the fax destination, or any
combination of these. The following table lists each of the archive
path variables and their definitions.

Table 4b Archive Path Macros

Variable | Definition

~1 Date (YYYYMMDD)

~92 Day of the week (SUN-SAT)

~3 Month (JAN-DEC)

~4 Year (YYYY)

~5 Day of the month (DD)

~6 Month as decimal (01-12)

~7 User ID (up to 11 characters in 8.3 FAT format)

~8 Week as decimal (00-51)

~9 Billing Code #1 (up to 11 characters in 8.3 FAT format)
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Table 4b Archive Path Macros (Continued)

Table 4c Index File Fields (Continued)

Variable | Definition
~0 Billing Code #2 (up to 11 characters in 8.3 FAT format)
~A Remote ID (left to right, up to 11 characters in 8.3 FAT
format)
~B Remote ID (right to left, up to 11 characters in 8.3 FAT
format)
~C Group ID (up to 11 characters in 8.3 FAT format)
Example For example, this path:

\\Faxserver\Archive\~C\~7\~3~4 might look like this
after variable replacement:
\\Faxserver\Archive\DEVELOPM.ENT\JDOE\JAN1999

In this example, all of the faxes sent by user ID “JDoe" in
the “Development” group will be stored in a unique
archive folder, organized into separate subfolders each
month.

The total path length, after variable replacement, cannot exceed

128 characters. If you do not enter a path, no faxes will be archived.

Caution Because “~1" is interpreted as a macro in the path name, you
cannot use short path names (i.e. \Progra~1\RightFax\Archive) in this

field. You must use enter the full path names.

Index file Specify the UNC path and file name of the file where

all archive

ASCIl file.

events will be logged. The index is a comma-delimited
Each index entry appears on a separate line and

includes 24 data fields. The following table lists all of the fields for
each index entry in the order the fields appear.

Table 4c Index File Fields

Field Type | Length | Definition

To_ContactNum | String | 31 Recipient's phone number

To_Name String | 59 Recipient’'s name

To_Company String | 59 Recipient's company name

To_CityState String | 59 Recipient’s city and state

From_Name String | 59 Sender's name

From_PhoneNum | String | 31 Sender's phone number

Billinfo1 String | 156 Billing code 1

Billinfo2 String | 15 Billing code 2

FaxDIDNum String | 31 DID routing number

OperatorNum String | 31 Organization's general phone number

GeneralFaxNum | String | 31 Organization’s general fax number

RemotelD String | 21 Received remote 1D

Send_Time Integer | N/A Total time on fax board, in seconds

Fax_Status Integer | N/A A number corresponding to the fax's
last reported status.

Fax_Termstat Integer | N/A A number corresponding to the fax's
last reported transmission status.

NumPages Integer | N/A Includes optional cover sheet, if any

FineMode Integer | N/A O=normal, 1=fine

Received Integer | N/A O=sent, 1=received

FaxDate String | 10 Date the fax record was last modified
(mm/dd/yyyy)

FaxTime String |5 Time fax record last modified (hh:mm)

UniquelD String | 15 Unique ID for the fax assigned by

RightFax server

Field Type |Length | Definition
Owner_ID String | 21 User ID of the fax “owner”
To_FaxNum String | 31 Recipient's fax number
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Table 4c Index File Fields (Continued)

Field

Type | Length | Definition

Archived_Name | String | 256

File name used for the image archive

NewLine N/A N/A

(CR-LF combination record separator)

Because this log file is dynamic, if you plan to use a third-party
application to access the log information you must make sure the
file is opened in shared mode. Also, no third-party application
should be granted write access, and should not be configured so
as to keep the log file open for more than 10 to 20 seconds. The
optimal method for third-party access is to make a copy of the log
file, and then access data from the copy.

If no log file name is specified, RightFax will not log archive events.

Separate file per page output Archives each page of each
fax as a separate TIFF file (i.e., a five-page fax will be archived as
five separate files). This check box will only be available if you have
selected “TIFF-G3" or “TIFF-G4" in the Format box (see
“Format”on page 38.)

EquiTrac Archive Logs all successfully sent faxes to a file called
RightFax.txt in the WorkServer folder. The EquiTrac Archive log is a
comma-delimited ASCII file. Each log entry appears on a separate
line and includes nine data fields. The following table lists all of the
fields for each log entry in the order the fields appear.

Table 4d EquiTrac Archive Log Fields

Field Maximum length or format

RightFax user ID 21 characters

Phone number 31 characters

dialed

Billinfo1 15 characters

Billlnfo2 15 characters
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Table 4d EquiTrac Archive Log Fields (Continued)

Field Maximum length or format

Fax transmission hh:mm:ss

duration

Number of pages | ###
in fax

Fax error code Always 32, indicating success

Fax date mm/dd/yy

Fax time hh:mm

Always Delete After Archive Removes all archived faxes from
the user’'s FaxUtil mailbox.

Selecting a Service Account

All RightFax WorkServers log on to the network as services using a
Windows user account that you specify. This user account must
have access to all the network resources required by the tasks
(services) managed by your WorkServer modules. This account is
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initially selected during the RightFax installation. To change the
WorkServer module service account, click Select Service
Account. The Select Service Account dialog box opens.

Figure 4.2 The Select the Service Account Dialog Box

Select the account the Services will uze to startup.
MOTE: If you will be storing or accessing files on a Metiware volume, make sure the Service account exists as an account within Movell, Also
remember that passwords are case sengitive,

Dromain or Wworkgroup:

IHIGHTFAXUSEH

User Account:

InghtFaxLl ser

Pazsword:

Load Users

Cancel |

o]

Enter the new service account in the Domain or Workgroup and
User Account boxes. You can also click Load Users to scan for
and list a/l user accounts on the network, and then click a user
account in the list to automatically fill in the Domain or Workgroup

a

N

and User Account boxes. Enter the case-sensitive password for
the selected user account in both the Password and Confirm
Password boxes. Click OK to apply the new service account.

Warning If you manually type a name in the Domain or Workgroup field
that is longer than 15 characters, you may encounter errors in services
performed by the WorkServer. To avoid this, you should select the user
by clicking the Load Users button when the desired user account resides
on a domain whose name is longer than 15 characters.

Note If you will be storing or accessing files on a NetWare volume, you
must make sure the WorkServers' service accounts also exist as
accounts within Novell.

Adding and Deleting WorkServers

By default, three WorkServer modules are installed on the RightFax
server. Two WorkServer modules are devoted to the most frequent
tasks, and one is dedicated to network messaging and deleting
image files only. This default setup is optimal for most RightFax
configurations. However, changing the default configuration may
be necessary, depending on your fax server usage. For example, if
the server is used primarily for broadcast faxing, WorkServer #3
can be configured to perform the greater than average load of
PCL5 conversions, instead of the unnecessary network notification
function.

Here are some additional reasons for adding more WorkServers:
e If running OCR (Optical Character Recognition), either for

routing or conversion purposes, you may want to dedicate a
separate WorkServer to performing this processor intensive task.

o If the majority of your conversions are PostScript, you may want
to dedicate a separate WorkServer to this task.

e If you do a great deal of fax printing, you may want to dedicate a
separate WorkServer to performing this task as well.
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To add a new WorkServer, click Add WorkServer. To delete an
existing WorkServer, click the WorkServer to remove and click
Delete WorkServer. When you delete a WorkServer, the other
WorkServers will arrange themselves so they remain sequential.
For example, if you delete WorkServer #1, WorkServer #2 will
move to the WorkServer #1 position and WorkServer #3 will move
to the WorkServer #2 position.

Printing a Time Strip on Faxes

The WorkServer module can print a time strip at the top of every fax
that is printed to a network printer. The time strip can include the
time of arrival of received faxes, elapsed transmission time, time
printed, and the fax image file name.

Click Printer Configuration under the selected WorkServer.

Figure 4.3 The WorkServer Printer Configuration Dialog Box
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Enable Time Strip Enables printing a time strip at the top of
every fax that is printed to a network printer.

Note Although the time strip is printed as black text by default, RightFax
can print the time strip on the first page of each fax as white text on a
black background. This can be useful for manually sorting through printed
faxes. To enable the reversed time strip feature, edit the Windows
registry. Add a REG_DWORD value called PrintTimeReverse to
HKEY_LOCAL_MACHINE\Software\RightFax\Workserver and set the
value data to 1.

Name Specify what information to print in the Time Strip. The
Time Strip can contain any combination of text and variables. The
following table lists each of the variable options that can be used in
this box.

Table 4e Time Strip Macros

Macro | Definition

~1 The word “Sent” or “Received”

~2 Last transmission/receive date (MM/DD/YYYY)
~3 Last transmission/receive time (HH:MM)

~4 Last connection duration

~5 Last channel used

~6 WorkServer number

~7 Image file name

~8 Date and time printed (MM/DD/YYYY HH:MM)
~9 Unique ID

~0 RightFax user ID

~A Remote ID

~B Name of the fax recipient

~C Fax number of the fax recipient

~D Company name of the fax recipient
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Table 4e Time Strip Macros (Continued)

Macro Definition

~E Last transmission/receive date (YYYY/MM/DD)

~F Date and time printed (YYYY/MM/DD HH:MM)

Example The entry Fax ~1: ~2 ~3 might produce this text at the
top of a printed fax: Fax received: 01/05/99 10:42.

Configuring Kofax NetScan

RightFax can be configured to work in conjunction with the Kofax
NetScan network integration tool for scanners. Using the Kofax
NetScan, you can scan documents directly into the FaxUtil mailbox
of any RightFax user on your network. This makes it convenient to
fax printed pages when no electronic version is available.

Scanned images appear in the selected FaxUtil mailbox with the
message “Info not complete.” Images can then be faxed by
double-clicking the image in FaxUtil and completing the required
boxes in the Fax Information dialog box. For information on FaxUtil,
refer to the FaxUtil online help. For information on using the Fax
Information dialog box see “Using the Fax Information Dialog Box”
on page 254.

In order to integrate RightFax with the Kofax NetScan, at least one
WorkServer must have the Kofax integration enabled. Each

WorkServer is separately configured for Kofax NetScan integration.
Click Kofax NetScan Configuration under the selected WorkServer.

Figure 4.4 The WorkServer Kofax NetScan Configuration Dialog Box
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Enable NetScan Interface Enables RightFaxintegration with a
Kofax NetScan. Communication and integration with the Kofax
NetScan will only be handled by the WorkServers with this check
box selected.

Automatically Update NetScan Users Updates NetScan
users with the latest list of RightFax users every six hours or every
time the RightFax Server module is restarted. If this check box is
not selected, the NetScan can only be updated by selecting
Synchronize External Systems from the Utility menu in
Enterprise Fax Manager (see “Synchronizing the RightFax Server
with External Systems” on page 116).
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Location of NetScan Directories Specify the UNC path to
the folders that RightFax will monitor for new NetScan images. To
add a directory, type the UNC path in the Location of NetScan
Directories box and click Add Directory. To remove a directory,
click the directory and click Remove Directory.

Location for Scan-to-Disk Images Specify the UNC path to
the folder where images that are scanned to disk from the Kofax
NetScan will be saved.

For more information about configuring the Kofax NetScan for
RightFax integration, refer to your NetScan documentation.

Configuring PeopleSoft

PeopleSoft is an application for enterprise resource planning that
lets companies manage multiple resources from one integrated
platform. To use PeopleSoft with the RightFax server, you must
purchase a separate license. PeopleSoft must be used with the
RightFax Enterprise or Business Integration Module.

RightFax queries PeopleSoft for outgoing faxes, overriding the
PeopleSoft built-in ObjectFax server. This lets you combine the
benefits of RightFax least-cost routing and load balancing features
with your PeopleSoft platform.

RightFax 9.4 Administrator's Guide

To configure RightFax to work with PeopleSoft, at least one
WorkServer must have the PeopleSoft integration enabled. Each
WorkServer is separately configured for PeopleSoft integration.
Click PeopleSoft Configuration under the selected WorkServer.

Figure 4.5 The WorkServer PeopleSoft Configuration Dialog Box
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Enable PeopleSoft Interface Enables RightFax integration
with PeopleSoft. Communication and integration with the
PeopleSoft system will be handled by the WorkServers with this
check box selected.

Location of PeopleSoft directory Specify the UNC path to
the folder where PeopleSoft stores its outgoing fax jobs. The
service account for this WorkServer (see “Selecting a Service
Account” on page 40) must have read and write access to this
folder.
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Installing WorkServers on Remote Computers

a

The RightFax server lets you install and operate remote
WorkServers (WorkServers running on computers other than the
RightFax server). This lets you transfer selected
processor-intensive functions to other machines, freeing up
resources on your RightFax server. Running remote WorkServers
should only be considered for systems with 24 or more fax
channels in high volume fax broadcast situations. Three or four
properly configured WorkServers installed locally on the RightFax
server are sufficient to handle the fax load in most other
installations.

Warning After you install a remote WorkServer, you cannot delete any
WorkServers from your RightFax configuration. This will disrupt the order
of the services and the remaining WorkServers may fail to function as
expected.

Requirements

Supported Microsoft Windows Operating Systems

RightFax server software is supported on the following server
operating systems.

e Windows Server 2003 Standard x86
¢ Windows Server 2003 R2 Standard x86
¢ Windows Server 2003 Enterprise x86

Local server requirements

e Microsoft .NET Framework 2.0 or later*

¢ Microsoft Data Access Components 2.8*

e Microsoft Messaging Queuing*

e Microsoft Visual C++ 2005 runtime components*

e A Windows account to run RightFax services. The account
you choose must be a domain user that member of the local
administrators group and must have the right to logon as
service on the local computer.

RightFax server requirements

Before installing remote WorkServers, you must share the
\RightFax folder on the RightFax server and grant the WorkServer
service account full-control. This account must also have write
access to the Windows registry on the RightFax server.

To install the WorkServer on a Remote Computer

To ensure that your installation goes smoothly and to avoid
unnecessary delays, it is important to perform each step in the
installation completely and correctly before proceeding to the next
step.

1. Insert the RightFax Product Suite DVD. If AutoRun is enabled, a
menu of install options appears. If AutoRun is not enabled,
browse the DVD and run Setup.exe. The RightFax Product
Suite Setup wizard opens.

2. RightFax WorkServers require Microsoft .NET Framework 2.0 or
later. If this software is not installed on your system, Setup will
prompt you to install it. To install, click OK. To cancel Setup and
install .NET Framework 2.0 yourself, click Cancel.

3. Review the welcome screen and click Next.

4. Carefully read and accept the license agreement and click Next.

Chapter 4 Configuring the WorkServer Modules
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5. Setup can check for RightFax updates and other late-breaking
information. To check for updates, verify you have an active
HTTP connection and click Check for Updates. If updates are
found, follow the instructions in the Result section. To skip the
update check and continue with Setup, check the box next to
Do not check for updates and click Next.

6. Click Custom followed by Next.

7. Select the WorkServer Module Setup component and click
Next. No other Setup components should be chosen.

8. The Preview Requirements step lists third-party software
required by your chosen features and also lists the status of
setup operations. Software that must be installed will have a
status of Must Install. To continue, click Next.

9. To apply your settings and install required third-party software,
click Apply. This may take several minutes. When finished, click
Next.

10.1f your server does not already have Microsoft Message
Queuing installed, Setup will prompt you to install it. Select your
option and click Next.

11.RightFax requires TCP ports 10520, 10521, 10062, 34987,
and 34988. Setup can reserve these ports for exclusive use by
RightFax. To allow setup to reserve these ports, enable the
Reserve Ports option and click Next. If you do not reserve
these ports, some RightFax services may not start.

12.To apply your settings and install required third-party software,
click Apply. This will take several minutes. When finished, click
Next.

13.Choose your installation folder and click Next.

14.To begin installing RightFax software, click Apply. This may take
several minutes. When finished, click Next.
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15.Enter a Windows account to run RightFax services. This must
account be a domain user that member of the local
administrators group and must have the right to logon as
service on the local computer. In addition, this account must
also have full-control over the \RightFax folder on the RightFax
server and have write access to the Windows registry on the
RightFax server. Click Browse to load and select a user
account. Use the Test Account button verify account
credentials. When finished, click Next.

16.Enter your RightFax server name and click Next.

17. To apply your settings and complete Setup, click Apply
followed by Close.

Changing the remote WorkServer’s service account

When it is installed, the remote WorkServer uses the same service
account information as the WorkServers on the RightFax server. If
this is a local administrative account on the RightFax server, the
remote WorkServer service may not be able to log on to the
network. If so, you must change the service account used by the
remote WorkServer so that it has administrative permissions to the
computer on which it is installed. To change the WorkServer's
service account on the remote computer, open Windows Control
Panel and select Administrative Tools > Services. The
WorkServer is listed in the services as RightFax WorkServer
Module. Double-click the service name to open its configuration
dialog. You can specify a new service account name on the Log On
tab. You must repeat this procedure locally at the WorkServer
before the changes will take effect.
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Chapter 5
Configuring the DocTransport and BoardServer Modules

The RightFax DocTransport module lets you configure the methods Configuring the RightFax DocTra nsport Module

by which RightFax will be able to transmit documents. This module

lets you configure fax boards for conventional fax transmission, as 1. On the RightFax server, select Start > Programs > Enterprise
well as set up RightFax for SMS messaging, Fax-over-IP and Eicon Fax Manager.

fax boards. 2. In the Enterprise Fax Manager application, click the name of the
The RightFax BoardServer module acts as an interpreter between RightFax server to configure in the tree in the left pane. A list of
the some fax board drivers and the RightFax Server module for services appears at the lower-right pane of the window.
conventional fax transmission. It handles requests to schedule 3. In the Service Name list, double-click RightFax DocTransport
outgoing faxes for transmission and informs the Server module Module. The DocTransport Configuration dialog box opens.
when a new fax has been received and needs to be processed. The

BoardServer module can only be configured from within the Figure 5.1 The DocTransport Configuration dialog box

DocTransport module which oversees its functions. The |
DocTransport module is also responsible for starting and stopping : :E.".:z:i;f:s;f::‘:,,iz‘g:f::m_,, S

the BoardServer module. = E—

The DocTransport module must be properly configured to allow the
RightFax server to send and receive documents. RightFax supports
a maximum of 120 fax channels per DocTransport service which
includes all channels in the BoardServer module as well.

Caution Manually stopping or starting the BoardServer module will

& cease the scheduling of all faxes. To stop the BoardServer module you
must stop the DocTransport module to initiate a proper BoardServer
shutdown. To restart the BoardServer, simply start DocTransport as it is
designed to automatically start the BoardServer module. This also
applies when running the BoardServer in debug mode.

50L Connection
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Adding transport methods

By default, the DocTransport module includes the RightFax
BoardServer module set up as a transport method. With the
BoardServer module, you can configure most supported fax boards
for conventional fax transmission and receipt. You can also add the
following transport methods.

Table 5a Additional transport methods

Transport method

Description

Eicon Diva Server

Required if you will be installing any of the
following Eicon fax boards:

o Eicon Diva Server BRI-2M

o Eicon Diva Server 4BRI-8M

o Eicon Diva Server PRI/E1/T1
o Eicon Diva Server PRI/E1-30

Brooktrout TR1034
Series, SR140

Required if you will be installing any
Brooktrout TR1034-series fax boards or the
Brooktrout SR140 software platform of Fax
over IP.

T.37 Fax over IP

Required if you will be creating
administrative dialing rules that route faxes to
T.37-compatible fax machines.

Note You must configure the gateway if you
plan to send faxes directly to IP addresses
and wish to collect route codes.

Simulation Device

Allows simulated fax sending. Outgoing
faxes will appear to send but will not.
Simulation mode can be used with no fax
boards installed.

SMS Via Push Proxy
Gateway

Required if you install and plan to use the
Push Proxy Gateway. The RightFax Push
Proxy Gateway Guide provides
configuration information for this transport

type.
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If your RightFax configuration does not include any of these
transport methods, you will need to configure only the RightFax
BoardServer module to properly match your fax board
configuration. To open the BoardServer configuration program,
select RightFax BoardServer under Legacy on the pane on the
left side of the DocTransport Configuration dialog box, and then
click the Configure Boardserver button. For information on
configuring the RightFax BoardServer module, see “Configuring
the RightFax BoardServer” on page 66.

To add one or more of the optional transport methods to
the DocTransport module

1. Click the Add Transport button. This opens the Transport
Selection dialog box.

Figure 5.2 The Transport Selection dialog box
ﬂ

Select iansport to Add:

.. Diva Server, SoftIP
= oktrout
. . TR1034 Series, SR140
= FolP
© .T.37 Fax Over IP
- Simulation
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- SMS
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Select I Cancel |

2. Expand the tree in the left pane and select the transport method
to add.
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3. If you select either Eicon Diva Server or Brooktrout TR1034
Series, SR140, you must select a specific fax board in the right
pane.

4. Click Select to add the new transport method.

5. Repeat these steps for each optional transport method you
want to add.

6. After you have added all of the transport methods you will be
using, each must be properly configured for your system. The
rest of this chapter describes how to configure each of the
transport options in the DocTransport module.

Configuring automated billing codes

This feature automatically applies billing codes to outbound faxes
based on the user ID of the sender. To configure automatic billing
codes, click Auto Billing Code Settings in the left pane.

Figure 5.3 DocTransport Configuration Auto Billing Code Settings.
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Enable User Specific Phone Codes Enables the Automatic
Billing Codes feature.

To assign domestic and international phone codes to specific
RightFax users, you must create a list of RightFax users and their
phone codes.

Click Add Entry to add a new entry to the list. This opens a dialog
box asking you to enter a RightFax user ID and that user's domestic
and international long distance phone codes. When you click OK
to close the dialog box, the new entry is immediately displayed in
the DocTransport Configuration dialog box.

To edit an entry, click the entry in the list and click Edit Entry. To
delete an entry, click the entry and click Delete Entry.

To load a list of RightFax user IDs and phone codes from a file, type
the path and file name in the Phone Codes File Name box and
click Load File. The file name you specify must be a tab-delimited
ASCI! file. Each entry in this file must include the RightFax user ID,
domestic phone code, and international phone code. Individual
entries are separated by a carriage return

Example JDoe 1345 0345
JSmith 1678 0678
Blones 1111 0111

After you load the file, any additions, deletions, and editing changes
you make in the DocTransport Configuration dialog box will be
saved.

To distinguish international and domestic long distance
calls

After you have created a list of RightFax users and their phone
codes, you must specify dialing rules that tell RightFax when to dial
those codes.

Chapter 5 Configuring the DocTransport and BoardServer Modules
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When creating dialing rules, the character “F" added to the dial
string will be replaced with the user’'s domestic phone code. The
character “G" added to the dial string will be replaced with the
user's international phone code.

Example For example, for international calls, you might create a
dialing rule like this:

Pattern Append
011+ wGii

This tells RightFax that if the first three digits of an
outgoing fax number are “011" (the international dialing
prefix) then wait for a dial tone (w), look up the user's
international billing code and dial it (G), and then wait 10
seconds before dialing the number (ii).

For more information on creating dialing rules in RightFax, see “Adding
dialing rules” on page 205.

Configuring Global DocTransport Settings

Global board settings in the DocTransport module are global
settings that apply only to the transport methods enabled in
DocTransport. RightFax will use these settings regardless of the
transport method, fax board, or channel in use. To configure Global
DocTransport Settings, select Global DocTransport Settings in
the left pane. The rest of this section describes the options on this
screen.
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Figure 5.4 The DocTransport Global DocTransport Settings configuration
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Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax
DocTransport Module!” You can select the following options:

¢ None. No information is saved.
o Terse. Records critical errors only.
e Normal. Records errors and major events only.

¢ Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution If you leave this value set to “Verbose” for long periods of time,
the Event Log can become full which may prevent new events from being
logged.

Secure RPC Enabled Encrypts the data exchanged between
multiple RightFax DocTransports (e.g., Remote BoardServers) or
between a RightFax DocTransport module and the FaxStat
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program. Any DocTransport service on any other RightFax server
communicating with this server must be started using a valid
account and password rather than a local system account.

If you select this option, you must specify a user account that the
DocTransport service can use for authentication to and from other
DocTransport modules on the network. To specify a user account,
click the [...] button to the right of this option and enter a login
name and password.The quick header line can be customized
using special macros that are replaced in the quick header of each
fax.

Configuring Brooktrout 1034 and Trufax Fax
Boards

A

Brooktrout 1034-series and Trufax-series fax boards must be
added and configured in the DocTransport module. Brooktrout
related settings are configured using the Brooktrout Configuration
Tool provided by Brooktrout. Each Brooktrout 1034 and
Trufax-series board added to DocTransport must be configured
separately.

After you have specified the installed Brooktrout fax boards in
DocTransport (described in “Adding transport methods” on

page 48), expand the Brooktrout option in the list in the left pane
and select an Brooktrout board in the list.

Note Brooktrout Trufax 100 PCl and 200 PCI fax boards are configured
using the Legacy BoardServer transport.

Configuring Brooktrout Global Transport Settings

Brooktrout Global Transport Settings in the DocTransport module
are global settings that apply to all of the Brooktrout 1034-series
and Trufax-series fax boards and channels configured in the

DocTransport module. RightFax will use these settings regardless

A

of the fax board or fax channel in use. To configure global transport
settings, select Global Transport Settings in the left pane. The
rest of this section describes the options on this screen.

Figure 5.5 The Brooktrout 1034 Global Transport Settings configuration
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CD Timeout Specify the length of time, in seconds, that the
RightFax server will wait for a fax answer tone (CED tone) from a
remote fax machine when sending a fax.

Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax
DocTransport Module.” You can select the following options:

¢ None. No information is saved.

e Terse. Records critical errors only.

e Normal. Records errors and major events only.

e Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution |If you leave this value set to “Verbose” for long periods of time,
the Event Log can become full which may prevent new events from being

logged.
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ANI Pattern Match Specify the pattern of the dialing party
information string that will be received during incoming calls.

RightFax collects information about the dialing party’s phone
number for display in FaxUtil and for CSID routing (if used).
However, some organizations receive additional information (such
as ANI or DNIS) along with the caller's phone number. This box
specifies the pattern of the extra data so that it can be removed
prior to display or routing.

The ANI matching pattern is defined using these symbols.

Table 5b ANI Pattern Matching Symbols

Symbol Definition

* Matches one or more “star” characters in the source
string.

# Matches one or more “pound” characters in the
source string.

X Matches one or more digits belonging to the ANI
number.

Y Matches one or more digits belonging to the DNIS
number.

4 Matches one or more digits which are discarded.

0-9 Valid phone digits (literal digits). Separate literal digits

A-D from max-modifiers with a space.
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A digit can be added after any of these symbols to specify the

exact number of characters to expect.

Example For example, the “2" in the pattern x2*y indicates that the
pattern will contain a maximum of two ANI digits at the
beginning of the string.

Here are some examples of ANI Pattern Match settings
and the strings they match:

Setting Matches

1x10%y 1 X000 > .Y VY.
x2z*y2 9 XXz2zZ..X**...yy9

x#1z XXX...#22Z...

Allow Auditing Tells the DocTransport module to record a log
of all incoming and outgoing faxes.

File Specify the path and file name of the log file to use. If the file
does not exist, RightFax will create it when it logs the first entry. To
output the log file directly to a network printer, enter the printer port
instead of a file name. If you output to a network printer, you must
also select the Close File Between Each Page check box.

Level Specify the level of information to include in the log. There
are four levels of detail. Level 1 prints a single line summary of each
fax event, Level 2 prints a detailed description of each fax event,
Level 3 outputs a comma-delimited file, and Level 4 outputs a
tab-delimited file.
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If you set Level to “3," each fax event will be saved to a
comma-delimited file. Each log entry appears on a separate line
and includes 15 data fields. The following table lists all of the fields
for each log entry in the order the fields appear.

Table 5¢ Audit Log Level 3 Field Descriptions

Field

name Type/format | Length | Description

Direction | String 1 Sent/received flag (“S” or
“R”)

Date sent | MM/DD/YYYY | 10 Date that the call was
initiated

Time sent | HH:MM 5 Time that the call was
initiated

Channel | Numeric 2 Channel used by RightFax
(0-32)

Duration Numeric 5 Total transmission time in

seconds

Phone Alphanumeric | 31 Sent faxes: Fax number
number dialed

Received faxes: Routing
code (DID or DTMF) used

Remote String 49 Remote fax machine ID

ID

Result String 59 Result of the fax
transmission

Page String 79 Number of pages

count transmitted

Contact | String 31 Sent faxes only: The

number recipient’s voice number

Contact | String 59 Sent faxes only: The

name recipient’s name.

Table 5¢ Audit Log Level 3 Field Descriptions (Continued)

Field

name Type/format | Length  Description

Company | String 59 Sent faxes only: The

name recipient’s company name

User ID String 21 Sent faxes only: RightFax
user ID of the sender

Billing String 15 Sent faxes only: Billing code

code 1 1

Billing String 15 Sent faxes only: Billing code

code 2 2

If you set Level to “4," a new file is created each hour containing
that hour's fax events. Because a separate file is created for each
hour's fax events, do not specify a file name in the File box. You can
optionally specify a path to a folder where the log files, which are
given default names, will be saved.

Each log entry appears on a separate line and includes 28 data
fields. The following table lists all of the fields for each log entry in
the order the fields appear.

Table 5d Audit Log Level 4 Field Descriptions

Field name | Type Length | Description

Direction String 1 Sent/received flag (“S” or
“R”).

Date sent YYYYMMDD | 8 Date that the call was
initiated.

Time sent HHMM 4 Time that the call was
initiated.

Channel Numeric Channel used by RightFax.

Duration Numeric Total transmission time (in

seconds).
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Table 5d Audit Log Level 4 Field Descriptions (Continued)

Field name |Type Length | Description

Phone String 127 Fax number dialed.

number

Remote ID String 47 CSID of recipient fax
machine.

Good pages | Numeric 5 Number of pages
transmitted successfully.

Page count Numeric 5 Total number of pages in
the fax.

Board type Numeric 1 Type of fax board used to
send the fax
0 = Brooktrout

BT call status | Numeric 5 Brooktrout call result
status value.

BT call line Numeric 5 Brooktrout call result line

status status value.

BT fax status | Numeric 5 Brooktrout fax result status
value.

BT fax line Numeric 5 Brooktrout fax result line

status status value.

CDR flags Numeric 4 Hex value of CDR flags
0x0001 = PartialRetry
0x0002 = SchedRemote
0x0004 = SendForRemote
0x0008 = Has_ANI
0x0010 = Had_AOC
0x0020 =
Had_ISDNCauseVal

AOC value 1 | Numeric 9 AOC data value #1 (only

valid if indicated by flags).
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Table 5d Audit Log Level 4 Field Descriptions (Continued)

Field name | Type Length | Description

AOC value 2 | Numeric 9 AOC data value #2 (only
valid if indicated by flags).

AOC value 3 | Numeric 9 AOC data value #3 (only
valid if indicated by flags).

ISDN cause | String 5 ISDN call setup cause

value value (only valid if indicated
by flags).

Sender ID String 21 RightFax user ID of the
sender.

To name String 59 The recipient’s name.

From name String 59 Name of sender
(descriptive name, not the
ID).

Contact String 31 The recipient’s voice

number number.

Company String 59 The recipient’'s company

name name.

Billing code 1 | String 15 Billing code 1.

Billing code 2 | String 15 Billing code 2.

Secure CSID | String 21 CSID match code for
secure send operation.

Unique ID String 15 Assigned unique ID for fax
job.

Source String 47 Source server IP address

server or name.

InitialString This is a text message that will be included in the

audit file at the beginning of every page.

54



This line can contain control codes that can be used to convey
page formatting or other information to the application reading the
file. To add control codes to this string, use the following notation.

Table 5e InitialString Control Codes

Notation | Example | Represents

\x## \x1b Hexadecimal character values

\### \027 Decimal character values

Ax A ASCII representation of a control character

Close File Between Each Page Closes the log file after each
entry. This allows you to output the log to a network printer.

Allow TTI Line The transmit terminal information (TTI) line is a
line of text that prints at the top of each received fax page. The TTI
line includes the transmitting fax machine, the date and time of the
transmission, the fax page number, and the total page count.
Follow these steps to optionally add your organization's name to
the TTl line:

1. Open Windows Control Panel and run the RightFax
DocTransport application.

2. Click on each fax channel for each fax board listed in the left
pane.

3. Type the desired company name in the Fax ID box.

4. Repeat these steps on all RightFax servers and Remote
BoardServer computers.

Select this option to place a TTl line at the top of every page of a
fax. The date format in your TTl line is a function of the Windows
international or regional settings as installed on the fax server.

If this check box is selected, you must also specify how the TTl line
should be placed on the fax page.

Note Brooktrout Trufax fax boards do not support the TTI line feature.

e Select Overlay TTI Line to add the TTl line text to add any
existing text or image on the first line of the fax. Note that this can
obscure the TTl information. With Brooktrout fax boards, this
option functions the same as inserting the TTl line.

e Select Replace TTI Line to replace any existing text or image on
the first line of the fax with the TTl line. This erases existing fax
data from the first line but ensures that the overall length of the
fax stays the same.

e Select Insert TTI Line to add a new line to the top of the fax
page for the TTl information. This retains any fax data on the first
line but increases the length of the fax by one line.

Display GMT on the TTI Line Displays the local time relative
to Greenwich Mean Time (GMT). If this option is not selected, the
TTl line will display the local time at the fax's place of origin.

Quick Header Format Specify heading text to include under
the TTI line on outbound faxes. Quick headers must be enabled in
the General tab of the RightFax Server module Configuration
dialog box (see “Enable Quick Headers” on page 22).
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The quick header line can be customized using special macros that
are replaced in the quick header of each fax.

Table 5f Quick header macros

Macro Definition

~1 To-name field (59 characters maximum)

~2 Shortened to-name (23 characters maximum)

~3 To-contact number field (31 characters maximum)

~4 To-company field (59 characters maximum)

~5 Shortened to-company field (23 characters maximum)
~6 Billinfo1 field (15 characters maximum)

~7 Billinfo2 field (15 characters maximum)

~8 Unique ID (15 characters maximum)

Example For example, the setting Please deliver to: ~2 at ~5
might appear in a fax Quick Header as Please deliver to:
Jane Doe at Acme, Inc.

Beeping Tells the computer in which the fax boards are installed
to beep each time a call is placed or received.

Dialing Settings Prefix This field specifies one or more dialing
characters to add at the beginning of every outbound fax number
dialed by the server. The default setting (WW) instructs the fax
boards to automatically detect a dial tone before dialing. For a list
of valid dialing characters, please see page 209, of the
Administrator’s Guide.

Dialing Settings Postfix This field specifies one or more
dialing characters to add at the end of every outbound fax number
dialed by the fax server. For a list of valid dialing characters, please
see page 209, of the Administrator's Guide.

Call Grouping Whenever a fax is placed in the fax queue, Call
Grouping checks the queue for another fax going to the same
number. If another fax to the same number is scheduled, it keeps
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the line open and transmits the second fax, saving the time and
money of redialing and reconnecting a second time. The Call
Grouping feature is only available for use with Brooktrout fax
boards. This option enables the Call Grouping feature for all
Brooktrout1034 and Trufax-series fax boards.

Maximum Grouping This field specifies the maximum number
of pages (1-256) that the fax server will send to one phone number
before hanging up and sending another set of faxes.

Configuring Brooktrout 1034 and Trufax fax boards

After you have added a new Brooktrout fax board, it must be
configured to work with RightFax. To configure the board, click the
board name in the Board/Channel list in the left pane.

Figure 5.6 Brooktrout Board Configuration

xl
-~ Auto Billing Code Settings Ij DID Settings———————————————
- Global DocTransport Settings Board module number. |2 = - .
Nurnber of digits for routing: |4 'I
Legacy Mumber from the iotary switch on the board. B - &
=~ Brooktrout

-~ Global Transport Settings
Advanced Settings
S8 TR1034+P8-E1

¥ Set Eax|D for all channels:  |Fax Server

- Channel #0 ™ Set Capability for all channels: Eoth =
Channel #1

-~ Channel #2

-~ Channel #3 Configure Brooktrout Board

- Ch | #4
Ch::::l s Lonfigure Brooktrout

-~ Channel #6
-~ Channel #7

SGL Connection
ﬁ DSN=RightFax;UID=sa;PWh=472E65AZSBIESE3D442F 430, J

Select Service Account... | oK I Cancel I

Delete Device | Add Tranzpart I

Board Model Specify the nationality type of fax board installed.
This may or may not be the country in which you reside.

Set Fax ID for All Channels You can specify a fax ID for all
the channels on this fax board. The fax ID is transmitted by each
channel on this fax board to remote fax machines. Usually, this is
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set to your company name or general fax number. To specify a
unique fax ID for each channel, see “Configuring Brooktrout 1034
and Trufax fax channels” on page 57.

Set Capability for All Channels Sets the same capability
(dial-only, answer-only, or both) for all the channels on the fax
board. To specify the capability of each channel separately, see
“Configuring Brooktrout 1034 and Trufax fax channels” on
page 57.

Configure Brooktrout Opens the Brooktrout Configuration
Tool for configuring Brooktrout-related board settings. For more
information about the settings within the Brooktrout Configuration
Tool, see Brooktrout documentation.

Opening the Brooktrout Configuration Tool

After you have configured DocTransport, you must configure
Brooktrout-related board settings using the Brooktrout
Configuration Tool provided by Brooktrout. For more information
about the settings within the Brooktrout Configuration Tool, see
Brooktrout documentation. Follow these steps to open the
Brooktrout Configuration Tool:

1. In the DocTransport Configuration program, click your
1034-series of Trufax-series fax board.

2. Click the Configure Brooktrout button located on the right side
of the DocTransport configuration program. The Brooktrout
Configuration Tool opens.

Note The Brooktrout Configuration Tool can also be opened from the
Windows Programs list (Start > Programs > Brooktrout Configuration
Tool.

Configuring Brooktrout 1034 and Trufax fax channels

Each fax channel on a Brooktrout 1034-series and Trufax-series fax
board can be individually configured. To configure a channel, click
the channel number in the Board/Channel list.

Figure 5.7 Brooktrout Channel Configuration Dialog Box
ﬁ
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Activate Channel Activates this channel for use by RightFax. To
deactivate the channel, click to clear this check box.

Fax ID Specify the fax ID for this channel only. The fax ID is
transmitted to remote fax machines to identify the sender. Usually,
this is set to your company name or general fax number. This box
will not be available if you selected the Set Fax ID for all Channels
check box when configuring the Brooktrout board (see
“Configuring Brooktrout 1034 and Trufax fax boards” on page 56).

Capability Sets the capability (dial-only, answer-only, or both) for
this channel.

Max. Pages This Channel May Send Sets the maximum
number of pages per fax that can be sent by this channel, from 0 to
999 (up to 1000 pages per fax). This lets you reserve channels for
smaller faxes.
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Channel Extension Assigns a routing code to all incoming
faxes on this channel if no routing information is specified. Because
DID, T1 with DNIS, and ISDN telephone lines require routing
codes, this setting only applies to loop-start lines and T1 lines
without DNIS. The Channel Extension is also used when DTMF
routing is enabled on the line but the caller does not enter a routing
code.

Configure Brooktrout Opens the Brooktrout Configuration
Tool for configuring Brooktrout-related board settings. For more
information about the settings within the Brooktrout Configuration
Tool, see Brooktrout documentation.

Timed ability This feature changes the capability (send-only,
answer-only, or both) of the fax channel at defined times. For
example, you can set a channel to answer-only during business
hours, and then switch it to both dial and answer after hours so it
can be used for broadcast faxing in the evening.

You can define up to three time periods. Times are indicated in 24
hour military time (“0000” represents midnight, “1200" represents
noon, and “1730" represents 5:30 p.m.).

Start Specify the beginning of the time period. The first time
period always has its Start time set to “0000” (midnight).

End Specify the end of the time period. You must always specify
the end time of the last time period as “2359"

Capability Sets the capability (dial-only, answer-only, or both) for
this time period.

Inbound routing These settings all apply if you will be using
DTMF routing. DTMF routing is a method for routing faxes directly
to an individual based on the routing code entered manually by the
caller.

Enable DTMF Routing Enables DTMF inbound routing for this
channel.
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Initial Tone Prompts callers to enter a routing code for the fax by
playing a tone. When this option is selected, you must also select
the tone to play and the duration of the tone in seconds. For
information on the available tones, refer to your Brooktrout
documentation.

Initial Speech Prompts callers to enter a routing code for the
fax by playing a voice prompt. This requires a special voice module
license for your Brooktrout board.

When this option is selected, you must also specify the file of the
voice prompt. The default file, Prompt.ipk is located in the
RightFaxX\RFBoard folder. This prompt file can be played or
re-recorded via telephone.

To play the voice prompt for review, go to a command prompt on
the server and enter this command:

\rfboard\voice -p -cPhoneNum prompt.ipk

where PhoneNum is the phone number the Brooktrout board will
dial to play back the prompt.

The board will dial the phone number you specified. When you
answer the phone, it will play the message. Hang up when the
playback is complete.

To record a new voice prompt

1. Save a backup copy of the old Prompt.ipk file.
2. From a command prompt on the server, enter this command:
\rfboard\voice -r -cphonenum -u0 prompt.ipk

where phonenum is the phone number the Brooktrout board
will dial to initiate the recording.

3. The board will dial the phone number you specified. When you
answer the phone, it will begin recording your message. Press
the [#] key (pound key) when you are done.
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Failure Specify the file to play when a caller does not enter
enough DTMF digits to route the fax. The default file, Baddigit.ipk is
located in the RightFax\RFBoard folder. This prompt file can be
played or re-recorded via telephone. For information on playing and
recording voice prompts, see “Initial Speech” on page 75.

Confirmation Specify the file to play when a caller has correctly
entered DTMF digits for routing. The default file, Gotdigit.ipk is
located in the RightFax\RFBoard folder. This prompt file can be
played or re-recorded via telephone. For information on playing and
recording voice prompts see “Initial Speech” on page 75.

No Terminator Tells RightFax to accept the DTMF code entered
by the caller as soon as the correct number of digits have been
entered. No additional terminator key needs to be pressed.

Terminator Specify the key (on the phone) that the caller must
press when finished entering DTMF digits. This is necessary when
the Max. Digits and Min. Digits are not set to the same value.
Because in this case the routing code can be a variable number of
digits, the caller must provide some indication of when he has
finished entering DTMF digits.

Max. Digits Specify the maximum number of DTMF digits that
can be entered by the caller.

Min. Digits Specify the minimum number of DTMF digits that
can be entered by the caller.

Tone Wait Specify the length of time in seconds to wait after the
prompt is played for the caller to enter a routing code. If you have
specified a terminator key (described previously), the caller must
enter the code and the terminator in this length of time.

Brooktrout SR140 Boardless Fax Over IP

The Brooktrout SR140 transport is a software-only edition of fax
over IP that uses the H.323 and SIP protocols. SR140 does not
require a fax board. All SR140 channels require license key
activation. Do not attempt SR140 setup and configuration prior to
activating your SR140 license keys.

Licensing Brooktrout SR140 Channels

The Brooktrout License Manager, provided by Brooktrout allows
you to self-active your SR140 license key. Instructions and an
activation wizard are included with Brooktrout License Manager.
Using this method requires an active internet connection.
Alternatively, you may activate your SR140 channels by contacting
RightFax technical support at (520) 320-7070. A support
representative will guide you through the activation process.

For more information about SR140 licensing, see Answer ID 4939
at the Captaris knowledge base located at
http://www.captaris.com/Scripts/captaris.cfg/php.exe/enduser/std

_alp.php

Important To activate your SR140 channels, you must have an SR140
license card. This card contains your SR140 license key and is included
with the purchase of SR140 channels.

To open Brooktrout License Manager

1. Click the Windows Start button > Programs List > Cantata
License Manager. The Brooktrout License Manager opens.

Self-activation instructions can be found by clicking ? along the
Brooktrout License Manager toolbar.

Chapter 5 Configuring the DocTransport and BoardServer Modules

59



Adding the SR140 Transport

After you have activated your SR140 license you must add the
installed Brooktrout fax boards in DocTransport (described in
‘Adding transport methods” on page 48), expand the Brooktrout
option in the list in the left pane and select an Brooktrout board in
the list.

Configuring Brooktrout SR140 Global Transport Settings

Brooktrout SR140 Global Transport Settings in the DocTransport
module are global settings that apply to all Brooktrout SR140
channels configured in the DocTransport module. RightFax will use
these settings regardless of the fax board or fax channel in use. To
configure global transport settings, select Global Transport
Settings in the left pane. The rest of this section describes the
options on this screen.

Figure 5.8 Brooktrout SR140 Global Transport Settings configuration

ﬂ
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CD Timeout Specify the length of time, in seconds, that the
RightFax server will wait for a fax answer tone (CED tone) from a
remote fax machine when sending a fax.
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Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax
DocTransport Module!” You can select the following options:

¢ None. No information is saved.
o Terse. Records critical errors only.
e Normal. Records errors and major events only.

¢ Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution If you leave this value set to “Verbose” for long periods of time,
the Event Log can become full which may prevent new events from being
logged.

ANI Pattern Match Specify the pattern of the dialing party
information string that will be received during incoming calls.

RightFax collects information about the dialing party's phone
number for display in FaxUtil and for CSID routing (if used).
However, some organizations receive additional information (such
as ANI or DNIS) along with the caller's phone number. This box
specifies the pattern of the extra data so that it can be removed
prior to display or routing.

The ANI matching pattern is defined using these symbols.

Table 5g ANI Pattern Matching Symbols

Symbol Definition

*

Matches one or more “star” characters in the source
string.

# Matches one or more “pound” characters in the
source string.

X Matches one or more digits belonging to the ANI
number.

Y Matches one or more digits belonging to the DNIS
number.
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Table 5g ANI Pattern Matching Symbols (Continued)

Symbol Definition

4 Matches one or more digits which are discarded.
0-9 Valid phone digits (literal digits). Separate literal digits
A-D from max-modifiers with a space.

A digit can be added after any of these symbols to specify the
exact number of characters to expect.

Example For example, the “2" in the pattern x2*y indicates that the
pattern will contain a maximum of two ANI digits at the
beginning of the string.

Here are some examples of ANI Pattern Match settings
and the strings they match:

Setting Matches

1x10%y T XXX %Ly Yy
x2z*y2 9 XXzzz..X**...yy9

x#1z XXX...#222...

Allow Auditing Tells the DocTransport module to record a log of
all incoming and outgoing faxes.

File Specify the path and file name of the log file to use. If the file
does not exist, RightFax will create it when it logs the first entry. To
output the log file directly to a network printer, enter the printer port
instead of a file name. If you output to a network printer, you must
also select the Close File Between Each Page check box.

Level Specify the level of information to include in the log. There
are four levels of detail. Level 1 prints a single line summary of each
fax event, Level 2 prints a detailed description of each fax event,
Level 3 outputs a comma-delimited file, and Level 4 outputs a
tab-delimited file.

If you set Level to “3," each fax event will be saved to a
comma-delimited file. Each log entry appears on a separate line
and includes 15 data fields. The following table lists all of the fields
for each log entry in the order the fields appear.

Table 5h Audit Log Level 3 Field Descriptions

Field

name Type/format | Length | Description

Direction | String 1 Sent/received flag (“S” or
“R”)

Date sent | MM/DD/YYYY | 10 Date that the call was
initiated

Time sent | HH:MM 5 Time that the call was
initiated

Channel | Numeric 2 Channel used by RightFax
(0-32)

Duration Numeric 5 Total transmission time in

seconds

Phone Alphanumeric | 31 Sent faxes: Fax number
number dialed

Received faxes: Routing
code (DID or DTMF) used

Remote String 49 Remote fax machine ID

ID

Result String 59 Result of the fax
transmission

Page String 79 Number of pages

count transmitted

Contact | String 31 Sent faxes only: The

number recipient’s voice number

Contact | String 59 Sent faxes only: The

name recipient’s name.
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Table 5h Audit Log Level 3 Field Descriptions (Continued)

Field

name Type/format | Length | Description

Company | String 59 Sent faxes only: The

name recipient's company name

User ID String 21 Sent faxes only: RightFax
user ID of the sender

Billing String 15 Sent faxes only: Billing code

code 1 1

Billing String 15 Sent faxes only: Billing code

code 2 2

If you set Level to “4," a new file is created each hour containing
that hour's fax events. Because a separate file is created for each

hour's fax events, do not specify a file name in the File box. You can

optionally specify a path to a folder where the log files, which are
given default names, will be saved.

Each log entry appears on a separate line and includes 28 data
fields. The following table lists all of the fields for each log entry in

the order the

fields appear.

Table 5i Audit Log Level 4 Field Descriptions

Field name | Type Length | Description

Direction String 1 Sent/received flag (“S” or
“R”).

Date sent YYYYMMDD | 8 Date that the call was
initiated.

Time sent HHMM 4 Time that the call was
initiated.

Channel Numeric Channel used by RightFax.

Duration Numeric Total transmission time (in
seconds).
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Table 5i Audit Log Level 4 Field Descriptions (Continued)

Field name | Type Length | Description

Phone String 127 Fax number dialed.

number

Remote ID String 47 CSID of recipient fax
machine.

Good pages | Numeric 5 Number of pages
transmitted successfully.

Page count Numeric 5 Total number of pages in
the fax.

Board type Numeric 1 Type of fax board used to
send the fax
0 = Brooktrout

BT call status | Numeric 5 Brooktrout call result
status value.

BT call line Numeric 5 Brooktrout call result line

status status value.

BT fax status | Numeric 5 Brooktrout fax result status
value.

BT fax line Numeric 5 Brooktrout fax result line

status status value..

CDR flags Numeric 4 Hex value of CDR flags
0x0001 = PartialRetry
0x0002 = SchedRemote
0x0004 = SendForRemote
0x0008 = Has_ANI
0x0010 = Had_AOC
0x0020 =
Had_ISDNCauseVal

AOC value 1 | Numeric 9 AOC data value #1 (only

valid if indicated by flags).
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Table 5i Audit Log Level 4 Field Descriptions (Continued)

Field name | Type Length | Description

AOC value 2 | Numeric 9 AOC data value #2 (only
valid if indicated by flags).

AOC value 3 | Numeric 9 AOC data value #3 (only
valid if indicated by flags).

ISDN cause | String 5 ISDN call setup cause

value value (only valid if indicated
by flags).

Sender ID String 21 RightFax user ID of the
sender.

To name String 59 The recipient’s name.

From name String 59 Name of sender
(descriptive name, not the
ID).

Contact String 31 The recipient’s voice

number number.

Company String 59 The recipient’s company

name name.

Billing code 1 | String 15 Billing code 1.

Billing code 2 | String 15 Billing code 2.

Secure CSID | String 21 CSID match code for
secure send operation.

Unique ID String 15 Assigned unique ID for fax
job.

Source String 47 Source server IP address

server or name.

InitialString This is a text message that will be included in the
audit file at the beginning of every page.

This line can contain control codes that can be used to convey
page formatting or other information to the application reading the
file. To add control codes to this string, use the following notation.

Table 5 InitialString Control Codes

Notation | Example | Represents

\x## \x1b Hexadecimal character values

\### \027 Decimal character values

Ax A ASCII representation of a control character

Close File Between Each Page Closes the log file after each
entry. This allows you to output the log to a network printer.

Allow TTI Line The transmit terminal information (TTI) line is a
line of text that prints at the top of each received fax page. The TTI
line includes the transmitting fax machine, the date and time of the
transmission, the fax page number, and the total page count.
Follow these steps to optionally add your organization’s name to
the TTl line:

1. Open Windows Control Panel and run the RightFax
DocTransport application.

2. Click on each fax channel for each fax board listed in the left
pane.

3. Type the desired company name in the Fax ID box.

4. Repeat these steps on all RightFax servers and Remote
BoardServer computers.

Select this option to place a TTl line at the top of every page of a
fax. The date format in your TTl line is a function of the Windows
international or regional settings as installed on the fax server.
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If this check box is selected, you must also specify how the TTl line
should be placed on the fax page.

e Select Overlay TTI Line to add the TTl line text to add any
existing text or image on the first line of the fax. Note that this can
obscure the TTl information. With Brooktrout fax boards, this
option functions the same as inserting the TTl line.

o Select Replace TTI Line to replace any existing text or image on
the first line of the fax with the TTl line. This erases existing fax
data from the first line but ensures that the overall length of the
fax stays the same.

e Select Insert TTI Line to add a new line to the top of the fax
page for the TTl information. This retains any fax data on the first
line but increases the length of the fax by one line.

Display GMT on the TTI Line Displays the local time relative
to Greenwich Mean Time (GMT). If this option is not selected, the
TTI line will display the local time at the fax's place of origin.

Quick Header Format Specify heading text to include under
the TTl line on outbound faxes. Quick headers must be enabled in
the General tab of the RightFax Server module Configuration
dialog box (see “Enable Quick Headers” on page 22).
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The quick header line can be customized using special macros that
are replaced in the quick header of each fax.

Table 5k Quick header macros

Macro Definition

~1 To-name field (59 characters maximum)

~2 Shortened to-name (23 characters maximum)

~3 To-contact number field (31 characters maximum)

~4 To-company field (59 characters maximum)

~5 Shortened to-company field (23 characters maximum)
~6 Billinfo1 field (15 characters maximum)

~7 Billinfo2 field (15 characters maximum)

~8 Unique ID (15 characters maximum)

Example For example, the setting Please deliver to: ~2 at ~5
might appear in a fax Quick Header as Please deliver to:
Jane Doe at Acme, Inc.

Beeping Tells the computer in which the fax boards are installed
to beep each time a call is placed or received.

Dialing Settings Prefix This field specifies one or more dialing
characters to add at the beginning of every outbound fax number
dialed by the server. The default setting (WW) instructs the fax
boards to automatically detect a dial tone before dialing. For a list
of valid dialing characters, please see page 209, of the
Administrator's Guide.

Dialing Settings Postfix This field specifies one or more
dialing characters to add at the end of every outbound fax number
dialed by the fax server. For a list of valid dialing characters, please
see page 209, of the Administrator’s Guide.

Call Grouping Whenever a fax is placed in the fax queue, Call
Grouping checks the queue for another fax going to the same
number. If another fax to the same number is scheduled, it keeps
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the line open and transmits the second fax, saving the time and
money of redialing and reconnecting a second time. The Call
Grouping feature is only available for use with Brooktrout fax
boards. This option enables the Call Grouping feature for all
Brooktrout SR140 channels.

Maximum Grouping This field specifies the maximum number
of pages (1-256) that the fax server will send to one phone number
before hanging up and sending another set of faxes.

Configuring Brooktrout SR140

After you have added a Brooktrout SR140 Transport, it must be
configured to work with RightFax. To configure SR140, expand
Brooktrout and click SR140 in the Board/Channel list in the left
pane.

Figure 5.9 Brooktrout SR140 Configuration

ﬂ
- Auto Billing Code Settings S . > DID Settings
i Global DocTransport Settings (e e ]t (Lol 'l - 5
: MNumber of digits f ting: |4 'I
Legacy Mumber from the rotary switch on the board. ’7 MMBET af digits far jaufing
[=- Brooktrout
i Global Transport Settings
Advanced Settings F# Set FaxID for all channels: [Fax Server
EE TR1034+P5-E1
E--Ehannel #o I Set Capabilty for all channels: [5o, 'I
;- Channel #1
i Channel #2
i Channel #3 Configure Erooktrout Board
-+ Chanmnel #4
Ch::::l s Configure Brooktrout |
- Channel #6
i Channel #7

S0OL Cannection
’VIDSN=R|ghtFax,'LIID=sa;PWD=4?C2E65AZSBDSEBED442F43D; J ‘

Dielete Device I Add Transpart | Select Service Account.. I oK I Cancel |

Board Model Specify the nationality type of fax board installed.
This may or may not be the country in which you reside.

Set Fax ID for All Channels You can specify a fax ID for all
the channels on this fax board. The fax ID is transmitted by each
channel on this fax board to remote fax machines. Usually, this is
set to your company name or general fax number. To specify a
unique fax ID for each channel, see “Configuring Brooktrout
SR140 channels” on page 66.

Set Capability for All Channels Sets the same capability
(dial-only, answer-only, or both) for all the channels on the fax
board. To specify the capability of each channel separately, see
“Configuring Brooktrout SR140 channels” on page 66.

Configure Brooktrout Opens the Brooktrout Configuration
Tool for configuring Brooktrout-related settings. For more
information about the settings within the Brooktrout Configuration
Tool, see Brooktrout documentation.

Opening the Brooktrout Configuration Tool

After you have configured DocTransport, you must configure
Brooktrout-related settings using the Brooktrout Configuration
Tool provided by Brooktrout. For more information about the
settings within the Brooktrout Configuration Tool, see Brooktrout
documentation. Follow these steps to open the Brooktrout
Configuration Tool:

1. In the DocTransport Configuration program, click your SR140
transport.

2. Click the Configure Brooktrout button located on the right side
of the DocTransport configuration program. The Brooktrout
Configuration Tool opens.

Note The Brooktrout Configuration Tool can also be opened from the

Windows Programs list (Start > Programs > Brooktrout Configuration
Tool.
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Configuring Brooktrout SR140 channels

Each SR140 fax channel can be individually configured. To
configure a channel, click the channel number in the
Board/Channel list.

Figure 5.10 Brooktrout SR140 Channel Configuration
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Activate Channel Activates this channel for use by RightFax. To
deactivate the channel, click to clear this check box.

Fax ID Specify the fax ID for this channel only. The fax ID is
transmitted to remote fax machines to identify the sender. Usually,
this is set to your company name or general fax number. This box
will not be available if you selected the Set Fax ID for all Channels
check box when configuring SR140 (see “Configuring Brooktrout
SR140" on page 65).

Capability Sets the capability (dial-only, answer-only, or both) for
this channel.

Max. Pages This Channel May Send Sets the maximum
number of pages per fax that can be sent by this channel, from O to
999 (up to 1000 pages per fax). This lets you reserve channels for
smaller faxes.
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Channel Extension Assigns a routing code to all incoming
faxes on this channel if no routing information is specified. Because
DID, T1 with DNIS, and ISDN telephone lines require routing
codes, this setting only applies to loop-start lines and T1 lines
without DNIS. The Channel Extension is also used when DTMF
routing is enabled on the line but the caller does not enter a routing
code.

Configure Brooktrout Opens the Brooktrout Configuration
Tool for configuring Brooktrout-related board settings. For more
information about the settings within the Brooktrout Configuration
Tool, see Brooktrout documentation.

Timed ability This feature changes the capability (send-only,
answer-only, or both) of the fax channel at defined times. For
example, you can set a channel to answer-only during business
hours, and then switch it to both dial and answer after hours so it
can be used for broadcast faxing in the evening.

You can define up to three time periods. Times are indicated in 24
hour military time (“0000” represents midnight, “1200" represents
noon, and “1730" represents 5:30 p.m.).

Start Specify the beginning of the time period. The first time
period always has its Start time set to “0000” (midnight).

End Specify the end of the time period. You must always specify
the end time of the last time period as “2359".

Capability Sets the capability (dial-only, answer-only, or both) for
this time period.

Configuring the RightFax BoardServer

The RightFax BoardServer module must be configured if you will
be using any Brooktrout TR114-series fax boards or Intel Dialogic
fax boards.

In the DocTransport Configuration dialog box, expand the Legacy
option and select RightFax Boardserver. Click the Configure
Boardserver button. The Board Configuration opens.

66



Adding one or more fax boards

You must specify all of the fax boards that are installed in this
computer.

To add a Brooktrout fax board, click the Add Brooktrout button.
This opens a list of all supported Brooktrout boards. Click the
board type to add and click Select. The new board will be added to
the list of boards in the left pane. If you have more than one
Brooktrout fax board installed, repeat for each board. If you select a
digital fax board that requires additional digital configuration, you
will be prompted to run the RightFax Digital Configuration Wizard.
To run the Digital Configuration Wizard, click Next. For a
description of each option in the Digital Configuration Wizard, click
the [?] button in the top-right corner and then click on the option to
define.

Each fax board you add will appear in the list in the left pane of the
Board Configuration dialog box. After you have added all of your
fax boards to this list, you must configure global board settings
(which apply to all installed fax boards), individual board settings,
and settings for each individual fax channel (the phone lines that
come in and out of the boards).

Configuring BoardServer Global Board Settings

Global board settings in the BoardServer module are global
settings that apply to all of the fax boards and channels configured
in the BoardServer module. RightFax will use these settings

regardless of the fax board or fax channel in use. To configure
global fax board settings, select Global Board Settings in the left
pane. The rest of this section describes the options on this screen.

Figure 5.11 The BoardServer Global Board Settings configuration
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CD Timeout Specify the length of time, in seconds, that the
RightFax server will wait for a fax answer tone (CED tone) from a
remote fax machine when sending a fax.

Event LogLevel Specify the level of information logged in the
Application Event Log under the service name “RightFax
BoardServer Module” You can select the following options:

e None. No information is saved.

e Terse. Records critical errors only.

e Normal. Records errors and major events only.

e Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution |If you leave this value set to “Verbose” for long periods of time,

the Event Log can become full which may prevent new events from being
logged.

Chapter 5 Configuring the DocTransport and BoardServer Modules

67



ANI Pattern Match Specify the pattern of the dialing party
information string that will be received during incoming calls.

RightFax collects information about the dialing party’s phone
number for display in FaxUtil and for CSID routing (if used).
However, some organizations receive additional information (such
as ANI or DNIS) along with the caller's phone number. This box
specifies the pattern of the extra data so that it can be removed
prior to display or routing.

The ANI matching pattern is defined using these symbols.

Table 51 ANI Pattern Matching Symbols

Symbol Definition

* Matches one or more “star” characters in the source
string.

# Matches one or more “pound” characters in the
source string.

X Matches one or more digits belonging to the ANI
number.

Y Matches one or more digits belonging to the DNIS
number.

4 Matches one or more digits which are discarded.

0-9 Valid phone digits (literal digits). Separate literal digits

A-D from max-modifiers with a space.
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A digit can be added after any of these symbols to specify the

exact number of characters to expect.

Example For example, the “2" in the pattern x2*y indicates that the
pattern will contain a maximum of two ANI digits at the
beginning of the string.

Here are some examples of ANI Pattern Match settings
and the strings they match:

Setting Matches

1x10%y 1 X000 > .Y VY.
x2z*y2 9 XXz2zZ..X**...yy9

x#1z XXX...#22Z...

Allow Auditing Tells the DocTransport module to record a log
of all incoming and outgoing faxes.

File Specify the path and file name of the log file to use. If the file
does not exist, RightFax will create it when it logs the first entry. To
output the log file directly to a network printer, enter the printer port
instead of a file name. If you output to a network printer, you must
also select the Close File Between Each Page check box.

Level Specify the level of information to include in the log. There
are four levels of detail. Level 1 prints a single line summary of each
fax event, Level 2 prints a detailed description of each fax event,
Level 3 outputs a comma-delimited file, and Level 4 outputs a
tab-delimited file.
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If you set Level to “3," each fax event will be saved to a
comma-delimited file. Each log entry appears on a separate line
and includes 15 data fields. The following table lists all of the fields
for each log entry in the order the fields appear.

Table 5m Audit Log Level 3 Field Descriptions

Field

name Type/format | Length | Description

Direction | String 1 Sent/received flag (“S” or
“R”)

Date sent | MM/DD/YYYY | 10 Date that the call was
initiated

Time sent | HH:MM 5 Time that the call was
initiated

Channel | Numeric 2 Channel used by RightFax
(0-32)

Duration Numeric 5 Total transmission time in

seconds

Phone Alphanumeric | 31 Sent faxes: Fax number
number dialed

Received faxes: Routing
code (DID or DTMF) used

Remote String 49 Remote fax machine ID

ID

Result String 59 Result of the fax
transmission

Page String 79 Number of pages

count transmitted

Contact | String 31 Sent faxes only: The

number recipient’s voice number

Contact | String 59 Sent faxes only: The

name recipient’s name.

Table 5m Audit Log Level 3 Field Descriptions (Continued)

Field

name Type/format | Length  Description

Company | String 59 Sent faxes only: The

name recipient’s company name

User ID String 21 Sent faxes only: RightFax
user ID of the sender

Billing String 15 Sent faxes only: Billing code

code 1 1

Billing String 15 Sent faxes only: Billing code

code 2 2

If you set Level to “4," a new file is created each hour containing
that hour's fax events. Because a separate file is created for each
hour's fax events, do not specify a file name in the File box. You can
optionally specify a path to a folder where the log files, which are
given default names, will be saved.

Each log entry appears on a separate line and includes 28 data
fields. The following table lists all of the fields for each log entry in
the order the fields appear.

Table 5n Audit Log Level 4 Field Descriptions

Field name | Type Length | Description

Direction String 1 Sent/received flag (“S” or
“R”).

Date sent YYYYMMDD | 8 Date that the call was
initiated.

Time sent HHMM 4 Time that the call was
initiated.

Channel Numeric Channel used by RightFax.

Duration Numeric Total transmission time (in

seconds).
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Table 5n Audit Log Level 4 Field Descriptions (Continued)

Field name |Type Length | Description

Phone String 127 Fax number dialed.

number

Remote ID String 47 CSID of recipient fax
machine.

Good pages | Numeric 5 Number of pages
transmitted successfully.

Page count Numeric 5 Total number of pages in
the fax.

Board type Numeric 1 Type of fax board used to
send the fax
0 = Brooktrout

BT call status | Numeric 5 Brooktrout call result
status value.

BT call line Numeric 5 Brooktrout call result line

status status value.

BT fax status | Numeric 5 Brooktrout fax result status
value.

BT fax line Numeric 5 Brooktrout fax result line

status status value.

CDR flags Numeric 4 Hex value of CDR flags
0x0001 = PartialRetry
0x0002 = SchedRemote
0x0004 = SendForRemote
0x0008 = Has_ANI
0x0010 = Had_AOC
0x0020 =
Had_ISDNCauseVal

AOC value 1 | Numeric 9 AOC data value #1 (only

valid if indicated by flags).
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Table 5n Audit Log Level 4 Field Descriptions (Continued)

Field name | Type Length | Description

AOC value 2 | Numeric 9 AOC data value #2 (only
valid if indicated by flags).

AOC value 3 | Numeric 9 AOC data value #3 (only
valid if indicated by flags).

ISDN cause | String 5 ISDN call setup cause

value value (only valid if indicated
by flags).

Sender ID String 21 RightFax user ID of the
sender.

To name String 59 The recipient’s name.

From name String 59 Name of sender
(descriptive name, not the
ID).

Contact String 31 The recipient’s voice

number number.

Company String 59 The recipient’'s company

name name.

Billing code 1 | String 15 Billing code 1.

Billing code 2 | String 15 Billing code 2.

Secure CSID | String 21 CSID match code for
secure send operation.

Unique ID String 15 Assigned unique ID for fax
job.

Source String 47 Source server IP address

server or name.

InitialString This is a text message that will be included in the

audit file at the beginning of every page.
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This line can contain control codes that can be used to convey
page formatting or other information to the application reading the
file. To add control codes to this string, use the following notation.

Table 50 InitialString Control Codes

Notation | Example | Represents

\x## \x1b Hexadecimal character values

\### \027 Decimal character values

Ax A ASCII representation of a control character

Close File Between Each Page Closes the log file after each
entry. This allows you to output the log to a network printer.

Allow TTI Line The transmit terminal information (TTI) line is a
line of text that prints at the top of each received fax page. The TTI
line includes the transmitting fax machine, the date and time of the
transmission, the fax page number, and the total page count.
Follow these steps to optionally add your organization's name to
the TTl line:

1. Open Windows Control Panel and run the RightFax
DocTransport application.

2. Click on each fax channel for each fax board listed in the left
pane.

3. Type the desired company name in the Fax ID box.

4. Repeat these steps on all RightFax servers and Remote
BoardServer computers.

Select this option to place a TTl line at the top of every page of a
fax. The date format in your TTl line is a function of the Windows
international or regional settings as installed on the fax server.

If this check box is selected, you must also specify how the TTl line
should be placed on the fax page.

e Select Overlay TTI Line to add the TTl line text to add any
existing text or image on the first line of the fax. Note that this can
obscure the TTl information. With Brooktrout fax boards, this
option functions the same as inserting the TTl line.

e Select Replace TTI Line to replace any existing text or image on
the first line of the fax with the TTI line. This erases existing fax
data from the first line but ensures that the overall length of the
fax stays the same.

e Select Insert TTI Line to add a new line to the top of the fax
page for the TTl information. This retains any fax data on the first
line but increases the length of the fax by one line.

Display GMT on the TTI Line Displays the local time relative
to Greenwich Mean Time (GMT). If this option is not selected, the
TTl line will display the local time at the fax's place of origin.

Quick Header Format Specify heading text to include under
the TTI line on outbound faxes. Quick headers must be enabled in
the General tab of the RightFax Server module Configuration
dialog box (see “Enable Quick Headers” on page 22).

Note Intel Dialogic fax boards do not support the quick header feature.
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The quick header line can be customized using special macros that
are replaced in the quick header of each fax.

Table 5p Quick header macros

Macro Definition

~1 To-name field (59 characters maximum)

~2 Shortened to-name (23 characters maximum)

~3 To-contact number field (31 characters maximum)

~4 To-company field (59 characters maximum)

~5 Shortened to-company field (23 characters maximum)
~6 Billinfo1 field (15 characters maximum)

~7 Billinfo2 field (15 characters maximum)

~8 Unique ID (15 characters maximum)

Example For example, the setting Please deliver to: ~2 at ~5
might appear in a fax Quick Header as Please deliver to:
Jane Doe at Acme, Inc.

Simulation Disables any currently configured fax channels but
allows simulated fax sending. Outgoing faxes will appear to send
but will not. Simulation mode can be used with no fax boards
installed.

Secure RPC Enabled Encrypts the data exchanged between
multiple RightFax BoardServer modules or between a RightFax
BoardServer module and the FaxStat program. Any BoardServer
service on any other RightFax server communicating with this
server must be started using a valid account and password rather
than a local system account.

If you select this option, you must specify a user account that the
BoardServer service can use for authentication to and from other
BoardServer modules on the network. To specify a user account,
click the [...] button to the right of this option and enter a login
name and password.
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Beeping Tells the computer in which the fax boards are installed
to beep each time a call is placed or received.

Disable Loop Current Detection Disables the fax
transmission error correction feature of Brooktrout fax boards.
Select this check box if error correction is causing excessive fax
transmission failures.

Call Grouping Whenever a fax is placed in the fax queue, Call
Grouping checks the queue for another fax going to the same
number. If another fax to the same number is scheduled, it keeps
the line open and transmits the second fax, saving the time and
money of redialing and reconnecting a second time. The Call
Grouping feature is only available for use with Brooktrout fax
boards. This option enables the Call Grouping feature for all
Brooktrout1034 and Trufax-series fax boards.

Maximum Grouping This field specifies the maximum number
of pages (1-256) that the fax server will send to one phone number
before hanging up and sending another set of faxes.
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Configuring analog Brooktrout fax boards

After you have added a new Brooktrout fax board, it must be
configured to work with RightFax. To configure the board, click the
board name in the Board/Channel list in the left pane.

Figure 5.12 Brooktrout Board Configuration
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Base 1/0 Address The I/0O address of the first channel on the
board. This value must match the physical I/O address set on the
fax board. For information on setting the 1/O address on your fax
board, refer to the documentation included with the board.

Interrupt The interrupt setting used for all Brooktrout fax boards
in the computer. Make sure the selected interrupt does not conflict
with other hardware in the system.

Board Model Specify the nationality type of fax board installed.
This may or may not be the country in which you reside.

Disable Loop Current Detection Disables the fax
transmission error correction feature of Brooktrout fax boards.
Select this check box if error correction is causing excessive fax
transmission failures.

Set Fax ID for All Channels You can specify a fax ID for all
the channels on this fax board. The fax ID is transmitted by each
channel on this fax board to remote fax machines. Usually, this is
set to your company name or general fax number. To specify a
unigue fax ID for each channel, see “Configuring Brooktrout fax
channels” on page 74.

Set Capability for All Channels Sets the same capability
(dial-only, answer-only, or both) for all the channels on the fax
board. To specify the capability of each channel separately, see
“Configuring Brooktrout fax channels” on page 74.

DID settings Direct Inward Dial (DID) is a phone line service
that allows inbound fax routing based on the phone number that
was used to dial in to your fax server. The fax board reads a set
number of digits from the phone line and compares these digits to
each RightFax user's routing code. If a match is made, the fax can
be successfully routed.

These settings will only affect DID-capable fax boards.

Number of Digits to Collect Specify the number of digits
being sent to you by the phone company during incoming calls.
This value is fixed and maintained by your phone company when
your DID service is installed. If you are not sure how many digits are
being forwarded, contact your telephone service provider.

Number of Digits for Routing Specify the number of
received digits to use for DID routing. This is the number of digits in
each RightFax user's routing code. This value can be equal to, but
not greater than, the Number of Digits to Collect setting.

DID Service Type Specify the type of DID service (WINK or

IMMEDIATE). This setting is determined by the phone company
when your DID service is installed. If you are not sure how to set
this option, contact your telephone service provider.
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Configuring digital Brooktrout fax boards

After you have set up digital fax boards in the BoardServer
configuration program, you must configure the RightFax server to
recognize your network interface cards. When you add a digital
Brooktrout fax board in the BoardServer configuration program, a
new option, “Digital Configuration,” appears at the top of the tree in
the left pane. Click this option to run the digital configuration
wizard. Complete each entry in the wizard for your network
interface card.

For a description of any option in the wizard, click the [?1icon in the
top right corner of the dialog box, and then click the box you want
help with. Options that are unavailable either do not apply to the
board type or settings you have selected, or those settings are not
optional.

Configuring Brooktrout fax channels

Each fax channel on a Brooktrout fax board can be individually
configured. To configure a channel, click the channel number in the
Board/Channel list.

Figure 5.13 Brooktrout Channel Configuration Dialog Box
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Activate Channel Activates this channel for use by RightFax. To
deactivate the channel, click to clear this check box.

Enable ECM Enables CCITT error correction mode when
sending faxes. Error correction can improve fax quality on a noisy
phone line but can also increase the time it takes to send faxes.

Fax ID Specify the fax ID for this channel only. The fax ID is
transmitted to remote fax machines to identify the sender. Usually,
this is set to your company name or general fax number. This box
will not be available if you selected the Set Fax ID for all Channels
check box when configuring the Brooktrout board (see
“Configuring analog Brooktrout fax boards” on page 73).

Capability Sets the capability (dial-only, answer-only, or both) for
this channel. This box will not be available if you selected the Set
Capability for all Channels check box when configuring the
Brooktrout board (see “Configuring analog Brooktrout fax boards”
on page 73).

Max. Pages This Channel May Send Sets the maximum
number of pages per fax that can be sent by this channel, from 0 to
999 (up to 1000 pages per fax). This lets you reserve channels for
smaller faxes.

Channel Extension Assigns a routing code to all incoming
faxes on this channel if no routing information is specified. Because
DID, T1 with DNIS, and ISDN telephone lines require routing
codes, this setting only applies to loop-start lines and T1 lines
without DNIS. The Channel Extension is also used when DTMF
routing is enabled on the line but the caller does not enter a routing
code.

Timed ability This feature changes the capability (send-only,
answer-only, or both) of the fax channel at defined times. For
example, you can set a channel to answer-only during business
hours, and then switch it to both dial and answer after hours so it
can be used for broadcast faxing in the evening.
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You can define up to three time periods. Times are indicated in 24
hour military time (“0000” represents midnight, “1200” represents
noon, and “1730" represents 5:30 p.m.).

Start Specify the beginning of the time period. The first time
period always has its Start time set to “0000” (midnight).

End Specify the end of the time period. You must always specify
the end time of the last time period as “2359"

Capability Sets the capability (dial-only, answer-only, or both) for
this time period.

Inbound routing These settings all apply if you will be using
DTMF routing. DTMF routing is a method for routing faxes directly
to an individual based on the routing code entered manually by the
caller.

Enable DTMF Routing Enables DTMF inbound routing for this
channel.

Initial Tone Prompts callers to enter a routing code for the fax by
playing a tone. When this option is selected, you must also select
the tone to play and the duration of the tone in seconds. For
information on the available tones, refer to your Brooktrout
documentation.

Initial Speech Prompts callers to enter a routing code for the
fax by playing a voice prompt. This requires a special voice module
license for your Brooktrout board.

When this option is selected, you must also specify the file of the
voice prompt. The default file, Prompt.ipk is located in the
RightFax\DocTransport\Brooktrout folder. This prompt file can be
played or re-recorded via telephone.

To play the voice prompt for review, go to a command prompt on
the server and enter this command:

\rfboard\voice -p -c PhoneNum -u0 prompt.ipk

where PhoneNum is the phone number the Brooktrout board will
dial to play back the prompt.

The board will dial the phone number you specified. When you
answer the phone, it will play the message. Hang up when the
playback is complete.

To record a new voice prompt

1. Save a backup copy of the old Prompt.ipk file.
2. From a command prompt on the server, enter this command:
\rfboard\voice -r -c PhoneNum -u0 prompt.ipk

where phonenum is the phone number the Brooktrout board will
dial to initiate the recording.

3. The board will dial the phone number you specified. When you
answer the phone, it will begin recording your message. Press
the [#] key (pound key) when you are done.

Failure Specify the file to play when a caller does not enter
enough DTMF digits to route the fax. The default file, Baddigit.ipk is
located in the RightFax\DocTransport\Brooktrout folder. This
prompt file can be played or re-recorded via telephone. For
information on playing and recording voice prompts, see “Initial
Speech” on page 75.

Confirmation Specify the file to play when a caller has correctly
entered DTMF digits for routing. The default file, Gotdigit.ipk is
located in the RightFax\DocTransport\Brooktrout folder. This
prompt file can be played or re-recorded via telephone. For
information on playing and recording voice prompts see “Initial
Speech” on page 75.

No Terminator Tells RightFax to accept the DTMF code entered
by the caller as soon as the correct number of digits have been
entered. No additional terminator key needs to be pressed.

Terminator Specify the key (on the phone) that the caller must
press when finished entering DTMF digits. This is necessary when
the Max. Digits and Min. Digits are not set to the same value.
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Because in this case the routing code can be a variable number of
digits, the caller must provide some indication of when he has
finished entering DTMF digits.

Max. Digits Specify the maximum number of DTMF digits that
can be entered by the caller.

Min. Digits Specify the minimum number of DTMF digits that
can be entered by the caller.

Tone Wait Specify the length of time in seconds to wait after the
prompt is played for the caller to enter a routing code. If you have
specified a terminator key (described previously), the caller must
enter the code and the terminator in this length of time.

Configuring the Human Answered Fax feature in the
advanced settings

The Advanced Settings on the BoardServer configuration dialog
box apply to the Docs-on-Demand and TeleConnect optional
modules and to the Human Answered Fax feature. Refer to the
RightFax Docs-on-Demand Guide or Chapter 29, “Using
TeleConnect to Access Faxes by Phone” for installation and
configuration instructions for these products.

The Human Answered Fax feature detects when an outbound fax
call is answered by a person, rather than a fax machine, and then
provides an automated voice message informing the recipient that
a fax is being sent. The recipient is then offered one or more
options for receiving the fax.

Because it uses digital voice prompts, the Human Answered Fax
feature requires that you have installed at least one Brooktrout fax
board with licensed voice capability. For information on
voice-compatible Brooktrout fax boards, refer to your fax board
documentation or contact your Brooktrout fax board distributor.
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The Human Answered Fax feature uses voice files located in the
RFBoard\Voices\Dir folder on the RightFax server. Voice files are
saved as Dialogic OKI32 files (.vox files). These files can be played
or modified using any sound editor that supports the Dialogic
OKI32 file format.

To enable and configure the Human Answered Fax feature, expand
Advanced Settings, and then click Human Answered Fax in the
list in the left pane.

Cancelling a Human Answered Fax

To cancel a fax call that has been answered by a human you must
set the Human Ansered Fax > Voice Mode option to Voice Menu
and edit the Windows Registry as shown below.

For TR-114 faxboards.

1. Navigate to HKEY_LOCAL_MACHINE\Software\RightFax\
BoardServer.

2. Create a new DWORD value and name it
HAFCancellfNoResponse.

3. Set this value to 1 and exit the Windows Registry.
For TR-1034 faxboards.

1. Navigate to HKEY_LOCAL_MACHINE\Software\RightFax\
DocTransport\Transports\Brooktrout\HAF.

2. Create a new DWORD value and name it
HAFCancellfNoResponse.

3. Set this value to 1 and exit the Windows Registry.
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Figure 5.14 The Human Answered Fax Configuration dialog box

 Auto Billing Code Settings
EI Advanced Settings ¥ Enable Human Answered Fax
: Docs on Demand — Caling Mode
TeleConnect
-~ Human Answered Fax
. Global Board Settings

& Switch to Woice Mode if a Human is detected on a Fax Call
" Callback in Yoice Mode if a Human is detected on a Fax Cal

= Alwaps start each Fax Callin Woice Mode

—Woice Mode
* Yaice Prompt Only

[¥ Detailed VYaice Prompts
" Woice Menu P

Delete Bazrd | Add Brooktrout Board | Detect Gammalink Bosrd | Ok I Cancel |

Enable Human Answered Fax Enables the Human Answered
Fax feature.

Calling Mode Select one of the following options:

o Switch to Voice Mode if a Human is detected on a Fax Call.
This option causes the RightFax server to switch from fax
transmission mode to voice mode as soon as a human voice is
detected. If a fax machine is detected, the fax will be sent.

« Call back in Voice Mode if a Human is detected on a Fax Call.
This option causes the RightFax server to hang up when a human
voice is detected and immediately call back in voice mode. If a fax
machine is detected on either call, the fax will be sent.

o Always start each Fax Call in Voice Mode. This option causes
the RightFax server to initiate all outbound fax calls in voice
mode. If you select this option, you should also select Voice
Prompt Only under Voice Mode. This is because if a fax
machine picks up the call, RightFax will always send the fax after
a short delay, whereas if you select the Voice Menu option,
RightFax will wait indefinitely for a response from the call
recipient, and the fax will never be sent.

Voice Mode Select one of the following options:

 Voice Prompt Only. This option plays a voice prompt to the call
recipient and then waits for a fax tone before transmitting. The
voice prompt is a message informing the call recipient that this is
an incoming fax. The voice prompt used by the RightFax server
can be either simple or detailed.

¢ Voice Menu. This option plays a voice prompt followed by a
menu of options for the call recipient. The voice prompt used by
the RightFax server can be either simple or detailed.

If the voice menu is enabled, the call recipient will first hear either
the simple or detailed voice prompt (depending on which you have
enabled). The prompt will be followed by the file
HAF_MainMenu.vox, which says “To receive this fax press 1 or stay
on the line. To Cancel this fax press 9

e If the call recipient presses 1, the file HAF_PressStart.vox plays
saying “Please Press Start on your Fax machine To Receive your
Documents” and the fax server will attempt to send the fax.

e If the call recipient presses 9, the file HAF_Cancelled.vox plays
saying “This Fax Has Been Cancelled. We apologize for any
Inconvenience” and the fax will not be sent.

o If the caller does not press 1 or 9 within 10 seconds, the menu
will automatically play the file HAF_PressStart.vox prompting the
call recipient to start the fax machine, then the fax server will
attempt to send the fax.

Detailed Voice Prompts The Human Answered Fax feature
provides two types of voice prompt: a simple voice prompt and a
detailed voice prompt.

The simple voice prompt plays the file HAF_ThisisaFax.vox which
says “This is a fax,’ followed by HAF_PressStart.vox which says
“Please press start on your fax machine to receive your
documents”

The detailed voice prompt combines several separate voice files to
create a unique message that says “This is an n page fax” If you
select the Detailed Voice Prompts option in the Human
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Answered Fax tab of the Board Configuration dialog box
(described on page 77), the RightFax server will use the detailed
voice prompt.

The detailed voice prompt always includes the number of pages in
the fax and uses the appropriate a/an article to match the number
of pages. The detailed voice prompt can include “...from [company
name]" at the end of the prompt if a file called HAF_Source.vox is
located in the \Voices folder. This file is not provided with the
RightFax server software, so you must create this file if you want
your organization name identified as the source of the fax. The
detailed voice prompt then plays HAF_PressStart.vox which says
“Please press start on your fax machine to receive your
documents’

Translating the voice files

If you will be using the Human Answered Fax feature with a
language other than English, follow these guidelines when
configuring Human Answered Fax (described on page 76):

¢ Record a new translated version of the file HAF_ThisisaFax.vox
that will inform the call recipient that a fax transmission is being
attempted.

¢ Select Voice Prompt Only under Voice Mode.
¢ Do not select the option Detailed Voice Prompts.

Note Captaris recommends using the simple voice prompt without the
menu when translating the Human Answered Fax voice files to
languages other than English. Because both the menu and the detailed
voice prompt are generated by playing several separate voice files in
sequence, simply translating the individual files may result in improper
syntax. For descriptions of all of the voice files in the RFBoard\Voices\Dir
folder on the RightFax server, refer to the TeleConnect User's Guide.
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Adding data to the ISDN string

You can add data to the calling party number field of the ISDN
string for each fax sent from the RightFax server. This data can be
captured by some PBX systems for billing purposes. Before
implementing this feature, verify that the PBX system can accept
the data. If it does not, the PBX will reject the call.

To enable this feature, edit the Windows registry. Navigate to the
subkey
HKEY_LOCAL_MACHINE\Software\RightFax\DocTransport\Tran
sports\Brooktrout. Add the REG_DWORD registry value
UselSDNCallingParty.

If using a Brooktrout TR-114 board:

Navigate to the subkey
HKEY_LOCAL_MACHINE\Software\RightFax\BoardServer. Add
the REG_DWORD registry value UselSDNCallingParty.

The data options for the string are described in the following table.

Table 5q ISDN Data String Options

Data Value

—_

Fax number dialed.

RightFax user ID of the sender.

The recipient’s voice number.

The recipient’s name.

The recipient’'s company name.

Billing code 1.

Billing code 2.

Assigned unique ID for fax job.

©| 00 N oo o~ WOWN

CSID match code for secure send operation.

—_
o

Name of the sender.

—_
—_

Source server IP address or name.
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Defining an RTI line

The RTI (Receipt Terminal Information) line is a line of text that can
be printed at the bottom of each received fax page. The RTl line
includes information about the fax that supplements the TTl line
such as the total number of pages received, the name of the fax
server that received the fax, and the sender’s caller ID. You can
enable or disable the RTl line, specify the information you want it to
include, specify the font size, and specify where on the fax page to
print the line.

To enable this feature, edit the registry. Navigate to the subkey
HKEY_LOCAL_MACHINE \Software\RightFax\FaxServer and add
the registry values described in the following table.

After adding the registry values, stop and start the RightFax server
for the settings to take effect.

Table 5r RTI Line Registry Entries
Entry Data type | Values Description
ReceiveStamp | REG_ Any decimal Font size for the RTl line
FontSize DWORD | number (default text.
14)
ReceiveStamp | REG_SZ | Text and variables | The text to print. This

Format

can include one or more
variables from “Table
5s: ReceiveStampForm
at Variables” on

page 79.

(see “Table

5s: ReceiveStamp
Format Variables”
on page 79.)

Table 5r RTI Line Registry Entries

Entry Data type | Values Description
ReceiveStamp |REG_SZ | TOP Location on page to
Location BOTTOM (default) | print the RTI line.
LEFT
RIGHT
StampReceived | REG_ 0 = off Enable or disable the

Pages

DWORD RTI line.

The value for this entry
must be 1 to enable the
RTI line.

1 = on(default)

The following table lists the variables that can be included in your
RTI line text.

Table 5s ReceiveStampFormat Variables

Variable | Definition

~1 The current page number.

~2 The total number of fax pages received.

~3 The date and time that the fax was received (as reported by the
fax server).

~4 The name of the fax server that received the fax (up to 30
characters).

~5 The number of the fax channel that received the fax.

~6 The fax recipient’s DID number.

~7 The fax sender’s caller subscriber ID (CSID).

~8 Duration of the fax transmission in minutes and seconds.

~9 The fax recipient’s RightFax user ID (if applicable).

~0 The fax recipient’s RightFax user name (if applicable).

~A The unique ID assigned to the fax by the fax server.
This variable is case-sensitive.
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Table 5s ReceiveStampFormat Variables (Continued)

Variable | Definition

~B The current date formatted as a two-digit year followed by three
digits for the absolute day of the year. For example, “00001"
means January 1, 2000.

This variable is case-sensitive.

~C The total page count on the fax server. The number is reset each
day at midnight and then increments by one for each received
fax page.

This variable is case-sensitive.

Example The following value entered for the
ReceiveStampFormat entry ...

Page ~1 of ~2 received on ~3 on server ~4.
... might print as:

Page 4 of 4 received on 02-01-01 12:11:59 [US
Mountain Standard Time] on server RIGHTFAX.

Troubleshooting the BoardServer module

To help track errors, all RightFax server modules can be configured
to record a detailed log of program information in the Application
EventLog. When a problem occurs, this should be your first source
of information. Each entry will be attributed to the RightFax Server
module, RightFax Database module, RightFax BoardServer
module, or RightFax WorkServer module.
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Error 2140 when starting the BoardServer service with
Brooktrout fax boards

1. Confirm that the base 1/0 address and the interrupt in the
Board section of the BoardServer configuration program match
the physical settings on the board.

2. If the address and interrupt are configured correctly, confirm
that there are no other system conflicts with those addresses.

Note The RightFax BoardServer module must be stopped for this
test to work.

From a command line on the RightFax server, change to the
RightFaxX\RFBoard folder and enter this command:

type faxinit.cfg

A line appears for each fax channel listing the channel's
address. If the addresses do not match the ones you have
entered in the BoardServer configuration program, edit the text
file and fix them. After this is done, enter this command at the
RightFax\RFBoard prompt:

faxinit faxinit.cfg

If the addresses are not successfully found, then they are
probably conflicting with something else on your system.

3. If all of the addresses are found and you are still getting a 2140
error when starting the BoardServer module, there is probably
an interrupt conflict. Confirm that the interrupt on the board
matches the interrupt setting in the BoardServer configuration
program. If it does, try another interrupt setting. To do this, first
change the interrupt in the BoardServer configuration, and then
shut down the Windows server, turn off the computer, and
change the interrupt jumper on the fax board to match the
BoardServer configuration. Restart the system and try to restart
the service. Repeat this procedure trying different settings until
the service starts successfully.
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The BoardServer service is set to manual

The BoardServer module is normally configured as an automatic
service. If it encounters problems starting (such as configuration
errors), the BoardServer service sets itself to manual. To reset the
BoardServer service to automatic, fix the cause of the problem, and
then restart the BoardServer module manually. On successful
startup, the BoardServer module will reset itself to automatic.

Configuring Eicon Fax Boards

Eicon fax boards must be added in the DocTransport module and
then configured using the board configuration tool provided by
Eicon. Eicon Diva Server version 7.5 or later must be installed on
the RightFax server or remote BoardServer computer where the
Eicon boards are installed. Each Eicon board that you have added
to DocTransport must be configured separately.

Important DTMF routing with Eicon fax boards is not supported.

After you have specified the installed Eicon fax boards in
DocTransport (described in “Adding transport methods” on
page 48), expand the Eicon option in the list in the left pane and
select an Eicon board in the list. This displays a set of Eicon
configuration options.

Figure 5.15 The Eicon Diva Server Configuration options
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Delete Device | Add Transport |

Configuring Eicon Global Transport Settings

Eicon Global Transport Settings are global settings that apply only
to the Eicon transport methods. To configure Eicon Global
Transport settings, select Global Transport Settings in the left
pane. The rest of this section describes the options on this screen.
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Allow TTI Line The transmit terminal information (TTI) line is a
line of text that prints at the top of each received fax page. The TTI
line includes the transmitting fax machine, the date and time of the
transmission, the fax page number, and the total page count.

Display GMT on the TTI Line Displays the local time relative
to Greenwich Mean Time (GMT). If this option is not selected, the
TTI line will display the local time at the fax's place of origin.

Dialing Settings Prefix This field specifies one or more dialing
characters to add at the beginning of every outbound fax number
dialed by the server. The default setting (WW) instructs the

Configure Eicon Click this button to run the Eicon SoftIP
configuration program if necessary. However, this configuration
should have been completed before enabling the SoftIP channels
in RightFax.

DID settings Direct Inward Dial (DID) is a phone line service
that allows inbound fax routing based on the phone number that
was used to dial in to your fax server. The fax board reads a set
number of digits from the phone line and compares these digits to
each RightFax user's routing code. If a match is made, the fax can
be successfully routed.

These settings will only affect DID-capable fax boards.

Number of Digits for Routing Specify the number of
received digits to use for DID routing. This is the number of digits in
each RightFax user's routing code.

Set Fax ID for all Channels You can specify a fax ID for all the
SoftIP channels you add. The fax ID is transmitted by each channel
to the receiving fax device. Usually, this is set to your company
name or a general fax number.

Number of SoftlP Channels Select the number of SoftlP
channels that you want to enable in RightFax. Eicon SoftlP and
RightFax must both be licensed to support the number of channels
you specify.
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For more information about Eicon fax boards, see Chapter 7 of the
RightFax Fax Board guide located on the RightFax server in the
\RightFax\Doc folder.

Configuring T.37 Fax over IP

T.37 fax over IP is a fax transmission protocol that allows faxes to
be transmitted to T.37-compatible devices over IP, rather than
dedicated fax channels. The fax is packaged as an email message
with a TIFF attachment and then sent over IP via an SMTP server.
This message is automatically interpreted as a fax by the receiving
device, which then prints it.

To send documents using fax over IP, you must create dialing rules
that route the documents based on the fax numbers or email
addresses entered by your RightFax client for outbound faxes. For
information on how to configure a dialing rule to route to a fax over
IP destination, see page 211.

After you have added the T.37 Fax over IP transport method in
DocTransport (described in “Adding transport methods” on

page 48), expand the FolP option in the list in the left pane and
select T.37 Fax over IP. This displays the fax over IP configuration
options.

82



Figure 5.16 The T.37 Fax over IP Configuration options
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SMTP Server Address By default, fax over IP messages will be
sent via the SMTP server that you specified during the RightFax
server installation. If you did not specify an SMTP server name
during installation, enter the name of the SMTP server on your
network that will transmit fax-over-IP messages.

Email Address in the “From” Section of the T.37 fax
message Enter the email address that will be transmitted to the
receiving T.37-compatible device.

Configuring Fax over IP Failover

Fax over IP environments with a multi-router topology may
configure RightFax (via dialing rules) for real-time FolP fail-over.
When the primary FolP router or gateway is unavailable or times
out, faxes are automatically routed to a secondary router or
gateway. FolP fail-over is compatible with both SR140 and T.37
board-based architecture.

To enable FolP fail-over
1. Open the Windows Registry on the RightFax server.

2. Browse to the subkey of
HKLM\Software\RightFax\DocTransport\Transports\Brooktrout.

3. Create a new REG_DWORD entry called
DisableDialingRuleOnTimeout.

4. Edit the value to contain either of the following:
0 = FolP fail-over is not enabled.
1 = Enables FolP fail-over.

5. Close the Windows registry.

6. Log on to Enterprise Fax Manager and click the Dialing Rules
view.

7. Right-click Dialing Rules and click New. The Rule Edit window
opens.

8. In the Pattern field, enter a number that, when dialed, will be
sent via FolP.

9. Click the Number Adjustments tab. Type the @ symbol and
the IP address of your network’s primary FolP router.

For example, @192.168.0.1
10.When finished, click OK.
11.Repeat steps 7-9.
12.Click the Other tab.

13.Find the Extra Rule Weight box and click the up arrow until the
value is greater than 0. When finished, click OK.

14.0pen the Enterprise Fax Manager File menu and click Save
Dialing Plan.

Important When using FolP you must remove the wait for wink (or
WW) setting in the dialing settings, prefix box located in the
DocTransport, Global Transport Settings.
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Configuring Simulation Transports

The Simulation Channels transport is a set of virtual channels that
allow simulated faxing. Outgoing faxes will appear to send but will
not. Simulation mode can be used with no fax boards installed.

Configuring Simulation Global Transport Settings

Simulation Global Transport Settings in the DocTransport module
are global settings that apply to all simulation channels. RightFax
will use these settings regardless of the fax channel in use. To
configure global simulation transport settings, select Global
Transport Settings in the left pane. The rest of this section
describes the options on this screen.

CD Timeout Specify the length of time, in seconds, that the
RightFax server will wait for a fax answer tone (CED tone) from a
remote fax machine when sending a fax.

Beeping Tells the computer in which the fax boards are installed
to beep each time a call is placed or received.

Call Grouping Whenever a fax is placed in the fax queue, Call
Grouping checks the queue for another fax going to the same
number. If another fax to the same number is scheduled, it keeps
the line open and transmits the second fax, saving the time and
money of redialing and reconnecting a second time. The Call
Grouping feature is only available for use with Brooktrout fax
boards. This option enables the Call Grouping feature for all
Brooktrout1034 and Trufax-series fax boards.

Maximum Grouping This field specifies the maximum number
of pages (1-256) that the fax server will send to one phone number
before hanging up and sending another set of faxes.

Dialing Settings Prefix This field specifies one or more dialing
characters to add at the beginning of every outbound fax number
dialed by the server. The default setting (WW) instructs the fax
boards to automatically detect a dial tone before dialing. For a list
of valid dialing characters, please see page 209, of the
Administrator’'s Guide.
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Dialing Settings Postfix This field specifies one or more
dialing characters to add at the end of every outbound fax number
dialed by the fax server. For a list of valid dialing characters, please
see page 209, of the Administrator's Guide.

Configuring Simulation Channels

Set Fax ID for all Channels You can specify a fax ID for all the
channels on this fax board. The fax ID is transmitted by each
channel to the receiving fax machine. Usually, this is set to your
company name or general fax number.

Capability Sets the capability (dial-only, answer-only, or both) for
this channel.

Set Transmission Rate for all Channels You can specify a
simulated baud rate for all simulated fax channels. Simulated baud
rates range from 9600-33600.

Number of Simulation Channels You can specify simulated
fax channels. Simulated channels range from 1-120.

Activate Channel Activates this channel for use by RightFax. To
deactivate the channel, click to clear this check box.

Fax ID Specify the fax ID for this channel only. The fax ID is
transmitted to remote fax machines to identify the sender. Usually,
this is set to your company name or general fax number. This box
will not be available if you selected the Set Fax ID for all Channels
check box in the Simulation Channels configuration.

Capability Sets the capability (dial-only, answer-only, or both) for
this channel. This box will not be available if you selected the Set
Capability for all Channels check box in the Simulation
Channels configuration.

Transmission Rate Sets the simulated baud rate for all
simulated fax channels. Simulated baud rates range from
9600-33600. This box will not be available if you selected the Set
Transmission Rate for all Channels check box in the Simulation
Channels configuration.
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Max. Pages Channel may Send Sets the maximum number
of pages per fax that can be sent by this channel, from 0 to 999 (up
to 1000 pages per fax). This lets you reserve channels for smaller
size faxes only.

Timed ability This feature changes the capability (send-only,
answer-only, or both) of the fax channel at defined times. For
example, you can set a channel to answer-only during business
hours, and then switch it to both dial and answer after hours so it
can be used for broadcast faxing in the evening.

You can define up to three time periods. Times are indicated in 24
hour military time (“0000” represents midnight, “1200" represents
noon, and “1730" represents 5:30 p.m.).

Start Specify the beginning of the time period. The first time
period always has its Start time set to “0000” (midnight).

End Specify the end of the time period. You must always specify
the end time of the last time period as “2359".

Capability Sets the capability (dial-only, answer-only, or both) for
this time period.

Configuring SMS via the Push-Proxy Gateway

Short message service (SMS) is a communication protocol that
lets you send and receive short text messages to and from
SMS-compatible devices such as a cell phone. The RightFax server
can be configured to send fax notifications and alerts to SMS
numbers. RightFax clients can also send and receive SMS
messages. Because SMS is a text-only protocol, sent SMS
messages include only the notes added to the fax cover sheet. You
can also create dialing rules that automatically route outbound
faxes to SMS numbers. SMS functionality requires that you have
installed the RightFax Push-Proxy Gateway on the server running
the DocTransport service.

After you have added the SMS transport method in DocTransport
(described in “Adding transport methods” on page 48), expand the
SMS option in the list in the left pane and select Mobility
Push-Proxy Gateway. This displays the SMS configuration
options.

Figure 5.17 The SMS Configuration options
x|

- Auto Billing Code Settings
Global DocTransport Settings
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= SMS

[EE Mobility Push-Proxy Gateway Configure FPG |
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Delete Device | Add Transport |

Select Service Account... | Ok I Cancel |

Configure PPG Runs the Push-Proxy Gateway configuration
program. For information on completing these configuration
options, refer to the “Text Messaging Using the Push Proxy
Gateway” on page 167.

Number of Digits for Routing When the RightFax server
receives an incoming SMS message, it can route the message to
one or more mailboxes. Each RightFax mailbox (user ID) has a
unique routing code. SMS mailboxes should be configured to use
routing codes based on the phone number that the message was
sent to, typically the last three or four digits of the number. Enter
the number of digits that will be read from the end of the receiving
phone number that will be used for routing SMS messages.
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Running DocTransport on Remote Computers

A

A

Note One RightFax Enterprise server can support a total maximum of
16 separate DocTransport modules.

With the RightFax Enterprise server, you can install and run multiple
DocTransport modules simultaneously on the local and one or
more remote computers. This distributes the workload of the
RightFax server across several computers and provides expanded
channel capacity and system redundancy.

Caution While running DocTransport modules over a WAN is a
supported configuration, it is important that sufficient bandwidth is
available across the network to allow the DocTransport and RightFax
server to communicate efficiently. Insufficient bandwidth when running
remote DocTransport modules across a WAN may result in timeout errors
causing both inbound and outbound documents to fail.

When the RightFax server is configured to run one or more
DocTransport modules remotely, the workload of faxing is divided
between multiple computers. The RightFax server computer can
remain dedicated to database management and WorkServer
operations, while the remote DocTransport computers handle alll
the work relating to sending and receiving faxes.

Because the fax boards can be distributed between several
computers, your ability to expand your system’s fax channel
capacity is virtually unlimited using remote DocTransport modules.

Also, running remote DocTransport modules allows for system
redundancy. If a hardware or phone line failure occurs, fax traffic
can be automatically routed to other available DocTransport
modules quickly and with no interruption of service. In addition,
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remote DocTransport modules let you make the most out of
redundant hardware in clustered server configurations, as in the
following diagram.

Figure 5.18 Remote DocTransport Modules
in a Clustered Environment

Shared RAID
Cluster Cluster
_). (—

CPU #1 CPU #2

. il

BoardServer 1
1-120 ports

BoardServer 2
1- 120 ports

The ability to install multiple DocTransport modules is available in
RightFax Enterprise servers only.

Requirements

Supported Microsoft Windows Operating Systems

RightFax server software is supported on the following server
operating systems.

¢ Windows Server 2003 Standard x86
¢ Windows Server 2003 R2 Standard x86
e Windows Server 2003 Enterprise x86
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Local server requirements

¢ Microsoft .NET Framework 2.0 or later*

¢ Microsoft Data Access Components 2.8*

¢ Microsoft Messaging Queuing*

¢ Microsoft Visual C++ 2005 runtime components*

¢ A Windows account to run RightFax services. The account
you choose must be a domain user that member of the local
administrators group and must have the right to logon as
service on the local computer.

RightFax server requirements

Before installing remote DocTransports, you must share the
\RightFax folder on the RightFax server and grant the DocTransport
service account full-control. This account must also have write
access to the Windows registry on the RightFax server.

To install the DocTransport on a Remote Computer

Important Because they are not located on your RightFax server
computer, remote DocTransport modules cannot prevent you from
exceeding your RightFax channel licenses. You must manage the number
of activated channels across all the DocTransport modules, and do not
attempt to activate more channels than your organization has licensed.
The RightFax Server module service will shut down if the total number of
channels on all DocTransport modules exceeds your total number of
channel licenses.

Caution If you have changed the default DSN for the SQL connection
on the main RightFax server, you must manually change the DSN on the
remote DocTransport computer to match the DSN on the server.

To ensure that your installation goes smoothly and to avoid
unnecessary delays, it is important to perform each step in the
installation completely and correctly before proceeding to the next
step.

1. Insert the RightFax Product Suite DVD. If AutoRun is enabled, a
menu of install options appears. If AutoRun is not enabled,
browse the DVD and run Setup.exe. The RightFax Product
Suite Setup wizard opens.

2. RightFax DocTransports require Microsoft .NET Framework 2.0
or later. If this software is not installed on your system, Setup
will prompt you to install it. To install, click OK. To cancel Setup
and install .NET Framework 2.0 yourself, click Cancel.

3. Review the welcome screen and click Next.
4. Carefully read and accept the license agreement and click Next.

5. Setup can check for RightFax updates and other late-breaking
information. To check for updates, verify you have an active
HTTP connection and click Check for Updates. If updates are
found, follow the instructions in the Result section. To skip the
update check and continue with Setup, check the box next to
Do not check for updates and click Next.

6. Click Custom followed by Next.

7. Select the DocTransport Module Setup component and click
Next. No other Setup components should be chosen.

8. The Preview Requirements step lists third-party software
required by your chosen features and also lists the status of
setup operations. Software that must be installed will have a
status of Must Install. To continue, click Next.

9. To apply your settings and install required third-party software,
click Apply. This may take several minutes. When finished, click
Next.

10.1f your server does not already have Microsoft Message
Queuing installed, Setup will prompt you to install it. Select your
option and click Next.

Chapter 5 Configuring the DocTransport and BoardServer Modules
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11.RightFax requires TCP ports 10520, 10521, 10062, 34987,
and 34988. Setup can reserve these ports for exclusive use by
RightFax. To allow setup to reserve these ports, enable the
Reserve Ports option and click Next. If you do not reserve
these ports, some RightFax services may not start.

12.To apply your settings and install required third-party software,
click Apply. This will take several minutes. When finished, click
Next.

13.Choose your installation folder and click Next.

14.To begin installing RightFax software, click Apply. This may take
several minutes. When finished, click Next.

15.Enter a Windows account to run RightFax services. This must
account be a domain user that member of the local
administrators group and must have the right to logon as
service on the local computer. In addition, this account must
also have full-control over the \RightFax folder on the RightFax
server and have write access to the Windows registry on the
RightFax server. Click Browse to load and select a user
account. Use the Test Account button verify account
credentials. When finished, click Next.

16.Enter your RightFax server name. To verify remote access to the
RightFax server, click Check Access. When finished, click Next.

17. To apply your settings and complete Setup, click Apply
followed by Close.
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Chapter 6
Configuring Server-Side Application Conversion

By default, the RightFax server uses its standard conversion engine
to generate fax images from document file attachments. These are

Understanding Server-Side Application
Conversion

files passed to the RightFax server in their original format (such as
Word, Excel, or PowerPoint) instead of first being converted to
printer output. Document attachments are typically delivered to the
RightFax server via one of the email gateway modules (as mail
message attachments) or via RightFax Web Access.

While the standard RightFax conversion engine has some
advantages (such as being very fast and efficient), there are
occasionally variances between the fax image it generates and the
original document. In most cases these variances are minor and
acceptable. However, if the conversion quality of faxed file
attachments is unacceptably low, your RightFax servers can be
configured so that the applications associated with certain file
formats are launched to allow for direct (and therefore more
accurate) conversion by attachments’ native applications. This is
known as server-side application conversion or SSA.

Note Server-side application conversion is not used for documents that
are printed directly from the native applications to the RightFax

print-to-fax driver. This is because the conversion is handled by the native
application on the client computer before it is sent to the RightFax server.

Where possible, server-side application conversion supports
multiple concurrent document conversions to save processing time
and server resources. Also, blank pages are removed from the fax
image to save on fax costs and channel resources.

Server-side application conversion is available when faxing from:

e Files attached using FaxUtil.

e Windows XP and Windows Vista 32-bit client computers using
the Send To shortcut menu.

e The version of Microsoft Office installed on the RightFax server is
the same or newer than that used by client computers submitting
Office documents.

o File attachments sent via the Exchange, SMTP, and Lotus Notes
email gateways.

e Files attached with the <KADDDOC> embedded codes.
e The RightFax APl and COM API.

Launching an application at the RightFax server each time a file
attachment fax image is generated has some potential drawbacks.
You should weigh these drawbacks against the benefits before
configuring your RightFax server to perform server-side application
conversion.
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Full applications are much larger and more processor-intensive
than the standard RightFax conversion engine. You may need to
upgrade the RightFax server memory or processing capacity to
support server-side application conversion, especially if your
organization generates a lot of faxes with attached files.

Also, most applications are not designed to be run completely
without user intervention. Situations may arise in which an
application stops while it waits for user input (such as waiting for a
password). RightFax makes every attempt to prevent or bypass
such occurrences but cannot guarantee it will prevent all such
occurrences. If one or more faxes being processed through
server-side application conversion fail to send, you should check
that the application on the server is not stalled and waiting for
attention.

Finally, documents containing objects that the server does not have
access to (such as special fonts, links to files on other computers,
macros, or templates) may generate unpredictable results, such as
incorrect fax image output or conversion failure. To minimize this,
install as many TrueType fonts, document templates, macros, and
other components used by your organization to the computer or
computers that provides server-side application conversion.

If server-side application conversion does not succeed in creating
a fax image, RightFax will use its built-in conversion engine to
create the fax.

Description of the Captaris Conversion Engine

The Captaris Conversion Engine is a stand-alone, fault tolerant
service that is used to invoke applications used in server-side
application conversion. It detects when an SSA supported
attachment is passed to the RightFax server and launches the
appropriate application to convert the file.
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The Conversion Engine also supports and can be configured to
use Optical Character Recognition (OCR) technology. OCR
related settings are located under the RecoStar tab. For
information about OCR setup and configuration, see “Using
Optical Character Recognition” on page 233.

Below, are the SSA supported applications used by the Captaris
Conversion Engine:

¢ Microsoft Word, versions 2000 through 2007.

¢ Microsoft Excel, versions 2000 through 2007.

¢ Microsoft PowerPoint, versions 2000 through 2007.

¢ Microsoft Internet Explorer 6 and above.

To enable the RightFax server to perform server-side application
conversion, install the applications on the RightFax server and any
computers running remote WorkServers allocated for SSA (see
“Installing WorkServers on Remote Computers” on page 45).

Installing and Configuring Office Applications

=

On each of your RightFax servers and any other computers where
RightFax WorkServers will be executed (e.g., remote
WorkServers), follow these guidelines to install the Microsoft
Office Word, Excel, and PowerPoint applications (versions 2000
through 2007), for server-side application conversion.

Important If your organization sends Office 2007 documents as
attachments, you must install Office 2007 on the RightFax server or
remote WorkServer performing SSA.

1. If you have already installed Word, Excel, or PowerPoint on the
RightFax server, uninstall those applications using Add/Remove
Programs in Control Panel.

2. If you are installing Office XP, 20083, or 2007 applications, the
security for macros in Office must be set to the lowest setting.
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3. On the RightFax server, insert the Office installation CD and run

Setup.exe. During the installation, select the following options.

Table 6a Installing Office

Installation option

Select this

Destination folder

Default destination

Installation type

Custom installation

Components to install

Excel

Word

PowerPoint

Office Tools
Converters and Filters

Office Tools

Microsoft TrueType fonts

Converters and Filters
Text Converters

Select all of the options except
converters for use with Lotus Notes

Graphics Filters

Select all

Microsoft Excel

Select the Microsoft Excel program files,
spreadsheet converters, and Help

Spreadsheet Converters

Select all

Microsoft Word

Select the Microsoft Word program files,
text converters, and Help

Text Converters

Select all

Microsoft PowerPoint

Select the Microsoft PowerPoint
program files, presentation translators,
and Help

4. When the installation is complete, restart Windows.

5. If you have installed Microsoft Office 2003 or 2007, you must
activate the software either through the Internet or by calling
Microsoft. In addition, each Office 2003 or 2007 application
that you have installed must be launched on the server and then
closed so that any additional setup requirements at the user
profile level can be completed. Both of these steps must be
completed for Office 2003 and 2007 or server-side application
conversion will fail.

6. Microsoft recommends that you re-install the latest service pack
for your Windows software after installing any Office
applications. After this final step is complete, your Office
applications may require some configuration to ensure that
server-side application conversion works properly. Refer to the
following pages for information:

e “Configuring Word” (described on page 91).
¢ “Configuring Excel” (described on page 92).
e “Configuring PowerPoint” (described on page 92).

Configuring Word

Running the Exchange Events service on the RightFax server will
cause server-side application conversion through Word to fail. If
you must run Exchange Server on the same computer as your
RightFax server, you must disable the Exchange Events service.

Server-side application conversion through Word 2000-2007
converts these file types:

o Word for Windows (versions 2000-2007)
o RTF (rich text format)

Password-protected Word files will not be converted with the
exception of Outlook or Lotus Notes file attachments where the
Outlook or Notes client has had the correct password provided in
the Document Conversion options (described in the RightFax
Microsoft Exchange Module Guide and RightFax Lotus Notes
Module Guide.)

Chapter 6 Configuring Server-Side Application Conversion
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Using DOC Coversheets with Word 2007

Follow the steps below if your organization uses .DOC coversheets
and has installed Word 2007 on the RightFax server.

1. Log on to the RightFax server with an Administrator account.

2. Open Windows Explorer and browse to the
\RightFax\FCS\Doc folder.

Open the FCS.doc file.
Click the Close button at the Show Repairs window.

Save and close FCS.doc.

U

Repeat these steps for all .DOC coversheets.

Configuring Excel

Server-side application conversion renders whatever print area is
defined in the Excel Workbook.

Server-side application conversion through Excel 2000-2007
converts these file types:

o Excel for Windows (versions 2000-2007)

Password-protected Excel files will not be converted with the
exception of Microsoft Outlook or Lotus Notes file attachments
where the Outlook or Notes client has had the correct password
provided in the Document Conversion options (described in the
RightFax Microsoft Exchange Guide and RightFax Lotus Notes
Module Guide.)

Configuring PowerPoint

Server-side application conversion through PowerPoint
2000-2007 converts these file types:

o PowerPoint for Windows (versions 2000-2007)

Print options for creating the fax images are set by the user in each
PowerPoint presentation, using the Print tab in the PowerPoint
Options dialog box.
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Configuring the Captaris Conversion Engine

A

=

To configure the Captaris Conversion Engine, open the Windows
Control Panel and double-click the Captaris Conversion applet.
The Captaris Conversion Engine Configuration opens.

Note The Captaris Conversion Engine configuration applet cannot not
be opened from a remote computer.

Logging The Logging tab provides RightFax administrators with
control over the types of messages logged by the Conversion
Engine. Each of these messages can be customized using
categories and logging levels. By default, all output is written to the
Windows Event Logs, except when the service is running in debug
mode, in which case all messages are shown in real-time via the
diagnostics window. For more information about debug mode, see
“Troubleshooting the Conversion Engine” on page 95.

Service Account The Service Account button is used to select
a Windows account to run the Conversion Engine. This account
and the RightFax WorkServer module service account, must be the
same.

Important The service account password is only retained until the
control panel closes. It is not cached.

Configuring Internet Explorer

The conversion engine can invoke Internet Explorer 6 or above to
assist in the conversion of HTML documents. For information on
Internet Explorer conversion options, see the online help available
on the Internet Explorer tab.
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Server-Side Application Conversion 3. For each WorkServer number (\Worksrv#) add a
REG_DWORD value called KillServiceTimeout to

HKEY_LOCAL_MACHINE\Software\RightFax\Workserver
\Worksrv# and set the data value to the length of time you want

Configuring Server-Side Application Conversion . o . .
server-side application conversion to attempt conversion before

for Microsoft Visio timing out, in milliseconds (i.e., set the data value to 600000 for
RightFax supports Visio versions 2000-2007. Server-side 10 minutes).
application conversion of Visio documents (files with a .VSD 4. Restart the services.
extension) is performed by the RightFax WorkServers. Follow the To have the WorkServers recover after being stopped by this new
steps below to implement server-side application conversion for feature, open the Windows Control Panel and select
Visio documents. Administrative Tools > Services > RightFax WorkServer and go
to the Recovery tab to select the service's response to the
Installing Visio shutdown.
On each of your RightFax servers and remote WorkServers
computers, follow these guidelines to install Visio for server-side Controlling Visio Server-Side Application Conversion
application conversion. To control how and when Visio server-side application conversion
During the installation, select the following options. is used for specific document types, edit the Windows registry and
Table 6b Installing Visio add the REG_MULTI_SZ registry value.“NativeDocControI" in
. . : HKEY_LOCAL_MACHINE\Software\RightFax\WorkServer
Installation option | Select this \WorkSrv# (where # is the WorkServer number to modify.)
Setup type Custom/Complete The setting for this value is one or more lines each controlling a
Destination folder Default destination specific document type in the format:
Select components | Program files and graphic filters DocType,Action

Where DocType is the Visio document (VSD) to control, and Action
When the installation is complete, restart Windows. specifies how the document type should be handled. The following
table lists the actions you can specify.
To configure automatic timeout on a failed conversion

If, for any reason, Visio server-side application conversion fails, you
can configure RightFax to automatically timeout, stop the
conversion, and set the fax status to “conversion failed

1. On the RightFax server, stop all WorkServer services.

2. Edit the Windows Registry on the RightFax server.

Chapter 6 Configuring Server-Side Application Conversion



Table 6¢ NativeDocControl Actions

Value | Action

1 Attempt to convert the document using the native
application on the server. If this fails because the
application is not installed, because the application
cannot be started, or because the application returns an
error, then attempt to convert the document using the
built-in RightFax conversion engine.

2 Only attempt to convert the document using the native
application on the server. If this fails for any reason, abort
the fax.

3 Attempt to convert the document using the built-in

RightFax conversion engine. If this fails for any reason,
abort the fax.

4 Do not attempt to convert this type document. Conversion
will fail.
5 Attempt to convert the document using the built-in

RightFax conversion engine. If this fails, attempt
conversion with the native application.

Example NativeDocControl value setting:
VSD,2

Controlling PDF Server-Side Application Conversion

To control how and when PDF server-side application conversion is
used for specific document types, edit the Windows registry and
add the REG_MULTI_SZ registry value “NativeDocControl” in
HKEY_LOCAL_MACHINE\Software\RightFax\WorkServer
\WorkSrv# (where # is the WorkServer number to modify.)

The setting for this value is one or more lines each controlling a
specific document type in the format:

DocType,Action
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Where DocType is the document format to control (PDF), and
Action specifies how the document type should be handled. The
following table lists the actions you can specify.

Table 6d NativeDocControl Actions
Value | Action

1 Attempt to convert the document using the native
application on the server. If this fails because the
application is not installed, because the application
cannot be started, or because the application returns an
error, then attempt to convert the document using the
built-in RightFax conversion engine.

2 Only attempt to convert the document using the native
application on the server. If this fails for any reason, abort
the fax.

3 Attempt to convert the document using the built-in

RightFax conversion engine. If this fails for any reason,
abort the fax.

4 Do not attempt to convert this type document. Conversion
will fail.
5 Attempt to convert the document using the built-in

RightFax conversion engine. If this fails, attempt
conversion with the native application.

Example NativeDocControl value setting:
PDF,2
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Word-wrap for Text Attachments

Text attachments that contain long lines of text can potentially be
truncated. The steps below outline how to configure RightFax to
word-wrap text attachments.

1. Edit the Windows Registry on the RightFax server.

2. For each WorkServer number (\Worksrv#) add a
REG_DWORD value called WordWrapTextLength to
HKEY_LOCAL_MACHINE\Software\RightFax\Workserver
\Worksrv# and set the data value to the desired character
length (e.g., 150 will word-wrap anything over 150 characters).

3. Open the RightFax WorkServer Module.

4. Configure all RightFax WorkServers to use the option ‘Use PCL
Converter for Text Files’

5. Click OK to restart the WorkServer Modules.

Troubleshooting the Conversion Engine

Like all RightFax services, the Conversion Engine can be run in
'debug' mode. Debug mode provides RightFax administrators with
robust real-time monitoring, logging, and troubleshooting via a
separate diagnostics window. From this window it is possible to
customize the trace (logging) level, group by processes, and save
the output to an RTF or TXT file. Errors and warnings are also
displayed in different colors, making it easier to isolate problems.
The diagnostics window also allows the service to be started,
stopped, paused and resumed.

To run the Conversion Engine in debug mode

1. Open Enterprise Fax Manager, click your fax server name, and
browse to the services view in the lower-right corner.

2. Right-click the Captaris Conversion Engine and choose Stop.

3. When the service has stopped, right-click the service and select
Debug. The Diagnostics window opens.

Changes made to the Conversion Engine while running in debug
mode are not reflected in the diagnostics window until re-launched.
Also note that when running the Conversion Engine in debug
mode, it is possible to restart the service by clicking OK in the
Conversion Engine configuration. Setting the service that runs the
Conversion Engine (RflsoConv.exe) to manual startup will prevent
this problem, however, this is only recommended when performing
complex debug associated troubleshooting.

Chapter 6 Configuring Server-Side Application Conversion
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Chapter 7

Enabling and Using the Captaris Sync Module

RightFax maintains a database of users. This database defines
each user’'s RightFax-specific contact information, logon
information, preferences, and permissions. With the Captaris Sync
Module, it is possible to import and synchronize this information in
real-time or at definable intervals from Microsoft Active Directory or
from any LDAP (Lightweight Directory Access Protocol) compliant
data source.

User synchronization is not bi-directional. Meaning only the
RightFax database is updated. The synchronization source is not
modified.

Description of the Captaris Sync Module

The Captaris Sync Module is an XML/XSLT based tool that allows
RightFax administrators to create and synchronize users from
Active Directory (domains, groups, and organizational units) and
LDAP compliant data sources.

Features

e Synchronization data is not stored in Active Directory.

e Support for multiple domain environments.
o LDAP support.
¢ Robust real-time logging and diagnostics.

e Nested groups are not automatically included when
synchronizing from parent groups.

e Synchronization is managed as a standalone service.

97



Configuring the Captaris Sync Module
for Active Directory Synchronization

A

Open the Windows Control Panel and double-click Captaris Sync
Module. The Captaris Sync Module Configuration opens.

Note The Captaris Sync Module cannot not be configured from a
remote computer.

Figure 7.1 Captaris Sync Module Configuration Dialog Box

5 Captaris Sync Module Configuration ed |
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—Sources & Destinations

Spnchranization iz performed between any number of sources and destingtions. You must
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—Mappingz

Each mapping defines how and when a particular source and destination should be synchranized.

Source | Destination | Transform | Scheduls | Mew... I
Edi.. |
[elete, . |

Service Account.. ok Cancel Apply

Service Account The Service Account button is used to select
a Windows account to run the Captaris Sync module. This account
and the RightFax WorkServer module service account, must be the
same. If synchronizing with Active Directory, this account must be a
member of the Active Directory Domain Users group. If you

configure the Captaris Sync Module to detect users deleted Active
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Directory, corresponding RightFax users will also be deleted. To
use this function the service account must be a member of the
Domain Admins group.

Important The service account password is only retained until the
control panel closes. It is not cached.

Sources and Destinations are terms used to describe the
Active Directory you are synchronizing from (source) and the
RightFax server you are synchronizing to (destination). Each source
and destination are represented by their own tab. There is no limit
to the number of sources and destinations you can define. After
configuring at least one source and one destination, you can define
a mapping between them. A mapping associates Active Directory
attributes with RightFax attributes. For example, the fax number
specified for an Active Directory user is mapped to a RightFax
user's Routing Code. During synchronization, the Captaris Sync
Module will extract the last four digits of the Active Directory fax
number and insert them into the Routing Code field. Controlling
how this and other data will be transformed is done using the
transform file and the RightFax user template (described below).

To Define a Source and Destination

1. Click Sources & Destinations. The Sync Sources and
Destinations window opens.

2. Using the drop-down arrow, select your source (Active
Directory) followed by your destination (RightFax). The source
and destination should now be displayed in the Sync Sources
and Destination window.
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3. When finished, click OK.

Figure 7.2 The Sync Sources and Destinations Dialog Box
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Creating Mappings

Mappings define how and when sources and destinations are
synchronized. You can define as many mappings as you need and
previously defined sources and destinations can be used in more
than one mapping. This allows, for example, a single Active
Directory source to be synchronized into two different RightFax
servers, or two different sources to be synchronized to a single
RightFax server.

To Create a New Mapping
1. Under the General tab, click New. The Sync Mapping window
opens.

2. Using the drop-down arrows, choose your Source and
Destination.

3. In the Sync Mapping window, browse to the \RightFax\Shared
Files\Sync\Config folder and select the Transform File
relevant to your environment. The Transform File is responsible
for transforming data generated by the source into an XML file
translated by the destination. This file together with the RightFax
User Template, can be edited to create a custom
synchronization template.

4, Select a synchronization schedule.
5. When finished, click OK.

Source Settings The Source tab (AD- Domain) contains
settings associated with the Active Directory source. This tab also
contains three sub-tabs (Filters, Output, and Special). Each of
these is explained below.

Filters Filters are a set of parameters used by the Captaris Sync
Module to determine which users are synchronized from Active
Directory into RightFax. For each set of users you must choose a
domain and at least one Organizational Unit (OU) or group. You
may also choose to exclude users that are in certain groups. If you
do not assign a filter, synchronization will not occur.

To Create a New Filter

1. Select New. The Define Filter window opens.

2. In the Define Filter window, browse to your Domain and click
OK.

3. If necessary, browse and select OU’s by checking the box next
to each OU. OU'’s validated by the Sync Module will show a
grey underline. Those that cannot be validated will show a red
underline.

4. If necessary, add an include group and an exclude group.

Chapter 7 Enabling and Using the Captaris Sync Module
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5. When finished, click OK.

Important When synchronizing with Active Directory, nested groups
and OU's are NOT automatically included. This allows for finer control of
which groups and OU's are and are not included. Also note that when
browsing for a group that resides in a child domain, you must change the
Windows browser to point to the child domain you are attempting to
browse to. By default, the Windows browser will select the parent
domain for directory searches. Use the Locations button to browse to and
select the correct domain.

Output Use the Output tab to specify the output data for each
new, modified, or deleted Active Directory user found during a
synchronization event. This data is transformed into a format
suitable for the destination (RightFax).

Figure 7.3 The Output Tab

4 Captaris Sync Module Configuration ed |

Generall Logging AD - traincaptaris | RF - 92'

Filters ~ Olutput |Speclal|

—MNew / Modified Users

Select the collection of properties that will be output o the
ML file for each new or modified user.

Default Exchange Properties (12 properties) j

Edit Collections |

i Deleted Users

‘when deleted users are detected, the fallowing command is
output ta the =L file:

IDnIy delete if uzer is empty j

[~ OPTIONAL: Treat users that were previously synced
but are no langer included in the sync as if they had
been deleted

Service Account... 08 I Cancel Apply
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For New/Modified Users, you can select any number of Active
Directory text-based properties. Two predefined property
collections are available - Default Windows Properties and
Default Exchange Properties. These contain typical properties for
use with Windows and Exchange users, respectively.

The Deleted Users section allows you to control how RightFax will
treat users deleted from Active Directory. By default, the user is
only deleted if it is empty (i.e., without documents or phonebook
entries). Other options are, to always delete users or to never
delete users.

Warning Combining the option to “Treat users that were previously
synced but are no longer included in the sync as if they had been
deleted” with “Always delete user” can result in a large-scale deletion of
users and their faxes. Use with extreme caution.

To edit Property collections, highlight a collection and click Edit
Collections.

The two property collections that are shipped with RightFax cannot
be modified. You can, however, select the Copy button to create an
editable copy of either.

New collections are defined by assigning a name and then
choosing one or more properties that will belong to the collection.
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Properties are selected using the Property Picker dialog box. Use
the Citrl key to select multiple properties.

Figure 7.4 The Property Collection Dialog Box

Propetty Picker 2xl
Select one or more properties
Narne | Syntax | ﬂ
accountExpires Largelnteger
accountbameHistary UnicadeSting

Al
a

altRecipient DMString

altRecipientBL DM Sting

altSecurityl dentities UnicodeSting

assistant DMString

attiibuteCertificate OctetString j
Cancel_ |

Destination Settings The Destination tab (RF- RightFax
Server) contains settings associated with the RightFax server
destination. This tab also contains two sub-tabs (Servers and
Users).

Server The Server Name field is where the RightFax server name
(destination) is entered.

RightFax Account Use the RightFax Account button to select a
RightFax account with Administrative Access. This account is used
by Sync Module to create and delete users on the RightFax server.
Captaris recommends using an account dedicated solely to the
Sync module.

Important The RightFax account password is saved as an encrypted

registry item on the RightFax server. To avoid this, use NT authentication.

Users Enter a RightFax user account to use as a template or
model for creation of new (i.e., synchronized) users. New users will
inherit all settings associated with the specified user. You can set

up multiple RightFax/Destination profiles, each with a different
model user. This allows for all manner of customization, such as
having different users synchronized into different RightFax groups,
or with different RightFax permissions and so on.

Figure 7.5 The User Tab Configuration Dialog Box

% Captaris Sync Module Configuration 21x|

General' Loggingl AD - traincaptaris AP - 92 |

Server Users |

—RightFax User Template
Enter a RightFax user account that will be used as model for new user creation.

DEFALLT

 Incaming User Account Mapping
Sync nomally creates a new RightFax user for each new user it finds. This option tells Sync to by to map users
onto existing RightFax users before deciding to create a new user.

[+ Attempt to map onto existing RightFax users

Service Account... | Ok I Cancel Lpply
Troubleshooting

The Captaris Sync Module provides administrators with convenient
and customizable real-time logging and troubleshooting tools.

Logging The Logging tab provides RightFax administrators with
control over the types of messages logged by the Sync Module.
Each of these messages can be customized using categories and
logging levels. By default, all output is written to the Windows
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Event Logs, except when the service is running in diagnostics
(debug) mode, in which case all messages are shown in real-time
via the diagnostics window.

Figure 7.6 The Logging Tab Configuration Dialog Box

aptaris 5ync Module Configuration 21

General Logging IAD - traincaptaris | FF -52 |

Choose the types of meszages that will be logged by this service.

Select one or more message categories to change.

MName | Description | Walue
Client&P| RightFax Client 4P| Errar
FematingsPl RightF ax Remating AP Errar
RightF ax. 4 pi RightF ax Statistics AF1 Client Error
RightFaxTools  Common source code tools. Error
Syncal Sync's Active Directary Plugin W arning
SyncCore Sync Scheduler and Dispatcher Warning
SyncRF Sync's RightFax Plugin Wi arning
Errar -
aff Mothing

Logging output can be viewed uzing Windows Ewvent iewer.

“Warning  Errors & warnings
Infa Errars & warnings & info
“erbose  Ewemthing

Service Account... 08 I Cancel Apply
Diagnostics

Like all RightFax services, the sync Module can be run in 'debug'
mode. Debug mode provides RightFax administrators with robust
real-time monitoring, logging, and troubleshooting via a separate
diagnostics window. From this window it is possible to customize
the trace (logging) level, group by processes, and save the output
to an RTF or TXT file. Errors and warnings are also displayed in
different colors, making it easier to isolate problems. The
diagnostics window also allows the service to be started, stopped,
paused and resumed.
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To run the Sync Module in debug mode

-t

. Open Enterprise Fax Manager, click your fax server name, and
browse to the services view in the lower-right corner.

2. Right-click the Captaris Sync Module and choose Stop.
3. When the service has stopped, right-click the service and select
Debug. The Diagnostics window opens.

Figure 7.7 The Debug option, available when right-clicking the Captaris
Sync Module from Enterprise Fax Manager

Start Service

. Bunt|  Sbop Service -
Service Name Status fddd  Confiqure Service —I
RightFax Gueue ... | @ Running s
RightFae: Paging ... | € Running noop  Stark Al Services
RightFas wiorkSe... | € Running popo Stop All Services
RightFaz: wiorkSe... | @ Running ooon
RightFaz: wiorkSe... | @ Running 000
RightFaz eTransp .. | € Running A, e
RightFax: Remating | @ Running T4i, Cancel

C M. Stopped ALTOMETIC

-

Changes made to the Sync Module while running in debug mode
are not reflected in the diagnostics window until re-launched. Also
note that when running the Sync Module in debug mode, it is
possible to restart the service by clicking OK in the Sync Module
configuration. Setting the service that runs the Sync Module
(CapaSync.exe) to manual startup will prevent this problem,
however, this is only recommended when performing complex
debug associated troubleshooting.
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Verifying User Synchronization

Users created via the Sync Module are denoted in Enterprise Fax
Manager by a green dot next to their user icon. Users who do not
display this marker have not been updated or created via the Sync
Module.

Figure 7.8 Users created via the Captaris Sync Module as displayed in
Enterprise Fax Manager
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Configuring the Captaris Sync Module
for LDAP Synchronization

Lightweight Directory Access Protocol or LDAP is a standardized
Internet protocol used by email and other programs to look up
server-based information. LDAP servers may contain directory-like
contact information such as a contact name, email addresses, and
fax numbers. The Captaris Sync Module can extract, import, and
synchronize data of this type from any LDAP compliant data source
into your organizations RightFax servers.

These instructions assume you have a pre-configured LDAP server
available to accept LDAP connections and possesses a functional
LDAP data source.

Open the Windows Control Panel and double-click the Captaris
Sync Module applet. The Captaris Sync Module Configuration
opens.

Note The Captaris Sync Module configuration applet cannot not be
opened from a remote computer.

Figure 7.9 Captaris Sync Module Configuration Dialog Box

&% Captaris Sync Module Configuration ﬂll

General | Lnggingl AD - haincaptaris | RF-92 |

Sources & Destinations

Synchronization is performed between any number of sources and destinations. You must
define at least one source and one destination before synchronization can accur

Sources & Destinations... |

—Mappings
Each mapping definez how and when a particular source and destination should be synchronized.

Source | D estination ‘ Transform | Scheduls | Mew.. I
Edit... |
[Delete,. |

Service Account... | oK. Cancel Lpply

Service Account The Service Account button is used to select
a Windows account to run the Captaris Sync module. This account
and the RightFax WorkServer module service account, must be the
same.

Important the service account password is only retained until the
control panel closes. It is not cached.

Sources and Destinations are terms used to describe the
LDAP server you are synchronizing from (source) and the RightFax
server you are synchronizing to (destination). Each source and
destination are represented by their own tab. There is no limit to the
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number of sources and destinations you can define. After
configuring at least one source and one destination, you can define
a mapping between them. A mapping associates LDAP attributes
with RightFax attributes. For example, the fax number specified for
a Lotus Notes user is mapped to a RightFax user's Routing Code.
During synchronization, the Captaris Sync Module will extract the
last four digits of the Notes fax number and insert them into the
Routing Code field. Controlling how this and other data will be
transformed is done using the transform file and the RightFax user
template (described below).

Important In the above example, the Lotus Notes ‘facsimile phone
number’ field is not available by default and therefore must be made
publicly available by a Domino administrator.

To Define a Source and Destination

1. Click Sources & Destinations. The Sync Sources and
Destinations windows opens.

2. Using the drop-down menu, select your source (LDAP) followed
by your destination (RightFax). The source and destination
should now be displayed in the Sync Sources and Destination
window.

3. When finished, click OK.

Creating Mappings

Mappings define how and when sources and destinations are
synchronized. You can define as many mappings as you need and
previously defined sources and destinations can be used in more
than one mapping. This allows, for example, a single Lotus LDAP
source to be synchronized into two different RightFax servers, or
two different sources to be synchronized to a single RightFax
server.
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To Create a New Mapping

1. Under the General tab, click New. The Sync Mapping window
opens.

2. Using the drop-down arrows, choose your Source and
Destination.

3. Inthe Sync Mapping window, browse to the '\RightFax\Shared
Files\Sync\Config folder and select the Transform File
relevant to your environment. The Transform File is responsible
for transforming data generated by the source into an XML file
translated by the destination. This file together with the RightFax
User Template, can be edited to create a custom
synchronization template that fits the needs of your
environment.

Note There are two LDAP transform files included with the Sync
Module (Default Notes LDAP with Gateway to RightFax, and Default
Notes LDAP to RightFax). Use the Default Notes LDAP with Gateway
to RightFax transform file if you have the RightFax Lotus Notes email
gateway and wish to route inbound faxes to a Lotus client. For
information about the RightFax integration with Lotus Notes, see the
RightFax Lotus Notes Module Guide.

4. Select the synchronization schedule option that best suits your
environment.

5. When finished, click OK.

Source Settings The Source tab (LDAP- name) contains
settings associated with the LDAP source. This tab also contains
three sub-tabs (Filters, Output, and Special). Each of these is
explained below.

General The General tab allows you to create or choose an
existing LDAP configuration. Once you have created or selected an
LDAP configuration, you must set corresponding parameters.
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To Create a New LDAP Configuration

1. Under the General tab, click the pick-list button. The LDAP
Configuration window opens.

2. Inthe LDAP Configuration window, choose the New. The Select
Default Configuration window opens.

3. Select one of the bundled configuration options (Default Notes
LDAP with Gateway to RightFax or Default Notes LDAP to
RightFax) and click OK.

4. Under the General tab, enter a unique name for your LDAP
configuration.

5. Click the Connection tab. In the Server section, enter a host
and base DN (i.e., name/organization) followed by a port
number used by your LDAP server. In the security section, enter
the authentication method employed by your LDAP server. Click
Validate to confirm your information. If correct, you will receive
the message Validation Successful. When finished, click OK.

6. Click the Schema tab. Here you may change the default and
standard LDAP values.

7. Use Deleted Objects tab to configure deleted object tracking
(users, groups, and OU's). Specify a deleted objects storage
container, and if necessary, create search a filter to provide
results associated only with deleted objects. This feature can
only be used in LDAP environments that support object
tracking.

Filters Filters are a set of parameters used by the Captaris Sync
Module to determine which users are synchronized to RightFax. For
each set of users you must choose a domain and at least one
Organizational Unit (OU) or group. You may also choose to exclude
users that are in certain groups. If you do not assign a filter,
synchronization will not occur.

To Create a New Filter

1. Select New. The Define Filter window opens.

2. In the Define Filter window, browse to your Domain and click
OK.

3. If necessary, browse and select OU's by checking the box next
to each OU. OU's validated by the Sync Module will show a
grey underline. Those that cannot be validated will show a red
underline.

4. If necessary, add an include group and an exclude group.
5. When finished, click OK.

Output Use the Output tab to specify the output data for each
new, modified, or deleted LDAP user found during a
synchronization event. This data is transformed into a format
suitable for the destination (RightFax).

Figure 7.10 The Output Tab Dialog Box

+¥% Captaris Sync Module Configuration 21

General | Logging | AD - TusQA ~ LDAP - TusQA-RESE | AF - Tus@A-ZKHNSO1

Genelall Fitters OUtPLﬂl

—New / Modified Users

Select the collection of properties that will be output to the
XML file for each new or modied user,

Editable Motes LDAP properties (3 properties) j

Edit Collections... |

—Deleted Users

When deleted users are detected, the following command is
output to the XML file:

IOnI:.- delete f user is empty j

[~ OPTIOMAL: Trest users that were previously synced
but are no longer included in the sync as if they had

been deleted.
Service Accourt... | OK I Cancel Aoply
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For New/Modified Users, you can select any number of LDAP,
text-based properties. Two predefined property collections are
available - Default LDAP Properties and Default Notes LDAP
Properties. The Default Notes LDAP Properties contains typical
properties for use with LDAP.

The Deleted Users section allows you to control how RightFax will
treat users deleted from your LDAP server. By default, the user is
only deleted if it is empty (i.e., without documents or phonebook
entries). Other options are, to always delete users or to never
delete users.

Warning Combining the option to “Treat users that were previously
synced but are no longer included in the sync as if they had been
deleted” with “Always delete user” can result in a large-scale deletion of
users and their faxes. Use with extreme caution.

Property collections can be managed by highlighting a collection,
followed by clicking the Edit Collections button.

The two property collections shipped with RightFax cannot be
modified. You can, however, select the Copy button to create an
editable copy of either property collection.

New collections are defined by assigning a name and then
choosing one or more properties that will belong to the collection.
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Properties are selected using the Property Picker dialog box. Use
the Ctrl key to select multiple properties.

Figure 7.11 The Property Collection Dialog Box
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Destination Settings The Destination tab (RF- RightFax
Server) contains settings associated with the RightFax server
destination. This tab also contains two sub-tabs (Servers and
Users).

Server The Server Name field is where the RightFax server
name (destination) is entered.

RightFax Account Use the RightFax Account button to select a
RightFax account with Administrative Access. This account is used
by Sync Module to create and delete users on the RightFax server.
Captaris recommends using an account dedicated solely to the
Sync module.

Important The RightFax account password is saved as an encrypted
registry item on the RightFax server. To avoid this, use NT authentication.
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Users Enter a RightFax user account to use as a template or
model for creation of new (i.e., synchronized) users. New users will
inherit all settings associated with the specified user. You can set
up multiple RightFax/Destination profiles, each with a different
model user. This allows for all manner of customization, such as
having different users synchronized into different RightFax groups,
or with different RightFax permissions and so on.

Figure 7.12 The User Tab Configuration Dialog Box

&4 Captaris Sync Module Configuration 2

Genarall Logging I 4D - Waincaptais  RF -92 |

Server  Users |
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|DEFAULT

Incoming User Account b apping

Sync normally creates a new RightFax user for each new user it findz. This option tells Sync to by to map users
onto existing RightFax users before deciding to create a new user.

v Attempt bo map onto existing FightFax users

Service Accaount... | Ok I Cancel Apply
Troubleshooting

The Captaris Sync Module provides administrators with convenient
and customizable real-time logging and troubleshooting tools.

Logging The Logging tab provides RightFax administrators with
control over the types of messages logged by the Sync Module.
Each of these messages can be customized using categories and
logging levels. By default, all output is written to the Windows

Event Logs, except when the service is running in diagnostics
(debug) mode, in which case all messages are shown in real-time
via the diagnostics window.

Figure 7.13 The Logging Tab Configuration Dialog Box
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Logging output can be viewed using Windows Event Viewer.
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Service Account... | Ok I Cancel Apply
Diagnostics

Like all RightFax services, the sync Module can be run in 'debug’
mode. Debug mode provides RightFax administrators with robust
real-time monitoring, logging, and troubleshooting via a separate
diagnostics window. From this window it is possible to customize
the trace (logging) level, group by processes, and save the output
to an RTF or TXT file. Errors and warnings are also displayed in
different colors, making it easier to isolate problems. The

diagnostics window also allows the service to be started, stopped,
paused and resumed.
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To run the Sync Module in debug mode

1. Open Enterprise Fax Manager, click your fax server name, and
browse to the services view in the lower-right corner.

2. Right-click the Captaris Sync Module and choose Stop.

3. When the service has stopped, right-click the service and select

Debug. The Diagnostics window opens.

Figure 7.14 The Debug option, available when right-clicking the Captaris
Sync Module from Enterprise Fax Manager
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i Cancel

Changes made to the Sync Module while running in debug mode
are not reflected in the diagnostics window until re-launched. Also
note that when running the Sync Module in debug mode, it is
possible to restart the service by clicking OK in the Sync Module
configuration. Setting the service that runs the Sync Module
(CapaSync.exe) to manual startup will prevent this problem,
however, this is only recommended when performing complex
debug associated troubleshooting.
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Verifying User Synchronization

Users created via the Sync Module are denoted in Enterprise Fax
Manager by a green dot next to their user icon. Users who do not
display this marker have not been updated or created via the Sync
Module.

Figure 7.15 Users created via the Captaris Sync Module as displayed in
Enterprise Fax Manager
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Chapter 8
Managing Fax Servers with

Enterprise Fax Manager

You can use the Enterprise Fax Manager application to administer Quitting Enterprise Fax Manager
multiple RightFax servers. With Enterprise Fax Manager, you can
manage users, groups, signatures, forms, printers, billing codes,
library documents, and more, for all RightFax servers from one
application.

To quit Enterprise Fax Manager, on the File menu, click Exit. When
you quit the program, all of your changes and additions are saved.

The Enterprise Fax Manager window

When you start Enterprise Fax Manager, the Enterprise Fax
Manager window opens.

Enterprise Fax Manager (EFM) is a client application that can be
run on any Windows XP Professional or Windows Vista computer.
It is installed as an optional component during the client installation
(described in the RightFax Installation Guide.) The left pane of the window, called the Fax Server Tree, contains
the open RightFax servers and their administrative components
(users, forms, printers, etc.). The right pane displays details of the

Starting Enterprise Fax Manager selected component. ltems listed on the right, such as individual
users or library documents, are referred to as “objects!” Objects
After it has been installed, you can start Enterprise Fax Manager can be added, deleted, and modified according your needs. If you
from the Start > Programs menu, or click Enterprise Fax don't have a mouse, press F6 to switch the cursor between the left
Manager in the RightFax tray icon shortcut menu. and right panes.

When you start Enterprise Fax Manager for the first time, it will
attempt to log on under your network user ID. If you did not log on
to the network as “Administrator,’ the Login dialog box opens. Enter
a user ID and password with RightFax administrative access.
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Opening RightFax servers

To display a fax server in the Fax Server Tree, press CTRL+O, or in
the File menu, click Open Server. The Open Server dialog box
appears.

Figure 8.1 The Open Server Dialog Box
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In the Server Name box, type the name of the RightFax server to
open. In the Protocol box, enter the network protocol used by that
server.

After one or more RightFax servers have been opened in Enterprise
Fax Manager, the servers will, by default, open each time you run
the program. This default setting can be changed in Preferences,
described later in this chapter.

To close a RightFax server, click the server name and on the File
menu, click Close Server.

Refreshing data in the window

Users can create new library documents, forms, and signatures in
their FaxUtil mailboxes while Enterprise Fax Manager is open.
These new files will not appear in Enterprise Fax Manager until the
view is refreshed. To refresh all objects, including objects added or
modified since the last check, press F5 or on the Edit menu, click
Refresh.
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Setting Preferences

Enterprise Fax Manager has several customizable preferences. To
view your preferences, on the Edit menu, click Preferences. The
Preferences dialog box opens. The rest of this section describes
the options in this dialog box.

The User Copy Defaults tab

Figure 8.2 User Copy Defaults

User Copy Defaults | Dialing Rule Copy Options I General Prelerencesl

Default setti ft-button user drag operations:
&3 i
" Copy for IntelConnect [no fakes or phonebooks)
" Copy without Fases or Phonebooks
" Copy with Faxzes and Phonebooks
" Copy with Faxes Only
" Copy with Phonebooks Only
" #ppend Faxes and Phonebooks
" Append Fazes Only
 #ppend Phonebooks Only

Cancel

You can copy one or more users from one RightFax server to
another by dragging and dropping selected users to another server
in the Fax Server Tree. The options on the User Copy Defaults tab
set the behavior of Enterprise Fax Manager when copying RightFax
users from one server to another.

Always Prompt Display this list of options each time users are
copied from one server to another. You must select a copy option
before the users will be copied.

Copy for InterConnect (no faxes or phonebooks) Copies
all user information, excluding faxes and phonebook entries, and
then sets the user's Routing Type to InterConnect, pointing back
to the server that the user was copied from.

Copy without Faxes or Phonebooks Copies all user
information excluding faxes and phonebook entries.
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Copy with Faxes and Phonebooks Copies all user
information including faxes and phonebook entries. Duplicate users
will receive all faxes in the source account, even if the same faxes
already exist on the destination server, creating multiple copies of
the same fax.

Copy with Faxes Only Copies all user information including
faxes but not phonebook entries. Duplicate users will receive all
faxes in the source account, even if the same faxes already exist on
the destination server, creating multiple copies of the same fax.

Copy with Phonebooks Only Copies all user information
including phonebook entries but not faxes.

Append Faxes and Phonebooks Copies only information for
duplicate user accounts. All faxes and phonebook entries from the
source user account will be added to the destination user account.
No other user information will be changed. Users on the destination
server will receive all faxes in the source account, even if the same
faxes already exist on the destination server, creating multiple
copies of the same fax.

Append Faxes Only Copies only information for duplicate user
accounts. All faxes from the source user account will be added to
the destination user account. No other user information will be
changed. Users on the destination server will receive all faxes in the
source account, even if the same faxes already exist on the
destination server, creating multiple copies of the same fax.

Append Phonebooks Only Copies only information for
duplicate user accounts. All phonebook entries from the source
user account will be added to the destination user account. No
other user information will be changed.

The Dialing Rule Copy Options tab

Figure 8.3 Dialing Rule Copy Options
2l

Liser Copy Defaults  Didling Rule Copy Options | General Pleferencesl

¥ Copy ‘Beceive into Local' nles?

¥ Copy ‘Send Locally' ules?

Cancel

You can copy one or more dialing rules from one RightFax server to
another by dragging and dropping rules to another server in the list.
The options on the Dialing Rule Copy Options tab set the behavior
of Enterprise Fax Manager when copying RightFax dialing rules
from one server to another.

Replace all rules on destination Copies all dialing rules
from the source server to the destination server, deleting any
existing dialing rules.

Copy ‘Receive into Local’ rules Includes all dialing rules with
the “Receive into local server” action when copying. If this check
box is not selected, “Receive into local” rules will be ignored during
the copy.

Copy ‘Send Locally’ rules Includes all dialing rules with the
“Send locally” action when copying. If this check box is not
selected, “Send locally” rules will be ignored during the copy.
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The General Preferences tab

Figure 8.4 General Preferences

proevences 21

User Copy Defaults I Didling Fule Copy Options  General Preferences |

W Automatically re-open servers upon statup®
v Confim object deletions?

¥ Confim object ovenarites?

I~ automatically adjust status display column widths?
™ Use black and white icons?

¥ Enable duplicate routing code waming?

™ Enable service contiol warhing?

[™ Enable database locked warning?

Cancel |

The options on the General Preferences tab set some general
preferences for views and actions in Enterprise Fax Manager.

Automatically re-open servers upon startup Recalls
which servers were open when the program was last quit and
opens those servers again on startup. If this check box is not
selected, you must reopen each RightFax server upon starting
Enterprise Fax Manager.

Confirm object deletions Displays a confirmation dialog box

each time you delete an object, such as a user or library document.
I this check box is not selected, there will not be any confirmation

prior to deleting objects. This is convenient if you are deleting many
objects but makes it more likely that you will accidentally delete an
object that you want to keep.

Confirm object overwrites Displays a confirmation dialog box
each time you overwrite an object, such as by copying an object
with the same name into the system. If this check box is not
selected, there will not be any confirmation prior to overwriting
objects.
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Automatically adjust status display column width
Adjusts the widths of the columns in the Server Status and
Services pane (see “Monitoring the Status of RightFax Servers and
Services” on page 114)to fit the column’s contents. This option will
not affect the column widths in any other Enterprise Fax Manager
view. When this check box is selected, you can still manually adjust
the column widths in the Server Status and Services pane, but they
will resize each time the screen image is refreshed.

Use black and white icons Select this option if your monitor
is set to high contrast black and white. This changes the Enterprise
Fax Manager server status icons to colors that are can be read in
this color mode.

Enable duplicate routing code warning Displays a warning
message when a user is created that has a routing code that is the
same as another existing user.

Enable service control warning Displays a warning
message when you make any changes to the state of any of the
RightFax services.

Enable database locked warning Displays a warning
message when you attempt to access the database when it has
been locked by certain database management tools.

Viewing RightFax Server Information

To view the status of all open RightFax servers, click Fax Servers

at the top of the Fax Server Tree. A list of all open servers and the

status of each server appears in the right pane of the window. This
section describes each column in the right pane.

Server name

The Server Name column displays the name of each open RightFax
server and network protocol. An icon to the left of the name
indicates the status of the RightFax service. A green '+’ indicates
that all services are running normally. A yellow ‘!" indicates that one
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or more services are not running but that normal fax operations are
available. A red ‘=" indicates that one or more services are not
running and normal fax operations are not available.

Version

The Version column displays the RightFax server software version.

Serial number

The Serial Number column displays the serial number that was
entered when the RightFax server was installed. You must provide
this number when you contact Captaris RightFax customer
support.

Time running

The Time Running column displays the length of time that has
elapsed since the RightFax Server service was last started. Display
is in the format DDDD:HH:MM:SS.

Queue usage

The Queue Usage column displays the percentage of the fax
server's internal Event Queue that is currently in use. For more
information on the RightFax Event Queue, see “Understanding the
Fax Server Internal Event Queue” on page 33.

Fax board availability index

The Fax Board Availability Index column displays a number that
indicates the relative availability of the server's fax boards. The
higher the number, the more available the server for sending faxes.
RightFax uses this value when an outgoing fax number has two
equally weighted dialing rules that send it to two different servers.
In such a case, RightFax sends the fax via the server with the
highest availability index.

Character set mode

This column displays the OEM or ANSI code page being used by
the server. The code page determines the language character sets
that are supported for fax conversion.

Working with Objects

Sorting objects

To sort the objects listed in Enterprise Fax Manager by column,
double-click the column heading. The objects will sort in ascending
order and an indicator will appear in the column heading. You can
also click a column heading to alternately sort in ascending and
descending order. Enterprise Fax Manager recalls how objects are
sorted when you quit and restart the program.

Sorting columns

To move a column left or right, click the column heading and drag it
left or right to its new position.

Selecting objects

To edit, delete, or otherwise work with an existing object, you must
first select it in the list of objects displayed. Selected objects are
highlighted.

To select an object, click it or use the UP ARROW and DOWN
ARROW keys to move to the object and press the SPACEBAR to
highlight it. To un-select an object, click it or press the SPACEBAR
again. To select multiple objects, drag the mouse pointer down the
objects while holding the left mouse button. If the desired objects

are not all in a continuous group, click each object while holding
down CTRL.

Chapter 8 Managing Fax Servers with Enterprise Fax Manager
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Before adding objects

Before you begin adding objects to the RightFax system, it is
important that you plan the structure and anticipate the needs of
your network users. Consider whether you will divide your
organization into groups, whether you would like each group or
department to have its own cover sheet, and who will act as
administrator or alternate administrator for the group. Determine a
block of routing codes sufficient for the entire system and decide
upon any custom notification types desired. You should create new
objects in RightFax only after you have carefully considered these
issues.
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Monitoring the Status of RightFax Servers
and Services

Enterprise Fax Manager displays statistics and fax channel
information and manages services on each RightFax server. To view
and manage the status and services of each RightFax server, click
the name of the server in the Fax Server Tree in the left pane.

Figure 8.5 Server Status and Statistics

RightFax server statistics Fax channel information
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Status of RightFax services

Note If you are running remote DocTransports, they can be displayed in
Enterprise Fax Manager but will not include fax server data.

Click Update Now to recompile and update the server statistics.

Understanding the server statistics

Statistics about the server are displayed in the upper-left corner in
the right pane of the window.
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Fax Server Event Queue Usage The percentage of the fax
server's internal Event Queue currently in use. For more information
on the RightFax Event Queue see “Understanding the Fax Server
Internal Event Queue” on page 33.

Fax Server Events Processed The total number of events
processed by the fax server since the Server module was started.

BoardServer Availability Index The relative availability of the
fax boards on the server. The higher the number, the more available
the server for sending faxes. RightFax uses this value when an
outgoing fax number has two equally weighted dialing rules that
send it to two different servers. In such a case, RightFax sends the
fax via the server with the highest Availability Index.

Current Faxes Queued for Sending The current number of
outgoing faxes waiting to be sent.

Current Pages Queued for Sending The current number of
outgoing fax pages waiting to be sent.

Available Disk Space for Fax Images The percentage of

disk space on your RightFax server available for storing fax images.

Available Disk Space for Fax Database The percentage of
disk space on your RightFax server available for storing fax
database information.

All-Time Send Attempts The total number of faxes sent from
this server since the All-Time Counter Starting Date (described
later).

All-Time Pages Sent The total number of fax pages sent from
this server since the All-Time Counter Starting Date (described
later).

All-Time Faxes Received The total number of faxes received
on this server since the All-Time Counter Starting Date
(described later).

All-Time Pages Received The total number of fax pages
received on this server since the All-Time Counter Starting Date
(described later).

All-Time Counter Starting Date The starting date from which
the “All-Time” statistics (described earlier) are calculated.

Tip All of the All-Time statistics will report an error message if you are
running fax boards in simulation mode.

Monitoring fax channel information

Information about the fax channels on the server is displayed in the
upper-right corner in the right pane of the window

Channel Each fax channel that is available on this RightFax
server.

Operation The current operational status of each channel.

Routing Code The inbound routing code of this fax channel for
incoming faxes.

User ID The destination user ID of this fax channel for incoming
faxes.

Monitoring services

The lower-right pane of the window lists each RightFax service, its
status (running or stopped), the length of time it has been running,
and its startup method (manual or automatic). To monitor services
on remote servers, you must have network administrative access to
the server as well as RightFax administrative access.

Starting and stopping services
To start or stop a service, right-click the service to open a shortcut
menu.
o Click Start Service to start the selected service.

o Click Start all Services to start all services in the appropriate
sequence.

« Click Stop Service to stop the selected service.
e Click Stop all Services to stop all services.

Chapter 8 Managing Fax Servers with Enterprise Fax Manager
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Configuring services

To configure a service, double-click the service. Or, right-click the
service to open a shortcut menu, and then click Configure
Service.

e For information on configuring a RightFax Server, DocTransport,
or WorkServer, refer to the appropriate chapter in this guide.

e For information on configuring the AutoReply service, see
Chapter 24, “Responding to Inbound Faxes with AutoReply”.

e For information on configuring the RightFax email gateway, see
Chapter 28, “Using RightFax Email Gateways” or refer to the
RightFax Gateway for Microsoft Exchange or RightFax Gateway
for Lotus Notes Guide.

e For information on configuring the RightFax Integration Module,
refer to the RightFax Integration Module Guide.

Synchronizing the RightFax Server with
External Systems

The RightFax WorkServer modules synchronize with external
systems such as the Kofax NetScan user tables, library document
catalogs, and import files for billing codes on a periodic, scheduled
basis. You can force the server to synchronize immediately without
changing the defined schedule.

On the Utility menu, click Synchronize External Systems.

Running Enterprise Fax Manager Web Edition

Enterprise Fax Manager Web Edition is a Web-based version of
Enterprise Fax Manager that allows remote management of your
RightFax servers from any Web browser. Enterprise Fax Manager
Web Edition is included with all RightFax servers but must be
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installed separately on an IS server on your network. For
information on installing Enterprise Fax Manager Web Edition, refer
to the RightFax Installation Guide.

To run Enterprise Fax Manager Web Edition

Note Enterprise Fax Manager Web Edition was developed and tested
for use with Microsoft Internet Explorer version 6.0. Although it will run in
other browsers, RightFax recommends using Internet Explorer version
6.0 or later for best results.

1. Open a Web browser and point the URL to the /webefm folder
on the IS server. For example:

http://server.domain.com/webefm

116



2. Unless your IIS server is configured to allow anonymous
access, a dialog box will appear that prompts you to log on to
the 1IS server. Enter your logon information and click OK. The
browser will prompt you for information to open a RightFax
server.

Figure 8.6 Opening a RightFax Server in Enterprise Fax Manager Web
Edition
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3. Enter the name of the RightFax server to open and a RightFax

user ID and password that has administrative access to the
RightFax server. Click Logon RightFax Server.

4. The RightFax server you specified opens in the frame in the left
side of the page.

Figure 8.7 Server Options in Enterprise Fax Manager Web Edition
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Managing RightFax servers in Enterprise Fax Manager is similar
to managing RightFax servers in Enterprise Fax Manager for
Windows.

Throughout this guide, references to Enterprise Fax Manager
will describe the Windows version of Enterprise Fax Manager
and not the Web edition. However, in almost all cases, the
instructions will apply to both versions.

Selecting a language

Enterprise Fax Manager Web Edition is available in several different
languages.
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To change the language, select the language you want in the
Language menu in the upper-right corner of the page.



Chapter 9
Creating RightFax Users

Each fax user must be assigned a user ID on their local RightFax Manager” on page 109) and click Users under the RightFax server
server. The RightFax server uses the user ID to assign ownership to in the Fax Server Tree. The list of users appears in the right pane of
sent faxes and route received faxes to their intended recipients. You the window.
can customize each user's access to and usage of the system in
the user profile. Figure 9.1 The RightFax Users List
~lo|x|
File Edit Utlity Help
é Fax Servers (DS Name Route Code | Group Faunes | Subscriber | Rout «
M - R. htF U Bg;UUSTEF\ [Mamed Fipes] i ADMINISTRATOR | Administratar 1] EVERYONE (0 1] Fauh
IS _ BLEX AlerZ 100 EVERYONE |0 100 Fanh
anaglng Ig ax sers -gie Groups 2, BILL Bilv 100 EVERYOME |0 100 Fauh
Lghy Signatures &, CAaROL Carolbd 100 EVERYONE |0 100 Faxh
Every RightFax user in your organization has a unique user ID and (g fome, s T Y e
profile on a RightFax server. To add, edit, or delete RightFax user L_? T s é . ity b iioonel R Lo iy
profiles, run Enterprise Fax Manager (see “Starting Enterprise Fax (8 At VR v 0 |ommonc|s oo e
&, JANE JaneD 100 EVERYONE |0 100 Faxh

B Prefix Tables
B pedite Service Accounts

11 Users




Each user ID is preceded by an icon.

o If the icon is red, the user has administrative access.

o If the icon is yellow, the user does not have administrative
access.
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Adding a user

To add a new RightFax user, press INSERT or in the Edit menu,
click New. The User Edit dialog box opens. To configure the user
profile, see “Creating a User Profile” on page 121.
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o A dot indicates that the user is synchronized with another

o . . Figure 9.2 The User Edit dialog box
application, and editing changes should be made in that
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Understanding the default RightFax user

The “Default” user ID is included in the list of users on each
RightFax server. The Default user ID is used as a template for
creating new users. When you are configuring your RightFax users, |
edit the Default user to have the same attributes as the majority of
your fax users. Never delete the Default user.
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Cancel |

The new user will have the same attributes as the Default user ID,
except for the User ID, User Name, Password, and
Distinguished Name boxes. Because each RightFax user must
have a unique user ID, you must enter a value in the User ID box to
create the new user. All other boxes are optional. For information on
completing each of the options in each tab see “Editing user
properties” on page 121.



Deleting a user

To delete a user, select the user to delete and press DELETE or in
the Edit menu, click Delete. By default, you will be prompted for
confirmation that you want to delete the user.

Copying a user from one server to another

Using Enterprise Fax Manager you can copy one or more users
from one RightFax server to another. Select the users you want to
copy, and then drag the selection to another server. The amount of
information copied is configured in the Enterprise Fax Manager
Preferences dialog box (see “Setting Preferences” on page 110).

If you copy users from a new RightFax server version to an earlier
server version, you will lose configuration data that is not supported
by the older server (for example, features on version 8.7 servers will
not be available on version 8.5 servers).

Editing user properties

To edit the properties of an existing user, run Enterprise Fax
Manager, select the user to edit, and press ENTER or in the Edit
menu, click Edit. You can also double-click the user. The User Edit
dialog box opens.

To make global editing changes to selected groups of users, you
must use the Moduser.exe editing utility available as part of the
RightFax administrative utilities (downloadable separately from the
Captaris Web site).

Creating a User Profile

The user's profile is defined in the User Edit dialog box. This
section describes all the options in this dialog box.

The Identification tab

Figure 9.3 The User Edit Identification Tab
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User ID The unique identifier used throughout the RightFax
system to identify a user. In most cases, this ID should be the same
as the user’s network login name. The ID can be 21 characters
long.

Use Integrated Windows NT Security Each RightFax user
ID can be linked to a Windows user account to take advantage of
your network’s established Windows NT based security system
(see “Using Windows NT Security Authentication” on page 132).
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Click Select NT Account to enter a domain and account name to
link to the user. You can also select from a list of all user accounts
in each domain.

If you want this fax user to link to a Windows NT based user
account, select the Use Integrated Windows NT Security check
box to allow the user account to be accessed only via Windows NT
authentication. If a user's current Windows NT account is not
linked to any RightFax user |IDs, that user cannot manually enter the
user ID and password for anyone with this check box selected
when accessing client applications.

With this option, RightFax will authenticate the user based solely
on his Windows network account name and password, so the
RightFax Password field will be disabled.

User Name This is a descriptive name to help the administrator
identify users. If you will be adding user names with diacritical or
other characters refer to the RightFax Installation Guide for
information about character sets and code pages on your RightFax
server.

Password The password required by each user to access his
personal FaxUtil mailbox and to gain access to the fax server
settings in Enterprise Fax Manager. If you are creating a new user,
you can enter a password.

To change a user's password, click Change Password and enter a
new password. If you click Change Password and do not enter a
new password, the password will be erased and the user will not
be required to enter a password when accessing RightFax client
applications

Distinguished Name The Microsoft Exchange distinguished
name, used to confirm accurate RightFax and Exchange user
synchronization.

Group ID The name of the RightFax group to which the user
belongs. All users must belong to a group. For information on
creating new groups, see “Adding new groups” on page 136.
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Voice Mail Subscriber ID Specify the mailbox number to use
when routing faxes to a telephony server. This box is also used to
assign TeleConnect mailbox numbers to RightFax accounts
(requires the TeleConnect module, purchased separately).

Email address Enter the user's email address. This is required if
the user will be sending documents to email addresses in addition
to fax addresses via the RightFax client applications.

SMS/Mobile Address Enter the user's SMS-capable cell
phone number. This is the number to which SMS notifications
about the user’'s sent and received faxes will be sent.

Compute Disk Usage Click to calculate the space on the
server that is taken by this user’s faxes.

The Permissions tab

Figure 9.4 The User Edit Permissions Tab
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Administrative Access Gives users access to the
administrative functions of RightFax. Without this permission, a
user cannot open Enterprise Fax Manager or switch to another
user's mailbox without the correct password. All administrators can
run Enterprise Fax Manager and can switch to the mailboxes of
users belonging to their administered groups. Administrators with
this permission can not view any faxes other than their own without
also having the Administrator Can Bypass Privacy Restrictions
option also selected.

Administrator Can Bypass Privacy Restrictions Gives
users that have the Administrative Access option selected the
additional ability to view faxes in other users’ mailboxes. Only an
administrator that has this permission enabled can grant this
permission to other users.

Archive Sent Faxes Archives outbound faxes according to the
Archive options defined in the WorkServer configuration program
(see “Archive settings” on page 38).

Assign Default Billing Codes to Received Faxes Assigns
the user’s default billing code settings (see “Default Billing Codes”
on page 127) to all received faxes. This is most useful if you have
set RightFax to require billing codes on received faxes (see
“Requiring billing codes on received faxes” on page 159).

Bypass Billing Code Verification Allows the user to send
faxes without supplying correct billing codes. This attribute will not
exclude the user from having to supply other required fields in order
to send faxes. This attribute is only effective if billing code
verification is required system-wide.

Can Change Cover Sheets Lets the user change cover
sheets. If this check box is not selected, the user will be restricted
to using the cover sheet specified in the Default Outbound
Settings tab (page 126).

Can Edit/Add Forms Lets the user use the Store as Form
feature of FaxUtil to add new overlay forms to the RightFax system.

Can Edit/Add Library Docs Lets the user use the Store in
Library feature of FaxUtil to add new library documents to the
RightFax system.

Can OCR Faxes Allows the user to OCR faxes, either manually
or automatically, as defined in FaxUtil. This attribute does not affect
OCR routing and does not have to be enabled if OCR routing is
being used. You must have licensed the RightFax OCR Conversion
module for any OCR functions to be available.

Can Run Reports Lets the user create reports using the
RightFax Fax Reporter utility available at
http://www.captaris/support/downloads/rightfax/index.html.

Can Send SMS Messages Lets the user send documents to
SMS addresses from within the RightFax client applications.

Can Use High Priority Lets the user send faxes using “high”
priority. If disabled, the user is restricted to “normal” and “low”
priorities.

Disallow Billing Code Lookup Prevents the user from
viewing the list of valid billing codes. This requires the user to know
at least one valid billing code.

Note You must check both Disallow Billing Code Lookup and Disallow
Editing of Billing Codes to ensure that users will not be able to modify
their default billing code settings.

Disallow Editing of Billing Codes Prevents the user from
changing the default billing code settings for outgoing faxes. In
addition, any billing codes specified in phonebook entries are
ignored as are any <BILLINFO> embedded codes.

Disallow Fax Annotations Prevents the user from adding
notes to faxes.

Disallow Fax Deleting Prevents the user from deleting faxes.
This setting can be useful for persons doing manual fax routing. The
restriction applies to the user and not the mailbox, so if the user
switches mailboxes, he still cannot delete faxes.
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EDC Process Received Faxes This setting is used with
RightFax connectors that are purchased separately.

EDC Process Sent Faxes This setting is used with RightFax
connectors that are purchased separately.

Excluded from Group Fax Aging Excludes the user from the
automatic fax aging (image deletion) attributes of the group to
which he belongs.

Must Have Faxes Approved Requires every fax sent by the
user to be approved by a full, group, or alternate group
administrator.

Must Have Password Requires the user to have a password.
This does not restrict the user from changing his password.

Stamp Pages of Received Faxes with Audit Stamp
Enabled printing of the RTI line and adds one line of text to the
bottom of each received fax page listing total pages, date and time
received, fax server used, inbound routing code used, CSID of
sender, and transmission duration.

Unprotected Mailbox Allows all other RightFax users to view,
manipulate and delete documents in this user’s mailbox. This does
not affect the security of phonebook entries belonging to the user.

View First Page Only Restricts the user from viewing or
printing anything but the first page of a received fax. This is useful
when manual routing is employed. The restriction applies to the
mailbox regardless of the permissions of the user viewing the
mailbox. Faxes must be routed out of the restricted mailbox before
subsequent pages can be viewed or printed.
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The Inbound Routing tab

Figure 9.5 The User Edit Inbound Routing Tab

e 21 x|
Outbound Auto-Frinting | Default Receive Settings | Maotification
QOther | Pager Motification Adminiztiative Pager Alerts
|dentification I Permizzions Inbound Rauting | Default Outbound Settings

Routing Code [DIDADMIS number):
Fouting Tupe:
I Fax Maibox j
File Farmat:
[oc g
Flouting |nfo:
Enter a routing info template used to create new ugers. ~1=Full Name; ~2=Metwark |D
Beceived Fax Fouting Form:
I Syztem Diefault ﬂ
I~ | Delete after routing?

Routing Code (DID/DNIS Number) The routing code is a
unique number that RightFax uses to route received faxes to the
correct user. Enter the DTMF extension, DID phone number, or
channel number you have assigned to this user. When a fax is
received by the server, any routing information included is
compared to each user’'s Routing Code. If a match is made, the fax
is routed to the user’s mailbox. For more information on routing
faxes, see Chapter 283, “Routing Inbound Faxes”.

Note You must ensure that no routing code is used more than once. If
you do use the same routing code more than once, only one of the
persons to whom it is assigned will receive incoming faxes.
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Routing Type Specify where incoming faxes will be routed after
they arrive in the user’s fax mailbox. For more information on each of
the routing types, see Chapter 23, “Routing Inbound Faxes”.

File Format Choose the file format in which faxes will be
delivered when routed.

Table 9a File Formats for Routed Faxes

Format Description

DCX DCX combines multiple PCX pages into a single file.
It solves the multiple attachment problem of PCX
files but maintains the large file size (average of 135
Kb per page).

GIF GIF is graphics interchange format. This format is
available for routing in Microsoft Exchange.

PCX PCX produces a single page per file with an average
fax page size of 135 Kb. It is useful for routing
received faxes to DOS and Macintosh users
because DOS and Macintosh have built-in
capabilities to view PCX-formatted fax pages.

This format is not recommended for Windows client
applications, because PCX is a large format and
users have to sift through multiple attachments when
viewing multiple page faxes.

PDF PDF is portable document format.
TIFF-G3/ TIFF-G3 is a structured file type that is best for
TIFF-G4 monochromatic images like fax pages (average of 35

Kb per page). Most email systems have the ability to
read TIFF-G3 files, and you can associate the
RightFax Fax Viewer with TIFF-G3 files to view these
faxes in any application.

TIFF-G4 is a more compressed file format.

Routing Info Specify how to route the fax to the correct
destination for the Routing Type specified. If you route faxes to an
email mailbox, you must enter the email address here. For
information on the required Routing Info for each Routing Type
see Chapter 23, “Routing Inbound Faxes”.

Received Fax Routing Form Specify the Outlook form you
want to route incoming faxes to. Click “Default” to use the form set
in the Email Gateway configuration program (described in the
RightFax Gateway for Microsoft Exchange Guide). This list is only
available if you have selected “Exchange Mailbox” as your Routing
Type.

Delete After Routing Deletes received faxes from the user's
FaxUtil mailbox after the fax has been successfully routed to the
application specified in the Routing Type list.

If this check box is selected, notification of received faxes
(page 132) will not work.
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The Default Outbound Settings tab

Figure 9.6 The User Edit Default Outbound Settings Tab
userEit 2| x|

Outbound Auto-Frinting | Default Receive Settings | Naotification I
QOther | Pager Motification Administrative Pager Alerts |
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—Cover Sheet Default
¥ Send Cover Sheets?
Cover Shest Model: Cover Sheet Resolution:
[System Detait | |Fire (200« 200) =l
Private Fax Mumber: I
General Fax Humber: I
General Yoice Number: I
Fram Mame: I
Yoice Mumber: I

Default Fax Resolution Specify the resolution of the users
outbound faxes. Normal resolution (200x100 DPI) creates draft
quality images and allows shorter transmission times. Fine

resolution (200x200 DPI) is recommended for high quality printed
documents and Optical Character Recognition (OCR). This setting

affects the body of a fax, but not the cover sheet.

Default Priority Sets the priority at which all the user’s faxes are

responded to by the fax server unless specified otherwise in the
Fax Information dialog box when the fax is created.
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Auto-Delete Setting Specify when to delete sent faxes from
the user's FaxUtil mailbox. Although this option saves disk space,
automatically deleting sent faxes prevents the user from reviewing
or forwarding sent faxes. Enabling automatic deletion does not
affect the original document if it was created in another application.

If the user has the Archive Sent Faxes permission checked

(page 1283), or if they have enabled autoprinting of sent faxes in the
RightFax FaxUtil client application, sent faxes will not be
automatically deleted, even if this option is enabled.

Use Smart-Resume Allows the fax server to intelligently resend
only the portion of a fax which failed to send. For example, if the
connection is broken after 40 pages of a 50 page fax, normally all
50 pages have to be resent. By enabling Smart-Resume, the server
will only resend the last 10 pages.

This option can also be set by fax users on a per-fax basis from the
Fax Information dialog box (see “Using the Fax Information Dialog
Box” on page 254).

Send Cover Sheets Allows the user to send cover sheets with
faxes.

Cover Sheet Model Specify the default fax cover sheet file to

use. The list displays the fax cover sheet files in the RightFax\FCS
folder. Select Default to use the fax cover sheet specified for the

user's group.

Cover Sheet Resolution Specify the resolution of the user's
cover sheets. Normal resolution (200x100 DPI) creates draft
quality cover sheets and allows shorter transmission times. Fine
resolution (200x200 DPI) is recommended for high quality cover
sheets and Optical Character Recognition (OCR). This setting
affects the cover sheet only.

Sender Information Fields Specify the user's name, fax
number, and phone number information as it will appear on fax
cover sheets.
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The Other tab

Figure 9.7 The User Edit Other Tab
T 20|
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Cancel |

Automatic Fax List Updates Configures the user's FaxUtil
mailbox to automatically refresh (scan for new faxes).

Update Interval in Seconds Specify the interval at which
automatic fax list updates will occur.

Default Billing Codes Specify the Billing Code #1 and Billing
Code #2 settings that will appear in the Fax Information dialog
box each time the user sends a fax.

The Pager Notification tab

These settings let the fax server send SMS messages or pages to
RightFax users to notify them about the status of sent and received
faxes. This dialog box specifies the fax status messages to send to
the user. The text of the status messages that will be sent can be

customized in the User Messages tab of the RightFax Server
configuration program in Windows Control Panel (described on
page 27).

Before completing this dialog box, you must configure a list of SMS
and pager service types and providers. For information on
configuring pager or SMS services, see Chapter 17, “Adding SMS
and Pager Services”

Figure 9.8 The User Edit Pager Notification Tab

User Edit 21x|
Default Dutbound Settings I Outbound Auta-FPrinting I Default Receive Settings
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Cancel |

Pager ID Specify the user's pager ID. This is usually a numeric
ID and is often the phone number for the pager.

Pager/SMS Service Select the pager or SMS service to use
for delivering the notification. If you have not added and properly
configured paging/SMS services for this user, you must do so
before completing this dialog box (described in Chapter 17,
“Adding SMS and Pager Services”).
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Test SMS This button lets you send a test message to an
SMS-capable device. To send a test SMS message, select an
SMS service in the Pager/SMS Service box, type a phone number
in the Pager ID box, and then click this button.

New Fax is Received Pages the user each time a new fax is
received. If the TeleConnect module is installed, the RightFax
server will include the TeleConnect ID with all notifications of
incoming faxes. This lets users retrieve faxes without first
requesting a fax list.

New Fax is Received from Specific CSID/ANI Pages the
user each time a new fax is received from one or more specific
senders that are specified in the Patterns box.

Patterns Lists the CSID or ANI numbers that, when received,
will send a page alert to the user. Separate multiple numbers with
semicolons.

Outbound Fax has been Abandoned Pages the user each
time one of his outbound faxes fails to send for any reason.

The Administrative Pager Alerts tab

These settings let the fax server send SMS messages or pages to
RightFax administrators to alert them of specific RightFax events.
This dialog box specifies the RightFax server status messages to
send to the user. The text of the alert messages that will be sent
can be customized in the Admin Messages tab of the RightFax
Server configuration program in Windows Control Panel
(described on page 28).

RightFax Enterprise versions 8.7 and higher include a more
comprehensive Alerting and Monitoring service that lets you select
from hundreds of server statistics to monitor and define the event
thresholds, alert types, and alert messages to send. For more
information on the RightFax Alerting and Monitoring service, see
Chapter 18, “Using the Alerting and Monitoring Service”.
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Before completing this dialog box, you must configure a list of SMS
and pager service types and providers. For information on
configuring pager or SMS services, see Chapter 17, “Adding SMS
and Pager Services”.

Figure 9.9 The User Edit Administrative Pager Alerts Tab
User Edit 2lx

Default Dutbound Settings | Outbound Auta-Frinting I Default Receive Settings I
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[~ Perigdic Server Heartbeat?
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Cancel |

Pager ID Specify the user's pager ID. This is usually a numeric
ID and is often the phone number for the pager.

Pager/SMS Service Select the pager or SMS service to use
for delivering the alert message. If you have not added and properly
configured paging/SMS services for this user, you must do so
before completing this dialog box (described in Chapter 17,
‘Adding SMS and Pager Services").



Test SMS This button lets you send a test message to an
SMS-capable device. To send a test SMS message, select an
SMS service in the Pager/SMS Service box, type a phone number
in the Pager ID box, and then click this button.

Low Disk Space Free hard drive space on the RightFax server
has fallen below 150 MB.

Critically Low Disk Space Free hard drive space on the
RightFax server has fallen below 50 MB.

Send Queue too Deep The number of faxes or fax pages
queued to send exceeds a fixed number. Enter the number of faxes
to exceed in the Faxes box. Enter the number of fax pages to
exceed in the Pages box.

Fax Server Event Queue Full The percentage of the fax
server's internal Event Queue has reached 90%. For more
information on the RightFax Event Queue see “Understanding the
Fax Server Internal Event Queue” on page 33.

BoardServer Service Down One of the BoardServers has
become unable to send or receive faxes.

All BoardServers Down All of the BoardServers have become
unable to send or receive faxes.

Probable Line Failures An error or series of errors has
indicated to the BoardServer that a phone line is not operating
correctly.

Probable T1 Failure Multiple phone lines have failed in such a
way that the BoardServer suspects a T1 line is not operating
correctly.

Server improperly shut down The RightFax Server module
was shut down unexpectedly. This may indicate that the operating
system has failed or the server has lost power.

Periodic Server Heartbeat Sends a brief notification of the
RightFax server's status, including statistics on fax activity. When
you select this check box, you must also specify the Heartbeat
Interval, in minutes.

Understanding the Alert Frequencies

After an alert is triggered, the problem causing the alert must be
remedied within a set length of time before a fault of the same type
will cause another alert. For example, this prevents free disk space
fluctuating around 50 Mb from causing repeated alerts. If an alert
condition persists, the alert will be repeated periodically. Different
types of alerts have different delays and repeat intervals as listed in
the following table.

Table 9b Pager Alert Frequencies

Repeat
Alert Delay interval

All BoardServers are down. 10 minutes | 60 minutes

BoardServer send queue too deep. | 30 minutes | 90 minutes

Disk space is critically low 10 minutes | 30 minutes

(<50MB).

Disk space is getting low 20 minutes | 60 minutes

(<150MB).

Fax server internal queue has 30 minutes | 90 minutes

reached 909% utilization.

One or more BoardServers are 10 minutes | 60 minutes
down but one or others are still in

service.

Alerts that are not listed here are sent only once, when the alert
condition occurs.
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The Outbound Auto-Printing tab

Figure 9.10 The User Edit Outbound Auto-Printing Tab

O 2| x|
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Enable Automatic Printing of Sent Faxes Prints a copy of
all sent faxes. If this check box is selected, you must also select a
printer from the list of available printers. These are the printers that
you have set up under Printers in Enterprise Fax Manager (see
“‘Adding a printer” on page 149).

When to Print Specify whether to print successfully sent faxes,
faxes that were not successfully sent, or both.

What to Print Specify whether to print the fax history, the fax
cover sheet, and/or the fax body.
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The Default Receive Settings tab

Figure 9.11 The User Edit Default Receive Settings Tab
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Cancel

Automatic Forwarding Options Forward the user's faxes to
either a fax machine or another network user as soon as they are
received. Specify the fax number or RightFax user ID to forward to.

Automatic Printing Options Automatically print received
faxes. Select a printer from the list of available printers. These are
the printers that you have set up under Printers in Enterprise Fax
Manager (see “Adding a printer” on page 149). Click a print
resolution in the Resolution list.

Automatic OCR Options Convert all received faxes to text
using OCR (optical character recognition). This option requires the
RightFax OCR Converter module. Enter a three-letter file extension
for the output file in the Extension box.
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In the Format list, click the text format used to interpret your fax
pages. “ASCII" produces a plain text file. “Smart ASCII”
approximates the original format. “RTF” (rich text format) preserves
fonts and formatting but is only available for Windows clients.

In the Layout list, specify how you want the text to be formatted on
the page. “WYSIWYG" (What You See Is What You Get) will try to
read the fax in the layout it sees. If, for instance, RightFax sees that
the fax has three columns, it will try to read the document in column
style. “Left Justified” displays the text starting from the left margin of
the fax.

The Notification tab

These settings let you configure the fax server to notify RightFax
users about the status of sent and received faxes via email or SMS
text messaging. The text of the status messages that will be sent
can be customized in the Custom Messages tab of the RightFax
Server configuration program in Windows Control Panel
(described on page 25).

If you want to send notifications via SMS text messaging, you must
configure a list of SMS service types and providers before
completing this dialog box. For information on configuring SMS
services, see Chapter 17, “Adding SMS and Pager Services”.

If you want to use Network Broadcast notifications and are using
Windows 2003, you must open the Control Panel and enable the
Messenger service, which is disabled by default.

In addition, Network Broadcast notifications are not possible with
Windows Vista clients, as the Messenger service is not included
with Windows Vista.

Figure 9.12 The User Edit Notification Tab
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Method Select the notification method for the user.

e Use Group’s Method. Uses the notification method defined for
the group to which the user belongs (described on page 136).

e SMS. Sends the notification to an SMS capable device. If you
select this option, you must select an SMS service in the SMS
Service box.

« Email Systems. Sends the notification to the user’'s email box.
(Notes and Exchange notifications require you to purchase and
license a separate module.) You must specify the email address
of the user in the Notification Address/Info box.

¢ Custom notification methods. These can be created using the
RightFax API. Information on the RightFax API can be found at
www.captaris.com.

Note If you are routing inbound faxes to an email gateway or other
destination on your network and you have select the Delete After Routing
check box (page 125), no notifications for received faxes will be sent.

SMS Service Select the SMS service to use for delivering the
notification. If you have not added and properly configured an SMS
service, you must do so before completing this dialog box
(described in Chapter 17, “Adding SMS and Pager Services”).

Test SMS This button lets you send a test message to an
SMS-capable device. To send a test SMS message, select an
SMS service in the SMS Service box, type a phone number in the
Notification Address/Info box, and then click this button.

Notification Address/Info Specify the user's email address
for email notification, or other information necessary for sending fax
notifications of the type selected in the Notification Method list.

Notification About Outbound Faxes Specify the events for
outbound faxes for which the user will receive notification.

Notification About Received Faxes Specify the events for
received faxes for which the user will receive notification. If you
select the check box Reroute Received Fax Notification, you
must also select a RightFax user ID to route to from the list.
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Using Windows NT Security Authentication

RightFax Enterprise servers can take advantage of your network'’s
established Windows security system by linking each RightFax
user ID to a Windows user account. When logging on to client
applications that require authentication (such as Enterprise Fax
Manager and FaxUtil), RightFax attempts the Windows account
name and password with which you are currently logged on. If the
current Windows account name and password have been linked to
a RightFax user ID, that RightFax ID is used to log on. If no
RightFax user account is linked, a dialog box opens prompting you
to manually enter your RightFax user name and password.

Each user’s link status is displayed under the NT Account Link
Status column in the user list in Enterprise Fax Manager. The
status “N/A" means that the user is not required to log on via
Windows NT authentication. “No NT Account Assigned” means
that the user is required to log on via Windows NT authentication
but is not linked to a Windows account. (This user will be allowed
to log on manually.) “NT Account Assigned” means that the user is
required to log on via Windows NT authentication and is linked to a
Windows NT based account. This RightFax ID can only be
accessed when the user is logged on to Windows NT based
network with the linked account.

Linking RightFax user IDs to Windows NT based accounts

RightFax Enterprise server provides several methods for linking one
or more RightFax user IDs to existing Windows NT based
accounts.

To link a RightFax user ID

1. Edit the user properties in Enterprise Fax Manager.

2. Click the Identification tab.

3. Select the Use Integrated Windows NT Security option.
4. Click Select NT Account.
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5. Type or select the Windows domain and account names to link
and click OK. The linked domain and account name will be
listed under the RightFax user ID in the Identification tab.

Note You can only use the Windows NT account lookup feature
when you are running Enterprise Fax Manager on the RightFax server
or a Windows workstation.

To automatically link one or multiple existing RightFax
User IDs

1. In the Enterprise Fax Manager user list, select one or more
RightFax users.

2. Right-click any selected user to open a shortcut menu, and
select Enable NT Authentication and Link from the pop-up
menu.

RightFax links each selected user ID to the matching Windows
account in the domain to which you are currently logged on. If
there is no matching Windows account name in the current
domain, no link is created.

To automatically link all new user IDs

Because all new RightFax user IDs created in Enterprise Fax
Manager use the default user ID as a template, you can configure
the default user ID so that all new user IDs automatically link to
Windows accounts.

1. In Enterprise Fax Manager, edit the default user ID.

2. Click the Identification tab and select the Use Integrated
Windows NT Security option. Click OK.

For each new user ID you create in Enterprise Fax Manager,
RightFax will link the user ID to the matching Windows account
in the domain you are currently logged on to. If there is no
matching Windows account name in the current domain, no link
is created.

Importing Users

To simplify the process of setting up all your network users in the
RightFax server, you can import users into the fax server from your
network or from an ASCI file.

To import users from a Windows NT based network

1. In Enterprise Fax Manager, on the Utility menu, click Import
Users from NT Domain. The Import Users from NT
Server/Domain dialog box opens.

Figure 9.13 The Import Users from NT Server/Domain Dialog Box
2l
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2. Enter the computer name of the Primary Domain Controller
(PDC) or Backup Domain Controller (BDC) from which the
users will be imported.

3. Select the group to import.

4. Specify the RightFax user ID to use as a template (usually
Default).
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5. If you want to automatically assign a routing code to each user,
select the Automatically Assign Routing Codes check box,
and then enter the starting code. The first imported user will
receive the starting routing code and each additional user's
routing code will increment by one. If the system increments to
a routing code that already exists, it will be skipped.

6. When you have completed the dialog box, click Import to begin.



Chapter 10
Creating Groups of Users

You can create groups of users to which you can assign a common

Managing Groups

administrator, alternate administrator, fax options, and fax cover
sheet. You can use groups to subdivide your organization and
manage the fax server system more efficiently. For example, you
can create separate Marketing and Sales groups on the fax server.
Instead of having one administrator responsible for all fax users in
your organization, you can assign fax administrators to the
Marketing and Sales departments.

Groups can also play an important role in when notifying users of
new faxes. If a user does not respond to his notification by viewing
or printing a new fax within a specified time, the group
administrator will be alerted to the fax and can then print the fax or
forward it to someone else.

To add, edit, or delete groups of RightFax users, run Enterprise Fax
Manager (see “Starting Enterprise Fax Manager” on page 109) and
click Groups under the appropriate RightFax server in the left pane
of the window. If groups have been defined, the list of groups
appears in the right pane.

Figure 10.1 The Server Groups List
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Adding new groups

To create a new group, press INSERT or select New from the Edit
menu. The Group Edit dialog box opens. Because each RightFax
group must have a unique group ID, you must enter a value in the
group ID box. All other boxes are optional. For information on
completing each of the options on each tab see “Editing Group
Properties” on page 136.

Deleting groups

To delete a group, select the group to delete and press DELETE or
select Delete from the Edit menu. By default, you will be prompted
for confirmation that you want to delete the group.

Copying groups from one server to another

In Enterprise Fax Manager, you can copy one or more groups from
one RightFax server to another. Select the groups you want to
copy, and then drag the selection to another server.

If you copy groups from a new RightFax server version to an earlier
server version, you will lose configuration data that is not supported
on the older server (for example, features on version 8.5 servers will
not be available on version 8.0 servers).

Editing Group Properties

To edit the properties of an existing group, run Enterprise Fax
Manager, select the group to edit and press ENTER, or select Edit
from the Edit menu. You can also double-click the group. The
Group Edit dialog box opens.
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The Basic Information tab

Figure 10.2 The Group Edit Basic Information Tab

Group Edit 21 x|
Smart Fax Distribution I Fax Dialog Customization I
Basic Information | Automatic Fax Aging | Forced Scheduling
Group |D: | SEEENEITE
Ldministrator: |ADMINI5TF|ATDF|
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Cover Sheet Model: I{S_'.'stem Default} |
Matification Type: INetwork Broadcast j
Days to keep deleted fax records: ISU—
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&l faxes must be held for preview?—
|

Group ID The unique ID for this group.

Administrator Specify the user ID of the person who will be the
administrator of this group. The administrator has access to all the
mailboxes in the group and receives alerts when a user has not
printed or viewed a fax before the time specified in User Notify
Time in the RightFax Server configuration program expires (see
“User Notify Time" on page 23).

Alternate Administrator Specify the user ID of the person
who will be the alternate administrator of this group. The alternate
administrator will have access to all the mailboxes in this group and
will receive messages about faxes belonging to group members if
the user and the administrator have not printed or viewed a fax in
the designated interval.

Cover Sheet Model Specify the default fax cover sheet for the
group. The list displays the fax cover sheet files in the
RightFax\FCS folder. Selecting “Default” uses the cover sheet file
FCS.pcl.

Note Coversheet names must be 1-13 characters long and conform to
the 8.3 naming standard.
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Notification Type Specify the default notification method for
the group.

Days to keep deleted fax records The days keep deleted fax
records setting is based on the date the fax was recieved, not the
deleted date. Specify the number of days to keep records of
deleted faxes in the RightFax database. If set to O (zero), deleted
fax records will never be automatically purged by the fax server.

All faxes must have cover sheets Requires all users in the
group to use a cover sheet on outbound faxes.

All faxes must be held for preview All the faxes for users in
the group will be held for preview before they are sent. Users must
view the faxes and verify that they should be sent.

The Automatic Fax Aging tab

With automatic fax aging, you can specify the number of days after
the date a fax is sent or received that it will be deleted from a user’s
FaxUtil mailbox. Automatic fax aging is only available if you have a
RightFax Enterprise or Satellite server.

Automatic fax aging does not remove the fax records from the
RightFax database, so you can still run reports about the faxes.

You can also perform manual fax aging with the Faxage.exe
program.

Figure 10.3 The Group Edit Automatic Fax Aging Tab
Crovp Edit 21X

Smart Fax Distribution | Fax Dialog Customization |
Basic Infarmation Automatic Fax Aging | Farced Scheduling
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Cancel |

For each type of fax, enter the number of days the fax will remain
before it is deleted. To specify that faxes should not be deleted,
enter O (zero).

To apply these settings to all the users’ folders, select the check
box Settings apply to all user folders. To disable fax aging, click
to clear the check box.

The Forced Scheduling tab

Forced scheduling controls fax traffic volume on the basis of user
groups. You can restrict the total number of pages or total number
of faxes that are sent simultaneously by all users in the group and
limit these restrictions to a specific time period.

For example, if you have 50 sales representatives, each sending
100 faxes every hour, all of your fax channels may be continuously
busy processing their faxes. This could delay more important faxes
from other departments, as well as block incoming faxes. With
Forced Scheduling, you can restrict the members of the Sales
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group to sending no more than 20 pages at a time between the
hours of 8 A.M. and 5 P.M. and delay any faxes over that limit until
6 PM.

This feature restricts only simultaneously scheduled faxes. It does
not restrict the total number of faxes or fax pages that can be sent
during the specified time period. If a fax exceeds the maximum limit
and is delayed until a later time, it can be rescheduled at any time
by selecting Fax > Forward to New Number in FaxUtil.

Figure 10.4 The Group Edit Forced Scheduling Tab
GroupEdit 2| x|

Smart Fax Distribution | Fax Dialog Customization |
Basic Information | Autarnatic Fax Aging Forced Scheduling

Enabled? W

M aximum Concurent Pages: (100

b awimum Concurrent Faxes: IU—
Starting Time [HHkk): W
Ending Time (HHMM): [0000

Delay Until Time [HHMM]: W

Cancel |

Enabled Enables the Forced Scheduling feature.

Maximum Concurrent Pages Specify the maximum number
of fax pages that can be scheduled at one time by all the users in
the group.

Maximum Concurrent Faxes Specify the maximum number of
faxes that can be scheduled at one time by all the users in the
group.

Starting/Ending Time The starting and ending times for the
period that the restriction applies. This is written in 24-hour HHMM
format. For example, to set the restriction from 8:00 A.M. to 5:30
P.M., set the Starting Time to 0800, and set the Ending Time to
1730.
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If during this time period any faxes exceed the limits you specify,
those faxes will be delayed until the time you specify in the Delay
Until Time box.

Delay Until Time The time at which delayed faxes will be sent.
This is written in 24-hour HHMM format. For example, to send
delayed faxes at 6:00 P.M., enter 1800.

If the Delay Until Time falls between the Starting and Ending
times, automatically delayed faxes will never be sent. This is
because delayed faxes, by definition, cannot be sent between your
Starting and Ending times. In such a case, delayed faxes will be
continuously bumped to the next day at that same time.

The Smart Fax Distribution tab

With smart fax distribution, a group routing code is created and all
faxes received by the group are distributed systematically between
all the users in that group.

Figure 10.5 The Group Edit Smart Fax Distribution Tab

GroupEdit P =
B asic Infarmation | Lutomatic Fax Aging | Forced Scheduling |
Smart Fax Distribution Fax Dialog Custamization
Enabled? ¥
Bouting Code: |11T1
Distribution Type: ILinear j
R 4

Cancel |

Enabled Enables smart fax distribution for this group.
Routing Code Assigns a routing code to the group.
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Distribution Type Specify either linear or balanced distribution.
With linear distribution, faxes are distributed to each group member
in succession. With balanced distribution, faxes distribution is
determined by each user's processing rate. If one user is faster at
processing faxes than another, the faster user is distributed faxes at
a faster pace.

Member Refusal Allowed Lets users take themselves
temporarily out of the distribution loop. When this check box is
selected, users can refuse faxes by running FaxUtil and selecting
Tools > Refuse Distributions. This option is enabled by default
and must be disabled to allow per user customization

The Fax Dialog Customization Tab

This group of check boxes lets you customize the appearance of
the Fax Information dialog box (the dialog box used to create and
address outgoing faxes) for the users in this group. This is useful
for removing options that do not apply to or should not be changed
by these users.

Note The Fax Dialog Customization tab is available with Enterprise
editions of RightFax only.

Figure 10.6 The Group Edit Fax Dialog Customization Tab
Grop Ecit 21

Basic Information | ALutomatic Fax Aging | Forced Scheduling |

Smart Fax Distribution Fax Dialog Customization

To remove an oplion from the Fazx Information dialog box, click to
clear the check box for the option.

itdd Phonebook Entre Button fa
Alternate Fax Number
Auto-Delete Contral
EBilling Infarmation #1 Entry Field

Billing Information #2 Entry Field
Eflling Infarmation Lookup Button

Call-B ack/Confirmation Checkbow
Ceified Checkbox

City/State Entry Field

Company Entry Field

TRIKRE R KR REEE]

Cover Sheet Selection Button -
Frvwer Ghast T ande hd|

The following table lists each of the checkboxes on this dialog box,
and the tab and option on the Fax Information dialog box that
each checkbox represents. For more information on the options in
the Fax Information dialog box, see Chapter 25, “Creating,
Sending, and Deleting Faxes”.

Table 10a Fax Dialog Customization Checkboxes

Fax Information

Checkbox dialog box tab Option

Acquire Attachments | Attachments Scanner button (scanner icon)

from Scanner

Add Phonebook Entry | Main Add Entry button

Button

Alternate Body Attachments Ability to display Alt. Body

Attachment Checkbox column in Selected
Attachments list

Alternate Fax Number | Main Alt. Fax Number text box

Auto-Delete Control

More Options

Automatic Deletion selection
box

Billing Information #1 | Main Billing Code 1 text box (title

Entry Field may vary)

Billing Information #2 | Main Billing Code 2 text box (title

Entry Field may vary)

Billing Information Main Lookup button

Lookup Button

Browse for File Attachments Browse button (folder icon)

Attachment

Certified Checkbox Main Use certified delivery
checkbox

City/State Entry Field | Main City/State text box

Comments Text

Cover Sheet Notes

Comments for your Records
text box
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Table 10a Fax Dialog Customization Checkboxes (Continued)

Checkbox

Fax Information
dialog box tab

Option

Company Entry Field

Main

Company text box

Cover Sheet
Selection Button

More Options

Cover Sheet File selection
box

Cover Sheet Toggle

Main

Use cover sheet text box
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Table 10a Fax Dialog Customization Checkboxes (Continued)

Checkbox

Fax Information
dialog box tab

Option

Phonebook Import
Main Menu Option

Main

Phonebook button

Delay Send Controls

Main

Delay send checkbox and
time/date fields

Phonebook Selection | Main Phonebook button
Button
Preview Checkbox Main Hold for preview checkbox

Form Type Selection

More Options

Use form checkbox and
selection list

From Name Entry
Field

More Options

Name text box

Priority Checkbox More Options Priority selection box
Private Fax Number N/A Phonebook Import option on
Entry Field the Tools menu in FaxUtil.

From Phone Number
Entry Field

More Options

Voice Number text box

Recipient Type Field

Main

Down arrow button next to the
Fax number text box that lets
users select the Email
address option

General Fax Number
Entry Field

More Options

Company Fax Number text
box

General Voice
Number Entry Field

More Options

Company Voice Number text
box

Secure
Send/Recipient Fax
ID Control

More Options

Recipient Fax ID text box

Library Document/
Attachments
Selection

Attachments

Available Attachments library
document list and File Attach
button (paper clip icon)

‘More Options’ Tab

More Options

All tab contents

Native Attach
Document Checkbox

Attachments

Native column in Selected
Attachments list

Smart-Resume Main Use smart-resume checkbox
Checkbox

Transmission Quality | Main Fine mode checkbox

Control

Use PDF Checkbox Main Create PDF image checkbox
Voice Number Entry | Main Voice Number text box

Field

‘Notes' Button/Tab

Cover Sheet Notes

All tab contents

Notes Text Cover Sheet Notes | Notes to be Placed on the
Cover Sheet text box
PDF Options Main PDF Options button (next to

Create PDF image checkbox)
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Chapter 11
Creating Signatures

A

RightFax can personalize users’ outbound faxes with graphic
images of their signatures. Signature images are created in FaxUtil
and stored in the RightFax\SIG folder on the server. Enterprise Fax
Manager catalogs all the signatures and maintains the file names,
descriptions, and authorized user information.

Note Signature files are currently not supported in outbound PDF
documents.

Managing Signature Files

To edit or delete signature files, run Enterprise Fax Manager (see
“Starting Enterprise Fax Manager” on page 109) and click
Signatures under the desired RightFax server in the Fax Server
Tree.

You must create a new signature file in order for it to appear as an
object in Enterprise Fax Manager. New signature files are created
from the FaxUtil mailbox (see “Creating a New Signature File” on
page 142).

Deleting signatures

To delete a signature, select the signature to delete and press
DELETE or select Delete from the Edit menu. By default, you will

be prompted for confirmation that you want to delete the signature.

Deleting the signature’s reference in Enterprise Fax Manager does
not delete the signature file itself. A second confirmation dialog box
will ask you if you want to delete the file as well.

Copying signatures from one server to another

Enterprise Fax Manager can easily copy one or more signatures
from one RightFax server to another. Select the signatures you
want to copy, and then drag the selection onto another server.

If you copy signature files from a new RightFax server version to an
earlier server version, you will lose configuration data that is not
supported by the older server (in other words, features on version
8.0 servers will not be available on version 7.0 servers).
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Editing Signature File Properties

To edit the properties of an existing signature, run Enterprise Fax
Manager, select the signature to edit and press ENTER or select
Edit from the Edit menu. You can also double-click the signature.
The Edit Signature dialog box opens.

Figure 11.1 The Edit Signatures Dialog Box
2%
Signaturs Code: [lane |
OwrefsUserD: [JanD
Description: [lane's Signatwe
Image File Name: [0000T004.CFG 7|

Autharized Uszer
|J anel

Cancel

Signature Code The name the signature that will be displayed
in Enterprise Fax Manager.

Owner’s User ID The user ID of the owner of the signature file.

Description A description of the signature file for easy reference
in Enterprise Fax Manager.

Image File Name The name of the signature image file. This file
name is automatically generated and stored in the RightFax\SIG
folder on the RightFax server when the signature file is created. If
this box contains an invalid file name, RightFax will not be able to
use the signature image.

Authorized Users Up to three RightFax user IDs or group IDs
who are authorized to use this signature in addition to the owner of
the signature.
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Creating a New Signature File

Only users with RightFax administrative access can create
signature files. Signature files are created from a fax in a your
FaxUtil mailbox. You can scan a signature into your mailbox or fax a
signed document to yourself. After the document arrives in your
FaxUtil mailbox, follow these steps to create a signature file:

1. In FaxUtil, double-click the fax to view it using the RightFax Fax
Viewer.

2. Using the Select tool in the Fax Viewer toolbar, click the
signature.

Figure 11.2 The Select tool

&

3. Select Store from the Fax menu, and then select Make
Signature. The Edit Signature dialog box opens.

Enter an ID for the signature in the Signature Code box. This
must be unique, as it will be the identifying code Enterprise Fax
Manager displays in the ID column when viewing the list of
signatures. Enter the owner’s user ID and a description of the
signature. In the Authorized Users boxes, list up to three
RightFax user IDs or group IDs who are authorized to use this
signature in addition to the owner of the signature.

Adding a Signature to a Fax

4N

Signature files are inserted into fax-bound documents using the
<SIGNATURE> embedded code. For information on using this
and other embedded codes see Appendix A, “RightFax Embedded
Codes".

Caution Signature files will not display properly in documents that have
been converted to PostScript.
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Controlling signature placement

Signature images are positioned so that the left-middle point of the
signature aligns with the left-middle point of the <SIGNATURE>
embedded code in the document. RightFax supports a Windows
registry entry that modifies the vertical alignment of new signatures
created on the client workstation where the registry value is
present.

Table 11a Windows Registry Entry for Vertical Placement of Signature

Category Value

Key HKEY_CURRENT_USER\Software\RightFax
Client\VWR32

Value SignaturePositionPercent

Type DWORD

Data 0-100 (default 35)

Increasing the data for this value causes all newly created
signatures to be shifted upwards by a percentage of the height of
the signature image (the actual distance depends on the height of
the signature). Decreasing the data causes signatures to shift
down an equal distance.

This registry value only affects signatures when they are initially
created. If you change the data for this value, you will need to
recreate each signature that you want the new setting applied to.
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Chapter 12
Creating Overlay Forms

Overlay forms are fax image files that RightFax can superimpose Copying forms from one server to another
over outgoing faxes. These “forms” are typically replicas of

documents that your organization uses (for example, company
letterhead) and give your faxes the appearance of being printed on
the form prior to faxing.

In Enterprise Fax Manager, you can copy one or more forms from
one RightFax server to another. Select the forms you want to copy,
and then drag the selection to another server.

If you copy overlay forms from a new RightFax server version to an
earlier server version, you will lose configuration data that is not
Managing 0verlay Form Files supported by the older server (for example, features on version 8.5

servers will not be available on version 8.0 servers).
To edit or delete forms, run Enterprise Fax Manager (see “Starting

Enterprise Fax Manager” on page 109) and click Forms under the
RightFax server in the Fax Server Tree.

You must create a new form file in order for it to appear as an
object in Enterprise Fax Manager. New form files are created from
the FaxUtil mailbox (see “Creating a New Overlay Form” on

page 146).

Deleting a form

To delete a form, select the form to delete and press DELETE, or
select Delete from the Edit menu. You will be prompted for
confirmation that you want to delete the form. Deleting the form'’s
reference in Enterprise Fax Manager does not delete the form file
itself. A second confirmation dialog box will ask you if you want to
delete the file as well.
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Editing Form File Properties

To edit the properties of an existing form, run Enterprise Fax
Manager, select the form to edit and press ENTER, or select Edit in
the Edit menu. You can also double-click the form. The Edit Form
dialog box opens.

Figure 12.1 The Edit Form Dialog Box
EdtForm 21X
Eorm Mumber.

Famn [D ICDPY
Description ICopy back ground

Start Page:

IU
Number of Pages: ID
IU

Mext Farm Mumber

Image File Mame: ICUD}I.BDT 'I

Secure Fom? [

Authorized Group or ser; I VI
Cocet_|

Form Number The number that identifies the form. This is
assigned by RightFax when the form is created.

Form ID This is a unique name that identifies the form.

Description This is a description of the form file for easy
reference in Enterprise Fax Manager.

Start Page Specifies the first page of the body of the fax
document onto which the form will be placed. The page numbers
you specify are absolute, so if the start page for a form is set to 3
and you apply it to a document that only has two pages, none of
the document pages will include the form.

Note Overlay forms are never placed on fax cover sheets. If you enter 1
in the Start Page box, the form will appear on the first page of the body of
the fax following the cover sheet.
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Number of Pages The number of fax pages that will be overlaid
with the form. To overlay each page of the fax with the form, enter O
(zero).

Next Form Number Specifies the second form to use, if you
want to use two overlay forms in one fax (i.e., different forms for the
first page and all subsequent pages of your company letterhead).
Specify the form number of the next form file. For more information
on using two overlay forms in a single fax, see “Using Two Overlay
Forms in One Fax” on page 147.

Image File Name The name of the form image file. This is
automatically generated and stored in the RightFax\Papers folder
on the RightFax server when the form file is created. If this box
contains an invalid file name, RightFax will not be able to use the
form image.

Secure Form Restricts the form to specific groups or users. To
secure a form, select the Secure Form check box. In the
Authorized Group or User list, click the users or groups
authorized to use the form.

Creating a New Overlay Form

To create new overlay forms in FaxUtil, you must be assigned
permission in your user profile (see “The Permissions tab” on
page 122).

Form files are created from faxes in your FaxUtil mailbox. You
should always create forms using fine resolution. To set fine
resolution as the default in FaxUtil, select Tools > Options, and the
Options dialog box opens. On the Sending tab, select the Use
Fine Mode check box.
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To create a new overlay form Using Two Overlay Forms in One Fax

1. Create the form image in a word processor or any other You can configure two overlay forms to appear in a fax. For
application that lets you print to the RightFax fax printer. Send example, page 1 of the fax may include company letterhead, and
the fax image to your FaxUtil mailbox. pages 2, 3, 4, and 5 may include an invoice form.

2. Run FaxUtil and click the form in the list of received faxes. After the two forms have been configured following these

instructions, then each time you add the first form to an outgoing
fax, it will automatically be followed by the second form because
they are linked.

3. Select Fax > Store as Form, and the Store Fax as Form
dialog box opens.

Figure 12.2 The Store Fax as Form Dialog Box

ST HE To configure two forms for use in a single fax document
[remeEE — . 1. Create two forms according the instructions in “Creating a New
om [D: |Letterhea -
Famio:] Overlay Form” on page 146.
LDiescription: [Letterhead
S :2_ 2. Run Enterprise Fax Manager and edit the properties of the first
S of the two forms (described on page 146).
¥ Dverlay on Al Pages i .
Humbimf pagej — 3. In the Edit Form dialog box, in the Start Page box, enter the
I secued page number that you want the first form to initially appear on. In
AZ]C:;:ZBdGW ol most cases, this value will be set to 1.
| =
Ao Fosshad Note Overlay forms are never placed on fax cover sheets. If you
SRR enter 1 in the Start Page box, the form will appear on the first page of
171 Line Removak: [Erase TTI Lines =l the body of the fax, following the cover sheet.
s — B [ o | 4. In the Number of Pages box, enter the number of pages on
EEN which you want the first form to appear. If the first form will only
be used on the first page, enter 1.

4. In the Form ID box, enter a unique ID for the form. The 5. In the Next Form Number box, enter the form number of the
remaining boxes are the same as those in the Edit Form dialog second form to use. Click OK to close the Edit Form dialog
box (see “Editing Form File Properties” on page 146). box.

5. When you have completed the dialog box, click OK. The new 6. Edit the properties of the second of the two forms.
form will now appear in the Forms list in Enterprise Fax 7. In the Edit Form dialog box, in the Start Page box, enter the
Manager. page number that you want the second form to appear on. In

most cases, this value will be set to 2.
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8. In the Number of Pages box, enter the number of pages on
which you want the second form to appear. If you want the
second form to appear on all subsequent pages, enter O (zero).

9. Click OK to close the Edit Form dialog box.

Adding an Overlay Form to a Fax

Overlay forms are inserted into fax-bound documents using the
<FORMTYPE> embedded code or by specifying the form to use in
the Fax Information dialog box. For information on the Fax
Information dialog box, see “Using the Fax Information Dialog Box”
on page 254.



Chapter 13
Connecting Printers and Scanners

You can define an unlimited number of network printers in RightFax Deleting a printer
and make them available for automatic printing of faxes and other
automated network print functions. Printers can be added
individually or imported in groups from your network. The printers
you configure here are not the printers and print-to-fax devices that
allow RightFax users to fax documents from native applications. . .
Rather, these are the printers available to RightFax for automatically Copying printers from one server to another
printing sent and received faxes. Using Enterprise Fax Manager you can easily copy one or more
printers from one RightFax server to another. Select the printers
you want to copy, and then drag the selection to another server.

To delete a printer, select the printer to delete and press DELETE
or select Delete from the Edit menu. By default, you will be
prompted for confirmation that you want to delete the printer.

Managing Printers If you copy printers from a new RightFax server version to an earlier
server version, you will lose configuration data that is not supported
by the older server (for example, features on version 8.5 servers will
not be available on version 8.0 servers).

To add, edit, or delete printers on the RightFax server, run
Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on
page 109) and click Printers under the desired RightFax server in
the Fax Server Tree.

Adding a printer

To add a new printer to RightFax, press INSERT or select New
from the Edit menu. The Edit Network Printer dialog box opens.
For information on completing each of the options in this dialog box
see “Editing Printer Properties” on page 150.
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Editing Printer Properties

To edit the properties of an existing printer, run Enterprise Fax
Manager, select the printer to edit and press ENTER, or select Edit
from the Edit menu. You can also double-click the printer. The Edit
Network Printer dialog box opens.

Figure 13.1 The Edit Network Printer Dialog Box

Edit Network Printer 2lx|

Printer |0 IF‘HINTEH2
Description IHF‘ Lazerlet Il

Printer Type: ILaserJetIII j
™ Direct TCPAP Printing?
Server Name: |PRINTSERVER

GQueue Name: [PRINTERZ

Default Paper Size: IFIT LS Letter Vl

Diefault Paper Source: INnne vl
[
ok I Cancel |

Printer ID The identifier RightFax will use for this printer. This ID
should match the printer's network ID to avoid confusion.

Description This is a description of the form file for easy
reference in Enterprise Fax Manager. If this box is completed, users
will see both the Printer ID and Description in the Print dialog
box. If this box is not completed, only the Printer ID will be
displayed.

Printer Type Sets the printer driver used by the fax server to
format faxes printed to this printer. Choose the one that most
closely corresponds to your printer. If your laser printer supports
both PostScript and PCL5, choose one of the HP Laserlet types
rather than PostScript for faster printing.

Direct TCP/IP Printing Allows faxes to be printed directly to
an IP port on a printer using the LPR, a TCP/IP utility.

Server Name Indicates on which file server the queue exists. If

the queue is in NDS, this should be the value at the top of the tree.
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Queue Name Differs depending on your network operating
system. On NetWare 3.x, the Queue Name should contain the
Bindery name of the queue, i.e. “LASER1. On LAN Server and
Windows NT based networks, Queue Name should contain the
share name of the queue. On NetWare 4.x servers that are using
NDS, Queue Name should contain the Distinguished Name of the
queue object, i.e. “LASER1.SALES.ACME!

Default Paper Size Sets how the fax server will scale a fax
page to fit onto the printable area of a laser printer. This also sets
what size paper to select. “None” will not scale the image at all
which can result in some portion of the page being truncated. “Fit
Letter” causes the fax page to be scaled to fit onto the printable
area of U.S. letter size paper (8.5 x 11 in.). “Fit Legal” scales the
page to fit onto the printable area of U.S. legal size paper (8.5 x 14
in.). “Fit Letter/Legal” scales the fax to fit on letter size paper if it is
12.5 inches or less, otherwise it will be scaled to fit legal size
paper. This last option is useful for firms receiving faxes in a mix of
letter and legal sizes and where dual-bin laser printers are used. In
such cases, the laser printer will select the appropriate size paper,
letter or legal, to correspond to the size of the fax page. “Fit A4”
scales the fax to fit onto the printable area of A4 size paper (210 x
297 mm). “Fit A4/Legal” is identical to Fit Letter/Legal, except that
the printer will choose between A4 and Legal paper trays.

Note All laser printers have an unprintable margin area. RightFax takes
this into account when scaling and fits the full fax page within the
printable region. The result is a small (5%) reduction in the page image
when printed on a laser printer. Because fax pages have no unprintable
regions, this scaling is necessary to prevent portions of the fax from being
lost during printing.

Default Paper Source Determines which paper tray selection
command RightFax will send to the printer. If the Default Paper
Size is set to “Fit Letter/Legal” or “Fit A4/Legal;’ it is
recommended that this value be set to “None!" Otherwise the
automatic selection of paper trays will not work.
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Importing Printers into RightFax

You can import printers from your network into RightFax in groups
or you can import all printers.

To import printers

1. In Enterprise Fax Manager, in the Utility menu, select Import
Printers from Network. The Import Network Printers dialog
box opens.

Figure 13.2 The Import Network Printers Dialog Box
2
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2. Select the network context to import from.

3. Before importing printers, you can specify the characteristics of
printers for which to search. You can set the printer driver, paper
size, paper type, and whether the printer is set to print to an IP
port. Click Set Default Printer Information.

4. To search for printers, click Find Printers in Selected Context.
Depending on the size of the network, this scan can take
several minutes. To cancel the search, click Stop Loading.

5. The list of available printers appears in the Current printer list.
Click to select the printers to import, and then click Import
Selected Printers.

Configuring RightFax to Automatically Print Faxes

Each RightFax user profile can be configured to automatically print
sent or received faxes. Before you can configure automatic printing
for users, you must set up at least one network printer in Enterprise
Fax Manager. For information on adding and configuring network
printers see “Adding a printer” on page 149.

be configured by individual users in the FaxUtil client application.

\ Note The ability to automatically print sent and received faxes can also

To configure a user to automatically print sent and received faxes,
select Users in Enterprise Fax Manager and double-click the user
ID to edit. Automatically printing sent faxes is configured in the
Outbound Auto-Printing tab (page 130) and automatically
printing received faxes is configured in the Default Receive
Settings tab (page 130).

Using Scanners with RightFax

If you need to fax a document that has already been printed, you
can use either a local or network scanner to scan the document
directly into RightFax for fax transmission.

Using a desktop scanner

RightFax can scan documents for fax transmission from any
TWAIN32-compliant scanner connected to your computer. To
make your local scanner available in RightFax, install the scanner,

Chapter 13 Connecting Printers and Scanners
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its drivers, and the TWAIN32 drivers according to the installation
instructions provided with the scanner. RightFax automatically
detects the TWAIN32 drivers and makes the scanner available
when creating a fax document.

To scan a document for fax transmission

1. Open the Fax Information dialog box using any of the methods
provided by your RightFax client installation. For information on
opening the Fax Information dialog box for creating,
addressing, and sending fax documents, see Chapter 25,
“Creating, Sending, and Deleting Faxes”.

2. In the Fax Information dialog box, click the Attachments tab.

Figure 13.3 The Scanner Button
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3. Click the scanner button on the right side of the Available
Attachments list. The Document Scan dialog box opens.

Figure 13.4 The Document Scan Dialog Box
x

Current Scanner:

IF'araIIeI Scanner 2400

Start Scan |
oK | Cancel |

Documents Scanned: 0

4. Select the scanner to use in the Current Scanner box and click
Start Scan. RightFax opens the scanner’s control dialogs.
Place the document(s) to scan on the scanner bed and
complete the dialog(s) that appear according to the instructions
for scanning documents provided with your scanner.

When the document has been scanned, it will appear in the
Selected Attachments list in the Fax Information dialog box.

Using the Kofax NetScan

RightFax integrates with the Kofax NetScan network scanner
(page 43). For more information about configuring these two
products to work together, refer to your NetScan documentation.

The Standalone Fax Connector

A

The Standalone Fax Connector uses a stand-alone fax machine to
send faxes through the RightFax server. This makes least-cost
routing, automatic retries, and other RightFax features available to
conventional fax machines throughout your organization.

Note The Standalone Fax Connector can be used with Brooktrout
TR114 and TR1034 fax boards. TruFax 100 and 200 fax boards do not
support this feature.
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Each fax machine connects to the RightFax server on a specific
channel or DID extension via a phone line or PBX. When a fax is
sent, it is redirected to the RightFax server for processing and
transmission. The user is prompted with voice or tones to enter the

destination fax number and other required fax recipient information.

Connecting a stand-alone fax machine to the RightFax
server

There are several ways to connect a stand-alone fax machine to
your RightFax server. In each case, a RightFax user ID is created to
host the Standalone Fax Connector and is assigned a unique
Routing Code value (called the “extension”). The user then dials
into this extension from the fax machine (exactly how this is
accomplished depends on your phone system) in order to access
the RightFax server.

To enable stand-alone fax machine support

1. On the RightFax server, run Enterprise Fax Manager and create
a new user. In the Routing Code box, enter an extension that
will be dedicated to the Standalone Fax Connector. For
information on creating a new user, see “Adding a user” on
page 120.

2. On the RightFax server, run Regedt32.exe.

3. If using TR1034 fax boards:
Under HKEY_LOCAL_MACHINE\Software\RightFax\
DocTransport\Transports\Brooktrout, add a new key named
“SFC".
If using TR114 fax boards:
Under HKEY_LOCAL_MACHINE\Software\RightFax\
BoardServer, add a new key named “SFC".

4. Open the SFC key and add a new value named “Extensions”
and set the data type to REG_MULTI_SZ.

5. In the Multi-String Editor dialog box, enter the extension that
will be dedicated to the Standalone Fax Connector. Separate
multiple entries with a carriage return.

6. In the SFC key, add another new value named “Change” and
set the data type to REG_DWORD.

7. In the DWORD Editor dialog box, set the data to “1" hex. This
forces the BoardServer and DocTransport to read the
Extensions value.

After it reads the list of extensions, the BoardServer sets the
Change value to “0" hex. When you make a change to the
Extensions value in this key, you must set the Change value
back to “1" hex to force the BoardServer to re-read the new
data.

Using the Standalone Fax Connector

After the Standalone Fax Connector has been enabled, users can
access it from any fax machine that can dial in to the extension you
have dedicated. Users have the option of dialing their intended
recipients directly or entering the ID of a phonebook entry that then
dials the recipient(s) listed in that entry. Add individual or group
phonebook entries under the user ID that you have designated for
the Standalone Fax Connector and assign each entry a numeric ID.

Chapter 13 Connecting Printers and Scanners
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To send a fax using the Standalone Fax Connector

1. Dial the Standalone Fax Connector extension. This number

must be listed in the Extensions value in the SFC key in the
Windows registry on the fax server. Depending on your
Brooktrout fax board configuration, either a tone or voice
message will prompt you for the destination fax number.

. To manually enter a destination fax number, enter the fax number
and billing codes using this format:

FaxNumber*billinfo1*billinfo2#

Separate the fax number and billing codes using the asterisk [*]
key and press the pound [#] key when you are done. If billing
codes are not required, they can be left out of the dial string, but
you must include a fax number and end by pressing the pound
[#] key.

To use a phonebook entry, enter the numeric ID of the
phonebook entry and press the pound [#] key.

. Another tone or voice prompt will instruct you to begin
transmitting the fax. Press the Start button on the fax machine.
The fax machine will proceed to scan the pages and send the
fax to the specified phone number or to the destination(s) in the
phonebook entry.

RightFax 9.4 Administrator's Guide
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Chapter 14
Creating Billing Codes

RightFax tracks and reports fax activity using billing codes. Users
can be required to enter one or two codes for every fax before it
can be sent or deleted. These codes can be validated internally
against a master table or externally using a separate application (for
example, an accounting program). To validate billing codes
internally, you must create a list of valid billing codes in RightFax.

RightFax supports the use of two billing codes for each faxed
document. These are referred to as “Billing Code 1" and “Billing
Code 2! Your organization can require both billing codes on faxes
(such as one code for account number and one for a matter
number), one billing code (to track the individual or department
sending the fax, for example), or no billing codes.

Customizing the Names of Billing Code Fields

For users, the RightFax billing code fields appear in the Fax
Information dialog box. By default, the names of the billing code
fields are “Account” and “Matter” To change these names to meet
the needs of your organization, run Enterprise Fax Manager (see
“Starting Enterprise Fax Manager” on page 109), select
Customize Cover Sheet Fields from the Utility menu, and click
the Billing Codes tab. Enter new descriptions for the Billing Code
1 and 2 fields in the description boxes. The new names will appear
throughout your RightFax client applications.

Managing Billing Codes

You can create a list of billing codes that is used to validate the
codes entered by fax users when sending faxes. To add, edit, or
delete billing codes, run Enterprise Fax Manager and click Billing
Codes under the desired RightFax server.

Adding a billing code
To add a new billing code to RightFax, press INSERT, or select
New from the Edit menu. The Edit Billing Code dialog box opens.
For information on completing each of the options in this dialog
box, see “Editing Billing Code Properties” on page 158.

Deleting a billing code

To delete a billing code, select the billing code to delete and press
DELETE, or select Delete from the Edit menu.

Copying billing codes from one server to another

In Enterprise Fax Manager, you can copy one or more billing codes
from one RightFax server to another. Select the billing codes you
want to copy, and then drag the selection to another server.

If you copy billing codes from a new RightFax server version to an
earlier server version, you will lose configuration data that is not
supported by the older server (for example, features on version 8.5
servers will not be available on version 8.0 servers).
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Editing Billing Code Properties

To edit the properties of an existing billing code, run Enterprise Fax
Manager, select the billing code to edit and press ENTER, or select
Edit from the Edit menu. You can also double-click the billing code.
The Edit Billing Code dialog box opens.

Figure 14.1 The Edit Billing Code Dialog Box
21

Biling Cads 1
Biling Code2: [

Diescription: |Jane Doe

Cancel |

Billing Code 1 and 2 Enter one or two billing codes.

Description Enter a descriptive name for the billing code.

Importing Billing Codes

You can import billing code records from an ASCI| text file. This is
most useful when systems such as EquiTrac or central databases

are used to store a master set of billing codes. Such systems can

be programmed to periodically generate a formatted ASCII file that
the RightFax server will recognize and process. After such a system
is configured, billing code maintenance can be fully automated.

Creating the billing code file

The ASCII billing codes file must be named Codechg.csv and must
be located in the RightFax\Worksrv folder.

The file Codechg.csv must be formatted with one complete billing
code record per line. The codes themselves cannot contain
spaces, but descriptions can. For each record, the codes and
description must be separated by commas. You can import new
billing codes as well as specify deletions and changes to billing
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codes. Each billing code record must include a leading field that
indicates the desired operation. The leading field (a single
character followed by a comma in all cases) can be ‘A’ indicating an
addition, ‘C’ indicating a change to an existing code, or ‘D’
indicating that a code should be deleted.

Format Operation,Billinfo1,Billinfo2,Description

Example A,Smith,9054 Harry Smith Inc.
C,Jones,5687Bob Jones Corp.
D,Smith,2390

(A “delete” line need not contain a description, and any included
description will be ignored.)

Configuring RightFax to import billing codes

To configure RightFax to import the ASCII billing code file, run the
WorkServer configuration program, select the WorkServer in
whose folder you saved the Codechg.csv file, and set a value in the
Billing Code Import Interval field. This parameter determines the
interval in minutes that the WorkServer should check for a new
billing code file. At every interval, the WorkServer checks for the file
Codechg.csy, in its own folder. If the file exists, the WorkServer
imports the additions, changes, and deletions specified in the file.
After the entire file is processed, the WorkServer erases
Codechg.csv so that it will not be picked up again at the next
check.

The WorkServer also produces a log file, Codechg.log, that can be
examined to see what codes were imported from the most recent
Codechg.csv. The log file is overwritten each time an import is
executed, so it will not grow indefinitely.

When writing the input file it is recommended that it not be initially
named Codechg.csv. If it is, the WorkServer may attempt to open
and process the file before you have finished building it. It is best to
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use a temporary name (such as Codechg.$$$) to build the file.
After all lines have been written to the file, close it and re-name it to
Codechg.csv.

Example A batch file can be created that automates this process,
for example:
i
cd \rfax\worksrv

getcodes codechg.$$$
ren codechg.$$$ codechg.csv

In this example, GETCODES is a program supplied by
the user that creates an ASCII file of billing code
changes in the required format.

Requiring and Validating Billing Codes

Requiring billing codes on sent faxes

After you have created a list of billing codes, you can require all
users to enter one or both billing codes with each fax sent. To
require the billing code fields be completed before a fax can be
sent, run Enterprise Fax Manager, select Customize Cover Sheet
Fields from the Utility menu, and click the Sending Required
Fields tab. Select either or both of the First Billing Info or Second
Billing Info check boxes.

Fields that you have marked as required will appear bold in the Fax
Information dialog box.

Requiring billing codes on received faxes

You can also use billing codes to track information about your
received faxes. When you require billing codes on received faxes,
the recipient will not be able to delete the fax until the required
billing codes have been assigned. To require billing codes on
received faxes, run Enterprise Fax Manager, select Customize

Cover Sheet Fields from the Utility menu, and click the Receive
Required Fields tab. Check either or both the First Billing Info or
Second Billing Info fields.

Users can manually assign billing codes to their received faxes by
double-clicking the fax in FaxUtil to open the RightFax viewer and
selecting Assign From Information in the Fax menu. A dialog box
appears with fields for entering the necessary billing code
information.

Configuring billing code validation

N

You can configure the RightFax server to validate billing codes
against the billing code list in the RightFax server. If a supplied
billing code does not match one in your list, it will be rejected and
the fax will not send. To configure RightFax to validate billing codes,
run Enterprise Fax Manager, select Customize Cover Sheet
Fields from the Utility menu, and click the Billing Codes tab.
Check the Verify Billing Codes for Sent and Received Faxes
option.

Note Validating billing codes against an external application requires
you to create a custom utility using the RightFax API. For information on
customizing your RightFax system with the RightFax API, visit the
Captaris web site at www.captaris.com or contact Captaris for
implementation services.

Accessing ODBC Billing Codes

You can integrate billing codes from an external ODBC source for
use in all of your users’ outbound faxes. The ODBC source can be
created and configured using the ODBC configuration program.
Each client workstation must be configured individually to access
these billing codes.

Chapter 14 Creating Billing Codes
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Click the RightFax tray icon in the Windows taskbar. In the shortcut Under ODBC Billing Tables, click Add. The Configure ODBC
menu, select ODBC Configuration. The Configure ODBC Tables Billing Table dialog box opens.

dialog box opens.
Figure 14.3 The Configure ODBC Billing Table Dialog Box

Figure 14.2 The Configure ODBC Tab|eS Dlalog BOX Configure ODBC Billing Table x|
x S TolNeme: [GD5C G o
ODEC Phone Books: ODBC Source: IdBASE Files j - |
Add SELECT...
&I Eilling Info #1 Field: |c.client_id
Eilling Irifo #2 Field: |m.matter_id
LConfigure... Description #1 Field: Ic client_name
Desciiption #2 Field: |m_matterﬁname
ODEC Biling Tables: FROM..
Add Iducsadm.chenl a5 ., docsadm.matter as m
Delste WHERE...
Im.client_id = c.aystemn_id
Canfigure... ORDER BY...
|c: client_name
x| Concel_| [DBC User ID: [odbeuser I Use RightF&X User D
ODBC User Password. I ““““““““““ ™ Use RightF& Password
Records ta load at once: [250 _I::'
SOL Cursor Type: | Dynarnic j
Ok I Cancel |

Complete each of the boxes according to your ODBC database
specifications.

Billing Table Name This is a descriptive name for this billing
codes table.

ODBC Source The name of your ODBC billing codes data
source.

ODBC Field Names Relates the fields of the ODBC database
to the standard RightFax billing code fields. This is done with
simple SQL query statements.

ODBC User ID and Password These are the ID and
password to access the ODBC database. If the ID and password
match those used to log into RightFax, you can check those boxes
instead.



Records to Load at Once Limits the number of records
displayed at one time during billing code lookup by entering the
limit in this box.

SQL Cursor Type Selects an SQL cursor type. In most cases,
this option should be set to “Dynamic”

Querying an ODBC billing code list

After you have configured the necessary ODBC information on a
user's workstation, that user can access ODBC billing codes when
sending faxes.

To look up ODBC billing codes

1.

In the Fax Information dialog box, click Lookup to select
RightFax billing codes or a specific ODBC billing code table.

Select the ODBC billing code table you created. This opens a
list of the ODBC billing codes.

If you limited the number of records displayed at one time in the
Records to Load at Once box in the Configure ODBC Billing
Table dialog box, you will see only the specified number of
records (or fewer). To view the previous or next batch of codes,
click the arrows on the right side of the list.

Click the billing code information you want, and click OK to
enter it in the Fax Information dialog box.

Chapter 14 Creating Billing Codes
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Chapter 15
Creating Library Documents

You can store frequently faxed documents (such as company
literature, credit applications, or employment forms) in a fax
document library for easy retrieval. Library documents are stored in
the RightFax\Image folder on the RightFax server formatted for fax
transmission. This allows your most frequently faxed documents to
be sent as quickly with a minimum of system resources.

Managing Library Documents

To edit or delete library documents, run Enterprise Fax Manager
(see “Starting Enterprise Fax Manager” on page 109)and click
Library Documents under the desired RightFax server in the Fax
Server Tree.

You must create a new library document in order for it to appear as
an object in Enterprise Fax Manager. New library documents are
created from the FaxUtil mailbox (see “Creating a New Library
Document” on page 164).

Deleting a library document

To delete a library document, select the document to delete and
press DELETE, or select Delete from the Edit menu. By default,
you will be prompted for confirmation that you want to delete the
library document.

Deleting the library document’s reference in Enterprise Fax
Manager does not delete the document file itself. A second
confirmation dialog box will ask you if you want to delete the file as
well.

Copying library documents from one server to another

In Enterprise Fax Manager you can copy one or more library
documents from one RightFax server to another. Select the library
documents you want to copy, and then drag the selection to
another server.

If you copy library documents from a new RightFax server version to
an earlier server version, you will lose configuration data that is not
supported by the older server (in other words, features on version
8.5 servers will not be available on version 8.0 servers).

Library document usage statistics

Enterprise Fax Manager keeps a record of each time a library
document is sent via Fax-on-Demand, the Web, or local area
network, and displays the totals in the right pane of the Enterprise
Fax Manager window. To reset these counters back to zero, click
the library documents to reset and select Reset Usage Counts in
the Edit menu.
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Editing Library Document Properties

To edit the properties of an existing library document, run
Enterprise Fax Manager, select the document to edit and press
ENTER, or select Edit in the Edit menu. You can also double-click
the library document. The Edit Library Document dialog box
opens.

Figure 15.1 The Edit Library Document Dialog Box
20

Document |D: | ELETAMNISINNY

Description: IUSing NT Authentication in RightFA:

Image File Hame: INTSECUHE
Pages: |1

v Accessible via EOD?
™ Include in Catalog?

Fequest Pazzword: I
Activation Date: [~ |mx1 471939 vl Expiration Date: [~ |1D;14f1999 vl

Option:
W Accessible via LAN?
v Accessible via Web?

Ok I Cancel |

Document ID This is a unique code that identifies the library
document. If you want the library document to be available via the
Web or Fax-on-Demand (described in the RightFax
Docs-on-Demand Guide), you must assign a numeric document
ID.

Description This is a descriptive name for the library document.

Image File Name The name of the library document file. This is
generated automatically when the library document is created and
should typically never need to be changed. All library document

files are saved in the RightFax\Image folder on the RightFax server.

Pages The number of pages in the document.

Accessible via LAN Makes the library document available on
the local area network for faxing from client workstations.
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Accessible via Web Makes the library document available to
users via your Web site using Web Fax Tools.

Accessible via FOD Makes the library document available to
users via touch tone phone using Fax on Demand.

Include in Catalog Includes this document in the Fax on
Demand catalog of available faxes.

Request Password The numeric password that is required by
Fax on Demand when users request this document.

Activation Date The date that the library document becomes
available for use. Click to select the check box and select the
activation date. To make the library document available immediately,
do not select this option.

Expiration Date The date that you want the library document to
become unavailable for use. Click to select the check box and
select the expiration date. If you do not select this option, the library
document will available indefinitely.

Creating a New Library Document

To add new library documents in FaxUtil, you must be assigned
permission in your user profile (see “The Permissions tab” on
page 122).

Library documents are created from a fax in your FaxUtil mailbox.
You should always create library documents using Fine resolution.
To set fine resolution as the default in FaxUtil, select Tools >
Options, and the Options dialog box opens. On the Sending tab,
select the Use Fine Mode check box.

To create a new library document

1. Create the document in a word processor or other application
that lets you print to the RightFax fax printer. Send the fax image
to your FaxUtil mailbox.

2. Run FaxUtil and click the document in the list of received faxes.
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3. In the Fax menu, click Store in Library. The Store Fax in
Document Library dialog box opens.

4. Specify a Document ID and Description for the new library
document. These fields and the remaining options are the same
as the Edit Library Document dialog box (page 164).

5. When you have completed the dialog box, click OK. The new
document will now appear in the Library Documents list in
Enterprise Fax Manager.

Automating the creation of new library documents

You can also automate the creation of new library documents using
the <NEWLIB> and <NEWLIB2> embedded codes. For
information on using these and other embedded codes see
Appendix A, “RightFax Embedded Codes”.

Faxing a Library Document

Library documents are sent as attachments to faxes. To attach a
library document, you have the following options:

o When creating a new fax in FaxUtil, in the Fax Information dialog
box, click the Attachments tab and select the library documents
to include.

e When creating a new fax using the Quick Fax/Broadcast
command from the tray icon, click the Attachments tab and
select the library documents to include.

¢ You can also add library documents to fax-bound documents
using the <LIBDOC> and <LIBDOC2> embedded codes. For
information on using these and other embedded codes see
Appendix A, “RightFax Embedded Codes”".
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Chapter 16
Text Messaging Using the Push Proxy Gateway

The Push Proxy Gateway (PPG) quickly and easily enables 1. During the setup phase of the RightFax installation, choose
applications to deliver information to mobile users via Short Custom.
Message Service (SMS) text messaging. It uses a Global System
for Mobile Communications (GSM) modem or direct connection to Figure 16.1 Choose Custom install during setup.
a Short Message Service Center (SMSC) to deliver them via the
mobile network to the target device. It can also be a natural Select a typical feature set or create your own
extension of the Captaris RightFax enterprise fax and e-document @@@
delivery solution channels. PPG functionality can be accessed
locally and/or remotely. " Typical RightFax Server [~ Description
. .fﬂg!;u:rseiou to choose a customized set of
To install Push Proxy Gateway ® Tp e '
Use the following steps to install PPG during the RightFax server " RlightFax Exchange Connector
installation.
“iL

Cancel < Back | Mest > I
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2. On the Select features screen, expand Server Modules and

check the box for DocTransport Module. Expand
DocTransport Module, and check the box for Push Proxy

Gateway.

Figure 16.2 Choose DocTransport Module and Push Proxy Gateway

RightFax Product Suite Setup

Select features

Check the features pou want and uncheck the ones you don't want.

=-[F Server Modules

D Server Module

B[ DocTransport Module

® R Push Prosy Gateway

------ O workserver Module

------ O aleting Module
= web &pplications
#-[J Exchange Connectors
=[] Clients/Tools

----- O Administrative Utilities

Lancel

&2

— Drezcription
Enables mezsage delivery to -
mobile devices. Requires GSM
modem, direct connection bo
SMSC, or direct UDFP
connection to deliver messages
wia the mobile netwark, il

— Requirements
o MET 20
® C++ Runtime
® YWindows 32-bit 05
® Windows Server 05

| Hewut » I

| < Back

3. Proceed with the installation as you normally would, selecting

the options you require.

How to add PPG to RightFax after the initial install
To install PPG after RightFax has already been installed, do the

following:

1. Go to Add or Remove Programs in your Control Panel.

2. Choose your version of RightFax, and click Change.

3. In the wizard, choose Modify.
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4. Expand Server Modules and check the box for DocTransport
Module. Expand DocTransport Module, and check the box for
Push Proxy Gateway.

5. Proceed with the installation, making any other changes you
require.

Caution The PPG's public port (default TCP 8980) should be
accessible to any computers that will send messages to the PPG. The
other ports, especially the internal port (default 5001) and the
administration port (8901) should not be accessible from the Internet. As
with all servers, take care to keep the server up to date with any
necessary patches. If the PPG accepts connections from the Internet, it is
especially important to keep Microsoft IIS up to date with security
patches.

Understanding Message Types

N

The PPG supports the delivery of plain text SMS messages

Plain text messages are sent by the PPG as text-only Short
Message Service (SMS) messages. All GSM handsets on the
market today can receive these SMS messages.

PPG is capable of two-way SMS messaging and can receive SMS
messages in reply to the outgoing SMS messages that it sends.

Note Plain text messages should only be used with a Modem or SMPP
connector.
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Understanding Connectors

PPG uses connectors (sometimes called channels) to support
different methods of delivering SMS messages. Modem and
SMPP connectors are supported.

Understanding the Modem Connector

Modem connectors allow messages to be submitted to the
carrier's Short Message Service Center (SMSC) through a GSM
modem that is attached to the PPG server. You can use any GSM
modem that provides a serial-port (COM) interface and supports
the GSM 07.07 and 07.05 AT commands. The GSM modem can be
a card connected to your server, or a mobile phone (with a GSM
modem) connected to your server via a data cable. PPG supports
two serial port modems on a single server.

Modem Connector Throughput

The PPG throughput via a modem connector, using API, is as
follows:

Single Modem:

¢ Sending Outbound only: 14 per minute

¢ Receiving Inbound only: 14 per minute

o Two-way (In and out simultaneously): 10 per minute
Two Modems:

e Outbound only: 14 per minute

e Inbound only: 30 per minute

« Two-way (In and out simultaneously): 10 per minute

Understanding SMPP Connectors

SMPP connectors allow a high volume of messages to be sent via
an SMSC. The supported protocol is SMPP version 3.4.

SMPP Connector Throughput

The PPG throughput via an SMPP connector, using AP, is as
follows:

o Two-way (simultaneously): 120 per minute

Understanding Two-Way SMS Support

PPG supports two-way SMS messaging via SMPP or Modem
connectors.

Two-Way SMS and SMPP Connectors

PPG can use SMPP connectors to assist RightFax in associating
incoming SMS messages with RightFax user mailboxes for routing
purposes.

The wireless carrier allocates a phone number or short code to the
PPG Administrator. This number is referred to as a reply number.
The reply number is used by mobile devices to reply to the SMS
messages sent to them via the PPG. It is also used by the SMSC
to receive the incoming SMS messages, that are then sent to PPG.

When PPG sends an SMS message, it specifies one of these
available numbers in the From field. The recipient device sends an
SMS message back to one of the reply numbers, all of which are
intercepted by the SMSC and routed to PPG. Then, PPG can
send the reply number, message contents, and the replying
device's address to RightFax.

Understanding Log Files

PPG maintains log files in its program directory. The three log file
types are transaction, error, and debug logs. The log files are
rotated, or rolled, every 24 hours by default, where each roll occurs
at zero-hundred hours. When this occurs, new log files are created
with filenames based on the current time.

Chapter 16  Text Messaging Using the Push Proxy Gateway
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The interval setting for transaction logs can be changed so that the
roll occurs anytime between 10 minutes and 24 hours. A directory
to which the transaction log files are saved can be specified.

Transaction log files are generated in a standard format that can be
parsed or saved by external applications, as shown in Table 3a.
Error log files display error and warning messages that are also
viewable in the debug log file. Debug log files do not need to be
enabled in order to generate and view the error log files.

The rolled logs and the current logging file have file names with the
following format:

prefix-GYYYYMMDDHHMM.LOG

In the above format, prefix is cppg for transaction log files, dbgp for
debug log files, and errp for error log files.

Understanding Transaction Logs

The following table lists the formats used in a PPG transaction log.

Table 16a Transaction log formats
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Table 16a Transaction log formats

Col | Value Description Example
5 Push ID Push ID extracted PushID: P1/64;
from the PAP
message
6 Device Subscriber number or | Device: +14255551212;
address address of destination
(destination) | extracted from PAP
message
7 Notification Address to be notified | NotifyTo: ;
URL when the message
has been sent. Does
not apply to Modem
connector.
8 Status Status of the Status: delivered

message, either
Delivered or Failed.

Col

Value Description Example

1

Type The type of message:
Outbound, Inbound,
Notification, and
Service. Service is
used for PPG Service
Startup/Shutdown
messages.

Type: Outbound

Date and time | Date and time of 12/03/2003 13:50:36:923

request

Static - separator -

Push Initiator
address

IP address of the Push | Pl: 1.2.3.4;
Initiator

The transaction logs use this format:

Type: [value]; PI: [value]; MessagelD: [value];
FromAddress: [value]; ToAddress: [value]; NotifyTo:
[value]; Status: [value]

Transaction log example:

12/03/2003 13:50:36:923 - Type: Outbound; PI:
1.2.3.4; MessagelD: PI/64; FromAddress:
14255551234; ToAddress: +14255551212; NotifyTo: ;
Status: Delivered

Configuring the Push Proxy Gateway

You can configure PPG using the RightFax interface. This section
describes the PPG configuration options, and provides information
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to help you get up and running. Accessing and Configuring the PPG
After you make changes in the PPG interface via RightFax,

Stopping and Starting the PPG Services (described in the following sections), you must stop and restart the
The PPG and the PPG Administration run as Windows services PPG service before the changes will take effect. For more
and can be started and stopped via RightFax Enterprise Fax information, see the previous section.
Manager.

) ) Important You must add PPG as a Transport in the Doc Transport
1. Choose Start > Programs > RightFax Enterprise Fax Module before you can configure and use the PPG. Refer to the
Manager. DocTransport Module chapter in this guide for more information.

2. In the left pane, select the server on which PPG is installed.
) . ) ) Accessing PPG via RightFax
3. Right-click the PPG service that you wish to start or stop,

located in the Service Name column You can access PPG configuration options via the Enterprise Fax

. . . Manager.
o Click Start Service to start the selected service.
o Click Stop Service to stop the selected service. To access PPG via RightFax
Figure 16.3 Starting or stopping the PPG service. 1. Choose Start > Programs > RightFax Enterprise Fax Manager.

2. In the left pane, select the server on which PPG is installed.

| Last Updates S777008 74308 PM
S — — 3. Double-click Mobility Push Proxy Administration, located in the
Service Name column.

Pt mx Do Travspon Moduse |

= = B

The PPG Administration dialog box displays.

Note You should not use the remote feature of the Windows Service
\ Control Manager. To control the service from a remote computer, use
Terminal Services to log on to the server and use the Windows Service
Control Manager.
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Using the Interfaces tab

The Interfaces tab establishes connection details for the PPG. The
Connector section of the tab displays different fields when you
change the Active Connector.

Figure 16.4 The Interfaces tab —~Modem

|PPG Administration[ 127.0.0.1:8901 ] -0 =l

Interfaces I License Managementl Logaing I

i Services Interface

Send Message Port: IEDD‘I—
Receive Message Port: IEDD2—
Administration Port: ISSD‘I—
Active Connector: W

Message Encoding Format: IUS ASCI vl

—GSM Modem Connector

Modem: Icomone - l

Enable Modem: [

Baud Rate: ISBUU Ll Parity: IT”IDF'-‘M:"TY ﬂ

Data Bits: [F7 =] stopBits [ONESTOREIT =

MHumber: |1 234567830
SMSC: |+1111111111
b odem Init String: I"AT+EIMGF=D"

Lancel |

Send Message Port Enter the port number of the Internal
Interface. This is a port used for communication between the 1S
extension and the PPG service. It should not be accessible by
outside/Internet computers. The port value is 5001 by default.

Receive Message Port The PPG service sends inbound

messages to RightFax via this port. This port uses 5002 by default.
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Administration Port The PPG Administration service listens
on this port for configuration requests and uses 8901 by default.
This port must be on the machine where PPG is installed.

Important Some of the ports used by the PPG by default are
registered as service contact ports with the Internet Assigned Numbers
Authority (IANA). If you encounter a port conflict, you can assign a
different port number by modifying the entries on the Interface page or
editing the CPPG.INI file.

Refer to http://www.iana.org/assignments/port-numbers for a list of
registered ports.

Active Connector Choose the connector to be used by the
PPG. GSM Modem and SMPP are supported.

Message Encoding Format Select a message encoding
format. US ASCII for most single-byte languages, or UCS-2 for
most double-byte languages. UCS stands for Unicode Character
Set.

Note SMS message size limits When sending messages via the
Modem connector, all messages are carried in a single SMS message. In
the GSM environment, a single SMS message holds 140 bytes of
information.

When sending SMS messages, the PPG assumes that the text only uses
characters contained in the GSM 7-bit default character-set, US ASCII,
as specified by GSM 03.38. In this case, the SMS specifications allow
160 7-bit characters to be carried in the 140-byte SMS message. The
content of the message may therefore be up to 160 single-byte
characters in length.

If the PPG needs to send a message that includes characters that are not
contained in the GSM 03.38 character-set (certain Scandinavian
characters, Thai, Chinese, and so on), the SMS message must use the
UCS-2 Message Encoding Format. Since each Unicode character
occupies two bytes, the content of the SMS message cannot exceed 70
double-byte characters.
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These fields are specific to the GSM Modem connector:

Modem Select an available modem from the drop down box.
Enable Modem Select this checkbox to instruct PPG that the

selected port is active and should use these configuration settings.

Baud Rate, Data Bits, Parity, and Stop Bits Change the
fields for Baud Rate, Data Bits, Parity, and Stop Bits as appropriate
for the modem in use.

Number The phone number of the cell phone or cellular modem
that will connect to the communications port.

SMSC Enter the telephone number of the SMSC used by the
carrier to which your modem is subscribed. Contact your carrier to
get this number.

Modem Init String Enter the initialization string. The default is
‘AT+CMGF=0" The initialization string can be found in the phone’s
manual.

These fields are specific to the UDP connector:

Figure 16.5 The Interfaces tab — UDP

H|PPG Administration[ 127.0.0.1:3901 ] 10| =|

Interfaces | License Managementl Loggingl

—Services Interface

Send Meszage Port: I5|jD1
Receive Message Port: |5|302
Adrinistration Port: |8901

Active Connectar:

Message Encoding Format: Ius ASCI vl

r— Direct UDP Connector

[refault destination port: |2943

ok | Lancel |

Default Destination Port = The PPG uses port number 2948.
RightFax 9.4 does not use the UDP connector.
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These fields are specific to the SMPP connector:

Figure 16.6 The Interfaces tab — SMPP

| PPG Administration] 127.0.0.1:8901 ] 18] =|

Interfaces | License Managementl Loggingl

— Services Interface

Send Meszage Port: IEDD‘I
Receive Message Port: |5E|D2

Administration Part: ISSD‘I

Active Connector:

Message Encoding Format: IUS A5 vl

— SMPP Connector

SMSCIP Address: I Part: |3UDU
© Single Port ' Double Port SMPP Yersion: |52

Syster ID: I— Fietry Interval: 200
S T |1— Timeout [nter:al: IEDDD

Password: I— tMax Meg/Min: |1 20
Mzg Lifetime: l?.D—

[~ Short Code
Address Range:
Add Range | -
I Clear Fange | ;I

Ok | Lancel

SMSC IP Address The IP address of the carrier.

Single Port Choose to instruct PPG to communicate with the
SMSC via a single port.

Double Port Choose to instruct PPG to communicate with the
SMSC via a dual port. This is the default.

System ID This is identification on the carrier's system, such as a
user name. It is provided by the carrier.

System Type This is additional information used to identify the
user and is provided by the carrier.
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Password This password is used to connect to the SMSC and
is provided by the carrier.

Port The port used to connect to the SMSC, in the format IP
Address:Port.

SMPP Version The version number is generally 3, depending
on the SMSC implementation.

Retry Interval The number of seconds the PPG waits to retry a
connection, after a connection fails.

Timeout Interval The connection is no longer valid if a
response is not received within this number of milliseconds.

Max Msg/Min The maximum number of messages sent per
minute.

Msg Lifetime The number of hours a message is considered
valid. The message is discarded if it is not delivered within this time
frame.

Short Code Select if using a shortened phone number, if one
was assigned to you.

Address Range Input the range of phone numbers assigned to
your SMPP connection.

¢ Add an individual number by entering it in the upper field, then
clicking Add Range.

¢ Add a range of numbers by entering the beginning of the range in
the upper field and the end of the range in the lower field. Click
Add Range. The assigned numbers in the range are
automatically generated.

Add Range Click to specify the addresses as entered in the
Address Range fields.

Clear Range Click to delete all of the numbers currently
assigned to this connection.
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Using the License Management tab

The License Management tab allows you to add or remove PPG
licenses.

A transaction is defined as one message sent to one address. For
example:
¢ One SMS message, sent to one phone, equals one transaction.

e One SMS message, including a list of 10 phone numbers, equals
10 transactions.

Figure 16.7 The License Management tab
| PPG Administration] 127.0.0.1:8901 ] ] 4

Interfaces i L

—Installed Licenses

Serial Mumber:

0000000-233216000-Zy0EQME

add | Delete |

Licensed transaction per minute: IBUDD

Ok I LCancel

Serial Number - The full license key.

Add - Click to add the license entered in the Serial Number field
to the list of available PPG licenses.

Delete - Click to remove a selected license from the list.

Licensed transaction per minute - Alicense is
automatically installed that allows 6000 transactions per minute.
This high number allows more licensed transactions than the server
could ever possibly process, so there is essentially no need for
additional licenses.
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Using the Logging tab

The Logging tab determines how transaction and debug log files
are collected. The transaction log contains the Call Detail Records
(CDR) and will be of the form:

cppg-GYYYYMMDDHHMM.LOG

where G is the gateway ID, and the rest of the string is the date
and time the log file started.

See “Understanding Log Files” on page 169 for more information
about log files.

Figure 16.8 The Logging tab

| PPG Administration[ 127.0.0.1:8901 ]

=101 x|

Interfaces I License Management

— Trangzaction Log

Mumber of days to retain tranzaction log: ISD—

Automatically rotate logs? r

Fiotate logs every ID— minutes.
Fotate logs to separate directory:

—Debug Log

Debug Log: [

Fietain Debug Logs for[Days]: ISU

Ok LCancel
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Number of days to retain transaction logs - Enter a value
for how many days old log files will remain on the system. By
default, 90 days of previous log activity is saved.

Automatically rotate logs - Select to rotate log files
automatically. By default, the server's log file is closed and a new
log file is created at midnight each day. This option closes the
current log file and opens a new one more frequently.

Rotate logs every n minutes - Specifies how often log files
should be rotated. Type the value in hours and minutes (00:10 to
24:00).

Rotate logs to separate directory - By default, the rotated
log files are saved in the PPG installation directory. To save the log
files in a different directory, type the complete path of the target
directory in this box.

Note Log files must be saved on a local drive. They cannot be saved to
a mapped network drive.

Debug Log - Select to enable a detailed log file of gateway
activity. Debug logs can be quite large, so this setting should be off
for normal operation. If the debug log is enabled, then the PPG
service must be stopped and restarted before it will take effect.

Important Enable the “Enable Debug Log” setting only if directed to do
so by Captaris customer support.

Retain Debug Logs for (Days) - Enter a value for how many
days the debug log files will remain on the system. The default is
90.
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Chapter 17
Adding SMS and Pager Services

You can configure the RightFax server to send email, pager
messages, or SMS messages to fax users and administrators to
alert or notify them of specific RightFax events. To send these alerts
and notifications from RightFax, you must create a list of available
services and providers.

If you will be configuring SMS notifications, you must have installed
and configured the RightFax Push-Proxy Gateway. The RightFax
Push-Proxy Gateway is installed as an optional component on the
RightFax server. If you did not select the Push-Proxy Gateway
option when you ran the RightFax server installation, it must be
installed now.

To install the RightFax Push-Proxy Gateway
1. Run Add/Remove Programs from Windows Control Panel,
highlight RightFax Product Suite, and then click Change.

2. Click Next at the opening screen. This opens a list of installation
options. Select Modify and click Next.

3. On the Setup Features screen, expand the RightFax Server
category and select Push Proxy Gateway for install. Click
Next.

4. Complete the Installation Wizard according to the instructions
in the RightFax Installation Guide.

5. When you are prompted to reboot the computer, click Yes.

6. After the computer restarts, select Start > Programs >
Enterprise Fax Manager.

7. In the Enterprise Fax Manager application, click the name of the
RightFax server to configure in the tree in the left pane. A list of
services appears at the lower-right pane of the window.

8. In the Service Name list, double-click RightFax DocTransport
Module. The Transport Configuration dialog box opens. (The
DocTransport configuration program is described more
thoroughly in Chapter 5, “Configuring the DocTransport and
BoardServer Modules”.

9. Click the Add Transport button. In the Select Transport dialog
box, select the option SMS Via Push-Proxy Gateway in the left
pane and the click Select. This will add SMS functionality to the
RightFax server.

10.Close the DocTransport configuration program and select
Start > Programs > Enterprise Fax Manager.

11.In the Enterprise Fax Manager application, select Dialing Rules
under the local fax server in the left pane.

12.Press [INSERT] to add a new dialing rule. Click the Destination
tab and select SMS in the Send Via Transport box.

13.Close Enterprise Fax Manager.
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After it is installed, the Push-Proxy Gateway must be configured for Deleting SMS or pager services
your organization’s specific needs. For information on configuring
the RightFax Push Proxy Gateway, refer to the RightFax

Push-Proxy Gateway Guide.

To delete a pager service, select the service to delete and press
DELETE, or select Delete from the Edit menu.

Copying SMS and pager services from one server to
another

Managing SMS and Pager Services

You must create a pager service configuration for each type of
pager service your users subscribe to. To add, edit, or delete pager
services, run Enterprise Fax Manager and click SMS/Pager
Services under the desired RightFax server in the Fax Server Tree.

Adding SMS and pager services

To add a new pager service to RightFax, press INSERT or select
New from the Edit menu. The Edit SMS/Pager Service Definition
dialog box opens. For information on completing the options in this
dialog box, see “Editing SMS and Pager Service Properties” on
page 179.

After you have created a list of SMS and pager services, you can
configure fax user notifications and administrative alerts. Fax status
notifications and how they will be delivered are configured
individually for each RightFax user (described on page 127). A
default notification method can also be configured for groups,
(described on page 137). Fax server status alerts for administrators
can be configured for individual administrative users (described on
page 128), or you can use the RightFax Alerting and Monitoring
service to create and customize a list of server statistics to monitor
and alert on (described in Chapter 18, “Using the Alerting and
Monitoring Service”).

Users can be paged via SMTP email (requiring Internet
connectivity), via TAP or UCP protocols (requiring any
TAPI-compatible or AT-compatible modem), or send SMS
messages (requiring the Captaris Push-Proxy Gateway).

In Enterprise Fax Manager, you can copy one or more pager
services from one RightFax server to another. Select the pager
services to copy, and then drag the selection to another server.

If you copy pager services from a new RightFax server version to an
earlier server version, you will lose configuration data that is not
supported by the older server (in other words, features on version
8.5 servers will not be available on version 8.0 servers).



Editing SMS and Pager Service Properties

To edit the properties of an existing service, select the pager
service to edit and press ENTER, or select Edit from the Edit menu.
You can also double-click the service. Each type of service you add
has different configuration settings. the sections that follow
describe each type of service and the required configuration
options.

Configuring SMTP services

Figure 17.1 SMTP service configuration

Edit SMS/Pager Service Definition 2lx|

Service |0 ISMTF‘ SERVICE
Service Type: ISMTP vl
SMTP Server: ISMTPSEHVEH.MYCDMPANY.CDM
SMTP Sender Address: IMmddress@MyCompany.com

ok I Cancel |

Service ID This is a descriptive ID for the service provider or
type of service. When you edit and change the service ID of a listed
pager service, Enterprise Fax Manager creates a copy of the
service with the new name, rather than re-naming the service.

Service Type Select SMTP as the service type.

SMTP Server The name of your service provider's SMTP server.

SMTP Sender Address This is an SMTP mail address from
which the page will be sent. Some SMTP message servers require
the sender's SMTP address in order to process transactions.

Configuring TAP and UCP Dial-up services

TAP dial-up and UCP dial-up both have the same configuration
options.

Figure 17.2 TAP and UCP dial-up service configuration

Edit SMS/Pager Service Definition 2lx|

Service |D: |TAP DIAL-UP SERVICE
Service Type: | TAP Dialup v[

Terminal Phone Nurmber: |555-1 212

Service Pasaword Ipasswnrd

Provider: vl
Lonnection Timeout: [14 3: [seconds)
Message Transaction Timeout: ﬂ [seconds]
I awimum Message Size; |32 32 [characters]
todem Communication Driver: ICDM‘I j

™ Ignore TAPI disling location rulss?

Direct Modem P.

Port Speed [baud rate]: |1ZUD ‘I

Diata Framing: [7¢4 -

tdodem AT nit String:

Dial Type: |Tone 'l

Dialing Prefix:

oK I Cancel |

Service ID This is a descriptive ID for the service provider or
type of service. When you edit and change the service ID of a listed
pager service, Enterprise Fax Manager creates a copy of the
service with the new name, rather than re-naming the service.

Service Type Select TAP Dial-up or UCP Dial-up as the service
type.

Terminal Phone Number This is your service provider's
modem phone number (for TAP and UCP messaging only).

Chapter 17 Adding SMS and Pager Services
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Service Password The password your service provider requires
to access their TAP or UCP messaging systems (if any).

Provider Specify the specific provider for your UCP or TAP
service. If your provider is not listed here, select “None!

Connection Timeout The length of time, in seconds, for
RightFax to successfully connect to the TAP or UCP messaging
system. If a timeout occurs, RightFax will abandon the call and no
message will be sent.

Message Transaction Timeout The length of time, in
seconds, for RightFax to successfully send the message to the TAP
or UCP messaging system. If a timeout occurs, RightFax will
abandon the call and no message will be sent.

Maximum Message Size The maximum number of characters
allowed by your service provider for pager or SMS messages.

Modem Communication Driver Specify the COM port for
the modem on the RightFax server. If you have installed one or
more TAPI modems on your RightFax server, you can select from
those modems as well. If you select a TAPI modem, the Direct
Modem Parameters settings (described later) will be unavailable
because those settings will be taken from your TAPI modem
configuration on the RightFax server.

Ignore TAPI Dialing Location Rules Ignores any specified
dialing location rules (such as add 9 to dial out) if you have
specified a TAPI modem in the Modem Communication Driver
box (described earlier).

Direct Modem Parameters These parameters are configured
according to your modem type and phone system dialing
requirements. If your pager or SMS service provider recommends a
baud rate for connecting to their TAP or UCP systems, enter the
baud rate in the Port Speed box.
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Configuring SMS services

Figure 17.3 SMS service configuration

Edit SM5,/Pager Service Definition 2l

Service |D: ISMS
Service Type: ISMS vl
PG Hosi(IF or Mame]: [111.0.0.1
PPG Port Mumber. [5001

LCaonfigure PPG

ok I Cancel |

Service ID This is a descriptive ID for the service provider or
type of service. When you edit and change the service ID of a listed
pager service, Enterprise Fax Manager creates a copy of the
service with the new name, rather than re-naming the service.

Service Type Select SMS as the service type.

PPG Host (IP or Name) Use the default value for the PPG
Host.

PPG Port Number Use the default value for the PPG Port
Number.

Logging SMS and Pager Alerts

SMS and pager alerts are logged in the Windows Event Log with a
special event identifier. The purpose of this identifier is to allow
Windows monitoring systems to identify when an alert has
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occurred without monitoring the contents of the event entry. To
filter on these events, filter for Source = “RightFax Server Module”
and Category = “Administrative Alert”

At least one person must be set up to receive an alert of each type
to cause this logging to occur. If no users are set up to receive
alerts, then none will be logged in the NT Event Log using the
special event identifier.

Chapter 17 Adding SMS and Pager Services
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Chapter 18
Using the Alerting and Monitoring Service

The RightFax Alerting and Monitoring service lets you monitor a set
of server statistics that you define in Enterprise Fax Manager and
receive alerts relating to those statistics. To use the RightFax
Alerting and Monitoring service, you must first install and configure
the service, and then define the statistics to monitor and their alert
thresholds.

Installing the Alerting and Monitoring Service

The Alerting service is automatically installed and enabled on all
RightFax Enterprise servers.

Installing the Alerting and Monitoring service on remote
computers

Because the RightFax Alerting service is designed to provide
information about and send alerts relating to the RightFax server,
you may choose to run the Alerting service on a computer other
than the RightFax server. When the Alerting service is installed on a
remote computer, it will continue to operate and send alerts even if
the RightFax server shuts down or experiences other problems.

When the Alerting service is installed on a remote computer, all of
the configuration for the service and the individual alerts is
managed on the RightFax server that the service will be monitoring.
No additional configuration on the remote computer is required.

To install the RightFax Alerting service on a remote
computer

1.

Make sure that the Alerting service is installed and enabled on
the RightFax server that you will be monitoring. In addition, you
must create a share of the Program Files\RightFax folder on the
RightFax server that is accessible by the computer that will be
running the remote service. If either of these requirements are
not met, the remote installation will fail.

Insert the RightFax Product Suite DVD. If AutoRun is enabled, a
menu of install options appears. If AutoRun is not enabled,
browse the DVD and run Setup.exe. The RightFax Product
Suite Setup wizard opens.

RightFax 9.4 requires Microsoft .NET Framework 2.0 or later. If
this software is not installed on your system, Setup will prompt
you to install it. To install, click OK. To cancel Setup and install
.NET Framework 2.0 yourself, click Cancel.

Review the welcome screen and click Next.

5. Carefully read and accept the license agreement and click Next.

6. Setup can check for RightFax updates and other late-breaking

information. To check for updates, verify you have an active
HTTP connection and click Check for Updates. If updates are
found, follow the instructions in the Result section. To skip the
update check and continue with Setup, check the box next to
Do not check for updates and click Next.
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7. Click Custom followed by Next.

8. Select the Alerting Module Setup component and click Next.
No other Setup components should be chosen.

9. The Preview Requirements step lists third-party software
required by your chosen features and also lists the status of
setup operations. Software that must be installed will have a
status of Must Install. To continue, click Next.

10.To apply your settings and install required third-party software,
click Apply. This may take several minutes. When finished, click
Next.

11.Choose your installation folder and click Next.

12.To begin installing RightFax software, click Apply. This may take
several minutes. When finished, click Next.

13.Enter a Windows account to run RightFax services. This
account must be a member of the local administrators group
and must have the right to logon as service on the local
computer. Click Browse to load and select a user account. Use
the Test Account button verify account credentials. When
finished, click Next.

14.Enter your RightFax server and click Next.

15.To apply your settings and complete Setup, click Apply
followed by Close.

Configuring the RightFax Alerting Service

To configure the Alerting and Monitoring service, open Windows
Control Panel and double-click RightFax Alerting Monitoring. The
Alerting & Monitoring Configuration dialog box opens.

The rest of this section describes the options on each of the tabs
on this dialog box.
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The Alerting and Monitoring Configuration General Tab

Figure 18.1 The Alerting & Monitoring Configuration General tab

*j Alerting & Monitoring Configuration : ﬂﬂ

General | Launch Piogram | SMTP |

Evert g eve | R |

Refresh delay: I1 minutes
Repeat delay: |5 minLtes

™ Remote aletting service

Select service account... |
el

Event log level Specify the level of information logged in the
Application Event Log under the service name “RightFax Alerting
Module! You can select the following options:

¢ None. No information is saved.

e Terse. Records critical errors only.

o Normal. Records errors and major events only.

¢ Verbose. Records all significant events and is most useful for
tracking and resolving problems.

Caution If you leave this value set to “Verbose” for long periods of
time, the Event Log can become full which may prevent new events
from being logged.

Refresh delay Specify the frequency, in minutes, that the
Alerting service will poll the RightFax server for statistics.



Repeat delay Specify the frequency, in minutes, that alerts will
be sent when statistic thresholds are met.

Remote alerting service This option indicates that the Alerting
service will operate on a computer separate from the RightFax
server. If you select this option, the Alerting service will not be
started automatically by the Server module. For more information
on installing and running the Alerting service remotely, see
“Installing the Alerting and Monitoring service on remote
computers” on page 183.

Select service account The RightFax Alerting service logs on
to the network by default using the local system account. Click this
button to optionally specify a different Windows user account for
the service to use. If you want the Alerting service to authenticate
to the RightFax server using NT authentication, you must select a
Windows user account that has a corresponding RightFax user
with NT authentication enabled.

When you select this option, the Select service account dialog
box opens. For information on how to complete the options on this
dialog box, see “Selecting a Service Account” on page 40.

The Alerting and Monitoring Configuration Launch
Program Tab

Figure 18.2 The Alerting & Monitoring Configuration Launch Program tab

‘| Alerting & Monitoring Configuration 2=l

Beneral Launch Program | smTP |

These zettings apply to programs launched in response to an alert
condition.

Laog on as:

% 5 ame credentials a3 alerting service accounk

" This account: I
M password: I

¥ Allow program to interact with desktop

Cancel |

The RightFax Alerting service lets you optionally run a program
(such as a batch file or other process) when thresholds for
monitored statistics are reached. The options on this tab let you
configure how these programs will be launched by the Alerting
service.

Log on as Programs launched by the Alerting service require a
Windows user account in order to access the network. Select one
of the following options:

o Same credentials as alerting service account. Programs
launched by the Alerting service will use the same user account
information as the Alerting service.

e This account. Specify a Windows user account other than that
used by the Alerting service. If you select this option, you must
also enter the password for the specified user account in the NT
password box.

Chapter 18  Using the Alerting and Monitoring Service
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Allow program to interact with desktop Specifies whether

the program launched will be accessible from the Windows
desktop and usable by whomever is logged on when the service is
started.

The Alerting and Monitoring Configuration SMTP Tab

Figure 18.3 The Alerting & Monitoring Configuration SMTP tab

*j Alerting & Monitoring Configuration x|

Generall Launch Progiam  SMTP |

SMTP Server I

Cancel |

The RightFax Alerting service lets you optionally deliver alerts as
email messages via SMTP when thresholds for monitored statistics
are reached. In the SMTP Server box, enter the name of the SMTP
server that will transport these alerts. The email addresses to which
alerts will be sent are configured for each individual alert in
Enterprise Fax Manager (described in the next section).
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Defining the Statistics to Monitor and
their Alert Thresholds

To create, edit, or delete individual alerts, run Enterprise Fax
Manager (see “Starting Enterprise Fax Manager” on page 109) and
click Alerts & Monitors under the desired RightFax server in the
Fax Server Tree.

Figure 18.4 The Alerts and Monitors List

[H‘RightFax Enterprise Fax Manager ;Iglil
File Edit Utiliey Help
& Fax Servers D Description I onitoring Walue Action Con =
E-g POXD5KO01991 [Named :
>$ Users @ Database div |Database drive space Percentage of dis... |63 % »>=90
h 8 Groups €@ Fawserver tim [Faw server time rupning Time running 81088 seconds <haney 0
ol Signatures
+ 3 Foms
2y Printers
@8 Biling Codes
@) Library Documents

Dialing Fiules
BB Prefix Tables
LY Hpedie Service Accy

‘| .
A

‘ |3 Alerts

The alerts and monitors that you create are displayed when you
click Alerts & Monitors in Enterprise Fax Manager. Each monitor is
preceded by a colored icon to indicate its current status. These
icons are:

e Yellow. Indicates an error retrieving the value of the statistic.

¢ Blue. Indicates that the statistic is being monitored but no alert
has been set.

¢ Green. Indicates that the statistic that has an associated alert
condition, but the condition has not been met.

¢ Red. Indicates that the statistic that has an associated alert
condition, and the condition has been met.
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The current value for the statistic you are monitoring is displayed in
the Value column. Not all monitored statistics can be configured to
deliver an alert. Monitored statistics that are configured to deliver
alerts are indicated by a green icon in the ID column. Statistics that
cannot be configured to deliver an alert are indicated by a blue
icon. Statistics that cannot be determined due to failure of the

monitored service or other problems are indicated by a yellow icon.

Adding new alerts

To create a new alert, press INSERT or select New from the Edit
menu. The Alert Properties dialog box opens. For information on

completing each of the options on each tab see “Editing Alert
Properties” on page 187.

Deleting alerts

To delete an alert, select the alert to delete and press DELETE or
select Delete from the Edit menu. You will be prompted for
confirmation that you want to delete the alert.

Copying alerts from one server to another

In Enterprise Fax Manager, you can copy one or more alerts from
one RightFax server to another. Select the alerts you want to copy,
and then drag the selection to another server in the Fax Server
Tree. If you copy alerts from a new RightFax server version to an
earlier server version, you will lose any configuration data that is not
supported on the older server.

Editing Alert Properties

To edit the properties of an existing alert, run Enterprise Fax
Manager, select the alert to edit and press ENTER, or select Edit
from the Edit menu. You can also double-click the alert. The Alert
Properties dialog box opens.

Figure 18.5 The Alert Properties Monitor Tab

Alert Properties 21x|
I onitar
r~ ldentification
Name ||
Description l—
— Statistic
Category I j
Statistic to maritor | =l
Cace_|

Some of the statistics that you configure in this dialog box do not
support alerts. These statistics can be configured entirely on the
Monitor tab. If you select a statistic for which an alert can be
configured, two additional tabs, Actions and Message, will appear
on this dialog box. These tabs are described later in this section.

Name This is the name of the alert that will appear under the ID
column in Enterprise Fax Manager.

Description This is the alert description that will appear under
the Description column in Enterprise Fax Manager.

Chapter 18  Using the Alerting and Monitoring Service
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Category Alerts are divided into several categories. The
statistics that you can monitor (selected in the Statistics to
monitor box) will differ depending on the category you select.
Select from the following options:

o Fax Server. Statistics related to activity and events on the
RightFax server.

o Database. Statistics related to the RightFax database.

o Workserver. Statistics related to WorkServers and the
processes they control.

o Gateway. Statistics related to email gateways.

¢ Local BoardServer. Statistics related to the BoardServer
service on the RightFax server.

¢ All BoardServers. Statistics related to the local BoardServer
and any remote BoardServer services.

e RPC Server. Statistics related to the RPC server which
coordinates communication between the RightFax server and
other resources on the network.

o Paging Server. Statistics related to the paging server used to
send notifications via SMS and pages.

Statistic to monitor Select the statistic you want to monitor.
The statistics that you can monitor will differ depending on the
category you select. For a description of each statistic in this list,
see Appendix D, “Alerting and Monitoring Statistics”. Depending
on the statistic you select, additional options may appear below the
Statistic to monitor box. These additional options must be

4N
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completed in order to correctly define the statistic. For a definition
of these options, click the [?] icon in the title bar and then click on
the option to define.

Caution Alerting statistics that allow you to specify a fax channel
number require that you start numbering from 1. This differs from the
BoardServer configuration which starts numbering channels with O
(zero). If you want to monitor the first fax channel, you must specify
channel 1, even though it is numbered as channel O in the BoardServer.
If you specify channel O in the alerting statistics to monitor, it will be
changed automatically to channel 1.

The Actions tab

When you select a statistic on the Monitor tab for which an alert
can be generated, two additional tabs will appear on the Alert
Properties dialog box: Actions and Message. See Appendix D,
“Alerting and Monitoring Statistics” for a list of statistics that
support alerts. You must complete the options on both of these
tabs in order to generate an alert.
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The options on the Actions tab let you define the conditions and To create a new alert action

thresholds under which an alert will be generated, as well as the _ . . . .
alert action to take when a statistic’s threshold is met. 1. Click the New Action button in the Actions group box. This

opens the Action tab of the Edit Action dialog box.
Figure 18.6 The Alerting Properties Actions tab

pre— M Figure 18.7 The Edit Action dialog box Action tab
Monitor  Actions |Message| Editiiction 2]
—&lert condition Action |Time of Lse |
Conditian Igraater than 'l
Threzhold ISU =l - I
— &ction Action I j
=) 4l B
Mame | Action Type | Taiget |
Alert Admin Metwork Broade...  RFAdmin
|
_DK Cancel
LGt | 2. In the Name box, type a name for the alert to create.

Condition Select the operator by which the threshold value will
be evaluated.

Threshold Specify a threshold value. An alert will be generated
only if the condition you select meets this threshold value.

Alert on error If this option is selected, an alert will be
generated if the value for the statistic cannot be generated due to
errors or other problems with the RightFax service being polled.

Actions The options in this group box let you create, edit, and
delete alert actions that will be taken when the statistic threshold is
met. You can configure multiple actions for each alert. Follow these
steps to create a new alert action:
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3. In the Action box, select the type of alert to send. Alerts can be

sent using these four methods:

¢ Network Broadcast. The network will pop up a message on
the specified users computer.

Note Network Broadcast notifications are not possible with
Windows Vista clients, as the Messenger service is not included with
Windows Vista.

e Program. The RightFax Alerting service lets you optionally
run a program (such as a batch file or other process) when
thresholds for monitored statistics are reached. A specified
program will be launched.

e SMS. A message will be sent to an SMS-capable device
such as a cell phone or PDA.

e SMTP. An email message will be sent to a specified user via
an SMTP server.

Important If you are using Windows 2003 and wish to use
Network Broadcast notifications, you must open the Control Panel
and enable the Messenger service, which is disabled by default.

Depending on the type of alert action you select, additional
options will appear below the Action box. These additional
options must be completed for the alert to successfully send.
For a definition of each of these options, click the [?] icon in the
title bar and then click on the option to define.
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. When all of the options on the Action tab have been completed,

click the Time of Use tab.

Figure 18.8 The Edit Action Time of Use tab
Edit Action = 2lxl
action  Time of Use |
Days of week ka use this alert:
F5 Wm M1 Mw WTh MF ¥ sa
[™ Limit use to the specified times
Start time | 2:52:35 PM :l

End time | 2:52:35 M :‘

cwee_|

. To limit the alert to occur only on specific days, select the active

days under Days of the week to use this alert.

. If you want to limit the alert to occur only at specific times,

select the Limit use to the specified time option, and then
select a start and end time.

Click OK to save the alert. The new alert will appear in the list of
alerts on the Actions tab of the Alert Properties dialog box.

. To enable the alert, click the check box next to the alert name in

the list of alerts.
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The Message tab

The Message tab on the Alert Properties dialog box only appears
if a statistic you select in the Statistic to monitor box supports
alerts. See Appendix D, “Alerting and Monitoring Statistics” for a
list of statistics that support alerts. The options on this tab let you
define the message text of the alert that will be sent.

Figure 18.9 The Alerting Properties Message tab

Alert Properties 21
MUnilDrI Actions Message |
 Message
The $[Name] is below 307 =]
This iz how your mezzage would appear bazed on the curment status:
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~ Macro
tacro | Current Yalug -
Marne Database dive space
Description Databaze dive space
Owner ADMINISTRATOR |
oritar 5SS failures
Parm1 0
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Message Enter the message text of the alert. You can use any
combination of text and macros from the Macros list. An example of
the alert message will be displayed in the box below this option.

Macros This is a list of macros that can be included in your
message text. To add a macro to the message, place the cursor in
the Message box where you want the macro text to appear and
then double-click the macro in this list.
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Chapter 19
Using SNMP Alerting

The RightFax SNMP Alerting feature collects status data from the 3. Click SNMP Service and click OK. You will be prompted to
RightFax server and returns it to a monitoring application for insert your Windows CD. Insert the CD, specify the drive letter
processing and reporting. SNMP Alerting also actively sends of your CD-ROM drive, and click Continue.

status messages and alerts to your network monitor application for
realtime monitoring of RightFax processes. RightFax alerts are
divided into four severities: Critical, Error, Warning, and
Informational, and alerts can be enabled or disabled according to
their severity. The RightFax SNMP Alerting feature also allows
RightFax services to be stopped and restarted directly from your

4. Once the SNMP service has been installed, close the Network
dialog box.

Configuring the SNMP Service

network monitor application. on the RightFax Server
To use SNMP Alerting, the Microsoft SNMP service must be ) ) )
installed on both the RightFax server and on the network server that To configure the SNMP service properties

will monitor messages. , .
d 1. On the RightFax server, select the Network program in Control

To install the Microsoft SNMP Service Panel, and then click the Services tab.

2. Double-click SNMP Service in the list of network services, and
If the SNMP service has not already been installed on the RightFax then click the Traps tab.

server, follow these steps: 3. In the Community Name box, add the community name Public.

1. On the RightFax server, select the Network program in

Windows Control Panel, and then click the Services tab. 4. In the Trap Destination box, enter the |IP address of each

machine on your network where you want to send RightFax
2. If SNMP Service does not appear in the Network Services list, SNMP alerts (each machine used for network monitoring).

click Add. RightFax alerts can be sent to an unlimited number of network
monitoring stations on your network. Click OK.
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Configuring the Network Monitor Application

Before it can receive SNMP alerts from the RightFax servers, your
organization’s network monitor application must be configured to
recognize the RightFax SNMP Alerting Management Information
Base (MIB) variables and trap definitions.

In the network monitor, execute the appropriate command(s) to
load new SNMP MIB variables and trap definitions. The MIB
variables for RightFax SNMP Alerting are located in a file called
Avtc.mib and the trap definitions are located in Rftrapd.conf. Both
of these files are installed by default to the RightFax server in the
RightFaxX\SNMP folder.

RightFax includes a utility that automates this configuration for HP
OpenView Network Node Manager. To automatically load the MIB
variables and trap definitions in Network Node Manager, run the file
Rfhpov.bat from a command line on the Network Node Manager
machine. This file is installed by default to the RightFax server in the
RightFax\SNMP folder.

Receiving RightFax Alerts in Your Network
Monitor

RightFax SNMP Alerting actively pushes RightFax alerts to your
SNMP-capable network monitoring application. This helps you
ensure that problems with the RightFax server are reported and
addressed promptly. SNMP Alerting also lets you query several
variables on the RightFax server so you can view the status of the
fax server in real time.

The fax server can send up to nine alerts to your SNMP network
monitor. The following table defines each RightFax alert. The
default RightFax severity is also listed, however your network
monitor software may be configured to use different terminology. In
RightFax terms, “Critical” is severity level one, “Error” is severity
level two, and “Warning” is severity level three.

Table 19a RightFax SNMP Alerts

RightFax 9.4 Administrator's Guide

Default
Alert message severity | Definition
“All BoardServers are Critical | All BoardServers attached
down. Fax sending and to this fax server have gone
receiving is not currently down.
operating’
“One or more drives on the | Warning | One or more drives on the
fax server are approaching RightFax server have less
critically low disk space than 150 MB free.
(<150 MB)”
“One or more drives on the | Critical | One or more drives on the
fax server are critically low RightFax server have less
on disk space (<50 MB). than 50 Mb free.
Many fax server functions
have been suspended’”
“Possible phone line failure | Critical | One or more fax channels
on channel #, three have gone down due to line
consecutive no-dial tone failure.
errors within 45 minutes.’
“RightFax Email Gateway | Warning | The RightFax server is
Module on unable to communicate with
FaxServerName: The the Exchange server.
Exchange Connector has
not responded in a timely
fashion. Inbound message
processing temporarily
disabled.*
“The fax server internal Critical | The RightFax internal event

queue is more than 90%
utilized”

queue is more than 90
percent utilized.
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Table 19a RightFax SNMP Alerts (Continued)

Default
Alert message severity | Definition
“The fax server process Critical | A fax server was shut down
was not properly unexpectedly.
shutdown!

“The send queue depth on | Critical | There are more than 1,000
server ServerName is faxes or 10,000 fax pages in
currently: #/# (faxes/pgs)” the fax queue.

One BoardServer is down,
but at least one other
BoardServer is still running.

“Unable to communicate Error
with BoardServer
ServerName (error 2)"

Each alert severity indicates how vital the component is to the
operation of the RightFax server. “Critical” and “Error” alerts
indicate a loss of fax functionality. “Warning” and “Informational”
alerts indicate a loss of fax capacity. These severity levels may use
different names in your network monitoring application, but the
hierarchy of severities remains the same. RightFax does not send
specific “clearing” alerts that indicate when the cause of an alert
has been resolved.

Alerts generated by RightFax SNMP Alerting are stored in your
network monitor under the “RightFax Server Alerts” category.
Please refer to your network monitoring application’s
documentation for information on displaying and managing alarm
messages.

Because SNMP alerts are generated from the Windows Event Log
on the RightFax server machine, the event log level of each
individual RightFax service must be set to an appropriate level. The
“Terse” setting records critical errors only. “Verbose” records all
significant events and is most useful for tracking and resolving
problems but can cause the event log to fill up quickly, which may
prevent new events from being logged. For information on
configuring the event log level for each RightFax service, refer to
the RightFax Administrator's Guide.

Enabling and disabling RightFax alerts

The RightFax SNMP MIB contains four variables that let you
enable or disable the RightFax alerts according to severity. To edit
these variables, expand the MIB tree to:

.iso.org.dod.internet.private.enterprises.AVTC.Right-FAX.
rfFaxServer.rfServerTraps

This object contains four editable (read/write) variables:
e rfSvrEnableCriticalTraps

o rfSvrEnableErrorTraps

e rfSvrEnableWarningTraps
rfSvrEnablelnformationalTraps

Each variable can be set to either “objectENABLE" or
“objectDISABLE! Changes to these variables take effect
immediately. Please refer to your network monitoring application’s
documentation for information on editing variables in the MIB.

Querying RightFax Status Variables

The RightFax SNMP MIB is comprised of 12 objects, each made
up of several variables. These variables provide realtime status
information on the RightFax server. To query the RightFax variables
in your network monitoring application, expand the MIB tree to:

.iso.org.dod.internet.private.enterprises.AVTC.Right-FAX.
rfFaxServer
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All addresses below this branch point to a RightFax SNMP object
or variable. The following tree lists each object in the RightFax
SNMP MIB tree. Objects in bold contain variables.

rfFaxServer_OV_v1itraps_

RightFax 9.4 Administrator's Guide

Table 19b Variables in the rfFaxServer_OV_v1Traps_ MIB Object

rfFaxServer (.1.3.6.1.4.1.3529.2.1)

——rfFaxServer_OV_v1Traps_ (.0)

—rfServer (.1)

—rfServerModule (.2)

——rfBoardServerModule (.3)

—rfBoards (.4)
rfBoardInfoTable (.4.1)
|—rfBoardInfoEntry (\4.1.1)
rfChannelinfoTable (.4.2)
|—rfChanneIInfoEntry (.4.2.1)

——rfDatabaseModule (.5)

- rfRPCServerModule (.6)

——rfQueueHandler (.7)

——rfPagingServer (.8)

—rfWorkServers (.9)
rfWorkSvrModuleTable (.9.1)
I—rfWorkSvrModuIeEntry (.9.1.1)
rfWorkSvrFunctionTable (.9.2)
I—rfWorkSerunctionEntry (.9.2.1)

——rfEMailGateway (.10)
rfGatewayModuleTable (.10.1)

rfGatewayModuleEntry (.10.1.1)

—rfServerTraps (.11)

Variable

Type

Definition

rfSvrCriticalTrap

Notif.

Text of critical alert reported by the
RightFax server. This is a notification type
variable and cannot be queried or edited.

rfSvrErrorTrap

Notif.

Text of error alert reported by the
RightFax server. This is a notification type
variable and cannot be queried or edited.

rfSvrWarningTrap

Notif.

Text of warning alert reported by the
RightFax server. This is a notification type
variable and cannot be queried or edited.

rfSvrinformationalTrap

Notif.

Text of informational alert reported by the
RightFax server. This is a notification type
variable and cannot be queried or edited.

rfServer

Table 19¢ Variables in the rfServer MIB Object

Variable Type | Definition

rfSvrQueueUsage Integer | Percentage of the fax server’s
internal Event Queue currently in
use.

rfSvrEventsProcessed Integer | Total number of events processed

The following tables list each of the RightFax SNMP variables and
their definitions grouped according to the objects they are
contained in. Variables in boldface are editable. For information on
using your network monitoring application to access the MIB tree
and query variables in the MIB, please refer to the documentation
for your particular application.

by the fax server since the Server
module was started.

rfSvrBoardSvrAvaillndex Integer | Availability of the server’s fax
boards).
rfSvrCurrentFaxesQueued | Integer | Current number of outgoing faxes

waiting to be sent.

196



Table 19¢ Variables in the rfServer MIB Object (Continued)

Variable

Type

Definition

rfSvrCurrentPagesQueued

Integer

Current number of outgoing fax
pages waiting to be sent.

rfSvrDiskAvailForfaximages

Integer

Percentage of disk space on the
fax server available for storing fax
images.

rfSvrDiskAvailForfaxDB

Integer

Percentage of disk space on the
fax server available for storing fax
database information.

rfSvrAllTimeFaxesSent

Integer

Total number of faxes sent from
this server since the All-Time
Counter starting date
(rfSvrAllTimeCounterStart).

rfSvrAllTimePagesSent

Integer

Total number of fax pages sent
from this server since the All-Time
Counter starting date
(rfSvrAllTimeCounterStart).

rfSvrAllITimeFaxesReceived

Integer

Total number of faxes received on
this server since the All-Time
Counter starting date
(rfSvrAllTimeCounterStart).

rfSvrAllITimePagesReceived

Integer

Total number of fax pages
received on this server since the
All-Time Counter starting date
(rfSvrAllTimeCounterStart).

rfSvrAlITimeCounterStart

Integer

Starting date from which the
“All-Time" statistics are
calculated.

rfServerModule

Table 19d Variables in the rfServerModule MIB Object

Variable Type | Definition
rfSvrModuleServiceName String | Fax Server module service name.
rfSvrModuleVersionNumber | String | Fax Server module version

number.

rfSvrModuleServiceStatus | Integer

Current Fax Server service state.

rfSvrModuleTimeRunning

String

Length of time the Fax Server
service has been running.

rfBoardServerModule

Table 19e Variables in the rfBoardServerModule MIB Object

Variable Type | Definition
rfBoardSvrModuleServiceName | String | BoardServer service name.
rfBoardSvrVersionNumber String | BoardServer module version
number.
rfBoardSvrModuleStatus Integer | Current BoardServer service
state.
rfBoardSvrModuleTimeRunning | String | Length of time the

BoardServer has been
running.
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rfBoards.rfBoardinfoTable.rfBoardinfoEntry

Table 19f Variables in the rfBoards.rfBoardInfoTable.rfBoardinfoEntry MIB

Object

Variable Type

Definition

rfBoardindex | Integer

Fax board index.

rfBoardName | String

Each installed fax board type.

rfBoards.rfChannellnfoTable.rfChannelinfoEntry

Table 19g Variables in the rfBoards.rfChannellnfoTable.rfChannelinfoEntry

MIB Object

Variable Type | Definition

rfChannellndex Integer | Channel table index (lists each
installed fax channel).

rfChannelChannel String | Channel numbers and [S] or [R] flag
indicating send or receive
functionality.

rfChannelOperation String | Current operational status of all
channels.

rfChannelRoutingCode | String | Inbound routing code for all
incoming faxes.

rfChannelPhoneNumber | String | Destination phone number of
outgoing faxes.

rfChannelUserlD String | Destination User ID for incoming
faxes.

rfChannelState String | Channel state.

rfChannelRemotelD String | Remote ID of machines sending
incoming faxes.

rfChannelRate String | Current rate of transmission.
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Table 19g Variables in the rfBoards.rfChannelinfoTable.rfChannelinfoEntry

MIB Object (Continued)

Variable Type | Definition

rfChannelCompression | String | Data compression method.

rfChannelPagesInCall Integer | Number of fax pages being
transmitted during this call.

rfChannelMinutesRemain | Integer | Estimated number of minutes
remaining until end of transmission.

rfDatabaseModule

Table 19h Variables in the rfDatabaseModule MIB Object

Variable Type | Definition

rfDatabaseSvrModuleServiceName | String | Database module service
name.

rfDatabaseSvrVersionNumber String | Database module version
number.

rfDatabaseSvrModuleStatus Integer | Current Database module
service state.

rfDatabaseSvrModuleTimeRunning | String | Length of time the
Database service has
been running.

rfRPCServerModule

Table 19i Variables in the fRPCServerModule MIB Object
Variable Type | Definition
rfRPCSvrModuleServiceName | String | RPC module service name.
rfRPCSvrVersionNumber String | RPC module version number.
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Table 19i Variables in the fRPCServerModule MIB Object (Continued)

Variable Type | Definition

rfRPCSvrModuleStatus Integer | Current RPC module service
state.

rfRPCSvrModuleTimeRunning | String | Length of time the RPC
service has been running.

rfQueueHandler

Table 19j Variables in the rfQueueHandler MIB Object

Variable

Type

Definition

rfQueueHandlerModuleServiceName

String

Queue handler service
name.

rfQueueHandlerModuleStatus

Integer | Current Queue handler

service state.

rfQueueHandlerModuleTimeRunning

String

Length of time the
queue handler has been
running.

rfPagingServer

Table 19k Variables in the rfPagingServer MIB Object

Variable Type | Definition

rfPagingSvrModuleServiceName | String | Paging module service
name.

rfPagingSvrVersionNumber String | Paging module version

number.

Table 19k Variables in the rfPagingServer MIB Object (Continued)

Variable Type | Definition

rfPagingSvrModuleStatus Integer | Current Paging module
service state.

rfPagingSvrModuleTimeRunning | String | Length of time the Paging

module has been running.

rfWorkServers.rfWorkSvrModuleTable.rfWorkSvr

ModuleEntry

Table 19| Variables in the

rfWorkServers.rfWorkSvrModuleTable.rfWorkSvrModuleEntry MIB

Object

Variable Type | Definition

rfWorkSvrModulelndex Integer | WorkServer module table
index (lists all WorkServers).

rfWorkSvrModuleServiceName | String | Each WorkServer module
service name.

rfWorkSvrModuleVersionNumber | String | Each WorkServer module
version number.

rfWorkSvrModuleStatus Integer | Each WorkServer module
service state.

rfWorkSvrModuleTimeRunning String | Length of time each

WorkServer has been
running.
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rfWorkServers.rfWorkSvrFunctionTable.rfWorkSvr

FunctionEntry

Table 19m Variables in the

rfWorkServers.rfWorkSvrFunctionTable.rfWorkSvrFunctionEntry MIB

Object
Variable Type | Definition
rfWorkSvrFunctionindex Integer | Workserver function table
index (lists all
WorkServers).
rfWorkSvrFunctionArchive Integer | Is Archive service
processed? (Yes/No)
rfWorkSvrFunctionCoverSheet Integer | Is Cover sheet service
processed?
(Yes/No)
rfWorkSvrFunctionCVL Integer | Is CVL service processed?
(Yes/No)
rfWorkSvrFunctionFileRoute Integer | Is FileRoute service
processed? (Yes/No)
rfWorkSvrFunctionOverlay Integer | Is Overlay service
processed? (Yes/No)
rfWorkSvrFunctionPCL5 Integer | Is PCL5 service
processed? (Yes/No)
rfWorkSvrFunctionPrint Integer | Is Print service processed?
(Yes/No)
rfWorkSvrFunctionNetMessaging | Integer | Is Network Messaging
service processed?
(Yes/No)
rfWorkSvrFunctionDellmageFile | Integer | Is Delete Image File service
processed? (Yes/No)
rfWorkSvrFunctionOCR Integer | Is OCR service processed?

(Yes/No)

Table 19m Variables in the
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rfWorkServers.rfWorkSvrFunctionTable.rfWorkSvrFunctionEntry MIB

Object (Continued)

Variable Type | Definition
rfWorkSvrFunctioninterConnect | Integer | Is InterConnect service
processed?
(Yes/No)
rfWorkSvrFunctionPostscript Integer | Is PostScript service

processed? (Yes/No)

rfEMailGateway.rfGatewayModuleTable.rfGateway

ModuleEntry

Table 19n Variables in the

rfEMailGateway.rfGatewayModuleTable.rfGatewayModuleEntry MIB

Object

Variable Type | Definition

rfGatewayModulelndex Integer | Gateway module table entry
index (lists each email
gateway).

rfGatewayModuleServiceName | String | Each gateway service
name.

rfGatewayModuleVersionNumber | String | Each gateway module
version number.

rfGatewayModuleStatus Integer | Current state of each
gateway service.

rfGatewayModuleTimeRunning | String | Length of time each

gateway has been running.
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rfServerTraps

Table 190 Variables in the rfServerTraps MIB Object

Variable

Type

Definition

rfSvrTrapComputer

String

Computer that generated the
alert. This variable is used

only for trap notifications and
cannot be queried or edited.

rfSvrTrapSource

String

Source of the alert. This
variable is used only for trap
notifications and cannot be
queried or edited.

rfSvrTrapSeverity

Integer

Severity of the alert. This
variable is used only for trap
notifications and cannot be
queried or edited.

rfSvrTrapMessage

String

Alert notification message.
This variable is used only for
trap notifications and cannot
be queried or edited.

rfSvrEnableCriticalTraps

Integer

Critical alerts
enabled/disabled.

rfSvrEnableErrorTraps

Integer

Error alerts
enabled/disabled.

rfSvrEnableWarningTraps

Integer

Warning alerts
enabled/disabled.

rfSvrEnablelnformationalTraps

Integer

Informational alerts
enabled/disabled.

Controlling RightFax Services From Your Network
Monitor

Each RightFax service object in the MIB contains a status variable.
For example, the rfDatabaseModule object contains the variable
rfDatabaseSvrModuleStatus. There are a total of eight service
status variables, each contained in a separate MIB object:

e rfSvrModuleServiceStatus

o rfBoardSvrModuleStatus

e rfDatabaseSvrModuleStatus

o fRPCSvrModuleStatus

¢ rfQueueHandlerModuleStatus

o rfPagingSvrModuleStatus

e rfWorkSvrModuleStatus

o rfGatewayModuleStatus

When queried, these variables list the current state of the service
on the RightFax service (such as stopped, started, or paused).

You can also edit these variables to manually start or stop the
services on the RightFax server. Each variable can be set to either
“statSERVICE_STOPPED" or “statSERVICE_RUNNING!
Changing any of these variables automatically instructs the
RightFax server to start or stop the appropriate service. Please
refer to your network monitoring application’s documentation for
information on editing variables in the MIB.

Troubleshooting the RightFax Alerts

SNMP alerts are designed to call attention to events or conditions
on the RightFax server that may effect your server’s ability to send
and receive faxes. The actual causes of these events and
conditions are not reported as part of the SNMP alerts. In most
cases, reviewing the Event Log on the server which is reporting the
alert will provide details as to the cause of the alert.
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The troubleshooting information in this chapter is designed to point
network administrators who have a familiarity with RightFax to the
most common causes and solutions for each the nine SNMP
RightFax alerts. However, as a client-server application, RightFax
relies on the network for much of its functionality. Because network
related problems can trigger RightFax alerts, the steps included
here may not always resolve the cause of the alert. If RightFax
alerts persist after following these steps, contact your RightFax
administrator and/or network administrator.

All BoardServers down

This alert indicates that all primary and remote BoardServer
services have failed.

1. Run Enterprise Fax Manager or the Windows Services
application and attempt to restart the BoardServer(s). If the
BoardServer(s) fail to start, check the application log in the
Windows Event Viewer for details.

2. If the application log does not provide adequate information to
resolve the problem, attempt to run the BoardServer in a
window. On the RightFax server and any machines running

remote BoardServers, change to the RFBoard folder and enter:

boardsrv.exe -d -1

This runs the BoardServer module as a session in a window in
debug mode. As the board initializes, debug information is
displayed and the reason for the BoardServer failure should
appear as the last line of the debug text. (There may be
additional lines of information associated with the BoardServer
module shutting down again after the failure.)

3. If a RightFax BoardServer module on a remote machine starts
and appears to be running normally but the alert persists, the
failure may be due to problems with network connectivity
between the remote BoardServer machine and the RightFax
server.
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Critically low disk space

This alert indicates that one or more drives on the RightFax server
have fallen below 50 MB of available space.

1. Run Enterprise Fax Manager and check the status of the

RightFax services. If the RightFax Server module has not already
stopped, stop it. RightFax will automatically stop processing
additional fax traffic until both the drive that RightFax is installed
on and the drive that Windows is installed on have more than
50 MB available. Additional SNMP alerts may be generated as
a result of this action.

. Uninstall any unnecessary applications from the RightFax server

using the Add/Remove Software program in Control Panel.

. If this does not alleviate the storage problem, check the

RightFax\Image folder. If it is exceptionally large, consider
running the FAXAGE utility. This will delete faxes from the server
database based on the age of the fax. For information on
running Faxage.exe please refer to the RightFax Administrator’s
Guide.

. If running FAXAGE is not an option, you can move the

RightFax\Image folder to a new drive. First, create a
RightFax\Image folder on a new drive with sufficient free
storage space. Stop the RightFax Server module and move all
of the images from the old RightFax\Image folder to the new
one. Run Regedt32.exe on the RightFax server and add a new
REG_SZ entry called “Image” to the
HKEY_LOCAL_MACHINE\Software\RightFax key and set its
value to “D:\RIGHTFAX\IMAGE" (where D is the new drive).
Restart the RightFax Server module.
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Exchange server is not responding

This alert indicates that the RightFax server is unable to
communicate with the Exchange server. This is probably due to a
failure of the RightFax connector for Exchange which is the service
responsible for all communications between the two systems.

1. Attempt to restart the connector on the Exchange server
through Windows Services.

2. If the connector still appears to be running, shut down and
restart the connector.

Fax server event queue full

This alert indicates that the RightFax internal event queue is more
than 90% utilized. This indicates that too many events currently
require the attention of the RightFax Server module.

1. To get the RightFax server back online, the event queue size
needs to be increased. A modest increase to the event queue
size will not have any adverse effects on the RightFax server

. If the Faxdata.DOF file is 2 MB or larger, too many events are

queued and not being resolved. The most common cause of this
file becoming too large is unresolved work requests involving fax
notifications and/or OCR. If users are set to receive
notifications via Network Broadcast and no WorkServer is set to
perform the “Network Broadcast” task, all the notification
requests for the users will remain in the Faxdata.DOF file.
Similarly, if users have enabled automatic OCR of received
faxes and no WorkServers are set to perform OCR, the work
requests will go unresolved and stack up. Also, if users have a
large number of faxes in their FaxUtil mailboxes with a status of
“Info Not Complete, the fax server will constantly monitor the
faxes and repeatedly notify the users that their faxes need
attention, occupying event queue resources.

For more information on diagnosing and resolving RightFax
database problems, please refer to the RightFax Administrator's
Guide.

itself. On the RightFax server run REGEDT32. Look for the
REG_DWORD entry “QueueSize” in the
HKEY_LOCAL_MACHINE\Software\RightFax\FaxServer key. If
the entry is there, change the value to 3000 (decimal). If the
entry is not there, add it and set its value to 3000. Run the
Services program from Control Panel and stop and restart the
RightFax Server module. The fax server should return to normal
operation.

. During a period of low fax traffic, run the Services program from
Control Panel and stop the RightFax Server module. This will
automatically stop the Database module and the WorkServer
modules. Go to the RightFax\Database folder and check the
size of the Faxdata.DOF file. If the is between 500 KB and

2 MB, the alert was probably the result of a large fax broadcast
or unusually high fax volume. Increasing the event queue will
prevent this from happening again. Restart the RightFax Server
module.

Low disk space

This alert indicates that one or more drives on the RightFax server
have less than 150 MB free. This condition by itself should not
effect your server's fax functionality, but is intended to warn you
that resources are getting low. Please see the troubleshooting
steps for “Critically Low Disk Space” (page 202) for information on
resolving this alert.
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Probable line failure

This alert indicates that one or more of the fax channels have gone
down due to line failure. This alert is only generated when the
BoardServer returns certain errors in sequence over a given period
of time and is the direct result of phone line problems as opposed
to a failure on the RightFax server.

1. To prevent additional alerts while diagnosing the problem, run
the BoardServer configuration program and deactivate the
channel that is generating the alerts.

2. Verify that all phone lines are correctly and securely attached to
the fax board(s).

3. Disconnect the phone lines from the server and attach a
standard phone to verify that the line is still active.

4. If using a of PBX, verify that the line is still active through the
PBX.

5. For T1 installations, confirm that the green light on the fax board
that indicates the T1 line is active is lit.

Send queue too deep

This alert indicates that there are more than a predefined number of
faxes or fax pages in the fax queue waiting to send.

1. Verify that there are no other problems being reported with the
server or phone lines that might prevent all of your outbound fax
channels from being used.

2. If this alert appears frequently, too few fax channels may be
dedicated to outbound faxing. Run the BoardServer
configuration program and reevaluate each channel’s
send/receive capability.

3. If your fax traffic exceeds the capability of all of your fax
channels, consider increasing your total number of channels.
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Server improperly shut down

This alert indicates that a fax server was shut down unexpectedly.
This indicates a sudden and unexpected loss of power.

1. Ensure that the server has recovered properly and is stable. The
RightFax services should restart automatically. Monitor services
and the Event Viewer for any problems.

2. The most common result of an unexpected shutdown is
database corruption, which, if severe, can prevent the RightFax
Server module from starting. For information on diagnosing and
resolving RightFax database problems, please refer to the
RightFax Administrator's Guide.

3. Faxes that were in progress during the shutdown may need to
be released or resent by the creator of the fax. To “release” a fax,
highlight the fax in FaxUtil, and then select Fax > Status >
Release.

One BoardServer down

A BoardServer attached to this server has gone down, but at least
one other BoardServer is still running.

This alert is generally not produced as the result of a BoardServer
going down, but rather the loss of network connectivity between
the RightFax server and a remote BoardServer machine. You can
verify this by running the Windows Services application on each
remote BoardServer machine to confirm that they are all operating
correctly. If this is the case, contact your network administrator.

If one or more BoardServer services are down, refer to the
instructions for the “All BoardServers down" alert (page 202).
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Chapter 20

Creating Dialing Rules and
Least-Cost Routing Plans

Dialing rules allow precise control of outbound faxing by specifying
rules and restrictions over how faxes are sent, according to their
destination fax numbers. For example, using dialing rules, all faxes
to a certain area code can be sent via WAN to another RightFax
server in your organization at that area code to be sent as a local
call, saving long-distance charges. As another example, all
international faxes can be restricted to send only at times of day
when rates are lowest.

RightFax Intelligent Least-Cost Routing™ (LCR) routes outbound
faxes between servers on a wide-area network (WAN) in order to
minimize long distance and other telephone charges. Intelligent
Least-Cost Routing is comprised of several RightFax components:
dialing rules, load balancing, destination tables, InterConnect, and
testing tools.

Managing Dialing Rules

When creating a dialing rule, you specify the fax number (or, using
wildcards, a number pattern) and then attach rules and restrictions
to faxes whose destination fax number matches that pattern. In

cases where one fax number matches multiple dialing rule patterns,

the fax server weighs each rule according to how closely it matches
the fax number, and then sends the fax according to the rule with
the greatest weight.

Because servers can be in different locations or serve groups with
varying needs, dialing rules are server-specific. If you have multiple
RightFax servers, you must create an appropriate list of dialing
rules for each server.

To add, edit, or delete dialing rules in RightFax, run Enterprise Fax
Manager and click Dialing Rules under the desired RightFax server
in the Fax Server Tree.

Important The RightFax 9.0 version of Enterprise Fax Manager cannot
create, edit, or otherwise manage dialing rules created by RightFax 9.4
sofware.

Adding dialing rules

To add a new dialing rule, press INSERT or select New from the
Edit menu. The Rule Edit dialog box opens. For information on
completing each of the options in this dialog box, see “Editing
Dialing Rules” on page 206.
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Deleting dialing rules

To delete a dialing rule, select the rule to delete and press

DELETE, or select Delete from the Edit menu.
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Editing Dialing Rules

To edit the properties of an existing dialing rule, run Enterprise Fax
Manager, select the rule to edit and press ENTER, or select Edit
from the Edit menu. You can also double-click the dialing rule. The

Copying dialing rules from one server to another

In Enterprise Fax Manager, you can copy one or more dialing rules
from one RightFax server to another. Select the rules you want to
copy, and then drag the selection to another server. The amount of
information copied is configured in the Enterprise Fax Manager
Preferences dialog box (see “Setting Preferences” on page 110).

If you copy dialing rules from a new RightFax server version to an
earlier server version, you will lose configuration data that is not
supported by the older server (for example, features on version 8.5
servers will not be available on version 8.0 servers).

Saving dialing rules

Changes you make to dialing rules are not automatically saved
when you quit Enterprise Fax Manager. If you have unsaved dialing
rules, an asterisk appears next to the Dialing Plan icon in the server
tree. To save changes or additions to your dialing rules, press
CTRL+S or select Save Dialing Plan from the File menu.

Rule Edit dialog box opens.

The Matching tab

Figure 20.1 The Rule Edit Matching Tab

RuleEdit 2=l
Destination | Other | DnD Matifications |
Matching | Restrictions I Murnber Adjustments Time and Day
—Battern
+ I atches zero or more digits [must be at end)
- M atches zera ar ane digit
? tatches exactly one digit

%[tbl.#] Matches digits against prefix table

— Priariti
[V Applies lo High priority faxes
¥ Applias to Mormal priority faxes
IV applies to Low priority fases

—Fax Traffic Tupe
' Rule applies to all raffic
" Rule applies to Production traffic anly

' Rule applies to Mon-Production traffic anly

r~ Other
tinimum Queue Depth [in pages): ID _|:jl

inimum Fax Size [in pages]: IU _|:;l

Cancel |

Pattern The destination fax number or number pattern that the
dialing rule will apply to. RightFax ignores any hyphens,
parentheses, or spaces in the pattern string. The pattern can
include the digits 0—9, as well as the pound [#] and asterisk [*]
keys.
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You can use wildcards to define variables in the number pattern
and thereby specify a range of numbers that the rule will apply to.
The following table lists each wildcard that can be used in the
Pattern box and its definition.

Table 20a Dialing Rule Pattern Wildcards

Wildcard Definition Examples
+ Matches zero or more | “+" matches any fax number
digits; must always entered.
appear at the endof | 4154 matches any number that
number string. begins with 415, including
415-320-7000, 415-4455, and
4151.
~ Matches zero or one “~415+" matches any number
digit; can be placed beginning with 415 or [digit]415
anywhere in the including 415-320-7000, 415-3222,
number string. 1-415-320-7000, and 2415.
“~~415+" matches
1-415-320-7000,
9-1-415-320-7000, and
415-320-7000.
? Matches exactly one “415-320-7?7??" matches any

digit.

number that starts with 415-320
and has its final four digits between
7000 and 7999.

number within the area code 415.

% [tablelD,#]

Matches digits defined
in a destination table
to the number of digits
specified (see
“Managing Destination
Tables” on page 214).

“415-%[EAST,3]+" matches all
numbers that begin with 415 and
have a three-digit prefix defined in
the destination table “EAST”

Wildcards decrease the weight of a pattern match because they
are always less specific than an exact match. For example, the fax
number 520-320-7000 matches the pattern “5620-320-7007" and
“520+", but will always be matched with the first rule because it is
more specific.

Note To add the comma symbol to the list of supported wildcards you
must edit the Windows registry to contain the following information:

1.) Open the Windows Registry on the RightFax server.

2.) Browse to the subkey of HKLM\Software\RightFax\DocTransport.
3.) Edit the REG_DWORD entry of ValidPatternChars.

4.) Add the value data of 0123456789*#~\, .

5.) Close the Windows registry.

Priorities Restricts rule matching by the priority assigned by the
user to the fax. Only faxes with the priority levels selected here will
be considered for this rule. Matching based on priority can be
useful when doing fax broadcasts or other large volume faxing. It
can also be useful for universal redirection of faxes (e.g., send all
high priority faxes from Server2 instead of Server1).

Fax Traffic Type Apply the dialing rule based on whether the fax
was generated by the RightFax Integration Module. You can restrict
the rule to production faxes only, non-production faxes only, or
apply the rule to all faxes.

Minimum Queue Depth Specify the number of fax pages that
must be waiting in the server’s queue before this rule will be
considered. This lets you define a dialing rule that can offload
outgoing fax traffic to another server when the load on the current
server gets too high.

Minimum Fax Size Specify the minimum number of pages a fax
must be before this rule will be considered. This lets you define a
dialing rule that can offload very large faxes to another server,
leaving the local server free to send only smaller faxes.
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The Restrictions tab

Each dialing rule can be restricted to specific servers, users, or
groups in your organization.

Figure 20.2 The Rule Edit Restrictions Tab

RuteEdit 21|
Destination | Other I DnD Motifications |
Matching Restrictions | MNumber Adjustments | Time and Day

—Ser
4 " Only These  AllBut These
Sernver: I
Separate multiple servers with commas,
—User
o All [Every) " Only These " AllBut These
Wiser List: |
Separate multiple uzers with commas.
— Group:
& Al [Every]  Only These Al But These
Group List: I
Separate multiple groups with commas.

Cancel |

You have the following options:

o To apply the rule regardless of the origin of the fax, click
All (Every).

« To apply the rule to only the IDs you specify, click Only These.
Enter one or more names of the servers, users, or groups to
which the rule applies. Separate multiple entries with commas.

o To apply the rule in all cases except the IDs you specify, click All
But These. Enter one or more names of the servers, users, or
groups that are exempt from the rule. Separate multiple entries
with commas.
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The Number Adjustments tab

The Number Adjustments tab specifies how fax numbers that
match the dialing rule should be modified in order to properly send
from the specified destination.

Figure 20.3 The Rule Edit Number Adjustments Tab

CUETEE 2l x|
Destination I Other | Dinl Matifications |
tatching | Restrictions Number Adjustments I Time and Day
Strip beginning digits: IE 3:
Prepend this: I
Strip ending digits: IIJ 3:
Append this: I
Creel_|

These options let you add or remove digits from the beginning or
end of the destination fax number. This can be used to
automatically add a “1" to long distance calls or to add a “9" if
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necessary to get an outside line. It can also be used to add a user’s
long distance billing code, or to remove all but the last four digits of
a number for internal routing.

Note RightFax can specify a global dialing prefix for all outbound faxes
in your Global Board Settings (see “Configuring BoardServer Global
Board Settings” on page 67). If your organization requires a dialing prefix
for all outgoing calls, you should specify the prefix there and not here in
the dialing rules.

You can append or prepend any combination of dialable digits. You
can also include special dialing characters that have special
meaning to RightFax. The following table lists the dialable
characters and their definitions (characters are not case-sensitive).

Table 20b Dialing Characters Supported by Dialing Rules

Character | Definition

0-9 Dialable phone digits.

! Hook-flash signal.

# Pound button on phone.

Asterisk button on phone.

, (comma) | 1-second pause (you can combine several of these
characters to increase the length of the pause).

A Replaced in the dial string by the fax's Billing Code 1
value.

B Replaced in the dial string by the fax’s Billing Code 2
value.

C Replaced in the dial string by the fax's ToContactNum

value (the recipient’s voice number).

D Replaced in the dial string by the fax’s ToName value
(the recipient’'s name). Any undialable characters in
this field will be discarded.

Table 20b Dialing Characters Supported by Dialing Rules (Continued)

Character | Definition

E Replaced in the dial string by the fax’s ToCompany
value (the recipient’'s company name). Any undialable
characters in this field will be discarded.

F Replaced in the dial string by the user's domestic long
distance Auto Billing Code (see “Configuring
automated billing codes” on page 49).

G Replaced in the dial string by the user’s international
long distance Auto Billing Code (see “Configuring
automated billing codes” on page 49)..

5-second pause (you can combine several of these
characters to increase the length of the pause).

Pulse dialing mode.

Tone dialing mode (default).

Wait up to 15 seconds for a dial tone.

Do not prepend the dialing prefix.

Do not append the dialing postfix.

Required for SR140 and T.37 FolP numbers. Appends
the IP address of the FolP router.

|~ |~|=s|l+|7
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The Time and Day tab

The Time and Day tab let you specify the time periods for each day
of the week that the rule will be applied. This can be used to take
advantage of special off peak phone rates or to balance fax loads
between servers at the times when your fax traffic is the highest.

Figure 20.4 The Rule Edit Time of Day Tab

RuteEdit 21|
Destination I Other I DnD Motifications |
Matching | Restrictions | MNumber Adjustments Time and Day
Monday: [

Tuezday: IDU23—
‘Wednesday lgggg—
Thursday ||]|]23—
Bidy [op23
Saturday: IUU23—
Sunday IUU23—

Quick Set

2l Times Weskend wigekdays

Peak Times Newver |

Cancel |

For each day of the week, enter the time period when the rule will
apply using 24-hour military notation (i.e., “07" for 7:00 a.m. and
“19"for 7:00 p.m.). Do not specify minutes. The rule will apply
throughout the last hour in the range. For example, when you
specify the time range “06-18," the rule will apply from 6:00 a.m.
until 6:59:59 p.m.

If you leave a box blank, the rule will not be in effect during that day.
To apply a rule at all times, enter “00—-23" next to each day.
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Quick Sets These buttons let you quickly apply the most
common time restriction settings.

The Destination tab

The Destination tab specifies where in your organization faxes
matching the dialing rule pattern should be routed prior to dialing
the destination fax number.

Figure 20.5 The Rule Edit Destination Tab

Ruleedit 20 x|
tdatching | Restrictions I Mumnber Adjustments | Time and Day |
Destination | Other | DnD Matifications

& Bend via Fax Server:

Marme: |TUSDSKDD‘I 391 =l

" Receive into Fax Server

Marne: I j
€ Sendpvia Transport: I j
Aooount: I j

™| &pplies orlpwhen local charnels are disabled J

Cancel |

Send via Fax Server Causes the fax to be routed to any
RightFax server (including the local server) on your network for
transmission. When you select this option, you must also specify
the destination server name and network protocol to use for
routing.
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When a fax is routed to another RightFax server on the network, the
destination fax number is reevaluated against the dialing rules on
the new server. The new server then transmits or forwards the fax
according to its own rules. Be careful not to create dialing rules on
two or more servers that would result in the servers looping one fax
between them. If this occurs, RightFax will send the fax after ten
loops.

Receive into Fax Server Causes the fax to be routed to a
RightFax server (including the local server) on the network and
delivered as an inbound fax. This allows you to define “intra-office”
routing rules that let RightFax users in your organization send faxes
to each other across different fax servers on the network. When
you select this option, you must also specify the destination server
name and network protocol to use for routing. If the fax number
does not match a routing code on the receiving RightFax server, the
fax will be routed to the Default user ID on that server.

Note The Send via Fax Server and Receive into Fax Server fields are
limited to a total of 15 characters if using a net bios name, or 16
characters if using an IP address.

Send via Transport This option lets you select one of the
transport methods that you added and configured in the RightFax
DocTransport module (described in Chapter 5, “Configuring the
DocTransport and BoardServer Modules”) as the fax destination,
rather than a specific RightFax server. In order to select a transport

method in this box, the transport must have been added in the
DocTransport module. You can select from the following transport
methods:

e FOIP. The fax will be transmitted via your SMTP server to a
T.37-compatible device. T.37 fax over IP is a fax transmission
protocol that allows faxes to be transmitted to T.37-compatible
devices over IP, rather than dedicated fax channels. The fax is
packaged as an email message with a TIFF attachment and then
sent over IP via an SMTP server. This message is automatically
interpreted as a fax by the receiving device, which then prints it.

To specify the email address of the destination T.37-compatible
device, click the Number Adjustments tab (described on

page 208), strip all of the digits from the destination fax number,
and then prepend the destination email address.

e SMS. The fax will be routed to an SMS number. When a fax is
sent to an SMS device, only the cover page notes are
transmitted.

To specify the destination SMS number, click the Number
Adjustments tab (described on page 208), strip all of the digits
from the destination fax number, and then prepend the desired
SMS number.

e DOCplus. DOCplus is a fax transmission service provided by
Xpedite (www.xpedite.com) that lets you forward fax images to an
Xpedite server for transmission via their fax channels. This feature
is most useful if you want to send a large volume of faxes in a
short period of time or need to send more faxes than your fax
channel capacity can efficiently manage.

If you select this option, you must also specify a DOCplus
account in the Account field. Select one of the Xpedite accounts
that you have configured in Enterprise Fax Manager.

Applies Only when Local Channels are Disabled Causes
the rule to be in effect only when the fax server has detected that all
fax channels are disabled.
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The Other tab

Figure 20.6 The Rule Edit Other Tab
Roleedic 21 x|

M atching I Restrictions | Murmber Adjustments | Time and Day |
Diestination Other | DD Motifications

— Special Action:

£~ Send on Specific Bange of Channels:
Start Channel: [0 _,::'

End|Charmnel; [0 _|::'

" Digallow Sending
" Delay Fax:
Dy Ll (HHI) [B000

Priority Delta: [0 _I;
Extra Rule Weight: |0 _|:;l

" PRule Disabled?

Comment:

Cancel |

No Special Action Processes the fax without delay on any
available channel.

Send on Specific Range of Channels Sends the fax only on
the channels you specify. The channel range specified here will
override any channel restriction placed on a specific fax using the
<CHANNEL> embedded code. This parameter is not transferred
with the fax if it is routed to another fax server for sending.

Disallow Sending Prevents faxes from sending based on
certain attributes such as the number pattern, time of day, or
sender. The user will get the message “Fax blocked from dialing
phone number’ To retry sending the fax, the user must “kick” the fax
(described in the FaxUtil online help).
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Delay Fax Prevents the fax from sending until a specified time of
day. If the specified time is earlier than the time the fax is received,
the fax will send at that time on the next day. Specify the Delay
Until time using military notation (0000-2359).

Note Intelligent Least-Cost Routing rules are evaluated one time. If
transmission is delayed by the Delay Fax setting, then other settings for
the rule will not be evaluated.

Priority Delta Set dialing rules to adjust a fax’s priority setting
(low, normal, or high). Priority is rated on a three-point scale: low
priority <= 1, normal priority = 2, high priority >= 3. Using the
priority delta, you can add or subtract points from all faxes that
match the dialing rule pattern to adjust their priority up or down.

Extra Rule Weight Add additional weight to the dialing rule.
When a fax number matches two or more dialing rules, RightFax
“weighs” each rule according to how closely it matches the dialed
number and uses the rule with the highest weight. This setting
adds extra weight to the rule so it can be selected over another rule
that has a better pattern match.

Dialing rule pattern characters are weighted as follows: digit match
(0-9) =10 points, + (plus) = 0 points, ? (question mark) =5
points, ~ (tilde) = 4 points.

Rule Disabled Removes the dialing rule from consideration by

the fax server. To enable the dialing rule, click to clear the check
box.

Comment Optionally enter a descriptive comment for the dialing
rule.
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The DnD Notifications tab

Figure 20.7 The Rule Edit DnD Notifications Tab

Ruteeat 2| x|
hatching I Restrictions | Mumber Adjustments | Time and Day |
Destination | Other DD Motifications
[v otify sender that the document was blocked?
Users ta Motify:
|ADMINISTFIATDF! |
Separate multiple users with commas.

Notify sender that the document was blocked Select this
option if you want the sender to be notified after attempting to send
a fax to a number that has been blocked by the Do-not-Dial feature.
If this option is not selected, the sender will get the “Fax number
blocked” custom message. To configure this message, see
“Configuring the Custom Messages Tab" on page 25.

Users to Notify Specify the RightFax user IDs to which
natifications will be sent. If you want to specify multiple user IDs,
separate ID’s with a comma. You can also select user IDs from a
list of all user IDs on the local server by clicking the [...] button. To
select multiple users from this list, press CTRL and click on each
user ID you want.

Example of dialing rules in use

A company with RightFax servers in New York and Seattle adds the
following dialing rules on the New York server:

Remove first three digits and send via Seattle server

206-820-5077?
Remove first six digits and receive into Seattle server

When someone in New York sends a fax to 206-820-7000 (faxing
to a customer in Seattle) the server will route the fax to the Seattle
server which then sends it via a local call. However when someone
in New York sends a fax to a co-worker in Seattle at
206-820-5065, the server will consider the fax a “received fax” and
will route it to the appropriate internal fax mailbox (5065).

Load Balancing

Load balancing is the process of dividing your outgoing fax traffic
across multiple RightFax BoardServers, each fax being routed to
the BoardServer with the most available fax channels.

To do this, create multiple dialing rules with the same number
pattern, each routing the fax to a different BoardServer computer.
Because the number patterns are the same, each rule will be
assigned the same “weight” When multiple rules match a fax
number with equal weight, RightFax directs the fax to the
BoardServer with the most available fax channels. If none of the
servers have outbound fax channels available, the fax will be
directed to the BoardServer that will have a channel available the
soonest.

R] Important Outbound faxes are always sent to the BoardServer with

the most assigned fax channels before the dialing rules that determine
load balancing are processed. For this reason, you should include all load
balancing dialing rules on all fax servers and remote BoardServer
computers. This will ensure that your load balancing rules operate even if
one or more BoardServer computers fail.
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The load balancing feature is only available in RightFax Enterprise amount of information copied is configured in the Enterprise Fax
servers. Manager Preferences dialog box (see “Setting Preferences” on
page 110).

. . . If you copy users from a new RightFax server version to an earlier
Managmg Destination Tables server version, you will lose configuration data that is not supported
by the older server (in other words, features on version 9.4 servers

You can store and organize groups of numbers such as dialing , , i .
will not be available on earlier server versions).

prefixes and area codes in destination tables. These tables are
used when creating dialing rules to represent a range of numbers,
rather than creating a separate rule for each number pattern. Saving destination tables

Changes you make to destination tables are not automatically
saved when you quit Enterprise Fax Manager. If you have unsaved
destination tables, an asterisk appears next to the Dialing Plan icon
in the server tree. To save changes or additions to your destination
tables, press CTRL+S or select Save Dialing Plan from the File
menu.

For example, a destination table can be created that contains all of
the area codes in a major metropolitan area. Using this destination
table, you can create a single dialing rule that addresses all of
these area codes, rather than creating a separate rule for each area
code.

To add, edit, or delete destination tables in RightFax, run Enterprise
Fax Manager and click Destination Tables under the desired
server in the server list.

Adding destination tables

To add a new destination table, press INSERT or select New from
the Edit menu. The Destination Table Edit dialog box opens. For

information on completing each of the options in this dialog box see
“Editing Destination Tables” on page 215.

Deleting destination tables

To delete a destination table, select the table to delete and press
DELETE, or select Delete from the Edit menu.

Copying destination tables from one server to another

In Enterprise Fax Manager, you can copy one or more destination
tables from one RightFax server to another. Select the tables you
want to copy, and then drag the selection to another server. The



Editing Destination Tables

To edit the properties of an existing destination table, run
Enterprise Fax Manager, select the table to edit and press ENTER
or select Edit from the Edit menu. You can also double-click the
destination table. The Destination Table Edit dialog box opens.

Figure 20.8 The Destination Table Edit dialog box
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In the Destination Table Name field, enter a name for the table,
and then type the entries you want in the Entries box. All the
entries in a destination table must be the same length. Entries can
only include the digits 0-9, pound [#], and asterisk [*].

Check the Use External Data Source option to use a list of
numbers from a SQL database. For more information about using
this feature refer to the next section, “Setting up Do not Dial lists
from a database”.

If the destination table will contain a range of numbers, enter the
starting and ending numbers in the series under Insert Range and
click the Insert Range button. All the numbers in the range you
specify will appear in the list.

Setting up Do not Dial lists from a database

If your organization maintains a database containing lists of phone
numbers that should not be dialed, you can link the destination
table directly to this database and then set up a dialing rule that will
prevent these numbers from receiving fax transmissions.

Before you can set up a Do not Dial list, you must configure the
database containing the numbers to block as an ODBC data
source. Refer to the documentation for your server’'s operating
system for information on configuring a new ODBC data source.

After you have set up the ODBC data source for the database
containing the numbers to block, follow these steps to set up Do
not Dial rules.

1. In Enterprise Fax Manager, create a new destination table.

2. Enter a name for the table, select the option Use External Data
Source, and then click the [...] button. This opens the
Configure External Data Source dialog box.

Figure 20.9 The Configure External Data Source dialog box
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. Click the [...] button next to the SOL Connection box to
configure the ODBC data source. This opens the RightFax
SQL Connection Editor dialog box.

Figure 20.10 The RightFax SQL Connection Editor dialog box
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. Click the [...] button next to the ODBC Data Source box and
select the ODBC data source you created for the Do not Dial
list.

. Specify the login information required to access the database
and then click OK. This will return you to the Configure
External Data Source dialog box with the connection
information entered in the SQL Connection field.

. In the Table Name field, enter the name of the table that
contains the phone numbers to block.

. In the Destination Column Name field, enter the name of the
table column specific to the phone numbers.

. In the Primary Key Column Name field, enter the name of the

primary key column for the table you specified in the Table
Name field.

RightFax 9.4 Administrator's Guide

9. In the Condition field, enter any SQL script that you might want
to use to limit the range of phone numbers in the database. For
example, you could enter a query for a field called “Block
Number” set to true. This would limit the range of blocked
phone numbers to only those for whom a separate field in the
table called “Block Number” is set to true.

10.Click OK. The Destination Table Edit dialog box reopens with
all of the phone numbers from the database listed in the Entries
box. The entries in the box are dynamic and will be automatically
updated as you make changes to the database that you are
linked to. There is no need to update this list after is has been
set up. Click OK to save the table.

11.In Enterprise Fax Manager, create a new dialing rule.

12.0n the Matching tab, enter the information for the new
destination table in the Pattern field using the following syntax:

%L PrefixTable,#]

Where PrefixTable is the name of the destination table you just
created and # is the number of digits in each phone number
entry. This should not be entered as a digit, but instead you
should enter the number of pound symbols equal to the length
of the phone numbers in your database.

Example %|[BlockedNumbers,#####3####]

13.Click the Other tab and select the option Disalow Sending.
14.Click OK to save the dialing rule.

Referencing Destination Tables in Dialing Rules

Destination tables are referenced in the Pattern setting of dialing
rules (page 206). This allows a single dialing rule to successfully
match groups of otherwise unrelated numbers.

In the Pattern box in the Rule Edit dialog box, replace the digits
referenced by the destination table with a percent sign (%)
followed by the name of the destination table, a comma, and the
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number of digits to reference all in square brackets. For example,
the following dialing rule correctly references the destination table
Region1 for the three-digit dialing prefix:

520-%[Region1,3]-???7?

RightFax InterConnect

InterConnect is a feature that routes faxes from one RightFax server
to another. This allows multiple RightFax servers to accept
incoming faxes for the same users and then forward the faxes to
the server on which the user's account exists.

For information on enabling and configuring InterConnect, see
“RightFax InterConnect” on page 244).

Testing Dialing Rules and Fax Routes

Because Intelligent Least-Cost Routing involves many variables
that could conflict with one another, RightFax includes diagnostic
tools for testing and confirming your fax routing scheme.

To run the tests, run Enterprise Fax Manager and click Dialing Plan
under the server you want to test.

Figure 20.11 Diagnostic Tools for Testing Least-Cost Routing Rules
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Pinging a server

By pinging a server, you can test communications with a selected
RightFax server using a particular protocol. To run this test, click
Ping.

The amount of time it takes information packets to make a round
trip between machines will display in seconds as “time for call” The
current sever load will display as “server availability index” The
higher the index value, the greater the server availability.
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Tracing the route of a fax

You can test the dialing rules you have constructed using real fax
numbers without actually sending a fax. This test will show where
the fax will be sent from, such as a specific server or a connector in
your system. This test will not indicate if the fax is delayed or if the
transmission is unsuccessful based on dialing rules. For this level
of detail, use the rule execution test.

To run this test, enter a fax telephone number in the Phone
Number box. You can also enter a specific user ID, group ID, fax
priority, and fax size to test how each effects the fax routing.

If the dialing rule applies to production faxes, click to select
Integration Fax. Production faxing is implemented with the
optional Integration Module.

Click Route Trace to start the test.

As the fax number passes one or more servers, the dialog box will
display which rules are being used, how the fax number is
manipulated along the way, the number of hops, or jumps, from
server to server, and the time it takes to route between servers. The
time between servers does not include the time to transfer image
data. That additional time will depend on the size, resolution, and
density of the fax.

Executing rules

Like tracing the route of a fax, you can test the dialing rules you
have constructed using real fax numbers without actually sending a
fax. Using the rule execution test, you can obtain more detailed
information about dialing rules on a server.

To run this test, enter a fax telephone number in the Phone
Number box. You can also enter a specific user ID, group ID, fax
priority, and fax size to test how each effects the route and
execution of the rule.

If the dialing rule applies to production faxes, click to select
Integration Fax. Production faxing is implemented with the
optional Integration Module.
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Click Test to start the test.

As the fax is routed, the dialog box displays each dialing rule
against which the fax number is compared and provides
information about the match weights and server availability.

Viewing disabled rules

The Downed Servers list displays any rules that are disabled due
to downed RightFax servers and the error that caused the rule to
be disabled.

To refresh the list of downed servers, click Reset Downed.

Call Blocking

Call blocking is a feature of DocTransport that can prevent users
from sending to unauthorized numbers. By default, the
DocTransport module blocks all outgoing calls to numbers
beginning with 911 (the standard emergency number throughout
the United States). All non-numeric characters are ignored by
DocTransport. For example, if a user sends a fax to ,,9717,
DocTransport will ignore the two preceding commas and match
911, thus blocking the number.

When an outgoing fax is blocked by this feature, it's flagged with a
scheduling error and correspondingly, is shown in RightFax client
applications with a status of “Scheduling Failed”

The numbers blocked by DocTransport can be added or changed
by adding the following REG_MULTI_SZ subkey to the Windows
registry on the fax server:
HKEY_LOCAL_MACHINE\Software\RightFax
\DocTransport\BlockedNumbers. Add the number (e.g., a prefix,
full, or partial number) to block, per line. All outbound faxes
beginning with the numbers entered here will be blocked.

218



DocTransport call blocking can be disabled by adding the following
REG_DWORD key to Windows registry on the fax server:
HKEY_LOCAL_MACHINE\Software\RightFax
\DocTransport\BlockingFlags. Set this value to “2" to disable all
call blocking at the DocTransport level.

Spam Blocking

It is possible to block unwanted or ‘spam’ faxes provided they
possess ANl information. If you receive, and wish to block
unwanted faxes that possess ANI information, you must first create
a RightFax account(s) where unwanted faxes will be routed to.
After creating this account you must then modify the Windows
regisry to contain a list of blocked numbers and the newly created
account to which they will be routed to.

Create a spam blocking registry entry

1. At the RightFax server, open the Windows registry and browse
to the subkey HKEY_LOCAL_MACHINE\Software\RightFax
\DocTransport.

2. Create a new subkey under \DocTransport called ANI.

3. In the ANI sub-key, create a new REG_MULTI_SZ value called
Entries.

4. Open the newly created Entries value and enter the ANI or
DNIS information and the RightFax user ID (where blocked
faxes will be routed to). An example using the DNIS number of
5551212 and the user account of SpamAccount is provided
below. All data added to the Entries value must be entered
using this format. There is no limit to the numbers you can add
here.

5551212, SpamAccount

5. Close the Windows registry.

Approving Blocked Faxes

Faxes that are blocked by dialing rules can be approved for
transmission by RightFax administrators. Group administrators and
alternate group administrators cannot approve faxes.

To approve a fax blocked by a dialing rule

1. Logon to FaxUtil as an administrator.

2. On the List menu, click Administrative Mode. to view the
contents of all fax mailboxes for which you are an administrator.

3. On the List menu, click Needing Approval to display faxes
waiting for approval.

4. To approve or disapprove a fax, right-click the fax and select
Status > Approve Fax or Disapprove Fax. You can add a note
(up to 450 characters) that will be stored with the date and your
user ID in the fax history. You can also delete the fax rather than
approve or disapprove it. If the fax is approved, it is immediately
scheduled to send. If the fax is not approved, it is assigned a
status of “ED: Approval Denied” in the original sender's FaxUtil
mailbox.

Least-Cost Routing Examples

Scenario 1: Using LCR (a simple example)

PDQ Company has a RightFax server in New York City
(“NYSERVER”) and one in Tucson (“TSNSERVER") and wants to
save money using Intelligent Least-Cost Routing. PDQ has
determined that it would be cheaper to send New York faxes bound
for Tucson and Southern Arizona numbers via TSNSERVER. It
adds this rule to NYSERVER:

520+
Send via fax server TSNSERVER. Use TCP/IP protocol.
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Scenario 2: Using dialing destination tables

PDQ Company wants to make sure that Southern Arizona calls
outside of Tucson are dialed correctly from TSNSERVER. The 458
prefix requires a ‘1’ be prepended onto the number. Also, the 520
area code should not be used. It adds this rule to TSNSERVER:

458+
Send via local fax server. Prepend 1.

520-458+
Send via local fax server. Strip 3 digits from beginning. Prepend 1.

Actually there are more prefixes that could be dialed in Southern
Arizona, but it would be cumbersome to add rules for each one.
PDQ determines that there are three prefixes (458, 459, 652) in
the 520 area code that function this way. PDQ creates a
destination table named SOUTHAZ and includes these three
prefixes. It can then use these two rules on TSNSERVER to cover
all of Southern Arizona outside Tucson:

%[SOUTHAZ,3]+
Send via local fax server. Prepend 1.

520-%[SOUTHAZ,3]+
Send via local fax server. Strip 3 digits from beginning. Prepend 1.

Scenario 3: Distinguishing ‘+’ wildcard rules from other
local numbers

The system administrator for NYSERVER now finds that faxes
bound for internal four-digit PBX numbers in New York beginning
with “520" are inadvertently being routed out to Tucson. In addition,
New York just added a prefix for the Tri-State area of “5620”"
(requiring a 1 be dialed first from the PDQ office) and those calls
are going to Tucson, too. To correct this situation, the administrator
adds these two rules to NYSERVER:

5207
Send via local fax server
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520-?7??7?
Send via local fax server. Prepend 1

These two rules intercept 520 calls that would otherwise match the
“520+" rule in Scenario #2. These rules would match the local
destination numbers more specifically and therefore be weighted
more heavily.

Scenario 4: Stripping unnecessary digits

The PDQ system administrator for NYSERVER has also noticed
that recent transfers from the Tucson site are still used to using the
long distance carrier from there. They are always putting a ‘1’ on
the beginning of ten digit long distance numbers. Because the
PDQ New York long distance carrier does not require it, she adds
this rule to NYSERVER to strip the ‘1"

Send via local fax server. Strip 1 beginning digit.

Scenario 5: Using LCR (an advanced example)

PDQ Company opens a sales office in Los Angeles with a new
RightFax server (‘LASERVER"). PDQ has worked a deal with the
local phone companies in L.A. such that all calls in the local
L.A./Orange County area are at a special low rate. A similar deal
was worked for the New York metro area. This means PDQ can
save money by routing all LA faxes to the LASERVER and all NY
faxes to the NYSERVER. However, because of charges related to
the TCP/IP connection between L.A. and N.Y., it is still cheaper to
send faxes during off-peak periods to L.A. and N.Y. via direct long
distance dialing.

PDQ would first set up four destination tables: an LA area code
(“LAACODE?") table and an LA area code+destination table
(“LAPREFIX") on NYSERVER, and a NY area code (“NYACODE")
table and a NY area code+destination table (“NYPREFIX") on
LASERVER.
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LAACODE and NYACODE each contain a list of area codes that
match the cut-rate phone numbers in their respective regional
areas. LAPREFIX and NYPREFIX match numbers in area codes
where the whole area code was not part of the cut-rate deal and
thus only certain prefixes are eligible.

NYSERVER would then have these two rules:

%[LAACODE,3]+
Time of day set to peak times. Send via fax server LASERVER.
TCP/IP protocol

1%[LAPREFIX,6]+
Time of day set to peak times. Send via fax server LASERVER.
TCP/IP protocol

LASERVER would have a matching set of rules referencing
NYACODE and NYPREFIX and routing to NYSERVER. Peak times
must be specified because it is still cheaper to send in the evening
and at night via long distance.

In addition, a local rule is required on both the NYSERVER and
LASERVER to strip off the unnecessary area code. PDQ adds this
rule on NYSERVER:

212+
Send via local fax server. Strip 3 digits

A similar rule would be necessary for LASERVER as well.

To enable Intelligent Least-Cost Routing for TSNSERVER to NY
and LA, a copy of each of the four destination tables and each of
the dialing rules would be entered on TSNSERVER.

Scenario 6: Boosting priority

PDQ Company is expanding and the load on the RightFax servers
is increasing. PDQ decides to boost the priority of faxes from
certain high priority Groups and Users on LASERVER to ensure
that their faxes are sent quickly. This rule is added to LASERVER:

+
Restricted only to Users: SALESMGR,CFO and to Group:
TOPDOGS. Priority Delta +1.

Scenario 7: International routing

PDQ Company expands into the international market. Their first
overseas site is London which has a RightFax server installed
(“UKSERVER?"). All faxes from LA, NY, and Tucson bound for
England need to be routed to UKSERVER. This rule is added to
each of these servers:

011-44+
Send via fax server UKSERVER. Use TCP/IP protocol.

Rules would need to be placed on UKSERVER to “normalize” the
phone numbers for England (such as stripping area codes or
adding digits if necessary).

Scenario 8: Load balancing

PDQ adds another RightFax server to its expanding NY site
(“NYSERVER2"). Also, usage data indicates that during peak
times, faxes on NYSERVER are taking, on average, several minutes
longer to be sent than those on NYSERVER2. Upon analysis, PDQ
finds that the users of NYSERVER are sending many more faxes
than the users on NYSERVER?2.

By entering these two rules on each server, new outgoing faxes on
each server will be routed to the one with the least load:

+
Send via local fax server

+
Send via fax server NYSERVER?2 (or NYSERVER). Use TCP/IP

protocol

Because each rule is weighted the same, RightFax load balances
between the two servers.
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Scenario 9: Backup servers

PDQ Company's system administrator for LASERVER hears about
the new NYSERVER?2 in New York and decides to make use of the
additional server by replicating all the dialing rules on LASERVER

for NYSERVER but this time referring them to NYSERVER2. This

leads to a guaranteed path of Intelligent Least-Cost Routing should
one or the other of the N.Y. servers fail for any reason.



Chapter 21
Creating Fax Cover Sheets

Fax cover sheets are saved as template files on the RightFax server.
Cover sheet files can include both text and graphics, customized to
your organization’s needs, and you can create multiple cover sheet
files, each for specific departmental use or for use with different
types of fax documents.

Fax cover sheet files can include special codes (called “cover sheet
codes”) that will display the recipient’s name and other contact
information for both the sender and the recipient when the cover
sheet is generated.

You can create the following types of cover sheets:

e HTML (described on page 223)
o Microsoft Word (described on page 225)
e PCL (described on page 227)

Note PCL cover sheets should not be used on RightFax servers
running Windows XP or Windows Vista. Windows XP and Vista clients
manage native printer fonts differently from other versions of Windows,
and cover sheet codes in PCL cover sheets may be improperly converted
by the fax server and may generate imaging errors.

RightFax cover sheet files may not be longer than one page. Any
cover sheet information that appears on subsequent pages will be
ignored. As a general rule, fax cover sheets should include

information about the sender and intended recipient as well as
information about your organization (such as logo, address, and
phone number).

All RightFax cover sheet files are stored in the RightFax\FCS folder
on the fax server. This folder contains sample fax cover sheets that
you can either modify or refer to as examples in creating your own
custom cover sheet files.

Creating an HTML Cover Sheet

HTML cover sheets can be created using an HTML or text editor.
RightFax supports both HTML and meta-HTML (single-file
multi-part MIME HTML) cover sheet files. Both HTML and
meta-HTML files may include any text and graphics that are
supported by these file types.

Graphic images in HTML cover sheets must be referenced using
absolute paths, not relative paths. This is because the cover sheet
file is processed and generated by the RightFax server in a location
separate from the RightFax\FCS folder where the cover sheet file is
stored, so images with relative path references will not be found.
This rule does not apply to meta-HTML cover sheets, because
meta-HTML embeds graphic images.
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Because information on the cover sheet about the sender and
intended recipient varies with each fax document, these variable
elements are included as special cover sheet codes (see “Using
HTML cover sheet codes” on page 224) that are replaced with the
correct information when the cover sheet is generated.

HTML cover sheet files must use either the extension .htm or .mht
(for meta-HTML files). Files with the extension .html will not be
recognized by the RightFax server. When you have completed the
HTML cover sheet file, copy it to the RightFax\FCS folder on the
RightFax server. Because the cover sheet file name is the name
users will see when they select cover sheets, it is recommended
that you use descriptive file names for all cover sheet files.

Using HTML cover sheet codes

Cover sheet codes are used when you want the fax cover sheet to
display information that can vary between fax documents (such as
the recipient’'s name and the number of pages). When a cover
sheet is generated by the RightFax server, the cover sheet codes
are replaced by the data they represent. In HTML cover sheets, all
cover sheet codes are surrounded by braces { }.

Table 21a Cover Sheet Codes for HTML Cover Sheets

Maximum
Code characters | Description
{BILLINFO1} 15 Billing code 1 (if any).
{BILLINFO2} 15 Billing code 2 (if any).
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Table 21a Cover Sheet Codes for HTML Cover Sheets (Continued)

Code

Maximum
characters

Description

{CCTEXT}

69

All the listed recipients of a fax
(including CC and BCC recipients) in
this format:

Name,FaxNum;Name,Faxnum:;...

You can include up to 21 {CCTEXT}
codes on a cover sheet, each code
representing one line of recipients up
to 69 characters long. Include one
{CCTEXT} code on each line that
should contain recipients. The cover
sheet will only list the number of
recipients for which space is provided.

{DATEONLY}

Variable

The date that the fax cover sheet was
generated. The date format is
determined by the default date format
on the RightFax server.

{EMAILADDRESS}

Variable

The sender's email address. This is the
email address that is entered in the
RightFax user properties (described
on page 121).

{FAXDIDNUM}

31

The sender’s fax number.

{FROMNAME}

59

The sender's name.

{FROMPHONENUM}

31

The sender’'s phone number.

{GENERALFAXNUM}

31

The general fax number for the
sender’s organization.

{NOTETEXT}

Variable

The notes added to the fax when it
was addressed.

{NUMPAGES}

Variable

The number of pages in the fax body,
not including the cover sheet. To
include the cover sheet in the page
count, use the {(NUMPAGESC]} code.
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Table 21a Cover Sheet Codes for HTML Cover Sheets (Continued)

Maximum

Code characters | Description

{NUMPAGESC} Variable The number of pages in the fax
including the cover sheet. To exclude
the cover sheet in the page count, use
the (NUMPAGES} code.

{OPERATORNUM} 31 The general phone number for the
sender’s organization.

{ROUTEINFO} Variable The routing information entered in the
user profile of the user creating the fax
(described on page 125).

{TIMEONLY} Variable The time that the fax cover sheet was
generated. The time format is
determined by the default time format
on the RightFax server.

{TOCITYSTATE} 59 The recipient’s city and state.

{TOCOMPANY} 59 The recipient’s organization name.

{TOCONTACTNUM} | 31 The recipient’s phone number.

{TOFAXNUM} 31 The recipient’s fax number.

{TONAME} 59 The recipient’s name.

{UNIQUEID} 16 The unique ID assigned to the
outgoing fax.

{WHENFAXED} Variable The date and time the document was

generated by the fax server. This is
different from the time it was actually
faxed to its destination, which is
recorded on the TTI line on each fax
page. The time the fax was processed
by the fax server can be very different
from the time it is actually sent,
especially if you are using the RightFax
Delay Send feature.

Creating a Microsoft Word Cover Sheet

If you have Microsoft Word installed on your RightFax server for
server-side application conversion (described in Chapter 6,
“Configuring Server-Side Application Conversion”), you can create
and use cover sheets in the native Word document format, rather
than storing them in PCL5 format.

If you use Microsoft Word to create your cover sheets, you can
store the cover sheets in their native Word ((DOC) format instead
of printing to a PCL file (page 228).

Note In order to perform native Word document cover sheet generation,
you must have correctly installed and configured Microsoft Word on the
RightFax server (page 91).

Word documents stored in the RightFax\FCS folder on the fax
server can be selected just like other PCL formatted cover sheet
files and will be converted to fax format using server-side
application conversion.

Cover sheets stored in the native Word format are easier to update
than PCL cover sheet files and support all language character sets
supported by Word and Windows, including Hebrew. Also, unlike
PCL cover sheets, native Word cover sheet codes can use any
TrueType font in addition to native printer fonts. Native Word cover
sheets can take slightly longer to convert to fax format than PCL
files, and this will be exaggerated if the server running Word has
insufficient RAM.

Fax cover sheets must be only one page long. All pages after page
one are ignored when the cover sheet is generated. Cover sheets
should include general information about your organization (such
as logo, address, and phone number) and display information about
the sender and intended recipient. Because information about the
sender and recipient are variables, these elements are inserted as
special cover sheet codes (described in the next section), which
are replaced with the correct information at the time the cover
sheet is generated.

Chapter 21  Creating Fax Cover Sheets
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Using Microsoft Word cover sheet codes

N

Cover sheet codes are used as placeholders for the information
that varies between faxes (such as the recipient’s name, and the
number of pages). When a RightFax cover sheet is generated for
an outbound fax, the cover sheet codes are replaced in the fax
image by the information they represent.

Cover sheet codes in native Word cover sheets are inserted as
Word DocVariable fields. Unlike cover sheet codes in PCL cover
sheets, native Word cover sheet codes can be any TrueType or
native printer font.

Note Although double-byte characters added to the text of a Microsoft
Word cover sheet will convert correctly, double-byte characters inserted
into DocVariable fields on Microsoft Word cover sheets will not.

Using DOC Coversheets with Word 2007

Follow the steps below if your organization uses .DOC coversheets
and has installed Word 2007 on the RightFax server.

1. Log on to the RightFax server with an Administrator account.

2. Open Windows Explorer and browse to the
\RightFax\FCS\Doc folder.

3. Open the FCS.doc file.
4. Click the Close button at the Show Repairs window.
5. Save and close FCS.doc.

Repeat these steps for all .DOC coversheets.
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To insert a DocVariable field

1. In your Word cover sheet, position the cursor where you want to
place the cover sheet code and select Field from the Insert
menu. The Field dialog box opens.

Note The DocVariable field will not appear in your document unless
you have selected Field Codes in the View tab of the Word Options
dialog box.

2. Click Document Automation, and click DocVariable under
Field Names. This displays DOCVARIABLE in the Field
Codes field.

3. Add the cover sheet code to the variable in the format:

DOCVARIABLE code

Where code is one of the supported cover sheet codes listed in
the following table. For example, the following cover sheet code
displays the destination fax number:

DOCVARIABLE ToFaxNum
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4. Click OK to insert the code.

Table 21b Native Word Document Cover Sheet Codes (Continued)

Table 21b Native Word Document Cover Sheet Codes Variable name | Description
- . NumPagesC Number of pages in the fax, including the cover
Variable name | Description page
Billinfo1 The first billing code assigned to the fax OperatorNum The general phone number for the sender's
Billinfo2 The second billing code assigned to the fax organization.
CCText The carbon copy (cc) recipient list for the fax. Routelnfo The routing information entered in the user
Use one CCText code only to display all of profile of the user creating the fax (described
your cc recipients on page 125).
EmailAddress | The sender's email address. This is the email ToCityState Recipient location
address. that is erlltered in the RightFax user ToCompany Recipient company name
properties (described on page 121).
ToContactN Recipient voi h b
FaxDate The date and time the fax was originally oonmactiim eCIPlen' Lol plee e
created, as opposed to the time of the send ToFaxNum Destination fax number
attempt ToName Recipient name
FaxDIDNum The sender’s direct fax number UniqueID The unique 1D assigned to the fax
FaxSendDate The date and time the fax was scheduled to UserlD RightFax user ID of fax sender
send, (if the fax was time-delayed) :
UserName RightFax User Name of fax sender
FromName The sender’s name
FromPhone The sender’s personal voice number \ Note If you place cover sheet codes in a Word text box, and the text
GeneralFaxNum | The general fax number for the sender’s box is not large gnough to fit all of the text that replaces the godgs,
N any extra text will be truncated on the cover sheet. You can fix this by
9 : increasing the size of the text box.
NoteText Cover sheet notes. Use one NoteText code
only to display all of your note text, even if your
cover sheet notes are comprised of multiple Creating a PCL Cover Sheet
<NOTE> embedded codes (page 318). If your
cover sheet displays only one line of note text, RightFax cover sheets can be created in any application that has
place a carriage return immediately after the the ability to print to a PCLS5 file. Fax cover sheets may only be one
DOCVARIABLE code. page in length and should include general information about your
NumPages Number of pages in the fax, excluding the o_rganlzgtlon (suph as logo, address, and phone numbgr)_ and
cover page display information about the sender and intended recipient.

Because information about the sender and recipient are variables,
these elements are inserted as special cover sheet codes (see
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“Using HTML cover sheet codes” on page 224) which are
replaced with the correct information at the time the cover sheet is
generated.

To print to a PCL5 file, select an HP Ill, HP 4 or compatible printer
driver and select the “Print to file” option in your application’s Print
dialog box. The file must have the extension .pcl and must be saved
in the RightFax\FCS folder on the RightFax server. You should use
as descriptive a file name as possible because the file name of the
PCL5 file is what your users will see when they change cover
sheets.

Modifying the sample PCL cover sheet

RightFax is shipped with sample cover sheet files and the source
documents they were created from. You can edit these source files
to include your organization name and logo, rather than create a
new cover sheet. Using Microsoft Word for Windows 6.0 or later,
open the FCS.doc file in the RightFaxX\FCS\PCL_Source folder,
make any desired changes, and print the modified cover sheet to a
file in the RightFax\FCS folder with the extension .pcl.

Note If you have trouble modifying the sample cover sheet and are
using Microsoft Word 97 or later, select Options in the Tools menu and
click the Compatibility tab. Select “Microsoft Word 6.0" in the
Recommend Options For field.
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Using PCL cover sheet codes

Cover sheet codes are special codes that represent information
that can vary from fax to fax (such as recipient name, and the
number of pages). When a RightFax cover sheet is generated for
an outbound fax, the cover sheet codes are replaced in the fax
image by the information they represent.

Example [f Jane Doe sends a fax using a cover sheet that contains
the line
From: <FROMNAME>, then the cover sheet will contain
this text when it is generated and added to the fax:

From: Jane Doe

Although you can use any font in the text of your cover sheets,
cover sheet codes must always use a native printer font. This is
because when the cover sheet document is printed to PCL5
format, all other font types are converted to graphic images. Only
native printer fonts are stored in the .pcl file that the cover sheet is
generated from in their original text format. And it is this text in the
.pcl file that is replaced on the fax image. If you do not use native
printer fonts for your cover sheet codes, the codes themselves will
appear on the cover sheet instead of being replaced by the
information they represent. All cover sheet codes are surrounded
by angle brackets (<>), which must also use the same native
printer font.

Table 21¢c Cover Sheet Codes for PCL Cover Sheets

Maximum
Code Characters | Description
<BILLINFO1> 15 Billing code 1 (if any).
<BILLINFO2> 15 Billing code 2 (if any).
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Table 21¢ Cover Sheet Codes for PCL Cover Sheets (Continued)

Table 21¢c Cover Sheet Codes for PCL Cover Sheets (Continued)

Code

Maximum
Characters

Description

<NOTETEXT>

69

The notes added to the fax when it
was addressed. You can include up
to 21 <NOTETEXT> codes on a
cover sheet, each code
representing one line of notes up to
69 characters long. Include one
<NOTETEXT> code on each line
that you want notes to be listed on.
The cover sheet will only include as
much note text as there is space
allotted for. If the notes for a fax are
shorter than the space provided by
<NOTETEXT> codes, the
remaining lines will be filled with
blanks.

<NUMPAGES>

Variable

The number of pages in the fax
body, not including the cover sheet.
To include the cover sheet in the
page count, use the
<NUMPAGESC> code.

<NUMPAGESC>

Variable

The number of pages in the fax
including the cover sheet. To
exclude the cover sheet in the page
count, use the <NUMPAGES>
code.

<OPERATORNUM>

31

The general phone number for the
sender’s organization.

Maximum

Code Characters | Description

<CCTEXT> 69 All the listed recipients of a fax
(including CC and BCC recipients)
in this format:
Name,FaxNum;Name,Faxnum:;...
You can include up to 21
{CCTEXT} codes on a cover sheet,
each code representing one line of
recipients up to 69 characters long.
Include one {CCTEXT} code on
each line that should contain
recipients. The cover sheet will only
list the number of recipients for
which space is provided.

<DATEONLY> Variable The date that the fax cover sheet
was generated. The date format is
determined by the default date
format on the RightFax server.

<EMAILADDRESS> Variable The sender’s email address. This is

<EMAIL_ADDRESS> the email address that is entered in
the RightFax user properties
(described on page 122).

<FAXDIDNUM> 31 The sender’s fax number.

<FROMNAME> 59 The sender’s name.

<FROM_NAME>

<FROMPHONENUM> | 31 The sender’s phone number.

<FROM_PHONENUM>

<GENERALFAXNUM> | 31 The general fax number for the

sender’s organization.

<ROUTEINFO>

Variable

The routing information entered in
the user profile of the user creating
the fax (described on page 125).

Chapter 21  Creating Fax Cover Sheets
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Table 21¢ Cover Sheet Codes for PCL Cover Sheets (Continued)

Maximum

Code Characters | Description

<TIMEONLY> Variable The time that the fax cover sheet
was generated. The time format is
determined by the default time
format on the RightFax server.

<TOCITYSTATE> 59 The recipient's city and state.

<TO_CITYSTATE>

<TOCOMPANY> 59 The recipient’s organization name.

<TO_COMPANY>

<TOCONTACTNUM> 31 The recipient’s phone number.

<TO_CONTACTNUM>

<TOFAXNUM> 31 The recipient’s fax number.

<TO_FAXNUM>

<TONAME> 59 The recipient’s name.

<TO_NAME>

<UNIQUEID> 16 The unique ID assigned to the
outgoing fax.

<WHENFAXED> Variable The date and time the document

<WHEN_FAXED>
<DATE>

was generated by the fax server.
This is different from the time it was
actually faxed to its destination,
which is recorded on the TTl line on
each fax page. The time the fax was
processed by the fax server can be
very different from the time it is
actually sent, especially if you are
using the RightFax Delay Send
feature.
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Selecting a Cover Sheet File to Use

Although you can create any number of custom cover sheet files,
the default cover sheet is the FCS.pcl file in the RightFaxX\FCS
folder. This is the cover sheet that is used if no other cover sheet
file is specified. RightFax includes a sample FCS.pcl file that can
be modified or replaced with a new cover sheet file customized for
your organization.

If your organization has several fax cover sheets for different types
of faxes, users who have been assigned the appropriate
permissions can specify which cover sheet to use for each fax they
send. In addition, you can specify a default cover sheet for each
user or each group of users.

To change cover sheets, a user must be assigned permission to do
S0.

To assign a user permission to change cover sheets

1. Run Enterprise Fax Manager (see “Starting Enterprise Fax
Manager” on page 109).

2. Click Users under the appropriate server and double-click the
user ID to modify.

3. Click the Permissions tab and select the Can Change Cover
Sheets check box.

To specify a cover sheet on a fax

When a user is entering the fax addressing information in the Fax
Information dialog box (page 254), a check box in the lower left
lets the user specify whether or not to include a fax cover sheet.
The cover sheet is included only with the current fax.

Users can include the <FCSFILE> code in documents (see
Appendix A, “RightFax Embedded Codes") which specifies a cover
sheet file to use for that document.
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Changing a user’s default cover sheet page 109) and select Customize Cover Sheet Fields from the
To assign a new default cover sheet to a specific user, run Utility menu. The Customize Cover Sheet Information dialog box

Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on opens.
page 109), click Users under the appropriate server, double-click

the user ID to modify, and click the Default Outbound Settings Figure 21.1 Required Fields for Outbound Faxes

2
tab. Under Cover Sheet Defaults, select the Send Cover Sheets Lot Sheet Infoii 2|
check box, and select the cover sheet file to use in the Cover sendnaRearedpac | receive Reguic Fidds | Bling Coses |
Sheet Model box. Toilang T From Name

¥ ToFE I»j:umber I From Yoice Phane Mumber
[ To Contact Mumber I Private Fax Mumber
Ch H y d f It h t [~ ToCompany ™ General Fax Number
anglng a group s e au cover s ee [~ TaCity/State ™ General Voice Number
To assign a default cover sheet to a RightFax group, run Enterprise I First Biling Info Field I™" Second Biing Info Fieid

Fax Manager (see “Starting Enterprise Fax Manager” on

page 109), click Groups under the appropriate server, double-click
the group ID to modify, and click the Basic Information tab. Select Concel_|
the cover sheet file to use in the Cover Sheet Model box.

Select the check box next to each field you want to require. The To
Fax Number option is required in order to send the fax, so it
cannot be cleared. If all of the required fields on an outgoing fax are

Requiring Cover Sheet Fields

To transmit an outgoing fax, information about the recipient must be not completed, the fax will remain in a user's FaxUtil mailbox with
completed in the Fax Information dialog box. The RightFax the status “Info Not Complete.”

administrator can specify how much information the user must

complete before the fax will send. To set the required fields, run Requiring cover sheet fields on received faxes

Enterprise Fax Manager (see “Starting Enterprise Fax Manager” on You can specify required fields for received faxes. This allows you

to require that the fax recipient include billing codes or other fields
for billing records.

In the Customize Cover Sheet Information dialog box, click the
Receive Required Fields tab. Select the check box next to each
field that you want to require.

If a fax arrives that does not include all required fields, the recipient
will not be able to delete the received fax without completing the
specified fields.
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Chapter 22

Using Optical Character Recognition

RightFax can be configured to use Optical Character Recognition
(OCR), built on RecoStar technology, to convert received faxes
from a graphic format into text, and is able to automatically route
faxes to their intended recipient based on the To name found on
the cover sheet.

A copy of the OCR'ed text file is saved with the fax image which
lets fax recipients edit and work with the content of their faxes. Fax
client applications can be set to automatically convert all received
faxes into text, or users may choose to convert selected faxes only.

Optical character recognition with the OCR Converter can be
performed only on faxes that contain printed text. OCR technology
does not work with most handwritten text.

Enabling OCR Processing
on the WorkServers

To enable OCR functionality on the RightFax server, it must be
added as a process to at least one WorkServer. Run the
WorkServer configuration program from Windows Control Panel
on the RightFax server to display the WorkServer Configuration

dialog box. In the component tree in the left pane, select the
WorkServer that you want to perform OCR processing. You can
enable OCR processing on as many WorkServers as you want.

Figure 22.1 The WorkServer Configuration dialog box

WorkServer Configuration - LOCAL

2=l

kserver 1

rinter Configuration

ofax MetScan Configuration
H 'eopleS oft Configuration

- Workserver 2

- Workserver 3

.

™ Bemote WorkServer Service

¥ Use PCL converter for tewt files

Services

Network Messaging

UCH
InterConnect
PostScript

Ewvent LogLevel |Terse ‘I
Frequency: |15 ‘l

Biling Code import interval: |0

—— Telephony Server Routing
I~ Enable I” | Boute Documents
B I” | Delete afterroute

Semver ICaIIKprT

Fratocal: m
InterConnect Retry Settings
LCount: |5_ Interyal: |5_ —‘
Optimize Faxing
™ Optimize Covers [ Short Bodies —‘

—— Achive Settings
Farmat: ITIFF-GS 'I [~ Histary
Pt |

Indes fle: |

™ Separate file per page output
I~ | Equilrac archive

I~ | &lwaus delete after archive
I™ | &rchive coversheet

Add WorkServer | Delete WorkServer |

Select Service Account |

Cancel

To enable OCR processing, click OCR in the Services list.
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Configuring users for automatic OCR conversion of all
received faxes

Configuring RightFax Users
for OCR Conversion

You must grant each individual RightFax user permission to perform
optical character recognition on received faxes. Because OCR
conversion is very processor-intensive on the RightFax
WorkServers responsible for OCR conversion, you may choose to
restrict OCR rights to a limited number of users.

Granting OCR permission to RightFax users

To give a RightFax user permission to use optical character
recognition features, run Enterprise Fax Manager, and double-click
the user to open the User Edit dialog box. Click the Permissions
tab and select Can OCR Faxes.

Figure 22.2 Enabling OCR for RightFax Users
userea 21 x|

Outbound Auta-Printing | Default Feceive Settings | Natification
QOther | Pager Motification | Administrative Pager Alerts
|dentification Pemissions | Inbound Routing | Default Outhound Settings

User Pemissions/Attributes:

Adrinistrative Access

Archive Sent Faxes

Aszign Default Biling Codes to Received Faxes
Bypass Biling Code Verification

Can Change Cover Sheets

Can Edit/4dd Forme

Car Edit/4dd Library Docs

Can Run Reports

Can Use High Priority

Dizallow Billing Code Lookup
Dizallow Editing of Biling Codes
Dizallow Fax Anotations
Diizallow Fax Deleting

EDC Process Received Faxes
EDC Process Sent Faxes
Excluded from Group Fax Aging
tust Have Faxes Appioved
Muszt Have Password

Stamp pages of received fares with audit stamp
Unprotected Mailbox

“Wiew First Page Only

OOO00000C0O00000ROCO0000;

Cancel

To configure a user for automatic OCR conversion of all received
faxes, run Enterprise Fax Manager, and double-click the user to
open the User Edit dialog box. Click the Default Receive Settings
tab.

Under Automatic OCR Options, select the Enabled check box to
automatically convert all received faxes using OCR. Enter a
three-letter file extension for the output file in the Extension box.

In the Format box, select the text format used to interpret your fax
pages. “ASCII" produces a plain text file. “RTF” (rich text format)
preserves fonts and formatting but is only available to Windows
users.

Opening OCR Text Files

The method you use to view OCR-converted faxes depends on the
fax client application you use. A specialized OCR viewer, called
Captaris Single Click Entry ships with RightFax and is installed as
part of the RightFax typical client. If you use an email gateway
application as your fax client (such as Microsoft® Exchange or
Lotus® Notes®), OCR-converted faxes will arrive as file attachments
to email messages along with the associated fax image file. These
text file attachments can be viewed and edited exactly like any
other email attachment.

If you use FaxUtil or RightFax Web Access as your fax client,
OCR-converted faxes are stored in the RightFax database along
with their associated fax image files. If a fax has an associated
OCR text file, a special OCR icon will appear next to the fax entry.

For information about Captaris Single Click Entry, see the FaxUtil
online help.



Using OCR to Route Received Faxes

When you route using OCR, the text on the received fax cover
sheet is compared to a customized routing table that contains
names and other text that identifies RightFax users in your
organization. When a match is found, the fax is routed to the
specified RightFax user.

Important Because large organizations can have several members
with the same or very similar names, OCR routing is not recommended
as a primary routing method. For large organizations, Captaris
recommends using OCR routing only as a backup for other fax routing
methods (described in Chapter 23, “Routing Inbound Faxes”). With other
fax routing methods, a mailbox can be configured that receives all “lost”
faxes whose intended recipient cannot be determined. These “lost” fax
mailboxes can then be configured for OCR routing.

Configuring RightFax to Perform OCR Routing

To use OCR routing, you must configure a “central” mailbox from
which the faxes will be routed, and then you must create a custom
routing table that contains RightFax user IDs and their associated
text. When a fax arrives in the central mailbox, the cover sheet text
is checked against the routing table for a match. If a match is found,
the fax is routed. If no match is found, the fax remains in the central
mailbox.

Creating and configuring the OCR central mailbox

To use OCR to route faxes to their intended recipients, the faxes
must arrive in one or more “central” mailboxes. These mailboxes are
configured so that all incoming faxes are rerouted using OCR
routing.

To create a central mailbox for OCR routing, run Enterprise Fax
Manager and add a new RightFax user called “OCR;" and then edit
the user properties. Click the Inbound Routing tab, and enter “0”
(zero) in the Routing Code box. This will cause all incoming faxes

whose owners cannot be determined to automatically route to this
mailbox. Next, click the Inbound Routing tab, and click OCR in the
Routing Type box. This configures the mailbox to perform OCR
routing on each received fax.

Note Only the central mailbox should have its Routing Type set to OCR.
Do not set the routing type of individual RightFax user mailboxes to OCR
or each user's mailbox will attempt to reroute all received faxes,
potentially creating endless routing loops.

In most cases, one central mailbox performing OCR routing is
sufficient. If the needs of your organization require you to create
multiple central mailboxes, each mailbox must have a routing code
that corresponds to a channel extension configured in the
BoardServer.

Creating the OCR routing table

The OCR routing table is a text file that is used to link text on the
fax cover sheet to specific RightFax user IDs. This file must be
called Route.txt and it must be located in the RightFax\WorkSrv
folder on the RightFax server. A sample Route.txt file is provided in
this folder for you to use as an example.

Each line of Route.txt must contain a separate entry in this format:
UserlD MatchingText

Where UserlD is the RightFax user ID to route to, and
MatchingText is the fax cover sheet text that is associated with that
user. The user ID and matching text must be separated by a single
space. The matching text may contain spaces and other special
characters. Here is an example of a short OCR routing table:

JCD Jane

JCD Doe

JCD Jane Doe

JCD Director of Marketing
JCD 555-1212

JSS John Smith

JSS 555-1000

Chapter 22  Using Optical Character Recognition
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The matching text must be matched exactly in order to route the fax.
In this example, a match on the word “Smith," if not preceded by
“John," will not be routed.

RightFax scans the routing table from top to bottom, routing the fax
to the first match. For this reason, the order in which you list user
IDs in this file may be important. You should place your highest
priority user IDs (executive management, for example) at the top of
the list so they will be sure to receive their faxes even if matching
text conflicts with other users in your organization.

Note Because OCR routing requires an exact match between your
OCR routing table and the cover sheet text, you should remove any blank
spaces at the end of your OCR routing table entries. If the matching text
includes trailing spaces, those spaces will be required as part of the text
to match.

Creating alternate routing tables

If you have set up multiple central mailboxes for OCR routing, you
can use a separate routing table for each mailbox. To specify a file
name for the routing table other than Route.txt, run Enterprise Fax
manager and edit the user ID for the mailbox. Click the Inbound
Routing tab, and enter the file name for the routing table in the
Routing Info box. The new routing table file must be located in the
same RightFax\WorkSrv folder and use the same format as the
Route.txt OCR routing file.

When you specify a new file name for the central mailbox routing
table, you can also specify a RightFax user ID to which unmatched
faxes will automatically route. After the file name, type a comma
followed by the RightFax user ID of the user to route the
unmatched faxes to. For example, if you have set up a special OCR
central mailbox that only receives and routes faxes to the Sales
department, you can specify a routing table called Sales.txt and
have all unmatched faxes automatically route to Jane Doe the Sales
Manager (whose RightFax user ID is JCD) by entering this line in
the Routing Info box of the Sales central mailbox:

SALES.TXTJCD

RightFax 9.4 Administrator's Guide
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Chapter 23
Routing Inbound Faxes

The RightFax server provides several methods for routing received
faxes to their intended recipients in your organization. The routing
method you choose will be based primarily on the type of telephone
service you use.

To route faxes to users, you assign a unique “routing code” to each
user. RightFax attempts to match information received with the fax
(such as digits dialed by or separately entered by the fax sender) to
one of your users’ routing codes. This user is then determined to be

from 555-1001 to 555-1020. Your phone company will forward
any or all of these dialed numbers to your system along with the
call. RightFax then uses these included numbers to route faxes to
the proper recipients.

Each RightFax user is assigned a personal fax mailbox that is
assigned a DID/DNIS number (routing code). When a call comes
in with a valid DID/DNIS number, the fax is placed in the
corresponding user’s fax mailbox.

the intended fax recipient. Routing codes should be assigned to users in accordance with the

After RightFax has determined who should receive an incoming fax, number of DID/DNIS digits for which your services are configured.
you then have several options for how that fax should be delivered For example, if you have a set of DID/DNIS numbers of 555-1001
(for example, to the FaxUtil mailbox or attached to an email through 555-1020, and your phone service is configured to
message). forward the last four digits of the dialed number, then you would
assign the routing codes 1001 through 1020 to your users. If you
have three digit service, then you would assign the routing codes

Configuring DID/DNIS Routing 001 through 020 to your users.

Direct Inward Dial (DID) lines support inbound phone service only,
and Dialed Number Identification Service (DNIS) supports
bi-directional faxing. These two methods are considered the most
accurate for fax routing.

Configuring RightFax for DID/DNIS routing

Each fax board must be configured for DID/DNIS routing
separately. To configure the RightFax server and fax board(s) for
DID/DNIS routing, run the RightFax BoardServer configuration

A DID/DNIS interface assigns multiple telephone numbers to a program.

single pair of wires (a telephone trunk). Often these numbers are
sequential and all contain the same prefix. For example, a single
DID/DNIS line may have 20 numbers associated with it ranging
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Configuring Brooktrout boards Configuring DTMF Routing
z?f Erf%ktrogt ;axtttfoardsv click the board name listed under Unlike DID/DNIS routing, DTMF uses Plain Old Telephone Service
obal Board Settings. (POTS) with a single phone number assigned to each phone line.

The person sending the fax dials this number and the call connects

Figure 23.1 The Brooktrout Global Board Settings Dialog Box R
9 9 9 normally. However, before the fax transmission starts, the fax board

ot B Code Satlings — prompts the caller with a tone or voice prompt to enter a routing
'E'Ij";r:[:;d 5:15“"3_‘ Era DA IUxZBD jv Mumber of digits to collect: |4 7 COde fOF the faX they are Sending.
- lobal 0arn ethings
e anne! 10 i Humbsrofcots o g | 4 If the caller enters a valid routing code (one that is assigned to a
- Channel i BosdHodel [U5 i O ) | RightFax user) the fax is placed in that user's mailbox. If the caller

i Channel #2
~ Channel i3 does not enter a code before a certain amount of time has elapsed,
or if the code does not correspond to a valid RightFax mailbox, the

fax is placed in the mailbox that corresponds to the Channel

¥ Enable ECH

¥ SetFax D for all channels: IHightFAX

1= e Eepatil farelcherres |3ty | Extension setting for the channel it arrived on (or to the
administrator of the Everyone group if no channel extension match
is found).

Delete Board | Add Brooktrout Board | Detect Gammallink Board | QK I Cancel |

In the Number of Digits to Collect box, enter the number of dialed
digits that will be forwarded to the system by the phone company.
In the Number of Digits for Routing box, enter the number of
collected digits that you will use when assigning routing codes to
users. In the DID Service Type box, enter the type of service that
the phone company provides, either “Immediate” or “Wink”

Configuring user routing information

To assign a DID/DNIS routing code to a user, edit the user profile
in Enterprise Fax Manager (see “Editing user properties” on

page 121), click the Inbound Routing tab, and enter the user’s
DID/DNIS phone extension in the Routing Code box. The number
you enter here must have the exact number of digits that you
specified in the Number of Digits for Routing box when
configuring the fax boards.



Configuring RightFax for DTMF routing

Each fax channel must be configured for DTMF routing separately.
To configure the RightFax server and fax board(s) for DTMF routing,
run the RightFax BoardServer configuration program. Click each
channel number under the fax boards.

Figure 23.2 Brooktrout Channel Settings Dialog Box
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1. Under Inbound Routing, select the Enable DTMF Routing
check box.

2. Click Initial Tone or Initial Speech (speech is only available
with Brooktrout fax boards) and configure the tone or speech
parameters.

3. Select the No Terminator check box if you don't want to require
the caller to press [#] or [*] after entering the routing code. If
you want to require the caller to press [#] or [*] after entering
the routing code, select the terminator character you want in the
Terminator box.

4. In the Max. Digits box, enter the maximum number of digits the
caller must enter for a valid DTMF routing code. In the Min.
Digits box, enter the minimum number of digits the caller must
enter for a valid DTMF routing code.

5. In the Tone Wait box, enter the length of time (in seconds) after
the prompt for the caller to enter the routing code.

Configuring user routing information

To assign a DTMF routing code to a user, edit the user profile in
Enterprise Fax Manager (see “Editing user properties” on

page 121), click the Inbound Routing tab, and enter the user's
DTMF code in the Routing Code box. The digits entered here
correspond directly to the digits entered by the caller when
prompted. Although each user must have a unique DTMF routing
code, the assigned codes can be of variable length.

Configuring OCR Routing

For information on using Optical Character Recognition for
inbound routing, see Chapter 22, “Using Optical Character
Recognition”.

Configuring Channel Routing

With channel routing, faxes are routed based on the phone line on
which they are received. This can work well if you have, for
example, four departments and four incoming fax lines (channels).
Each department uses a unique fax number, and all faxes to that
department are delivered to a single fax mailbox. Each of the
members of the department can check the department mailbox for
faxes, the faxes can be directed to a printer located in the
department, or the faxes can be routed manually or via OCR
routing to the intended recipient.
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Channel routing with digital fax boards

Configuring ANI Routing

Channel routing cannot be used with Intel Dialogic digital fax
boards.

To implement channel routing with other digital fax boards, edit the
Windows registry entry HKEY_LOCAL_MACHINE\ Software\
RightFax\DocTransport\Transports\Brooktrout. Create the

REG_DWORD entry DoDigitalChanRoute and set the value to 1.

After creating the entry, configure the routing with the following
instructions.

Configuring RightFax for channel routing

Each fax channel must be configured for channel routing
separately. To configure the RightFax server and fax boards for
channel routing, run the RightFax BoardServer configuration
program.

Click each channel number under the fax board names. For each
channel, set the Channel Extension to a number between 1 and
99. This setting will correspond to the Routing Code of the mailbox
that is to receive all faxes coming in on this channel. You can also
set two or more channels to the same Routing Extension if you
want a single mailbox to receive faxes from multiple channels.

Configuring recipient mailboxes

To assign channel extensions to mailboxes, edit the user profile for
each recipient mailbox in Enterprise Fax Manager. Click the
Inbound Routing tab and enter the Channel Extension setting of
the channel that you want to receive faxes from in the Routing
Code box.

ANI (Automatic Number Identification) is a service provided by
telephone service providers. It precedes each incoming phone call
with a series of digits that includes (among other things) the phone
number dialing in. Although the ANI data format differs slightly from
carrier to carrier, the basic format is:

KP+/+7(or 10)digits+ST

where KP is the key pulse, / is an information digit, 7(or 710) digits
is the calling party station directory number, and ST is a start signal.

RightFax can use ANI information to route inbound faxes to a user
mailbox based on the phone number that the fax originated from.
Using ANI routing, all faxes from a certain phone number can be
routed to a specific recipient. Similarly, all faxes originating from a
specific area code or telephone number prefix can be routed to a
specific recipient. This routing method can be useful to sales
departments for routing faxes according to sales territories.

ANI routing is not available with analog fax boards.

Configuring RightFax for ANI routing

To route faxes with ANI routing, the faxes must arrive in one
“central” mailbox. This mailbox is configured so that all incoming
faxes are rerouted using ANI routing.

To create a central mailbox for ANI routing, run Enterprise Fax

Manager and add a new RightFax user called “ANI," and then edit
the user properties. Click the Inbound Routing tab, and enter “0”
(zero) in the Routing Code box. This will cause all incoming faxes
whose owners cannot be determined to automatically route to this



mailbox. Next, click the Inbound Routing tab, and click ANI in the
Routing Type box. This configures the mailbox to perform ANI
routing on each received fax.

Note Only the central mailbox should have its Routing Type set to ANI.
Do not set the routing type of individual RightFax user mailboxes to AN/
or each user’s mailbox will attempt to reroute all received faxes,
potentially creating endless routing loops.

In most cases, one central mailbox performing ANI routing is
sufficient. If the needs of your organization require you to create
multiple central mailboxes, each mailbox must have a routing code
that corresponds to a channel extension configured in the
BoardServer.

Because the ANI data you receive from your service provider
probably includes extra informational digits, you must specify the
pattern of the ANI digits so that the extra digits can be removed
prior to ANI routing. To specify this pattern, open the RightFax
BoardServer service in Enterprise Fax Manager and select Global

Board Settings. In the ANI Pattern Matching box, enter the
pattern of ANI data you receive using the symbols in the following
table.

Table 23a ANI Pattern Symbols

Symbol Represents

* Matches one or more asterisk characters in the

source string.

# Matches one or more pound characters in the
source string.

X Matches one or more digits belonging to the ANI
number. (This is the only number sequence that will
be used for ANI routing, all other information is

ignored.)

Y Matches one or more digits belonging to the DNIS
number.

Y4 Matches one or more extraneous digits which are
discarded.

Max. Modifier | A digit that represents a maximum character match
(1-9) for any of these symbols described here. (For

example, “x2*y" will match x***...yyy... or xx***...yyy....)
Literal Digits Valid phone digits. (Separate literal digits from Max.
(0-9 and Modifiers with a space.)
A-D)

Example 1x10%y = 1xxx00XXXX***...yyy...
x27*y2 2 = xxzzz..***...yy2

Finally, on the RightFax server, create an ASCI| file called Ani.tbl in
the RightFax\Bin folder. This file is the ANI routing table. Each line
must contain a separate entry using this format:

RoutingCode ANIString
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